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ВСТУП 
 

Змістом лабораторного циклу є дослідження і проектування цифро-
вих пристроїв (ЦП) на засадах сучасної технології інженерної праці з вико-
ристанням систем автоматизованого проектування (САПР). Особливість 
методики навчання полягає в тому, що елементи САПР засвоюються пара-
лельно з основами цифрових пристроїв.  

З огляду на те, що інтегральні схеми (ІС) жорсткої структури можна 
розглядати як компоненти сучасних ІС програмованої структури, під час 
лабораторних досліджень поєднано засвоєння основ реалізації ЦП на тра-
диційній і новій елементній базі. Такий підхід зумовлений тим, що універ-
сальність складних великих і надвеликих інтегральних мікросхем програ-
мованої структури (надалі позначатимемо їх терміном ПЛІС – програмова-
ні логічні ІС) і пов’язане з цим підвищення їх серійноспроможності та 
зниження вартості радіоелектронної апаратури (РЕА) має спричинити пе-
рехід цифрової радіоелектроніки, в основному, на нову елементну базу. 

Через складність ПЛІС (в одному кристалі міститься від тисяч до мі-
льйонів еквівалентних вентилів типу двовходових логічних елементів) було 
розроблено нові автоматизовані методи синтезу цифрових структур і ком-
плексні засоби проектування апаратури на персональних комп’ютерах. Зок-
рема, для популярних ПЛІС фірми Altera впроваджено системи автоматизо-
ваного проектування MAX+plus і Quartus кількох версій. Хоча САПР різних 
фірм мають відмінності, методика проектування на їх основі є багато в чому 
спільною. Для визначеності в цьому циклі користуватимемося версією паке-
та MAX+plus II Baseline, яка підтримується фірмою Altera для університет-
ської освіти. Система є повноцикловою (типу EDA – electronic design 
automation). На відміну від попередніх систем (типу CAD – computer aided 
design) вона забезпечує всі етапи проекту – від моделювання до фізичного 
програмування великих інтегральніх схем (ВІС) та тестування результатів. 

   
В1   Початкові поняття програмного забезпечення MAX+plus II 
Проект (Design) – комплект файлів, створених користувачем і про-

грамним забезпеченням для досягнення поставленої мети. Проектним фай-
лом (Design File) з розширенням, що закінчується на df, називають такий, 
на основі якого створюється проект. Низка інших файлів, частина яких 
утворюється автоматично, є службовими або допоміжними, причому назва 
всіх файлів (але кожна зі своїм розширенням) має збігатися з ім’ям проекту 
(без розширення). Subdesign (підроект) – проект найнижчого рівня, що є 
або остаточним, або складником проекту вищого рівня, який у свою чергу 
може правити за підроект деякого суперпроекту і так далі за ієрархією. 

Device (пристрій, мікросхема) – надвелика інтегрована мікросхема 
програмованої структури. Pin (штирок) – реально існуючий вивід мікрос-



 

хеми для зовнішніх з’єднань. 
мікросхеми для обміну із зовнішніми пристроями, тобто штирок, на якому 
діє інформаційний сигнал.

гічні функції (серед них є складні), вбудовані в програмне забезпечення, 
або функції, створені користувачем, у тому числі для всього проекту чи 
його частини. Графічно символ зображається спрощеним умовним позн
ченням зі всіма входами та виходами. 
кач) 
ми або портами. 
внутрішній сигнал (на відміну від порту, що репре
нал).

якими здійснюється з
сля

 

хеми для зовнішніх з’єднань. 
мікросхеми для обміну із зовнішніми пристроями, тобто штирок, на якому 
діє інформаційний сигнал.

Symbol
гічні функції (серед них є складні), вбудовані в програмне забезпечення, 
або функції, створені користувачем, у тому числі для всього проекту чи 
його частини. Графічно символ зображається спрощеним умовним позн
ченням зі всіма входами та виходами. 
кач) – умовно позначений вивід символу для зв’язку з внутрішніми вузл
ми або портами. 
внутрішній сигнал (на відміну від порту, що репре
нал). 

САПР
якими здійснюється з
сля запуску програми (рис. В1). 

хеми для зовнішніх з’єднань. 
мікросхеми для обміну із зовнішніми пристроями, тобто штирок, на якому 
діє інформаційний сигнал.

Symbol (символ) 
гічні функції (серед них є складні), вбудовані в програмне забезпечення, 
або функції, створені користувачем, у тому числі для всього проекту чи 
його частини. Графічно символ зображається спрощеним умовним позн
ченням зі всіма входами та виходами. 

умовно позначений вивід символу для зв’язку з внутрішніми вузл
ми або портами. Node
внутрішній сигнал (на відміну від порту, що репре

САПР MAX+plus II
якими здійснюється з
запуску програми (рис. В1). 

хеми для зовнішніх з’єднань. 
мікросхеми для обміну із зовнішніми пристроями, тобто штирок, на якому 
діє інформаційний сигнал. 

(символ) – файл проекту, що відображає або стандартні л
гічні функції (серед них є складні), вбудовані в програмне забезпечення, 
або функції, створені користувачем, у тому числі для всього проекту чи 
його частини. Графічно символ зображається спрощеним умовним позн
ченням зі всіма входами та виходами. 

умовно позначений вивід символу для зв’язку з внутрішніми вузл
Node (вузол) 

внутрішній сигнал (на відміну від порту, що репре

В2   Вікно MAX+plus II Manager
MAX+plus II складається з  програмних модулів, 

якими здійснюється з головного вікна
запуску програми (рис. В1). 

6

хеми для зовнішніх з’єднань. Рort (у даному сенсі 
мікросхеми для обміну із зовнішніми пристроями, тобто штирок, на якому 

файл проекту, що відображає або стандартні л
гічні функції (серед них є складні), вбудовані в програмне забезпечення, 
або функції, створені користувачем, у тому числі для всього проекту чи 
його частини. Графічно символ зображається спрощеним умовним позн
ченням зі всіма входами та виходами. 

умовно позначений вивід символу для зв’язку з внутрішніми вузл
(вузол) – у програмних файлах відображає лише 

внутрішній сигнал (на відміну від порту, що репре

Вікно MAX+plus II Manager
складається з  програмних модулів, 

оловного вікна
запуску програми (рис. В1).  

Рисунок
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(у даному сенсі 
мікросхеми для обміну із зовнішніми пристроями, тобто штирок, на якому 

файл проекту, що відображає або стандартні л
гічні функції (серед них є складні), вбудовані в програмне забезпечення, 
або функції, створені користувачем, у тому числі для всього проекту чи 
його частини. Графічно символ зображається спрощеним умовним позн
ченням зі всіма входами та виходами. Pinstub

умовно позначений вивід символу для зв’язку з внутрішніми вузл
у програмних файлах відображає лише 

внутрішній сигнал (на відміну від порту, що репре

 
Вікно MAX+plus II Manager
складається з  програмних модулів, 

оловного вікна Manager, що 

унок В1 

(у даному сенсі – вивід, контакт)
мікросхеми для обміну із зовнішніми пристроями, тобто штирок, на якому 

файл проекту, що відображає або стандартні л
гічні функції (серед них є складні), вбудовані в програмне забезпечення, 
або функції, створені користувачем, у тому числі для всього проекту чи 
його частини. Графічно символ зображається спрощеним умовним позн

Pinstub (місце підімкнення, зати
умовно позначений вивід символу для зв’язку з внутрішніми вузл

у програмних файлах відображає лише 
внутрішній сигнал (на відміну від порту, що репрезентує зовнішній си

Вікно MAX+plus II Manager 
складається з  програмних модулів, 

Manager, що з’являється одразу 

вивід, контакт)
мікросхеми для обміну із зовнішніми пристроями, тобто штирок, на якому 

файл проекту, що відображає або стандартні л
гічні функції (серед них є складні), вбудовані в програмне забезпечення, 
або функції, створені користувачем, у тому числі для всього проекту чи 
його частини. Графічно символ зображається спрощеним умовним позн

(місце підімкнення, зати
умовно позначений вивід символу для зв’язку з внутрішніми вузл

у програмних файлах відображає лише 
зентує зовнішній си

складається з  програмних модулів, керування 
з’являється одразу 

вивід, контакт) – вивід 
мікросхеми для обміну із зовнішніми пристроями, тобто штирок, на якому 

файл проекту, що відображає або стандартні ло-
гічні функції (серед них є складні), вбудовані в програмне забезпечення, 
або функції, створені користувачем, у тому числі для всього проекту чи 
його частини. Графічно символ зображається спрощеним умовним позна-

(місце підімкнення, затис-
умовно позначений вивід символу для зв’язку з внутрішніми вузла-

у програмних файлах відображає лише 
зентує зовнішній сиг-

керування 
з’являється одразу пі-

вивід 
мікросхеми для обміну із зовнішніми пристроями, тобто штирок, на якому 

о-
гічні функції (серед них є складні), вбудовані в програмне забезпечення, 
або функції, створені користувачем, у тому числі для всього проекту чи 

а-
с-
а-

у програмних файлах відображає лише 
г-

керування 
і-
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Рядок заголовка (Title Bar) містить назву пакета (MAX+plus II), по-
вний шлях до папки з поточним проектом (директорію) та ім'я останнього. 
Оброблятися можуть файли лише того проекту, ім’я якого зазначене в 
цьому рядку, тому для переходу до потрібного проекту необхідно встано-
вити його ім'я в рядку заголовка, що легко зробити, користуючись назвою 
будь-якого файла цього проекту . 

Рядок меню (Menu) складається з елементів, набір яких не є сталим, 
а змінюється залежно від виконуваного модуля програми (у кожному мо-
дулі до 10 складників меню).  Але завжди відображаються 5 складників: 

– MAX+plus II – викликає потрібний програмний модуль; 
– File – крім звичайних операцій з файлами (створення нового 

файла – New, відкриття – Open, видалення – Delete File та виходу з про-
грами – Exit MAX+plus II) містить низку команд керування проектом, ча-
стина з яких розкривається списком у рядку Project; 

– Assign – складається з меню призначень проекту, серед яких вибір 
мікросхеми – Device, її виводів – Pin/Location/Chip, параметрів логічного 
синтезатора і часового аналізатора та ін.; 

– Options – відкриває меню опцій менеджера, серед них User 
Libraries (бібліотека користувача) з файлами сформованих символів і 
Preferences (надання переваги) – діалогове вікно з низкою корисних нала-
штувань: Ask Before Closing MAX+plus II (запитувати перед закриттям  
програми), Ask Before Deleting Files (запитувати перед видаленням файлів), 
Iconize Compiler at Start of Processing та Iconize Simulator at Start of 
Processing (згортати до значків вікна компілятора та імітатора під час їх 
старту), Show Toolbar та Show Status Bar (показувати рядок інструментів та 
рядок стану), Automatically Load Last Project at Start-Up (автоматично зава-
нтажувати останній проект під час запуску MAX+plus II); доцільно, при-
наймні, до набуття досвіду встановити прапорці всіх опцій, крім двох 
Iconize... (вікна компілятора та імітатора під час активізації цих модулів 
доцільно залишити на екрані аби переконатися, що обробляється файл по-
трібного проекту, та в правильності деяких налаштувань); 

– Help – відкриває меню довідки. 
Інструментальна панель (Tool-

bar) відображає піктограми (деякі з них 
відкривають діалогові вікна), що дозволяють швидко викликати команди, 
які містяться в меню. Перші дев’ять  з них – звичайні команди Windows 
(New – новий файл, Open – відкрити, Save – зберегти, Print – друкувати, 
Cut – вирізати, Copy – копіювати, Paste – вставити, Undo – скасувати 
останню дію, Context-Sensitive Help – контекстно-залежна довідка), а 12 
наступних – дублюють команди модулів з меню MAX+plus II. Крім того, з 
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десяток спеціальних піктограм з’являються залежно від активного модуля. 
Ще одна, вертикальна, палітра інструментів (ліворуч у вікні) активізуєть-
ся в окремих модулях для формування файлів (графічних, символьних і ча-
сових діаграм).  

Рядок поточного стану (Status Bar) відображає стислий опис елемента 
панелі або палітри інструментів, на який вказує курсор маніпулятора (миші). 

 
В3   Меню MAX+plus II 

Компонент меню „MAX+plus II” є найголовнішим, бо з нього запу-
скаються всі програмні модулі (програми-додатки), призначені для повно-
го циклу обробки проекту. Розгорнутий список складників меню 
MAX+plus II у вікні Manager показано на рисунку В1. Необхідний мінімум 
відомостей щодо використання програмних модулів (деякі з них назива-
ються редакторами) наочно викладається на конкретних прикладах безпо-
середньо в лабораторному циклі, а тут стисло охарактеризуємо лише їх 
призначення.  

Графічний редактор (Graphic Editor) призначений для вве-
дення проекту у вигляді схеми з'єднань символів компонентів, що 

перебувають у стандартних бібліотеках пакета або в бібліотеках користу-
вача. Результатом є сформований проектний файл з розширенням .gdf 
(Graphic Design File). 

Редактор часових діаграм (Waveform Editor) виконує функцію 
введення діаграм (епюр) вхідних сигналів та формування на основі 

компіляції і функціонального моделювання логіко-часових вихідних діаграм 
з метою наочної імітації функціонування пристрою. Результатом є файл з ро-
зширенням .scf (Simulator Channel File). За допомогою цього редактора мож-
на також створити проект шляхом введення потрібних часових діаграм. Сфо-
рмований  таким чином проектний файл має розширення .wdf (Waveform 
Design File). 

Текстовий редактор (Text Editor) призначений для створення і 
редагування проектних файлів, в яких проект вводиться мовою опису 

пристроїв AHDL (Altera Hardware Description Language) або близькими до 
неї мовами типу VHDL чи Verilog HDL. Результатом є файл з розширенням 
.tdf. (Text Design File). Цим редактором можна також задати в текстовому 
вигляді часові діаграми (вектори) сигналів у файлі з розширенням .vec.  

Символьний  редактор (Symbol Editor) дозволяє редагувати 
існуючі символи і створювати нові; будь-який відкомпільований 

проект може бути згорнутий до символу, поміщений до бібліотеки симво-
лів і використаний як елемент іншого проекту. Символи зручно застосову-
вати разом з іншими схемними компонентами в графічному і текстовому 
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редакторах. За ієрархічної побудови проекту його основний файл за допо-
могою символів набуває вигляду структурної схеми, що спрощує створен-
ня складних пристроїв. Файл цього редактора має розширення .sym 
(Symbol File). 

Редактор фізичного розміщення (Floorplan Editor), виконує 
автоматичне розміщення елементів мікросхеми і трасування з’єднань. 

Також є можливість ручного редагування зв’язків на плані розташування 
комірок мікросхеми. Результатом є конфігураційний файл, необхідний для 
фізичного програмування структури кристала; створюється також файл зві-
тності з інформацією, зокрема, про використання ресурсу ІС.  

Компілятор (Compiler) є головним програмним модулем, що 
виконує функції перевірки коректності введення проекту і локалізації 

помилок, математичного моделювання щодо оптимізації логічних функцій 
та часового аналізу, розподілу елементів по комірках мікросхеми тощо. Ре-
зультатом виконання підпрограм компілятора є формування низки службо-
вих файлів, які використовуються іншими редакторами, у тому числі для 
програмування та конфігурування ІС. 

Імітатор (Simulator) призначений для функціонального моде-
лювання проекту з метою перевірки правильності логіки його функ-

ціонування. Результатом моделювання є формування часових діаграм ви-
хідних сигналів, які є реакцією пристрою на вхідні сигнали, задані за до-
помогою редактора часових діаграм або текстового редактора. Вихідні си-
гнали відображаються у файлах з розширенням .gdf і .vec. 

Часовий аналізатор (Timing Analyser) виконує розрахунок ча-
сових інтервалів поширення сигналів між різними вузлами схеми 

скомпільованого проекту. Результатами аналізу є матриця затримок або ди-
сплей швидкодії, які можна зберегти у вигляді таблиці файла з розширенням 
.tao (Timing Analyzer Output File – вихідний файл часового аналізатора). 

Дисплей ієрархії (Hierarchy Display) забезпечує створення 
проекту ієрархічної структури, який може складатися з множини про-

ектів різних рівнів, причому число рівнів не обмежується. Основний проект 
(найвищого рівня), створений у графічному редакторі, відображається у 
файлі дисплея ієрархії зв’язками між складниками з гіперпосиланнями. 

Програматор (Programmer) виконує функції фізичного про-
грамування і верифікації мікросхем, тобто створення протягом хви-

лин реально працюючих пристроїв. Крім того, перед фізичним програму-
ванням можна здійснити перевірку що мікросхема є порожньою, а після 
нього виконати верифікацію (перевірку на відповідність пристрою даним у 
файлі програмування) та функціональне тестування (перевірку на відпові-
дність сигналів потрібним часовим діаграмам). 
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Процесор повідомлень (Message Processor) забезпечує фор-
мування, відображення і локалізацію (зазначення місця в проекті, 

якого стосується певна інформація) повідомлень трьох типів: про помилки 
(Error), попередження (Warning) і інформаційні (Info). Причину появи того 
чи іншого повідомлення можна з'ясувати через опцію Help on Message ме-
неджера. Компіляція проекту неможлива до повного усунення помилок, а 
за наявності попереджень вона успішно завершується, проте попередження 
мають бути ретельно проаналізовані з наступним усуненням їх причин або 
ігноруванням залежно від наслідків. Інформаційні повідомлення несуть 
додаткову інформацію, яку можна взяти до уваги на етапі конфігурування 
мікросхеми. 

 

В4   Методика виконання лабораторних робіт 
Лабораторний цикл охоплює: а) теоретичний матеріал з основних 

розділів цифрових пристроїв, б) виконання практичних завдань і в) лабора-
торні дослідження. Основна увага приділяється засвоєнню основ цифрових 
пристроїв, а комп’ютерна техніка є інструментарієм для відпрацювання 
навичок сучасної інженерної праці, коли левова частка діагностики під час 
експлуатації діючої апаратури та проектування і налагодження нової апа-
ратури має припадати на програмне моделювання за допомогою САПР. З 
метою активізації самостійного навчання лабораторні роботи мають варіа-
нтний характер – крім спільної частини дослідження типових пристроїв 
передбачено також індивідуальне завдання. Методично лабораторний цикл 
побудовано таким чином, аби роботи можна було виконати самостійно, у 
дистанційному режимі. 

З огляду на це перед виконанням лабораторної роботи необхідно: а) 
засвоїти теоретичний матеріал з її теми, б) виконати практичне завдання 
згідно зі своїм варіантом, в) ознайомитися з лабораторним завданням з ме-
тою з’ясувати, які процедури САПР і елементи програмного забезпечення 
потрібно відпрацювати під час дослідження. У зв’язку з надзвичайно роз-
галуженою системою MAX+Plus II рекомендується обмежитися потрібним 
мінімумом відомостей щодо САПР, достатніх для виконання даної роботи. 

 
В5   Зміст звіту з виконання лабораторної роботи 

Назва і мета роботи; результати виконання домашнього завдання; 
зміст кожного пункту лабораторного завдання: файли зі схемами, часовими 
діаграмами та іншими результатами зі стислими поясненнями і висновками. 

 
В6   Універсальний лабораторний стенд 

Лабораторний стенд призначений виконувати такі функції: 1) моде-
лювати ЦП і їх характеристики на комп’ютері; 2) реалізовувати реальні 
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пристрої на ПЛІС, що еквівалентно складанню і дослідженню ЦП на будь-
якій елементній базі; 3) одночасно з досліджуваним ЦП створювати вимі-
рювальні пристрої, зокрема, осцилограф; 4) відпрацьовувати (макетувати) 
прототипи реальних розробок, у тому числі під час курсового і дипломного 
проектування та науково-дослідної роботи (НДР). 

Основу стенда становлять персональний комп’ютер РС, лаборатор-
на плата UP2 (UP – University Program) фірми Altera (США) та 
з’єднувальний пристрій ByteBlaster (рис. В2), описаний у лабораторній ро-
боті № 9. Крім того, є можливість приєднувати джерела сигналів, радіови-
мірювальні та інші засоби, а також створювати систему з кількох плат. Ре-
сурс плати UP2 поділено між двома мікросхемами – родини МАХ7000S 
(тип EPM7128S) та FLEX10K (тип EPF10K70). На функціональній схемі 
(рис. В2) подано елементи, що стосуються першої ПЛІС, позначення яких 
відповідає схемі розташування (рис. В3). За функціональним призначен-
ням ці елементи можна поділити на групи, умовно відокремлені секціями 
(рис. В2). 

1 Мікросхема з функціональними рознімачами. ПЛІС EPM7128S 
встановлена у 84-контактний рознімач з пластиковим корпусом і виводами 
J-форми типу PLCC (Plastic J-lead Chip Carrier) – по 21 контакту з кожного 
боку. По периметру мікросхеми розташовано чотири 22-контактні дублю-
вальні рознімачі Р1...Р4, з’єднані з виводами відповідного боку ПЛІС. Но-
мери виводів мікросхеми позначено на самій платі, а їх з’єднання з контак-
тами рознімачів Р1...Р4 наведено в таблиці Б1 (тут і далі – див. додатки), де 
символом „х” позначено невикористовувані контакти. Живлення, „земля” 
та програмувальні сигнали JTAG до цих рознімачів не підведено. Контакт-
ні гнізда PS призначені для зовнішніх з’єднань сигнальних виводів корис-
тувача І/О. Додатковий рознімач розширення MAX_EXPANSION призна-
чений для під’єднання зовнішніх пристроїв. Його контакти з’єднано зі 
входами/виходами користувача І/О, глобальними входами, а також контак-
тами живлення та „землі” мікросхеми [9]. 

2 Живлення. Через коаксіальний кабель DC_IN до плати подається 
напруга 7...9 В від зовнішнього нестабілізованого джерела живлення, яке 
має забезпечувати струм не менше 350 мА. Наявність зовнішньої напруги 
індикується зеленим світлодіодом POWER, а її величину можна контролю-
вати з контактних площин RAW. Усі компоненти плати живляться напру-
гою VCC = 5 В від вбудованого інтегрального стабілізатора напруги Stab 
типу LM340T. Стабілізовану напругу можна контролювати з контактних 
площин DC. 

3 Тактовий генератор. На платі є вбудований тактовий генератор 
G з кварцовою стабілізацією частоти 25,175 МГц. Вихід генератора 
з’єднано з глобальним синхровходом мікросхеми GCLK (вивід 83).  
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1  ОСНОВНІ ЛОГІЧНІ ФУНКЦІЇ 
Мета роботи: дослідження типових логічних елементів; засвоєння 

основ керування файлами у MAX+plus II; засвоєння основ часового аналізу. 
Домашнє завдання 

! 1) Засвоїти теоретичні відомості щодо основних логічних функцій, 
співвідношень алгебри логіки а також арифметичних основ цифрової тех-
ніки, необхідних для розуміння логічних схем. Ознайомитися із загальни-
ми відомостями щодо пакета MAX+plus II (див. вступ).  

2) Визначити, яку логічну функцію виконують схеми з елементом, 
заданим згідно з варіантом (див. додаткок А, варіанти завдання 1). 

 
1.1  Стислі теоретичні відомості 

1.1.1  Основи алгебри логіки  
Цифровий пристрій є перетворювачем інформації в тому сенсі, що 

сигнал на кожному з його виходів залежить від сукупності вхідних сигналів 
за чітко визначеними правилами. Ці правила описуються мовою алгебри ло-
гіки, яка оперує з логічними змінними й функціями (вони називаються та-
кож двійковими, бо можуть набувати двох значень: логічного 0 або 1). От-
же, алгебра логіки є основою не тільки проектування ЦП, але й розуміння 
принципу їх дії. Вона використовується також за текстового опису проектів 
мовами програмування високого рівня HDL (Hardware Description Language 
– мови опису апаратних засобів), зокрема, мовою AHDL, яка пристосована 
до ІС фірми Altera. Основні логічні функції та зображення їх мовою AHDL 
наведено в таблиці 1.1.  

Функціонально повну систему або базис становить набір логічних 
функцій, за допомогою якого можна утворити логічну функцію будь-якої 
складності, наприклад, система функцій НЕ, АБО, І утворює булів базис. 
Мінімально повною є система, з якої не можна вилучити жодної функції без 
утрати її повноти; обов’язково в них має бути інверсія. Прикладом є сис-
теми з одного елемента І-НЕ чи АБО-НЕ (завдяки функціональній повноті 
елементи І-НЕ та АБО-НЕ називають універсальними). Пояснення щодо 
основ алгебри логіки а також арифметичні основи цифрової техніки, необ-
хідні для розуміння логічних схем, викладено в [1]. 

Основні співвідношення (табл. 1.2) розглядаються в булевій алгебрі, 
здебільшого, відносно функцій АБО та І, а справедливість тих чи інших фор-
мул відносно інших функцій з'ясовується окремо (у табл. 1.2 для прикладу 
наведено також співвідношення для функції Виключне АБО). Важливими се-
ред них є закони двоїстості або де Морґана, узагальнення яких свідчить, що 
взаємна заміна в логічному виразі будь-якої функції y прямих і інверсних 
змінних та знаків логічного додавання і множення спричиняє її заперечення.  

 ))((; 43214321 xxxxyxxxxy ++=+=  (1.1) 
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Таблиця 1
Назва логічної функції
(логічного елемента)
Звичайна

Повторення
(повторювач, буфер)
НЕ (елемент
інвертор) 
АБО (елемент
диз’юнктор) 
АБО-НЕ (елемент
АБО-НЕ / 

І (елемент І / збігу,
кон’юнктор)
І-НЕ (елемент
І-НЕ / Шеффера)
Виключне АБО 
(елемент  
нерівнозначності) 
Виключне АБО
(елемент 
рівнозначності) 

Заборона 
(елемент НІ)
Імплікація
(імплікатор)

Таблиця 1.1 – Основні логічні функції
Назва логічної функції
(логічного елемента)
Звичайна САПР

Повторення 
(повторювач, буфер) 

елемент НЕ, 
 

Buffer

(елемент АБО,  
диз’юнктор)  

елемент 
 Пірса) 

І (елемент І / збігу, 
кон’юнктор) 

елемент 
НЕ / Шеффера) 

NAND

Виключне АБО  
 

нерівнозначності)  
Виключне АБО-НЕ  

рівнозначності)  
XNOR

 
НІ) 

Імплікація 
(імплікатор) 

(

(Ninhb)

Основні логічні функції
Назва логічної функції 
(логічного елемента) 

Таблиця
відповід
ності

САПР x2 x1 

Buffer 
NOT 

0  
1  

OR 

NOR 

0 0 
0 1 
1 0 
1 1 

AND 

NAND 

0 0 
0 1 
1 0 
1 1 

XOR 

XNOR 

0 0 
0 1 
1 0 
1 1 

(Inhb) 

(Ninhb) 

0 0 
0 1 
1 0 
1 1 
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Основні логічні функції 
Таблиця 
відповід- 
ності 

Позначення функції

y0 y1 Булеве

0 1  
1 0  1

0

y

y

=

=

0  1 
1  0 
1  0 
1  0 

1

0

xy

xy

=

=

0  1 
0  1 
0  1 
1  0 

1

0

y

y

=

=

0  1 
1  0 
1  0 
0  1 1

0

xy

xy

=

=

0  1 
1  0 
0  1 
0  1 

1

0

xy
xy

=
=
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Позначення функції

Булеве AHDL

1

1

x

x

=

=
 

y0 = x1

y1 = !x1

21

21

xx

xx

+

+
 

y0 = x1 # x2

y1 = x

21

21

xx

xx

=

=
 

y0 = x1 & x2

y1 = x

21

21

xx

xx

⊕

⊕
 

y0 = x1 $ x2

y1 = x

21

21 \
xx

xx
→  

y0 = x1 & 

y1 = 

Позначення функції 

AHDL ДЕСТУ

y0 = x1 

y1 = !x1 

y0 = x1 # x2 

= x1 !# x2 

y0 = x1 & x2 

= x1 !& x2 

y0 = x1 $ x2 

= x1 !$ x2 

y0 = x1 & !x2 

= !x1 # x2 

Умовне 
позначення

ДЕСТУ 

 

 

 

 

 

Умовне графічне 
позначення 

САПР 
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Таблиця 1.2 – Основи алгебри логіки 

№ Співвідношення АБО (OR) 
а) 

І (AND) 
б) 

Виключне 
АБО (XOR) 

в) 
Аксіоми: 

1 Подвійне запере-чення xx =  – 

2 Дозвіл xx =+ 0  xx =⋅1  xx =⊕ 0  

3 Блокування (ін-
вертування) 11 =+x  00 =⋅x  ( xx =⊕1 ) 

4 Повторення xxx =+  xxx =⋅  0=⊕ xx  
5 Доповнення 1=+ xx  0=⋅ xx  1=⊕ xx  
Закони: 
1 Переставний 1221 xxxx +=+  1221 xxxx =  1221 xxxx ⊕=⊕  

2 Сполучний ( )321

321

xxx
xxx
++=

=++  ( )321

321

xxx
xxx

=
=  ( )321

321

xxx
xxx
⊕⊕=

=⊕⊕  

3 Розподільчий 
( )

3121

321

xxxx
xxx

+=
=+  ( ) ( )3121

321

xxxx
xxx

+++=
=+  ( )

3121

321

xxxx
xxx

⊕=
=⊕  

4 Двоїстості (де Морґана) 2121

2121

xxxx

xxxx

=+

=+  
2121

2121

xxxx

xxxx

+=

+=  – 

Наслідки: 
1 Склеювання 12121 xxxxx =+  ( )( ) 12121 xxxxx =++  12121 xxxxx =⊕  
2 Поглинання 1211 xxxx =+  ( ) 1211 xxxx =+  21211 xxxxx =⊕  
3 Заступлення 21211 xxxxx +=+  ( ) 21211 xxxxx =+  21211 xxxxx +=⊕  

На відміну від звичайної, у булевій алгебрі всі співвідношення си-
метричні відносно функцій логічного додавання та множення. Аби запобі-
гти помилок, операції виконують у послідовності за пріоритетом: найста-
рший пріоритет має функція логічного заперечення (НЕ), за нею йде логіч-
не множення (І, І-НЕ), нарешті, найнижчими є операції логічного додаван-
ня (АБО, АБО-НЕ) та додавання за модулем два (Виключне АБО, Виключ-
не АБО-НЕ). У САПР на основі мов HDL запрограмовано виконання опе-
рацій за пріоритетом: 1) НЕ, 2) І, І-НЕ, 3) Виключне АБО, Виключне АБО-
НЕ, 4) АБО, АБО-НЕ. Послідовність виконання дій можна змінити, як зав-
жди, за допомогою дужок. 

Добутки всіх літералів (змінних чи їх інверсій), при яких функція  
набуває значення логічної 1 (табл. 1.3), називають мінтермами (конститу-
єнтами одиниці). Сума мінтермів зображає функцію в досконалій  диз'юн-
ктивній нормальній формі (ДДНФ). Диз’юнкція літералів, де функція пере-
творюється на нуль, називається макстермом (конституєнтою нуля), а до-
бутком усіх макстермів функція зображається в досконалій кон’юнктивній 
нормальній формі (ДКНФ).  
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Будь-яка логічна функція зображається в ДДНФ або ДКНФ єдиним 
способом, тому ці форми є вихідними для подальшого аналізу й синтезу. 
Природно, досконалі форми можна зобразити і для інверсного значення 
функції (див. табл. 1.3.). 
Таблиця 1.3 – Досконалі форми зображення функції 

 

1.1.2  Примітиви (Primitives) 
Примітиви є функціональними модулями в САПР MAX+plus II, які 

репрезентують найпростіші типові елементи ЦП, а також допоміжні ком-
поненти в графічних і текстових файлах проекту (термін Primitive охоплює 
базові логічні елементи, тригери, порти, константи та ін.).  

Бібліотека всіх функціональних модулів САПР розташована в ката-
лозі [ім’я диска]:\maxplus2\max2lib, а примітиви зосереджено в підкаталозі 
\prim. У довідці меню Help > Primitives репрезентовано всі п’ять груп, на 
які поділяються примітиви за призначенням: Input & Output Primitives/Ports 
(порти), Buffer Primitives (буфери), Logic Primitives (логічні елементи), 
Flipflop & Latch Primitives (тригери) та Other Primitives (інші примітиви, 
серед яких допоміжний Title Block – блок заголовка для оформлення доку-
ментів.).  

Метою цієї лабораторної роботи є розгляд примітивів перших трьох 
груп, основні елементи яких подано у  файлі з директорією \max2work\tuto-
rial\1libr.gdf:  

1) порти (рис. 1.1, а): односпрямовані INPUT (введення), OUTPUT 
(виведення) і двоспрямований BIDIR (введення-виведення); 

2) буфери (рис. 1.1, б): GLOBAL – для підвищення навантажівної 
здатності в розгалужених колах синхронізації, скидання, дозволу тощо; 
TRI  Primitive – буфер із трьома станами виходу з високим рівнем дозволу 
Output Enable; LCELL Primitive (від logic cell – логічна комірка) – буфер 
для розподілення ресурсу мікросхеми між окремими її комірками (логіч-
ний синтезатор може автоматично запровадити буфер LCELL у схему, але 
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зівних чинників, насамперед температури середовища та нестабільності 

для організації швидких перенесень у лог
чному ланцюжку схем типу суматорів і лічильників; SOFT

й синтезатор сам з’ясовує, залишити буфер чи 
Primitive (від wire 

зично не існує і запроваджується до схеми штучно з метою змінити назву 

зображення констант для граф
логічна 1); стандартні елементи 

inhb), а також деякі їх пар
BNAND). 

порти; б) буфери; в) логічні примітиви

часовий аналізатор, призначений прост
жувати шляхи поширення сигналу, у тому числі критичні, що в

дію пристрою в проекті, синтезованому комп
ного режиму результати аналізу можуть бути 

відображені трьома видами. У цій лабораторній роботі розглядається м
в режимі використання матриці затримок 

(Delay Matrix), в якій наводиться час поширення сигналу від множин
адресатів. 

, якщо він вставлений користувачем); EXP Primitive
буфер з інверсним виходом для використа

сусідніми комірками того ж самого блоку логічних м
(при використанні буферів 

на її величину дестабіл
зівних чинників, насамперед температури середовища та нестабільності 

для організації швидких перенесень у лог
SOFT – програмний 

й синтезатор сам з’ясовує, залишити буфер чи 
 – дріт) – буфер ф

зично не існує і запроваджується до схеми штучно з метою змінити назву 

зображення констант для граф
); стандартні елементи 

), а також деякі їх пар

порти; б) буфери; в) логічні примітиви

часовий аналізатор, призначений прост
жувати шляхи поширення сигналу, у тому числі критичні, що в

дію пристрою в проекті, синтезованому комп
ного режиму результати аналізу можуть бути 

відображені трьома видами. У цій лабораторній роботі розглядається м
в режимі використання матриці затримок 

(Delay Matrix), в якій наводиться час поширення сигналу від множин

EXP Primitive
буфер з інверсним виходом для використан-

сусідніми комірками того ж самого блоку логічних ма-
(при використанні буферів LCELL

на її величину дестабілі-
зівних чинників, насамперед температури середовища та нестабільності 

для організації швидких перенесень у логі-
програмний 

й синтезатор сам з’ясовує, залишити буфер чи 
буфер фі-

зично не існує і запроваджується до схеми штучно з метою змінити назву 

зображення констант для графі-
); стандартні елементи 

), а також деякі їх пара-

 

 

 

порти; б) буфери; в) логічні примітиви 

часовий аналізатор, призначений просте-
жувати шляхи поширення сигналу, у тому числі критичні, що ви-

дію пристрою в проекті, синтезованому компі-
ного режиму результати аналізу можуть бути 

відображені трьома видами. У цій лабораторній роботі розглядається ме-
в режимі використання матриці затримок 

(Delay Matrix), в якій наводиться час поширення сигналу від множини вуз-

EXP Primitive 
н-
а-

LCELL 
і-

зівних чинників, насамперед температури середовища та нестабільності 
і-

програмний 
й синтезатор сам з’ясовує, залишити буфер чи 

і-
зично не існує і запроваджується до схеми штучно з метою змінити назву 

і-
); стандартні елементи 

а-

 

 

е-
и-
і-

ного режиму результати аналізу можуть бути 
е-

в режимі використання матриці затримок 
з-



 

товки матеріалів звіту

діалогових вікнах, їх 
лівої кнопки миші (
знаком „>”, подвійне клацання цією кнопкою 
правої кнопки миші (

MAX+plus II
нами керування ві
типових команд меню File та 

(повн

 

1.2.
товки матеріалів звіту

F Примітка. 
діалогових вікнах, їх 
лівої кнопки миші (
знаком „>”, подвійне клацання цією кнопкою 
правої кнопки миші (

бочому столі або з меню 
MAX+plus II
нами керування ві
типових команд меню File та 

1.2.
(повного каталог

файл) або з меню 
дкрити);

1.2.1 Основи керування файлами пакету MAX+plus II та підг
товки матеріалів звіту

Примітка. 
діалогових вікнах, їх 
лівої кнопки миші (
знаком „>”, подвійне клацання цією кнопкою 
правої кнопки миші (

1.2.1.1
бочому столі або з меню 

MAX+plus II BASE
нами керування вік
типових команд меню File та 

1.2.1.2 Відкрити потрібний файл
каталогу) 

а) піктограмою панелі інструментів 
файл) або з меню 
дкрити); 

1.2  Лабораторне завдання

снови керування файлами пакету MAX+plus II та підг
товки матеріалів звіту 

Примітка. Послідовність дій, виконуваних (в основному вікні, 
діалогових вікнах, їх частинах, у списках, що розкриваються) натисканням 
лівої кнопки миші (Button 1), далі найчастіше позначатимемо для стислості 
знаком „>”, подвійне клацання цією кнопкою 
правої кнопки миші (Button 2) 

1.1 Запустити програму
бочому столі або з меню 

ELINE > MAX+plus II
кна Manager, складниками меню MAX+plus II і списками 

типових команд меню File та 

Відкрити потрібний файл
 d:\max2work

а) піктограмою панелі інструментів 
файл) або з меню File
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1.2  Лабораторне завдання

снови керування файлами пакету MAX+plus II та підг

Послідовність дій, виконуваних (в основному вікні, 
частинах, у списках, що розкриваються) натисканням 

1), далі найчастіше позначатимемо для стислості 
знаком „>”, подвійне клацання цією кнопкою 

2) – знаком „В2”.
тити програму

бочому столі або з меню Windows
MAX+plus II

ager, складниками меню MAX+plus II і списками 
типових команд меню File та Help (див. Вступ).

Відкрити потрібний файл
work\tutorial

а) піктограмою панелі інструментів 
File > Open
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1.2  Лабораторне завдання

снови керування файлами пакету MAX+plus II та підг

Послідовність дій, виконуваних (в основному вікні, 
частинах, у списках, що розкриваються) натисканням 

1), далі найчастіше позначатимемо для стислості 
знаком „>”, подвійне клацання цією кнопкою – 

знаком „В2”. 
тити програму MAX+plus II (ярликом на р

Windows: 
MAX+plus II BASELINE

ager, складниками меню MAX+plus II і списками 
(див. Вступ).

Відкрити потрібний файл, наприклад, 
tutorial\1lab\1libr

а) піктограмою панелі інструментів 
Open викликати діалогове вікно 

1.2  Лабораторне завдання 

снови керування файлами пакету MAX+plus II та підг

Послідовність дій, виконуваних (в основному вікні, 
частинах, у списках, що розкриваються) натисканням 

1), далі найчастіше позначатимемо для стислості 
 знаком „В**”, а натискання 

MAX+plus II (ярликом на р
 Пуск > Все программ

BASELINE), ознайомитися з орг
ager, складниками меню MAX+plus II і списками 

(див. Вступ). 

, наприклад, 1libr
libr.gdf: 

а) піктограмою панелі інструментів Opens
викликати діалогове вікно 

снови керування файлами пакету MAX+plus II та підг

Послідовність дій, виконуваних (в основному вікні, 
частинах, у списках, що розкриваються) натисканням 

1), далі найчастіше позначатимемо для стислості 
знаком „В**”, а натискання 

MAX+plus II (ярликом на р
Все программ

, ознайомитися з орг
ager, складниками меню MAX+plus II і списками 

libr.gdf з директорі

Opens a file 
викликати діалогове вікно 

снови керування файлами пакету MAX+plus II та підго-

Послідовність дій, виконуваних (в основному вікні, 
частинах, у списках, що розкриваються) натисканням 

1), далі найчастіше позначатимемо для стислості 
знаком „В**”, а натискання 

MAX+plus II (ярликом на ро-
Все программы >

, ознайомитися з орга-
ager, складниками меню MAX+plus II і списками 

 
з директорії

(відкрити 
викликати діалогове вікно Open (ві-

о-

Послідовність дій, виконуваних (в основному вікні, 
частинах, у списках, що розкриваються) натисканням 

1), далі найчастіше позначатимемо для стислості 
знаком „В**”, а натискання 

о-
ы > 
а-

ager, складниками меню MAX+plus II і списками 

 
ї 

(відкрити 
і-



 

натиснути 

ня про його розміри;

 

натиснути 
1.2.

весь файл) вертикальної панелі 
ними стр
(вписати

ня про його розміри;

натиснути ОК), який після цього з’явиться у головному вікні.
1.2.1.3 Переглянути і скопіювати графічний файл:

а) інструментом Changes the Display (відобразити на екрані 
весь файл) вертикальної панелі 
ними стрілками в кут
вписати зобра

ня про його розміри;

ОК), який після цього з’явиться у головному вікні.
1.3 Переглянути і скопіювати графічний файл:
а) інструментом Changes the Display (відобразити на екрані 

весь файл) вертикальної панелі 
лками в кутках
аження у вікні) стиснути зображення, 

ня про його розміри; 
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ОК), який після цього з’явиться у головному вікні.
1.3 Переглянути і скопіювати графічний файл:
а) інструментом Changes the Display (відобразити на екрані 

весь файл) вертикальної панелі зліва
ах) або з меню

ження у вікні) стиснути зображення, 
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прокруткою ввести потрібне ім’я 
диска (наприклад,

двійним клацанням по відповідних 
папках послідовно
max2work

List (показ списку файлів) ввім
нути перемикач потрібного типу 
файлів, наприклад, 
files (файли графічного редакт
ра); 

файлів прокруткою вибрати
бне розширення, наприклад, *

цнути 
(або відмітити

ОК), який після цього з’явиться у головному вікні.
1.3 Переглянути і скопіювати графічний файл:
а) інструментом Changes the Display (відобразити на екрані 

зліва (у вигляді аркуша файла з черв
або з меню View

ження у вікні) стиснути зображення, 

гляд) 
льний розмір) пове
звичайного вигляду зобр
ження;

Increases (збільшення 
гляді лінзи зі знаком плюс) 
або з меню
Zoom
ження 
деталі символів елементів, в
дтак інструментом
(зменшення 

б) у віконці Drives (диски) 
прокруткою ввести потрібне ім’я 

(наприклад,
в) у віконці 

двійним клацанням по відповідних 
папках послідовно

work, tutorial
г) на вкладці 
показ списку файлів) ввім

нути перемикач потрібного типу 
файлів, наприклад, 

файли графічного редакт

ґ) біля встановленого типу 
файлів прокруткою вибрати
бне розширення, наприклад, *

д) у віконці 
 на імені 
відмітити потрібний файл та 

ОК), який після цього з’явиться у головному вікні.
1.3 Переглянути і скопіювати графічний файл:
а) інструментом Changes the Display (відобразити на екрані 

у вигляді аркуша файла з черв
View (вигляд) 

ження у вікні) стиснути зображення, 

б) з меню 
гляд) > Normal
льний розмір) пове
звичайного вигляду зобр
ження; 

в) інструментом
Increases (збільшення 
гляді лінзи зі знаком плюс) 
або з меню
Zoom In 
ження і продивитися потрібні 
деталі символів елементів, в
дтак інструментом
(зменшення 

б) у віконці Drives (диски) 
прокруткою ввести потрібне ім’я 

(наприклад, d:); 
у віконці Directories

двійним клацанням по відповідних 
папках послідовно розкрити 

tutorial та 1lab;
г) на вкладці Show
показ списку файлів) ввім

нути перемикач потрібного типу 
файлів, наприклад, Graphic

файли графічного редакт

ґ) біля встановленого типу 
файлів прокруткою вибрати
бне розширення, наприклад, *

д) у віконці Files двічі кл
 потрібного
потрібний файл та 

ОК), який після цього з’явиться у головному вікні. 
1.3 Переглянути і скопіювати графічний файл: 
а) інструментом Changes the Display (відобразити на екрані 

у вигляді аркуша файла з черв
(вигляд) > Fit in

ження у вікні) стиснути зображення, щоб мати уявл

б) з меню View
Normal Size

льний розмір) повернутися до 
звичайного вигляду зобр

в) інструментом
Increases (збільшення 
гляді лінзи зі знаком плюс) 
або з меню View (вигляд) 

 збільшити зобр
і продивитися потрібні 

деталі символів елементів, в
дтак інструментом 
(зменшення – у вигляді лінзи 

б) у віконці Drives (диски) 
прокруткою ввести потрібне ім’я 

Directories по-
двійним клацанням по відповідних 

розкрити d:\, 
; 

Show in Files
показ списку файлів) ввімк-

нути перемикач потрібного типу 
Graphic Editor

файли графічного редакто-

ґ) біля встановленого типу 
файлів прокруткою вибрати потрі-
бне розширення, наприклад, *.gdf; 

двічі кла-
ого файла

потрібний файл та 

а) інструментом Changes the Display (відобразити на екрані 
у вигляді аркуша файла з черво-

in Window
мати уявлен-

View (ви-
Size (норма-
нутися до 

звичайного вигляду зобра-

в) інструментом
Increases (збільшення – у ви-
гляді лінзи зі знаком плюс) 

(вигляд) > 
збільшити зобра-

і продивитися потрібні 
деталі символів елементів, ві-

 Reduces 
у вигляді лінзи 

б) у віконці Drives (диски) 
прокруткою ввести потрібне ім’я 

о-
двійним клацанням по відповідних 

, 

Files 
к-

нути перемикач потрібного типу 
Editor 
о-

ґ) біля встановленого типу 
і-
 
а-
а 

потрібний файл та 

а) інструментом Changes the Display (відобразити на екрані 
о-

Window 
н-

и-
а-

нутися до 
а-

в) інструментом 
и-

гляді лінзи зі знаком плюс) 
> 
а-

і продивитися потрібні 
і-

Reduces 
у вигляді лінзи 



 

зі знаком мінус) або з меню
но

х
кнопку миші; 
рамкою, а всі елементи всередині неї виділяться червоними рамками;

prim

з’явиться повідомлення, що такої директорії не існує, дати згоду на її ств
рення; в результаті буде створен
вікна 

 

зі знаком мінус) або з меню
нормального розміру;

файла: н
ху) і протягнути ним по діагоналі ділянки, утримуючи натиснутою ліву 
кнопку миші; 
рамкою, а всі елементи всередині неї виділяться червоними рамками;

або з м
1.2.

prim.gdf з директорією 

(ви
ти діалог

з’явиться повідомлення, що такої директорії не існує, дати згоду на її ств
рення; в результаті буде створен
вікна Manager

ти н

зі знаком мінус) або з меню
рмального розміру;

г) виділити потрібну ділянку для копіювання графічного 
файла: натиснути інструмент 

) і протягнути ним по діагоналі ділянки, утримуючи натиснутою ліву 
кнопку миші; після
рамкою, а всі елементи всередині неї виділяться червоними рамками;

ґ) інструментом горизонтальної панелі 
або з меню 

1.2.1.4 Створити власний файл потрібного типу
з директорією 

а) піктограмою панелі інструментів
изначити ім’я проекту) або з меню 
ти діалогове вікно

з’явиться повідомлення, що такої директорії не існує, дати згоду на її ств
рення; в результаті буде створен

Manager відобразиться повна директорія і назва проекту;
д) піктограмою панелі інструментів

ти новий файл) або з меню 

зі знаком мінус) або з меню
рмального розміру; 

г) виділити потрібну ділянку для копіювання графічного 
тиснути інструмент 

) і протягнути ним по діагоналі ділянки, утримуючи натиснутою ліву 
після відпусканн

рамкою, а всі елементи всередині неї виділяться червоними рамками;
ґ) інструментом горизонтальної панелі 

 Edit > Copy
Створити власний файл потрібного типу

з директорією d:\max
а) піктограмою панелі інструментів

значити ім’я проекту) або з меню 
ве вікно Project

з’явиться повідомлення, що такої директорії не існує, дати згоду на її ств
рення; в результаті буде створен

відобразиться повна директорія і назва проекту;
д) піктограмою панелі інструментів
вий файл) або з меню 

New

Editor
товий
form
наприклад, 
го з’явиться вікно 
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зі знаком мінус) або з меню View (вигляд) 

г) виділити потрібну ділянку для копіювання графічного 
тиснути інструмент Selects

) і протягнути ним по діагоналі ділянки, утримуючи натиснутою ліву 
відпускання кнопки ділянка буде облямована чорно

рамкою, а всі елементи всередині неї виділяться червоними рамками;
ґ) інструментом горизонтальної панелі 

Copy скопіювати виділену ділянку в буфер.
Створити власний файл потрібного типу

max2work\rt\
а) піктограмою панелі інструментів

значити ім’я проекту) або з меню 
Project Name

з’явиться повідомлення, що такої директорії не існує, дати згоду на її ств
рення; в результаті буде створена папка

відобразиться повна директорія і назва проекту;
д) піктограмою панелі інструментів
вий файл) або з меню File

New (новий файл);
е) вибрати 

Editor file), символьний
товий (Text 
form Editor file
наприклад, Graphic
го з’явиться вікно 
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(вигляд) > 

г) виділити потрібну ділянку для копіювання графічного 
Selects (вибрати 

) і протягнути ним по діагоналі ділянки, утримуючи натиснутою ліву 
кнопки ділянка буде облямована чорно

рамкою, а всі елементи всередині неї виділяться червоними рамками;
ґ) інструментом горизонтальної панелі 

скопіювати виділену ділянку в буфер.
Створити власний файл потрібного типу

\2br\prim.gdf
а) піктограмою панелі інструментів

значити ім’я проекту) або з меню File
Name (ім’я проекту);

б) у віконці Drives (диски) 
прокруткою 
диска (наприклад,

в)
двійним клацанням 
папках послідовно розкрити 
max2work
наприклад, 

г) у віконці 
ввести номер бригади і через косу 
риску ім’я проекту та залишити 
потрібне розширення (все зайве 
стерти), наприклад, 

ґ) натиснути ОК і, якщо 
з’явиться повідомлення, що такої директорії не існує, дати згоду на її ств

папка з номером бригади і в заголовку 
відобразиться повна директорія і назва проекту;
д) піктограмою панелі інструментів

File > New 
(новий файл); 
е) вибрати тип файла: графічний

, символьний
 Editor file
file) та його розширення (прокруткою), 
Graphic Editor

го з’явиться вікно безіменного 

> Zoom Out

г) виділити потрібну ділянку для копіювання графічного 
вибрати – перша

) і протягнути ним по діагоналі ділянки, утримуючи натиснутою ліву 
кнопки ділянка буде облямована чорно

рамкою, а всі елементи всередині неї виділяться червоними рамками;
ґ) інструментом горизонтальної панелі Copies

скопіювати виділену ділянку в буфер.
Створити власний файл потрібного типу

gdf:     
а) піктограмою панелі інструментів Specifies

File > Project
ім’я проекту); 

б) у віконці Drives (диски) 
прокруткою вибрати

(наприклад,
в) у віконці 

двійним клацанням 
папках послідовно розкрити 

work та папку
наприклад, rt; 

г) у віконці 
и номер бригади і через косу 

риску ім’я проекту та залишити 
потрібне розширення (все зайве 
стерти), наприклад, 

ґ) натиснути ОК і, якщо 
з’явиться повідомлення, що такої директорії не існує, дати згоду на її ств

з номером бригади і в заголовку 
відобразиться повна директорія і назва проекту;
д) піктограмою панелі інструментів Opens 

  викликати діалогове вікно 

тип файла: графічний
, символьний (Symbol

file) або часових діаграм
та його розширення (прокруткою), 

Editor file, .gdf
безіменного (

Out повернутися до 

г) виділити потрібну ділянку для копіювання графічного 
перша стрілка

) і протягнути ним по діагоналі ділянки, утримуючи натиснутою ліву 
кнопки ділянка буде облямована чорно

рамкою, а всі елементи всередині неї виділяться червоними рамками;
Copies (копіювати)

скопіювати виділену ділянку в буфер.
Створити власний файл потрібного типу, наприклад, 

Specifies the project
Project > Name 

б) у віконці Drives (диски) 
вибрати потрібне ім’я 

(наприклад, d:); 
у віконці Directories

двійним клацанням по відповідних 
папках послідовно розкрити 

папку з назвою групи, 

г) у віконці Project
и номер бригади і через косу 

риску ім’я проекту та залишити 
потрібне розширення (все зайве 
стерти), наприклад, 2br\prim

ґ) натиснути ОК і, якщо 
з’явиться повідомлення, що такої директорії не існує, дати згоду на її ств

з номером бригади і в заголовку 
відобразиться повна директорія і назва проекту; 

 a new file
викликати діалогове вікно 

тип файла: графічний
Symbol Editor file

або часових діаграм
та його розширення (прокруткою), 

gdf  > OK, 
(Untitled) файла; 

повернутися до 

г) виділити потрібну ділянку для копіювання графічного 
стрілка звер-

) і протягнути ним по діагоналі ділянки, утримуючи натиснутою ліву 
кнопки ділянка буде облямована чорною 

рамкою, а всі елементи всередині неї виділяться червоними рамками; 
(копіювати)

скопіювати виділену ділянку в буфер. 
, наприклад, 

project name
  виклика-

б) у віконці Drives (диски) 
потрібне ім’я 

Directories по-
відповідних 

папках послідовно розкрити d:\, 
з назвою групи, 

Project Name
и номер бригади і через косу 

риску ім’я проекту та залишити 
потрібне розширення (все зайве 

prim.gdf; 
ґ) натиснути ОК і, якщо 

з’явиться повідомлення, що такої директорії не існує, дати згоду на її ство-
з номером бригади і в заголовку 

file (створи-
викликати діалогове вікно 

тип файла: графічний (Graphic
file), текс-

або часових діаграм (Wave-
та його розширення (прокруткою), 

, після чо-
файла;  

повернутися до 

г) виділити потрібну ділянку для копіювання графічного 
р-

) і протягнути ним по діагоналі ділянки, утримуючи натиснутою ліву 
ю 

(копіювати) 

, наприклад, 

name 
а-

б) у віконці Drives (диски) 
потрібне ім’я 

о-
відповідних 

, 
з назвою групи, 

Name 
и номер бригади і через косу 

риску ім’я проекту та залишити 
потрібне розширення (все зайве 

ґ) натиснути ОК і, якщо 
о-

з номером бригади і в заголовку 

и-
викликати діалогове вікно 

Graphic 
с-
e-

та його розширення (прокруткою), 
о-



 

> 
ОК файлу автоматичн
к

copy
ренести до файла зображення, скопійоване в п
зиціонується лівим верхнім кутом у місці клацання;

для звіту всі потрібні графічні файли з лабораторної 
d

пунктів лабораторної роботи. Якщо 
рювати директорію в п
лише ім’я проекту. 

піктограм інструментів
них можна виконати також з контекстного меню, яке викликається кно
кою В2 (виконання операцій сполученням клавіш тут, здебільшого, не ро
глядається). 

проект, частинами якого можуть бути ко
Але лише задля документування, як звичайно, достатньо скопіювати файли 
потрібного типу безпосередньо в 
бораторної до своєї 

(файл часових діаграм) або його частину

 

to the
> Save As 
ОК файлу автоматичн
ка Manager

місц
copy of the
ренести до файла зображення, скопійоване в п
зиціонується лівим верхнім кутом у місці клацання;

з) повторити п
для звіту всі потрібні графічні файли з лабораторної 
d:\max2work

F Примітки
1. Копіювати файли для звіту можна під час виконання відповідних 

пунктів лабораторної роботи. Якщо 
рювати директорію в п
лише ім’я проекту. 

2. Тут подано швидке виконання операцій з файлами за допомогою 
піктограм інструментів
них можна виконати також з контекстного меню, яке викликається кно
кою В2 (виконання операцій сполученням клавіш тут, здебільшого, не ро
глядається). 

3. 
проект, частинами якого можуть бути ко
Але лише задля документування, як звичайно, достатньо скопіювати файли 
потрібного типу безпосередньо в 
бораторної до своєї 

1.2
(файл часових діаграм) або його частину

є) натисненням піктограми панелі і
the current
 викликається діалогове вікно 

ОК файлу автоматичн
Manager, із введеним у п

ж) у лівому верхньому кут
місці вставлення копії і піктограмою панелі інструментів

the Clipboard
ренести до файла зображення, скопійоване в п
зиціонується лівим верхнім кутом у місці клацання;

з) повторити п
для звіту всі потрібні графічні файли з лабораторної 

work\1lab\1libre
Примітки
Копіювати файли для звіту можна під час виконання відповідних 

пунктів лабораторної роботи. Якщо 
рювати директорію в п
лише ім’я проекту. 

Тут подано швидке виконання операцій з файлами за допомогою 
піктограм інструментів
них можна виконати також з контекстного меню, яке викликається кно
кою В2 (виконання операцій сполученням клавіш тут, здебільшого, не ро
глядається).  

 Наведені операції з файлами дають змогу створювати власний 
проект, частинами якого можуть бути ко
Але лише задля документування, як звичайно, достатньо скопіювати файли 
потрібного типу безпосередньо в 
бораторної до своєї 

1.2.1.5 Скопіювати 
(файл часових діаграм) або його частину

є) натисненням піктограми панелі і
current file (зберегти зміни в поточному файлі) або з меню 

викликається діалогове вікно 
ОК файлу автоматично надається ім’я проекту, зазначене в рядку заголо

, із введеним у підпункті
ж) у лівому верхньому кут
вставлення копії і піктограмою панелі інструментів

Clipboard (вставити копію з буфера) або з меню
ренести до файла зображення, скопійоване в п
зиціонується лівим верхнім кутом у місці клацання;

з) повторити підпункти
для звіту всі потрібні графічні файли з лабораторної 

libre.gdf, 1
Примітки: 
Копіювати файли для звіту можна під час виконання відповідних 

пунктів лабораторної роботи. Якщо 
рювати директорію в пп. 1.2.
лише ім’я проекту.  

Тут подано швидке виконання операцій з файлами за допомогою 
піктограм інструментів або командами складників рядка меню, але дея
них можна виконати також з контекстного меню, яке викликається кно
кою В2 (виконання операцій сполученням клавіш тут, здебільшого, не ро

Наведені операції з файлами дають змогу створювати власний 
проект, частинами якого можуть бути ко
Але лише задля документування, як звичайно, достатньо скопіювати файли 
потрібного типу безпосередньо в 
бораторної до своєї папки. 

Скопіювати 
(файл часових діаграм) або його частину
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є) натисненням піктограми панелі і
(зберегти зміни в поточному файлі) або з меню 

викликається діалогове вікно 
о надається ім’я проекту, зазначене в рядку заголо

ідпункті е)
ж) у лівому верхньому кут
вставлення копії і піктограмою панелі інструментів

(вставити копію з буфера) або з меню
ренести до файла зображення, скопійоване в п
зиціонується лівим верхнім кутом у місці клацання;

ідпункти а) – ж)
для звіту всі потрібні графічні файли з лабораторної 

, 1log_f.gdf, 1

Копіювати файли для звіту можна під час виконання відповідних 
пунктів лабораторної роботи. Якщо папка

1.2.1.4, б), в

Тут подано швидке виконання операцій з файлами за допомогою 
або командами складників рядка меню, але дея

них можна виконати також з контекстного меню, яке викликається кно
кою В2 (виконання операцій сполученням клавіш тут, здебільшого, не ро

Наведені операції з файлами дають змогу створювати власний 
проект, частинами якого можуть бути ко
Але лише задля документування, як звичайно, достатньо скопіювати файли 
потрібного типу безпосередньо в папці

Скопіювати у власну 
(файл часових діаграм) або його частину
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є) натисненням піктограми панелі і
(зберегти зміни в поточному файлі) або з меню 

викликається діалогове вікно Save As
о надається ім’я проекту, зазначене в рядку заголо

) розширенням, наприклад, 
ж) у лівому верхньому кутку файла курсором клацнути
вставлення копії і піктограмою панелі інструментів

(вставити копію з буфера) або з меню
ренести до файла зображення, скопійоване в пунктах
зиціонується лівим верхнім кутом у місці клацання;

ж) з метою скопіювати у власну 
для звіту всі потрібні графічні файли з лабораторної 

gdf, 1ryz.gdf, 1

Копіювати файли для звіту можна під час виконання відповідних 
папка вже існує, немає потреби ств
в), г); достатньо її вибрати та ввести 

Тут подано швидке виконання операцій з файлами за допомогою 
або командами складників рядка меню, але дея

них можна виконати також з контекстного меню, яке викликається кно
кою В2 (виконання операцій сполученням клавіш тут, здебільшого, не ро

Наведені операції з файлами дають змогу створювати власний 
проект, частинами якого можуть бути копії фрагментів інших проектів. 
Але лише задля документування, як звичайно, достатньо скопіювати файли 

папці  „Мой компьютер” 

у власну папку потрібний
(файл часових діаграм) або його частину з лабораторної 

є) натисненням піктограми панелі інструментів 
(зберегти зміни в поточному файлі) або з меню 

As, після натисненн
о надається ім’я проекту, зазначене в рядку заголо

розширенням, наприклад, 
у файла курсором клацнути

вставлення копії і піктограмою панелі інструментів
(вставити копію з буфера) або з меню

унктах 1.2.
зиціонується лівим верхнім кутом у місці клацання; 

з метою скопіювати у власну 
для звіту всі потрібні графічні файли з лабораторної 

, 1det.gdf. 

Копіювати файли для звіту можна під час виконання відповідних 
вже існує, немає потреби ств

; достатньо її вибрати та ввести 

Тут подано швидке виконання операцій з файлами за допомогою 
або командами складників рядка меню, але дея

них можна виконати також з контекстного меню, яке викликається кно
кою В2 (виконання операцій сполученням клавіш тут, здебільшого, не ро

Наведені операції з файлами дають змогу створювати власний 
пії фрагментів інших проектів. 

Але лише задля документування, як звичайно, достатньо скопіювати файли 
„Мой компьютер” 

потрібний 
лабораторної папки

струментів Saves
(зберегти зміни в поточному файлі) або з меню 

натиснення
о надається ім’я проекту, зазначене в рядку заголо

розширенням, наприклад, prim
у файла курсором клацнути

вставлення копії і піктограмою панелі інструментів
(вставити копію з буфера) або з меню Edit > 

1.2.1.3, г), ґ)

з метою скопіювати у власну 
для звіту всі потрібні графічні файли з лабораторної 

 

Копіювати файли для звіту можна під час виконання відповідних 
вже існує, немає потреби ств

; достатньо її вибрати та ввести 

Тут подано швидке виконання операцій з файлами за допомогою 
або командами складників рядка меню, але дея

них можна виконати також з контекстного меню, яке викликається кно
кою В2 (виконання операцій сполученням клавіш тут, здебільшого, не ро

Наведені операції з файлами дають змогу створювати власний 
пії фрагментів інших проектів. 

Але лише задля документування, як звичайно, достатньо скопіювати файли 
„Мой компьютер” Windows

 сигнальний файл 
папки: 

Saves changes
(зберегти зміни в поточному файлі) або з меню File

я в якому 
о надається ім’я проекту, зазначене в рядку заголов-

prim.gdf; 
у файла курсором клацнути на

вставлення копії і піктограмою панелі інструментів Pastes a
> Paste пе-
ґ), яке по-

 
з метою скопіювати у власну папку

для звіту всі потрібні графічні файли з лабораторної папки

Копіювати файли для звіту можна під час виконання відповідних 
вже існує, немає потреби ство-

; достатньо її вибрати та ввести 

Тут подано швидке виконання операцій з файлами за допомогою 
або командами складників рядка меню, але деякі з 

них можна виконати також з контекстного меню, яке викликається кноп-
кою В2 (виконання операцій сполученням клавіш тут, здебільшого, не роз-

Наведені операції з файлами дають змогу створювати власний 
пії фрагментів інших проектів. 

Але лише задля документування, як звичайно, достатньо скопіювати файли 
Windows з ла-

сигнальний файл 

changes 
File 

в якому 
в-

на 
a 
е-
о-

папку 
папки 

Копіювати файли для звіту можна під час виконання відповідних 
о-

; достатньо її вибрати та ввести 

Тут подано швидке виконання операцій з файлами за допомогою 
кі з 
п-
з-

Наведені операції з файлами дають змогу створювати власний 
пії фрагментів інших проектів. 

Але лише задля документування, як звичайно, достатньо скопіювати файли 
а-

сигнальний файл 



 

піктограмою (п. 
потреби виставити потрібну директорію, підняти прапорець 
Tops
сутності проекту з даною назвою, ввести його ім’я (за власним вибором) до 
віконця 
заголовк
1

1
of
ла) або ввести команду File > Proje
це ім’я з’явиться в рядку заголовка 

(п.
часового мод
> Grid Size)

та піктограмою скопіювати їх у буфер (п. 

крок (меню 
вставити зобр

для звіту всі потрібні сигнальні файли з лабораторної 
d

шити введення даних під час моделювання власного проекту шляхом в
користання фрагментів часових діаграм з інших проектів. Зауваження щ
до документування зроблено в примітці 3 до п. 

1

 

(проекту верхнього рівня), наприклад, 
піктограмою (п. 
потреби виставити потрібну директорію, підняти прапорець 
Tops of Hierarchies
сутності проекту з даною назвою, ввести його ім’я (за власним вибором) до 
віконця Project
заголовка 
1logfun.scf

хнього рівня), доці
1det.gdf, відтак натиснути піктограму 
of the current
ла) або ввести команду File > Proje
це ім’я з’явиться в рядку заголовка 

файл часових діаграм (

ним наданням йому імені, виставлено
приклад, 

зняти копію, наприклад, 
(п. 1.2.1.3,
часового мод
> Grid Size)

потрібні (всі або вибірково) часові діаграми, які в
та піктограмою скопіювати їх у буфер (п. 

самі інт
крок (меню 
вставити зобр

е) повторити п
для звіту всі потрібні сигнальні файли з лабораторної 
d:\max2work

F Примітка.
шити введення даних під час моделювання власного проекту шляхом в
користання фрагментів часових діаграм з інших проектів. Зауваження щ
до документування зроблено в примітці 3 до п. 

1.2.
а) Для зіставлення змісту залишити на екрані два файли, наприклад, 

1logfun.scf

а) якщо у власній 
(проекту верхнього рівня), наприклад, 

піктограмою (п. 1.2.
потреби виставити потрібну директорію, підняти прапорець 

Hierarchies 
сутності проекту з даною назвою, ввести його ім’я (за власним вибором) до 

Project Name
 Manager 

scf та 1log_f
Якщо ж у власній 

хнього рівня), доці
, відтак натиснути піктограму 

current file (надати проектові ім’я відповідно до імені поточного фа
ла) або ввести команду File > Proje
це ім’я з’явиться в рядку заголовка 

б) піктограмою (п. 
файл часових діаграм (

в) піктограмою (п. 
ним наданням йому імені, виставлено
приклад, 1logfun

г) піктограмою (п. 
зняти копію, наприклад, 
1.3, а) розташувати на екрані все зображення, прочитати інтервал 

часового моделювання (меню 
> Grid Size); 

ґ) натиснути клавішу 
потрібні (всі або вибірково) часові діаграми, які в

та піктограмою скопіювати їх у буфер (п. 
д) повернутися до свого створеного файла, виставити такі 

самі інтервал часового моделювання (меню 
крок (меню Options
вставити зображення з буфера (п. 

е) повторити п
для звіту всі потрібні сигнальні файли з лабораторної 

work\1lab\1logfun
Примітка.

шити введення даних під час моделювання власного проекту шляхом в
користання фрагментів часових діаграм з інших проектів. Зауваження щ
до документування зроблено в примітці 3 до п. 

1.2.1.6  Відпрацю
а) Для зіставлення змісту залишити на екрані два файли, наприклад, 
scf і 1log_f.gdf

а) якщо у власній 
(проекту верхнього рівня), наприклад, 

1.2.1.4, а) викликати діалогове вікно 
потреби виставити потрібну директорію, підняти прапорець 

 (показати тільки вершини ієрархій), переконатися у ві
сутності проекту з даною назвою, ввести його ім’я (за власним вибором) до 

Name та натиснути ОК, після чого це ім’я з’явиться в рядку 
 (треба бути уважними щодо назв: файли, наприклад, 
f.gdf належать до різних проектів);

кщо ж у власній 
хнього рівня), доцільно спочатку відкрити цей файл, наприклад, 

, відтак натиснути піктограму 
(надати проектові ім’я відповідно до імені поточного фа

ла) або ввести команду File > Proje
це ім’я з’явиться в рядку заголовка 

б) піктограмою (п. 
файл часових діаграм (

в) піктограмою (п. 
ним наданням йому імені, виставлено

logfun.scf; 
г) піктограмою (п. 

зняти копію, наприклад, 
а) розташувати на екрані все зображення, прочитати інтервал 
лювання (меню 

ґ) натиснути клавішу 
потрібні (всі або вибірково) часові діаграми, які в

та піктограмою скопіювати їх у буфер (п. 
д) повернутися до свого створеного файла, виставити такі 
рвал часового моделювання (меню 
tions > Grid 
ження з буфера (п. 

е) повторити підпункти
для звіту всі потрібні сигнальні файли з лабораторної 

logfun.scf, 1
Примітка. Наведені операції з файлами дають змогу пришви

шити введення даних під час моделювання власного проекту шляхом в
користання фрагментів часових діаграм з інших проектів. Зауваження щ
до документування зроблено в примітці 3 до п. 

Відпрацювати деякі 
а) Для зіставлення змісту залишити на екрані два файли, наприклад, 

gdf, відтак розгорнути їх до вікон зі смугами про
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а) якщо у власній папці не існує проекту з даною назвою 
(проекту верхнього рівня), наприклад, 

а) викликати діалогове вікно 
потреби виставити потрібну директорію, підняти прапорець 

(показати тільки вершини ієрархій), переконатися у ві
сутності проекту з даною назвою, ввести його ім’я (за власним вибором) до 

та натиснути ОК, після чого це ім’я з’явиться в рядку 
(треба бути уважними щодо назв: файли, наприклад, 
належать до різних проектів);

кщо ж у власній папці 
льно спочатку відкрити цей файл, наприклад, 

, відтак натиснути піктограму 
(надати проектові ім’я відповідно до імені поточного фа

ла) або ввести команду File > Project > 
це ім’я з’явиться в рядку заголовка Manager

б) піктограмою (п. 1.2.1.4,
файл часових діаграм (Waveform

в) піктограмою (п. 1.2.1.4,є) зберегти цей файл з автомати
ним наданням йому імені, виставлено

г) піктограмою (п. 1.2.1.2) відкрити файл, з якого потрібно 
зняти копію, наприклад, d:\max
а) розташувати на екрані все зображення, прочитати інтервал 
лювання (меню File > End Time)

ґ) натиснути клавішу Shift
потрібні (всі або вибірково) часові діаграми, які в

та піктограмою скопіювати їх у буфер (п. 
д) повернутися до свого створеного файла, виставити такі 
рвал часового моделювання (меню 

 Size), клацнути в поле 
ження з буфера (п. 1.2.1.4,

ідпункти а) – д)
для звіту всі потрібні сигнальні файли з лабораторної 

, 1ryz.scf, 1
Наведені операції з файлами дають змогу пришви

шити введення даних під час моделювання власного проекту шляхом в
користання фрагментів часових діаграм з інших проектів. Зауваження щ
до документування зроблено в примітці 3 до п. 

вати деякі прийоми роботи
а) Для зіставлення змісту залишити на екрані два файли, наприклад, 

, відтак розгорнути їх до вікон зі смугами про
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ці не існує проекту з даною назвою 
(проекту верхнього рівня), наприклад, 

а) викликати діалогове вікно 
потреби виставити потрібну директорію, підняти прапорець 

(показати тільки вершини ієрархій), переконатися у ві
сутності проекту з даною назвою, ввести його ім’я (за власним вибором) до 

та натиснути ОК, після чого це ім’я з’явиться в рядку 
(треба бути уважними щодо назв: файли, наприклад, 
належать до різних проектів);

 є файл проекту з даною назвою (ве
льно спочатку відкрити цей файл, наприклад, 

, відтак натиснути піктограму Changes 
(надати проектові ім’я відповідно до імені поточного фа

t > Set Proje
Manager; 
1.4, д), е) створити безіменний (

Waveform Editor file
1.4,є) зберегти цей файл з автомати

ним наданням йому імені, виставленого

1.2) відкрити файл, з якого потрібно 
max2work\1lab

а) розташувати на екрані все зображення, прочитати інтервал 
File > End Time) 

Shift і клацнути по черзі в пол
потрібні (всі або вибірково) часові діаграми, які в

та піктограмою скопіювати їх у буфер (п. 1.2.1.3,
д) повернутися до свого створеного файла, виставити такі 
рвал часового моделювання (меню 

), клацнути в поле 
1.4, ж); 
) з метою 

для звіту всі потрібні сигнальні файли з лабораторної 
, 1det.scf. 

Наведені операції з файлами дають змогу пришви
шити введення даних під час моделювання власного проекту шляхом в
користання фрагментів часових діаграм з інших проектів. Зауваження щ
до документування зроблено в примітці 3 до п. 

прийоми роботи
а) Для зіставлення змісту залишити на екрані два файли, наприклад, 

, відтак розгорнути їх до вікон зі смугами про

ці не існує проекту з даною назвою 
(проекту верхнього рівня), наприклад, 1logfun, надати йому ім’я: 

а) викликати діалогове вікно Project
потреби виставити потрібну директорію, підняти прапорець 

(показати тільки вершини ієрархій), переконатися у ві
сутності проекту з даною назвою, ввести його ім’я (за власним вибором) до 

та натиснути ОК, після чого це ім’я з’явиться в рядку 
(треба бути уважними щодо назв: файли, наприклад, 
належать до різних проектів); 

файл проекту з даною назвою (ве
льно спочатку відкрити цей файл, наприклад, 

 the project
(надати проектові ім’я відповідно до імені поточного фа

Project to Curren

е) створити безіменний (
file) з розширенням .

1.4,є) зберегти цей файл з автомати
го в заголовку 

1.2) відкрити файл, з якого потрібно 
lab\1logfun

а) розташувати на екрані все зображення, прочитати інтервал 
 та його крок (меню 

і клацнути по черзі в пол
потрібні (всі або вибірково) часові діаграми, які в

1.3, ґ); 
д) повернутися до свого створеного файла, виставити такі 
рвал часового моделювання (меню File > 

), клацнути в поле Name

з метою копіювання
для звіту всі потрібні сигнальні файли з лабораторної 

Наведені операції з файлами дають змогу пришви
шити введення даних під час моделювання власного проекту шляхом в
користання фрагментів часових діаграм з інших проектів. Зауваження щ
до документування зроблено в примітці 3 до п. 1.2.1.4.  

прийоми роботи з групою файлів.
а) Для зіставлення змісту залишити на екрані два файли, наприклад, 

, відтак розгорнути їх до вікон зі смугами про

ці не існує проекту з даною назвою 
, надати йому ім’я: 
Project Name

потреби виставити потрібну директорію, підняти прапорець Show
(показати тільки вершини ієрархій), переконатися у ві

сутності проекту з даною назвою, ввести його ім’я (за власним вибором) до 
та натиснути ОК, після чого це ім’я з’явиться в рядку 

(треба бути уважними щодо назв: файли, наприклад, 

файл проекту з даною назвою (ве
льно спочатку відкрити цей файл, наприклад, 

project name to
(надати проектові ім’я відповідно до імені поточного фа

Current File, після чого 

е) створити безіменний (
) з розширенням .scf

1.4,є) зберегти цей файл з автомати
в заголовку Manager

1.2) відкрити файл, з якого потрібно 
logfun.scf, інструментом 

а) розташувати на екрані все зображення, прочитати інтервал 
та його крок (меню 

і клацнути по черзі в пол
потрібні (всі або вибірково) часові діаграми, які виділяться чорним, 

д) повернутися до свого створеного файла, виставити такі 
> End Time

Name та піктограмою  

копіювання у власну 
для звіту всі потрібні сигнальні файли з лабораторної 

Наведені операції з файлами дають змогу пришви
шити введення даних під час моделювання власного проекту шляхом в
користання фрагментів часових діаграм з інших проектів. Зауваження щ

з групою файлів.
а) Для зіставлення змісту залишити на екрані два файли, наприклад, 

, відтак розгорнути їх до вікон зі смугами про

ці не існує проекту з даною назвою 
, надати йому ім’я: 

Name, у разі 
Show Only

(показати тільки вершини ієрархій), переконатися у від-
сутності проекту з даною назвою, ввести його ім’я (за власним вибором) до 

та натиснути ОК, після чого це ім’я з’явиться в рядку 
(треба бути уважними щодо назв: файли, наприклад, 

файл проекту з даною назвою (вер-
льно спочатку відкрити цей файл, наприклад, 

to the name
(надати проектові ім’я відповідно до імені поточного фай-

, після чого 

е) створити безіменний (Untitled) 
scf; 

1.4,є) зберегти цей файл з автоматич-
Manager, на-

1.2) відкрити файл, з якого потрібно 
, інструментом 

а) розташувати на екрані все зображення, прочитати інтервал 
та його крок (меню Options 

і клацнути по черзі в полі Name
иділяться чорним, 

д) повернутися до свого створеного файла, виставити такі 
Time) та його 

та піктограмою  

у власну папку
для звіту всі потрібні сигнальні файли з лабораторної папки

Наведені операції з файлами дають змогу пришвид-
шити введення даних під час моделювання власного проекту шляхом ви-
користання фрагментів часових діаграм з інших проектів. Зауваження що-

з групою файлів. 
а) Для зіставлення змісту залишити на екрані два файли, наприклад, 

, відтак розгорнути їх до вікон зі смугами прокручу-

ці не існує проекту з даною назвою 
, надати йому ім’я: 

, у разі 
Only 
д-

сутності проекту з даною назвою, ввести його ім’я (за власним вибором) до 
та натиснути ОК, після чого це ім’я з’явиться в рядку 

(треба бути уважними щодо назв: файли, наприклад, 

р-
льно спочатку відкрити цей файл, наприклад, 

name 
й-

, після чого 

) 

ч-
а-

1.2) відкрити файл, з якого потрібно 
, інструментом 

а) розташувати на екрані все зображення, прочитати інтервал 
Options 

Name 
иділяться чорним, 

д) повернутися до свого створеного файла, виставити такі 
) та його 

та піктограмою  

папку 
папки 

д-
и-
о-

а) Для зіставлення змісту залишити на екрані два файли, наприклад, 
у-



 

вання
смугами 

струментом верт
гувати існуючий текст 

чного файла і н
виділити цей напис червоною рамкою і при утримуваній лівій кнопці миші 
перетягнути йо
жуючи, зістав

 

вання в кожному: меню 
смугами прокручування

при
гнальн

струментом верт
гувати існуючий текст 

чного файла і н
виділити цей напис червоною рамкою і при утримуваній лівій кнопці миші 
перетягнути йо
жуючи, зістав

б) Для вибіркового копіювання залишити на екрані два файли, н

в кожному: меню 
прокручування

приклад, буфер з виходом 
гнальному файлі дібрати епюру 

струментом вертикальної панелі 
гувати існуючий текст 

чного файла і надрукувати напис „=
виділити цей напис червоною рамкою і при утримуваній лівій кнопці миші 
перетягнути його до виходу схеми для утворення напису „у1=
жуючи, зіставити в такий спосіб усі потрібні схеми з епюрами.  

б) Для вибіркового копіювання залишити на екрані два файли, н

в кожному: меню Window
прокручування на графічному файлі знайти потрібну схему, н
клад, буфер з виходом 
му файлі дібрати епюру 
кальної панелі 

гувати існуючий текст – у вигляді літери А) клацнути у вільному місці граф

друкувати напис „=
виділити цей напис червоною рамкою і при утримуваній лівій кнопці миші 

го до виходу схеми для утворення напису „у1=
ти в такий спосіб усі потрібні схеми з епюрами.  

б) Для вибіркового копіювання залишити на екрані два файли, н
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Window > The 
на графічному файлі знайти потрібну схему, н

клад, буфер з виходом у1, прокручуванням часових діаграм на с
му файлі дібрати епюру 
кальної панелі Enters

у вигляді літери А) клацнути у вільному місці граф

друкувати напис „=z1”, відтак інструментом вибору (стрілка) 
виділити цей напис червоною рамкою і при утримуваній лівій кнопці миші 

го до виходу схеми для утворення напису „у1=
ти в такий спосіб усі потрібні схеми з епюрами.  

б) Для вибіркового копіювання залишити на екрані два файли, н

24 

 Horizontally
на графічному файлі знайти потрібну схему, н

, прокручуванням часових діаграм на с
му файлі дібрати епюру zi, що відповідає цьому виходу, 

Enters new text... (вст
у вигляді літери А) клацнути у вільному місці граф

1”, відтак інструментом вибору (стрілка) 
виділити цей напис червоною рамкою і при утримуваній лівій кнопці миші 

го до виходу схеми для утворення напису „у1=
ти в такий спосіб усі потрібні схеми з епюрами.  

б) Для вибіркового копіювання залишити на екрані два файли, н

Horizontally (або клавішами 
на графічному файлі знайти потрібну схему, н

, прокручуванням часових діаграм на с
, що відповідає цьому виходу, 

... (вставити новий або ред
у вигляді літери А) клацнути у вільному місці граф

1”, відтак інструментом вибору (стрілка) 
виділити цей напис червоною рамкою і при утримуваній лівій кнопці миші 

го до виходу схеми для утворення напису „у1=
ти в такий спосіб усі потрібні схеми з епюрами.  

б) Для вибіркового копіювання залишити на екрані два файли, н

(або клавішами 
на графічному файлі знайти потрібну схему, н

, прокручуванням часових діаграм на с
, що відповідає цьому виходу, 

авити новий або ред
у вигляді літери А) клацнути у вільному місці граф

1”, відтак інструментом вибору (стрілка) 
виділити цей напис червоною рамкою і при утримуваній лівій кнопці миші 

го до виходу схеми для утворення напису „у1=z1”; продо
ти в такий спосіб усі потрібні схеми з епюрами.   

б) Для вибіркового копіювання залишити на екрані два файли, н

(або клавішами Shift+F4), 
на графічному файлі знайти потрібну схему, на-

, прокручуванням часових діаграм на си-
, що відповідає цьому виходу, ін-

авити новий або реда-
у вигляді літери А) клацнути у вільному місці графі-

1”, відтак інструментом вибору (стрілка) 
виділити цей напис червоною рамкою і при утримуваній лівій кнопці миші 

1”; продов-

б) Для вибіркового копіювання залишити на екрані два файли, на-

4), 
а-
и-
н-
а-
і-

1”, відтак інструментом вибору (стрілка) 
виділити цей напис червоною рамкою і при утримуваній лівій кнопці миші 

в-

а-



 

приклад, 
дтак розгорнути їх до вікон зі смугами прогону в кожному: меню 
> 
оригіналі знайти потрібні епюри, виділити і скопіювати їх у буфер, відтак 
клацнути в полі 

яких доводиться час від часу повертатися, доцільно їх впорядкувати.

тинних вікон на екрані (див. 

 

приклад, d
дтак розгорнути їх до вікон зі смугами прогону в кожному: меню 
> The Vertically
оригіналі знайти потрібні епюри, виділити і скопіювати їх у буфер, відтак 
клацнути в полі 

в) Коли під час роботи над проектами відкрито багато файлів, до 
яких доводиться час від часу повертатися, доцільно їх впорядкувати.

Для попереднього перегляду розташувати файли у вигляді непер
тинних вікон на екрані (див. 

d:\max2work
дтак розгорнути їх до вікон зі смугами прогону в кожному: меню 

Vertically (або клавішами 
оригіналі знайти потрібні епюри, виділити і скопіювати їх у буфер, відтак 
клацнути в полі Name

в) Коли під час роботи над проектами відкрито багато файлів, до 
яких доводиться час від часу повертатися, доцільно їх впорядкувати.

Для попереднього перегляду розташувати файли у вигляді непер
тинних вікон на екрані (див. 

work\rt\0br\1
дтак розгорнути їх до вікон зі смугами прогону в кожному: меню 

або клавішами 
оригіналі знайти потрібні епюри, виділити і скопіювати їх у буфер, відтак 

Name файла-

в) Коли під час роботи над проектами відкрито багато файлів, до 
яких доводиться час від часу повертатися, доцільно їх впорядкувати.

Для попереднього перегляду розташувати файли у вигляді непер
тинних вікон на екрані (див. 
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1log_func.
дтак розгорнути їх до вікон зі смугами прогону в кожному: меню 

або клавішами Shift
оригіналі знайти потрібні епюри, виділити і скопіювати їх у буфер, відтак 

-копії та встави

в) Коли під час роботи над проектами відкрито багато файлів, до 
яких доводиться час від часу повертатися, доцільно їх впорядкувати.

Для попереднього перегляду розташувати файли у вигляді непер
тинних вікон на екрані (див. рисунок

25 

.scf і d:\max
дтак розгорнути їх до вікон зі смугами прогону в кожному: меню 

Shift+F5), смугами прогону на файлі
оригіналі знайти потрібні епюри, виділити і скопіювати їх у буфер, відтак 

копії та вставити зображення з буфера.

в) Коли під час роботи над проектами відкрито багато файлів, до 
яких доводиться час від часу повертатися, доцільно їх впорядкувати.

Для попереднього перегляду розташувати файли у вигляді непер
рисунок зверху сторінки

max2work\1
дтак розгорнути їх до вікон зі смугами прогону в кожному: меню 

, смугами прогону на файлі
оригіналі знайти потрібні епюри, виділити і скопіювати їх у буфер, відтак 

ти зображення з буфера.

в) Коли під час роботи над проектами відкрито багато файлів, до 
яких доводиться час від часу повертатися, доцільно їх впорядкувати.

Для попереднього перегляду розташувати файли у вигляді непер
у сторінки) командою з меню 

1lab\1logfun
дтак розгорнути їх до вікон зі смугами прогону в кожному: меню 

, смугами прогону на файлі
оригіналі знайти потрібні епюри, виділити і скопіювати їх у буфер, відтак 

ти зображення з буфера.

в) Коли під час роботи над проектами відкрито багато файлів, до 
яких доводиться час від часу повертатися, доцільно їх впорядкувати.

Для попереднього перегляду розташувати файли у вигляді непер
) командою з меню 

logfun.scf, ві-
дтак розгорнути їх до вікон зі смугами прогону в кожному: меню Window

, смугами прогону на файлі-
оригіналі знайти потрібні епюри, виділити і скопіювати їх у буфер, відтак 

ти зображення з буфера. 

 
в) Коли під час роботи над проектами відкрито багато файлів, до 

яких доводиться час від часу повертатися, доцільно їх впорядкувати. 
Для попереднього перегляду розташувати файли у вигляді непере-

) командою з меню 

і-
Window 

-
оригіналі знайти потрібні епюри, виділити і скопіювати їх у буфер, відтак 

в) Коли під час роботи над проектами відкрито багато файлів, до 

е-
) командою з меню 



 

Window
першу чергу, згорнути до іконок внизу екрана клацанням символ
тання в рядку заголовку файла, а решту файлів розташувати каскадом з в
дображення
нок внизу сторінки
достатньо клацнути рядок його заголовка вгорі або нижній символ прокр
тки 
чі клацнути
розгортання чи рядок з ім’ям
ся до такого вікна (в каскаді чи повного), з якого він був згорнутий. 

дку заголовка 
проектний файл верхнього рівня). 
ся заново, або п

тримок, файл 
z
будови таблиці зручно користуватися часовим маркером 
ного кольору. Для цього слід перетягнути вузол (квадратик вгорі) маркера 
при натиснутій лівій кнопці в довільне положення 
нці діаграм і зчитати в полі рівня (
імені (
ти рівні і т. д. до заповнення всієї таблиці відповідності.

 

Window > 
першу чергу, згорнути до іконок внизу екрана клацанням символ
тання в рядку заголовку файла, а решту файлів розташувати каскадом з в
дображення
нок внизу сторінки
достатньо клацнути рядок його заголовка вгорі або нижній символ прокр
тки зліва, або рядок з ім’ям 1, 2, 3 ... 9 зі списку в меню
чі клацнути
розгортання чи рядок з ім’ям
ся до такого вікна (в каскаді чи повного), з якого він був згорнутий. 

хнього рівня (тобто до файла, з якого утворено проект, зазначений у р
дку заголовка 
проектний файл верхнього рівня). 
ся заново, або п

1.2.
1.2.

тримок, файл 
z1… z14 і записати вирази
будови таблиці зручно користуватися часовим маркером 
ного кольору. Для цього слід перетягнути вузол (квадратик вгорі) маркера 
при натиснутій лівій кнопці в довільне положення 
нці діаграм і зчитати в полі рівня (
імені (Name
ти рівні і т. д. до заповнення всієї таблиці відповідності.

> The Horizontally
першу чергу, згорнути до іконок внизу екрана клацанням символ
тання в рядку заголовку файла, а решту файлів розташувати каскадом з в
дображенням заголовків командою з меню 
нок внизу сторінки
достатньо клацнути рядок його заголовка вгорі або нижній символ прокр

, або рядок з ім’ям 1, 2, 3 ... 9 зі списку в меню
чі клацнути на ікон
розгортання чи рядок з ім’ям
ся до такого вікна (в каскаді чи повного), з якого він був згорнутий. 

Крім того, завжди можна 
хнього рівня (тобто до файла, з якого утворено проект, зазначений у р

дку заголовка Manager
проектний файл верхнього рівня). 
ся заново, або пересунеться з каскаду відкритих файлів на передній план. 

1.2.2  Дослідити логічні елементи
1.2.2.1 За ідеалізованими часовими діаграмами

тримок, файл 1logfun
записати вирази

будови таблиці зручно користуватися часовим маркером 
ного кольору. Для цього слід перетягнути вузол (квадратик вгорі) маркера 
при натиснутій лівій кнопці в довільне положення 
нці діаграм і зчитати в полі рівня (

Name). Відтак перетягнути маркер на другу ділянку і так само зчит
ти рівні і т. д. до заповнення всієї таблиці відповідності.

Horizontally або 
першу чергу, згорнути до іконок внизу екрана клацанням символ
тання в рядку заголовку файла, а решту файлів розташувати каскадом з в

м заголовків командою з меню 
нок внизу сторінки). Для переведення на передній план відкритого файла 
достатньо клацнути рядок його заголовка вгорі або нижній символ прокр

, або рядок з ім’ям 1, 2, 3 ... 9 зі списку в меню
іконці згорнутого файла, або один раз клацнути на іконці 

розгортання чи рядок з ім’ям
ся до такого вікна (в каскаді чи повного), з якого він був згорнутий. 

Крім того, завжди можна 
хнього рівня (тобто до файла, з якого утворено проект, зазначений у р

Manager) піктограмою 
проектний файл верхнього рівня). 

ресунеться з каскаду відкритих файлів на передній план. 
Дослідити логічні елементи
За ідеалізованими часовими діаграмами

logfun.scf ) 
записати вирази z1…

будови таблиці зручно користуватися часовим маркером 
ного кольору. Для цього слід перетягнути вузол (квадратик вгорі) маркера 
при натиснутій лівій кнопці в довільне положення 
нці діаграм і зчитати в полі рівня (

). Відтак перетягнути маркер на другу ділянку і так само зчит
ти рівні і т. д. до заповнення всієї таблиці відповідності.
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або The Vertically
першу чергу, згорнути до іконок внизу екрана клацанням символ
тання в рядку заголовку файла, а решту файлів розташувати каскадом з в

м заголовків командою з меню 
). Для переведення на передній план відкритого файла 

достатньо клацнути рядок його заголовка вгорі або нижній символ прокр
, або рядок з ім’ям 1, 2, 3 ... 9 зі списку в меню

згорнутого файла, або один раз клацнути на іконці 
розгортання чи рядок з ім’ям файла у згаданому списку, файл розгортаєт
ся до такого вікна (в каскаді чи повного), з якого він був згорнутий. 

Крім того, завжди можна 
хнього рівня (тобто до файла, з якого утворено проект, зазначений у р

) піктограмою Opens the top
проектний файл верхнього рівня). Після

ресунеться з каскаду відкритих файлів на передній план. 
Дослідити логічні елементи
За ідеалізованими часовими діаграмами

) побудувати таблиці відповідності
… z14 = f (

будови таблиці зручно користуватися часовим маркером 
ного кольору. Для цього слід перетягнути вузол (квадратик вгорі) маркера 
при натиснутій лівій кнопці в довільне положення 
нці діаграм і зчитати в полі рівня (Value

). Відтак перетягнути маркер на другу ділянку і так само зчит
ти рівні і т. д. до заповнення всієї таблиці відповідності.
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Vertically. Відтак файли, не потрібні в 
першу чергу, згорнути до іконок внизу екрана клацанням символ
тання в рядку заголовку файла, а решту файлів розташувати каскадом з в

м заголовків командою з меню Window
). Для переведення на передній план відкритого файла 

достатньо клацнути рядок його заголовка вгорі або нижній символ прокр
, або рядок з ім’ям 1, 2, 3 ... 9 зі списку в меню

згорнутого файла, або один раз клацнути на іконці 
у згаданому списку, файл розгортаєт

ся до такого вікна (в каскаді чи повного), з якого він був згорнутий. 
Крім того, завжди можна повернутися до проектного файла ве

хнього рівня (тобто до файла, з якого утворено проект, зазначений у р
Opens the top

Після натисненн
ресунеться з каскаду відкритих файлів на передній план. 

Дослідити логічні елементи 
За ідеалізованими часовими діаграмами

побудувати таблиці відповідності
(x1, x2) у булевому базисі. Під час п

будови таблиці зручно користуватися часовим маркером 
ного кольору. Для цього слід перетягнути вузол (квадратик вгорі) маркера 
при натиснутій лівій кнопці в довільне положення 

Value) значення сигналів, поданих в полі 
). Відтак перетягнути маркер на другу ділянку і так само зчит

ти рівні і т. д. до заповнення всієї таблиці відповідності.

. Відтак файли, не потрібні в 
першу чергу, згорнути до іконок внизу екрана клацанням символ
тання в рядку заголовку файла, а решту файлів розташувати каскадом з в

Window > Cascade
). Для переведення на передній план відкритого файла 

достатньо клацнути рядок його заголовка вгорі або нижній символ прокр
, або рядок з ім’ям 1, 2, 3 ... 9 зі списку в меню Window

згорнутого файла, або один раз клацнути на іконці 
у згаданому списку, файл розгортаєт

ся до такого вікна (в каскаді чи повного), з якого він був згорнутий. 
повернутися до проектного файла ве

хнього рівня (тобто до файла, з якого утворено проект, зазначений у р
Opens the top-level design file (
натиснення її цей файл або відкриєт

ресунеться з каскаду відкритих файлів на передній план. 

За ідеалізованими часовими діаграмами (без урахування з
побудувати таблиці відповідності

у булевому базисі. Під час п
будови таблиці зручно користуватися часовим маркером 
ного кольору. Для цього слід перетягнути вузол (квадратик вгорі) маркера 
при натиснутій лівій кнопці в довільне положення на першій часовій діл

) значення сигналів, поданих в полі 
). Відтак перетягнути маркер на другу ділянку і так само зчит

ти рівні і т. д. до заповнення всієї таблиці відповідності. 

. Відтак файли, не потрібні в 
першу чергу, згорнути до іконок внизу екрана клацанням символ
тання в рядку заголовку файла, а решту файлів розташувати каскадом з в

Cascade (див. 
). Для переведення на передній план відкритого файла 

достатньо клацнути рядок його заголовка вгорі або нижній символ прокр
Window. Якщо дв

згорнутого файла, або один раз клацнути на іконці 
у згаданому списку, файл розгортаєт

ся до такого вікна (в каскаді чи повного), з якого він був згорнутий. 
повернутися до проектного файла ве

хнього рівня (тобто до файла, з якого утворено проект, зазначений у р
level design file (
її цей файл або відкриєт

ресунеться з каскаду відкритих файлів на передній план. 

(без урахування з
побудувати таблиці відповідності

у булевому базисі. Під час п
будови таблиці зручно користуватися часовим маркером – лінією блаки
ного кольору. Для цього слід перетягнути вузол (квадратик вгорі) маркера 

на першій часовій діл
) значення сигналів, поданих в полі 

). Відтак перетягнути маркер на другу ділянку і так само зчит
 

. Відтак файли, не потрібні в 
першу чергу, згорнути до іконок внизу екрана клацанням символу згор-
тання в рядку заголовку файла, а решту файлів розташувати каскадом з ві-

(див. рису-
). Для переведення на передній план відкритого файла 

достатньо клацнути рядок його заголовка вгорі або нижній символ прокру-
. Якщо дві-

згорнутого файла, або один раз клацнути на іконці 
у згаданому списку, файл розгортаєть-

ся до такого вікна (в каскаді чи повного), з якого він був згорнутий.  
повернутися до проектного файла вер-

хнього рівня (тобто до файла, з якого утворено проект, зазначений у ря-
level design file (відкрити 
її цей файл або відкриєть-

ресунеться з каскаду відкритих файлів на передній план.  

(без урахування за-
побудувати таблиці відповідності функцій 

у булевому базисі. Під час по-
лінією блакит-

ного кольору. Для цього слід перетягнути вузол (квадратик вгорі) маркера 
на першій часовій діля-

) значення сигналів, поданих в полі 
). Відтак перетягнути маркер на другу ділянку і так само зчита-

. Відтак файли, не потрібні в 
р-
і-
у-

). Для переведення на передній план відкритого файла 
у-
і-

згорнутого файла, або один раз клацнути на іконці 
ь-

р-
я-

відкрити 
ь-

а-
функцій 

о-
т-

ного кольору. Для цього слід перетягнути вузол (квадратик вгорі) маркера 
я-

) значення сигналів, поданих в полі 
а-
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F Примітки: 
1. Переривчастим клацанням по стрілках біля поля часу маркера 

(Ref) він переводиться до стрибка рівнів на діаграмах. 
2. Ширину поля імені і поля рівня можна змінити перетягуванням 

відповідного вузла (квадратика між полями). 
3. Аби коментарі (рядок з червоною лінією А) були правильно роз-

ташовані відносно часових епюр, слід спочатку розгорнути файл на весь ек-
ран, а відтак, за необхідності, згорнути у вікно (тобто на частину екрану).    

1.2.2.2 Визначити еквівалентну логічну функцію, виконувану ко-
жною схемою на примітивах (файл 1log_f.gdf ). На копії схеми у власному 
файлі навести номери часових діаграм (файл 1logfun.scf), що відповідають 
кожному виходу, наприклад, y1 = z1, y2 = z2 тощо.      

1.2.2.3 Спостерігати на виході основних логічних елементів (файл 
1ryz.gdf) виникнення ризиків у вигляді паразитних імпульсів внаслідок 
небезпечних змагань сигналів (файл 1ryzyk.scf); дані подати фрагментами 
ідеалізованих (без урахування затримок) осцилограм вхідних і вихідних 
сигналів у місцях виникнення ризиків зі стислим поясненням. 

1.2.2.4 Ознайомитися з дібраними елементами бібліотеки при-
мітивів (файл 1libr.gdf): 1) портами, 2) буферами, 3) логічними елемента-
ми, а також прикладами їх мікросхемного виконання на ІС серії 74.  Дати 
тлумачення сенсу кожного позначеного символами примітива. Отримати 
інформацію з довідки для кожного примітива.  

 
1.2.3 Засвоїти основи часового аналізу на прикладі дослідження 

формувального кола на логічних елементах 
1.2.3.1 За схемою і часовими діаграмами (файли 1det.gdf, .scf) розг-

лянути принцип побудови різницевого елемента (РЕ) на логічному елемен-
ті І-НЕ і елементі затримки з інверсією (буфер ЕХР) та застосування його у 
колах формування коротких імпульсів – детекторах фронтів вхідних імпуль-
сів х: за позитивним (dx1n), негативним (dx2n) їх перепадом та за обома пе-
репадами (dx3). 

F Примітки: 
1. У класичному детекторі фронтів на ІС жорсткої структури для за-

тримки та інверсії застосовують ланцюжок з непарної кількості логічних 
елементів з інверсними виходами. Щодо алгебри логіки це не має сенсу, 
тому компілятор за аксіомою подвійного заперечення усуває зі схеми „зай-
ві” ланцюжки елементів, отже, і затримку. Аби запобігти цьому, в ІС про-
грамованої структури застосовано буфер ЕХР. 

2. На часових діаграмах у полі імені наведено три типи вузлів: вхід-
ні порти з позначкою I (Input), вихідні O (Output) та внутрішні вузли В 



 

(Вuried 
німи контактами („ніжками”) ІС. Внутрішні вузли подано задля наочності 
з’ясува

вихідних імпульсів ручним способом
по стрілках біля поля часу маркера (див. 
останній до потрібного перепаду сигналу і відлічуємо час у 

том вибору у вигляді стрілки на вертикальній палітрі): індикатори 
terval

віконце, яке дозволяє перевести маркер в будь
ці. Для переведення маркера в довільну позицію незалежно від кроку сітки 
слід зняти прапорець 

хідних виводів мікросхеми часовим аналізатором у режимі матриці затр
мок.

чено в рядку заголовка 
або командою File > Proje

Save
конці про успішну (

 

(Вuried – внутрішній, прихований), не сполучені безпосередньо із зовні
німи контактами („ніжками”) ІС. Внутрішні вузли подано задля наочності 
з’ясування

1.2
вихідних імпульсів ручним способом
по стрілках біля поля часу маркера (див. 
останній до потрібного перепаду сигналу і відлічуємо час у 

F Примітки
1. Для вимірювань можна користуватися також курсором (інструме

том вибору у вигляді стрілки на вертикальній палітрі): індикатори 
terval відзначають часове положення стрілки і віддаль між нею і маркером.

2. Подвійним клацанням по індикаторному полю 
віконце, яке дозволяє перевести маркер в будь
ці. Для переведення маркера в довільну позицію незалежно від кроку сітки 
слід зняти прапорець 

1.2.
хідних виводів мікросхеми часовим аналізатором у режимі матриці затр
мок. 

діаг
чено в рядку заголовка 
або командою File > Proje

ни у файлі і запустити компілятор) 
Save & Compile
конці про успішну (

внутрішній, прихований), не сполучені безпосередньо із зовні
німи контактами („ніжками”) ІС. Внутрішні вузли подано задля наочності 

ння виникнення коротких імпульсів.
2.3.2 Виміряти затримки поширення сигналів

вихідних імпульсів ручним способом
по стрілках біля поля часу маркера (див. 
останній до потрібного перепаду сигналу і відлічуємо час у 

Примітки
Для вимірювань можна користуватися також курсором (інструме

том вибору у вигляді стрілки на вертикальній палітрі): індикатори 
відзначають часове положення стрілки і віддаль між нею і маркером.
Подвійним клацанням по індикаторному полю 

віконце, яке дозволяє перевести маркер в будь
ці. Для переведення маркера в довільну позицію незалежно від кроку сітки 
слід зняти прапорець 

1.2.3.3 Виміряти затримки поширення сигналів
хідних виводів мікросхеми часовим аналізатором у режимі матриці затр

а) Відкрити  графічний  файл (наочніше)  або  файл  часових  
грам власної копії проекту 1

чено в рядку заголовка 
або командою File > Proje

б) Піктограмою 
ни у файлі і запустити компілятор) 
Compile скомпілювати проект, натиснути ОК в інформаційному в

конці про успішну (

внутрішній, прихований), не сполучені безпосередньо із зовні
німи контактами („ніжками”) ІС. Внутрішні вузли подано задля наочності 

виникнення коротких імпульсів.
Виміряти затримки поширення сигналів

вихідних імпульсів ручним способом
по стрілках біля поля часу маркера (див. 
останній до потрібного перепаду сигналу і відлічуємо час у 

Примітки: 
Для вимірювань можна користуватися також курсором (інструме

том вибору у вигляді стрілки на вертикальній палітрі): індикатори 
відзначають часове положення стрілки і віддаль між нею і маркером.
Подвійним клацанням по індикаторному полю 

віконце, яке дозволяє перевести маркер в будь
ці. Для переведення маркера в довільну позицію незалежно від кроку сітки 
слід зняти прапорець Snap to

3.3 Виміряти затримки поширення сигналів
хідних виводів мікросхеми часовим аналізатором у режимі матриці затр

а) Відкрити  графічний  файл (наочніше)  або  файл  часових  
рам власної копії проекту 1

чено в рядку заголовка Manager
або командою File > Project > 

б) Піктограмою 
ни у файлі і запустити компілятор) 

скомпілювати проект, натиснути ОК в інформаційному в
конці про успішну (successful
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внутрішній, прихований), не сполучені безпосередньо із зовні
німи контактами („ніжками”) ІС. Внутрішні вузли подано задля наочності 

виникнення коротких імпульсів.
Виміряти затримки поширення сигналів

вихідних імпульсів ручним способом. Для цього 
по стрілках біля поля часу маркера (див. 
останній до потрібного перепаду сигналу і відлічуємо час у 

Для вимірювань можна користуватися також курсором (інструме
том вибору у вигляді стрілки на вертикальній палітрі): індикатори 

відзначають часове положення стрілки і віддаль між нею і маркером.
Подвійним клацанням по індикаторному полю 

віконце, яке дозволяє перевести маркер в будь
ці. Для переведення маркера в довільну позицію незалежно від кроку сітки 

to Grid (прив’язка до сіт
3.3 Виміряти затримки поширення сигналів

хідних виводів мікросхеми часовим аналізатором у режимі матриці затр

а) Відкрити  графічний  файл (наочніше)  або  файл  часових  
рам власної копії проекту 1

Manager, інакше це ім’я треба ввести піктограмою 
t > Set Proje

б) Піктограмою Saves … 
ни у файлі і запустити компілятор) 

скомпілювати проект, натиснути ОК в інформаційному в
successful) компіляцію та закрити вікно компілято
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внутрішній, прихований), не сполучені безпосередньо із зовні
німи контактами („ніжками”) ІС. Внутрішні вузли подано задля наочності 

виникнення коротких імпульсів. 
Виміряти затримки поширення сигналів

. Для цього 
по стрілках біля поля часу маркера (див. рисунок
останній до потрібного перепаду сигналу і відлічуємо час у 

Для вимірювань можна користуватися також курсором (інструме
том вибору у вигляді стрілки на вертикальній палітрі): індикатори 

відзначають часове положення стрілки і віддаль між нею і маркером.
Подвійним клацанням по індикаторному полю 

віконце, яке дозволяє перевести маркер в будь-
ці. Для переведення маркера в довільну позицію незалежно від кроку сітки 

прив’язка до сіт
3.3 Виміряти затримки поширення сигналів

хідних виводів мікросхеми часовим аналізатором у режимі матриці затр

а) Відкрити  графічний  файл (наочніше)  або  файл  часових  
рам власної копії проекту 1det, директорія та ім’я якого позн

, інакше це ім’я треба ввести піктограмою 
Project to Current

… and starts
ни у файлі і запустити компілятор) або командою File > Proje

скомпілювати проект, натиснути ОК в інформаційному в
) компіляцію та закрити вікно компілято

внутрішній, прихований), не сполучені безпосередньо із зовні
німи контактами („ніжками”) ІС. Внутрішні вузли подано задля наочності 

Виміряти затримки поширення сигналів
. Для цього переривчастим
рисунок до п. 1.2.

останній до потрібного перепаду сигналу і відлічуємо час у 

Для вимірювань можна користуватися також курсором (інструме
том вибору у вигляді стрілки на вертикальній палітрі): індикатори 

відзначають часове положення стрілки і віддаль між нею і маркером.
Подвійним клацанням по індикаторному полю 

-яку позицію на часовій сі
ці. Для переведення маркера в довільну позицію незалежно від кроку сітки 

прив’язка до сітки) в меню
3.3 Виміряти затримки поширення сигналів

хідних виводів мікросхеми часовим аналізатором у режимі матриці затр

а) Відкрити  графічний  файл (наочніше)  або  файл  часових  
ректорія та ім’я якого позн

, інакше це ім’я треба ввести піктограмою 
Current File.  
starts the Compiler
або командою File > Proje

скомпілювати проект, натиснути ОК в інформаційному в
) компіляцію та закрити вікно компілято

внутрішній, прихований), не сполучені безпосередньо із зовні
німи контактами („ніжками”) ІС. Внутрішні вузли подано задля наочності 

Виміряти затримки поширення сигналів та тривалості 
переривчастим клацанням 

1.2.2.1) переводимо 
останній до потрібного перепаду сигналу і відлічуємо час у згаданому полі.

Для вимірювань можна користуватися також курсором (інструме
том вибору у вигляді стрілки на вертикальній палітрі): індикатори Time

відзначають часове положення стрілки і віддаль між нею і маркером.
Подвійним клацанням по індикаторному полю Ref викликається 

яку позицію на часовій сі
ці. Для переведення маркера в довільну позицію незалежно від кроку сітки 

в меню Options
3.3 Виміряти затримки поширення сигналів від вхідних до в

хідних виводів мікросхеми часовим аналізатором у режимі матриці затр

а) Відкрити  графічний  файл (наочніше)  або  файл  часових  
ректорія та ім’я якого позн

, інакше це ім’я треба ввести піктограмою 

Compiler (зберегти зм
або командою File > Proje

скомпілювати проект, натиснути ОК в інформаційному в
) компіляцію та закрити вікно компілято

внутрішній, прихований), не сполучені безпосередньо із зовніш-
німи контактами („ніжками”) ІС. Внутрішні вузли подано задля наочності 

та тривалості 
клацанням 

2.1) переводимо 
згаданому полі. 

Для вимірювань можна користуватися також курсором (інструмен-
Time та In-

відзначають часове положення стрілки і віддаль між нею і маркером. 
викликається 

яку позицію на часовій сіт-
ці. Для переведення маркера в довільну позицію незалежно від кроку сітки 

Options. 
від вхідних до ви-

хідних виводів мікросхеми часовим аналізатором у режимі матриці затри-

а) Відкрити  графічний  файл (наочніше)  або  файл  часових  
ректорія та ім’я якого позна-

, інакше це ім’я треба ввести піктограмою 

(зберегти змі-
або командою File > Project > 

скомпілювати проект, натиснути ОК в інформаційному ві-
) компіляцію та закрити вікно компілятора. 

ш-
німи контактами („ніжками”) ІС. Внутрішні вузли подано задля наочності 

та тривалості 
клацанням 

2.1) переводимо 

н-
n-

викликається 
т-

ці. Для переведення маркера в довільну позицію незалежно від кроку сітки 

и-
и-

а) Відкрити  графічний  файл (наочніше)  або  файл  часових  
а-

, інакше це ім’я треба ввести піктограмою 

і-
t > 
і-

 



 

Ti
помогою ма

аналізатора, відтак натиснути 
лізу, після чого матриця виявля
ристатися для визначення  шляхів поширення сигна
мованих імпу

вигляді) не зберігається, її легко відновити: ввести ім’я проекту активного 
файла та запустити часовий аналізатор.

розширен
аналізатора): при активному вікні 

 

Ana
Timing Analy
помогою ма

г) запустити ча
аналізатора, відтак натиснути 
лізу, після чого матриця виявля
ристатися для визначення  шляхів поширення сигна
мованих імпу

F Примітка. 
вигляді) не зберігається, її легко відновити: ввести ім’я проекту активного 
файла та запустити часовий аналізатор.

ґ) Зберегти результати аналізу у формі таблиці текстового файла з 
розширенням 
аналізатора): при активному вікні 

в) Викликати часовий аналізатор піктограмою 
alyzer (відкрити часовий аналізатор) або з меню MAX+plus II > 

Analyzer та, якщо раніше не було вибрано тип часового аналізу за д
помогою матриці затримок, установити його з меню 

г) запустити ча
аналізатора, відтак натиснути 
лізу, після чого матриця виявля
ристатися для визначення  шляхів поширення сигна
мованих імпульсів тощо.

Примітка. 
вигляді) не зберігається, її легко відновити: ввести ім’я проекту активного 
файла та запустити часовий аналізатор.

ґ) Зберегти результати аналізу у формі таблиці текстового файла з 
ням .tao (

аналізатора): при активному вікні 

в) Викликати часовий аналізатор піктограмою 
(відкрити часовий аналізатор) або з меню MAX+plus II > 
та, якщо раніше не було вибрано тип часового аналізу за д

риці затримок, установити його з меню 
г) запустити часовий аналізатор натис

аналізатора, відтак натиснути 
лізу, після чого матриця виявля
ристатися для визначення  шляхів поширення сигна

льсів тощо. 

Примітка. З огляду на те, що матриця затримок (у первісному 
вигляді) не зберігається, її легко відновити: ввести ім’я проекту активного 
файла та запустити часовий аналізатор.

ґ) Зберегти результати аналізу у формі таблиці текстового файла з 
(Timing Analyzer

аналізатора): при активному вікні 
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в) Викликати часовий аналізатор піктограмою 
(відкрити часовий аналізатор) або з меню MAX+plus II > 
та, якщо раніше не було вибрано тип часового аналізу за д

риці затримок, установити його з меню 
вий аналізатор натис

аналізатора, відтак натиснути OK у віконці про закін
лізу, після чого матриця виявляється заповненою. Відтак нею можна ск
ристатися для визначення  шляхів поширення сигна

З огляду на те, що матриця затримок (у первісному 
вигляді) не зберігається, її легко відновити: ввести ім’я проекту активного 
файла та запустити часовий аналізатор.

ґ) Зберегти результати аналізу у формі таблиці текстового файла з 
Analyzer Output

аналізатора): при активному вікні Timing
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в) Викликати часовий аналізатор піктограмою 
(відкрити часовий аналізатор) або з меню MAX+plus II > 
та, якщо раніше не було вибрано тип часового аналізу за д

риці затримок, установити його з меню 
вий аналізатор натисненням кно

конці про закін
ється заповненою. Відтак нею можна ск

ристатися для визначення  шляхів поширення сигна

З огляду на те, що матриця затримок (у первісному 
вигляді) не зберігається, її легко відновити: ввести ім’я проекту активного 
файла та запустити часовий аналізатор. 

ґ) Зберегти результати аналізу у формі таблиці текстового файла з 
Output File

Timing Analyzer

в) Викликати часовий аналізатор піктограмою 
(відкрити часовий аналізатор) або з меню MAX+plus II > 
та, якщо раніше не було вибрано тип часового аналізу за д

риці затримок, установити його з меню Analysis
ненням кно

конці про закінчення (completed) ан
ється заповненою. Відтак нею можна ск

ристатися для визначення  шляхів поширення сигналів, тривалості сфо

З огляду на те, що матриця затримок (у первісному 
вигляді) не зберігається, її легко відновити: ввести ім’я проекту активного 

ґ) Зберегти результати аналізу у формі таблиці текстового файла з 
File – вихідний файл часового 

Analyzer із заповненою таблицею 

в) Викликати часовий аналізатор піктограмою Opens the
(відкрити часовий аналізатор) або з меню MAX+plus II > 
та, якщо раніше не було вибрано тип часового аналізу за д

Analysis > Delay Matrix
ненням кнопки Start

чення (completed) ан
ється заповненою. Відтак нею можна ск

лів, тривалості сфо

З огляду на те, що матриця затримок (у первісному 
вигляді) не зберігається, її легко відновити: ввести ім’я проекту активного 

 
ґ) Зберегти результати аналізу у формі таблиці текстового файла з 

вихідний файл часового 
із заповненою таблицею 

the Timing
(відкрити часовий аналізатор) або з меню MAX+plus II > 
та, якщо раніше не було вибрано тип часового аналізу за до-

Delay Matrix.  
Start у вікні 

чення (completed) ана-
ється заповненою. Відтак нею можна ско-

лів, тривалості сфор-

 
З огляду на те, що матриця затримок (у первісному 

вигляді) не зберігається, її легко відновити: ввести ім’я проекту активного 

 
ґ) Зберегти результати аналізу у формі таблиці текстового файла з 

вихідний файл часового 
із заповненою таблицею 

Timing 
(відкрити часовий аналізатор) або з меню MAX+plus II > 

о-
 

у вікні 
а-
о-
р-

З огляду на те, що матриця затримок (у первісному 
вигляді) не зберігається, її легко відновити: ввести ім’я проекту активного 

ґ) Зберегти результати аналізу у формі таблиці текстового файла з 
вихідний файл часового 
із заповненою таблицею 



 

(інакше відновити її як зазначено в примітці) натиснути піктограму збер
ження файла (або з меню 
ці 

раму відкриття файла 
.
ця затримок (1

                   

файл (наприклад, з метою виправити його) чи додати до існуючого.

тою документувати у власну 

ром

trix
ку поширення сигналів: меню 
закладці діалогового вікна 
приклад, 
прапорець 
доступні з вибраних джерел > 

 

(інакше відновити її як зазначено в примітці) натиснути піктограму збер
ження файла (або з меню 
ці Save Analysis

д) Відкрити текстовий файл із таблицею затримок: натиснути пікто
раму відкриття файла 
.tao > [ім’я проекту].
ця затримок (1

                   

F Примітки
1. Якщо файл з таким ім’ям вже існує, надійде запит: перезаписати 

файл (наприклад, з метою виправити його) чи додати до існуючого.
2. Файл можна записати і за іншою директорією (наприклад, з м

тою документувати у власну 
1.2.

ром з урахуванням як зовнішніх виводів мікросхеми, так і внутрішніх вузлів.
а) Після виконання п. 

trix джерела (
ку поширення сигналів: меню 
закладці діалогового вікна 
приклад, Inputs
прапорець 
доступні з вибраних джерел > 

(інакше відновити її як зазначено в примітці) натиснути піктограму збер
ження файла (або з меню 

Analysis As.
д) Відкрити текстовий файл із таблицею затримок: натиснути пікто

раму відкриття файла 
> [ім’я проекту].

ця затримок (1det.tao)

DELAY MATRIX 
-------------------------------------------------------------------
SOURCE  DESTINATION  MIN_PATH MAX_PATH

                         Джерело  Адресат                              Шлях
x               dx1n                     4.5ns              6.4ns
x               dx2n                     4.5ns              6.4ns
x               dx3                       4.5ns              6.4ns

Примітки
Якщо файл з таким ім’ям вже існує, надійде запит: перезаписати 

файл (наприклад, з метою виправити його) чи додати до існуючого.
Файл можна записати і за іншою директорією (наприклад, з м

тою документувати у власну 
1.2.3.4 Виміряти затримки поширення сигналів часовим аналізат

з урахуванням як зовнішніх виводів мікросхеми, так і внутрішніх вузлів.
а) Після виконання п. 

джерела (Source
ку поширення сигналів: меню 
закладці діалогового вікна 

Inputs – входи і 
прапорець Show All
доступні з вибраних джерел > 

(інакше відновити її як зазначено в примітці) натиснути піктограму збер
ження файла (або з меню File

.  
д) Відкрити текстовий файл із таблицею затримок: натиснути пікто

раму відкриття файла Opens а 
> [ім’я проекту]. tao > OK

tao) набуде вигляду на зразок наведеного фрагменту.

DELAY MATRIX 
-------------------------------------------------------------------
SOURCE  DESTINATION  MIN_PATH MAX_PATH

Джерело  Адресат                              Шлях
x               dx1n                     4.5ns              6.4ns
x               dx2n                     4.5ns              6.4ns
x               dx3                       4.5ns              6.4ns

Примітки: 
Якщо файл з таким ім’ям вже існує, надійде запит: перезаписати 

файл (наприклад, з метою виправити його) чи додати до існуючого.
Файл можна записати і за іншою директорією (наприклад, з м

тою документувати у власну 
Виміряти затримки поширення сигналів часовим аналізат

з урахуванням як зовнішніх виводів мікросхеми, так і внутрішніх вузлів.
а) Після виконання п. 

Source) – вузли, від яких потрібно почати 
ку поширення сигналів: меню 
закладці діалогового вікна Timing

входи і Combinational
All Node Name

доступні з вибраних джерел > 
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(інакше відновити її як зазначено в примітці) натиснути піктограму збер
File > Save Analysis

д) Відкрити текстовий файл із таблицею затримок: натиснути пікто
а file (або з меню File > 

OK (або В** по 
набуде вигляду на зразок наведеного фрагменту.

DELAY MATRIX Матриця затримок
-------------------------------------------------------------------
SOURCE  DESTINATION  MIN_PATH MAX_PATH

Джерело  Адресат                              Шлях
x               dx1n                     4.5ns              6.4ns
x               dx2n                     4.5ns              6.4ns
x               dx3                       4.5ns              6.4ns

Якщо файл з таким ім’ям вже існує, надійде запит: перезаписати 
файл (наприклад, з метою виправити його) чи додати до існуючого.

Файл можна записати і за іншою директорією (наприклад, з м
тою документувати у власну папку).  

Виміряти затримки поширення сигналів часовим аналізат
з урахуванням як зовнішніх виводів мікросхеми, так і внутрішніх вузлів.
а) Після виконання п. 1.2.3.3, а

вузли, від яких потрібно почати 
ку поширення сигналів: меню Node > 

Timing Analysis
Combinational
Name Synonyms

доступні з вибраних джерел > Clear для очищення закладки 
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(інакше відновити її як зазначено в примітці) натиснути піктограму збер
Analysis As

д) Відкрити текстовий файл із таблицею затримок: натиснути пікто
(або з меню File > 

(або В** по назві файла у віконці File
набуде вигляду на зразок наведеного фрагменту.

Матриця затримок
-------------------------------------------------------------------
SOURCE  DESTINATION  MIN_PATH MAX_PATH

Джерело  Адресат                              Шлях
x               dx1n                     4.5ns              6.4ns
x               dx2n                     4.5ns              6.4ns
x               dx3                       4.5ns              6.4ns

Якщо файл з таким ім’ям вже існує, надійде запит: перезаписати 
файл (наприклад, з метою виправити його) чи додати до існуючого.

Файл можна записати і за іншою директорією (наприклад, з м
 

Виміряти затримки поширення сигналів часовим аналізат
з урахуванням як зовнішніх виводів мікросхеми, так і внутрішніх вузлів.

а), б), в) внести до матриці 
вузли, від яких потрібно почати 

> Timing Analysis
Analysis Source

Combinational – комбінаційні кола) > установити 
Synonyms, якщо потрібно продивитися всі 
для очищення закладки 

(інакше відновити її як зазначено в примітці) натиснути піктограму збер
As) та натиснути 

д) Відкрити текстовий файл із таблицею затримок: натиснути пікто
(або з меню File > Open) > 

файла у віконці File
набуде вигляду на зразок наведеного фрагменту.

Матриця затримок
-------------------------------------------------------------------
SOURCE  DESTINATION  MIN_PATH MAX_PATH

Джерело  Адресат                              Шлях 
x               dx1n                     4.5ns              6.4ns
x               dx2n                     4.5ns              6.4ns
x               dx3                       4.5ns              6.4ns

Якщо файл з таким ім’ям вже існує, надійде запит: перезаписати 
файл (наприклад, з метою виправити його) чи додати до існуючого.

Файл можна записати і за іншою директорією (наприклад, з м

Виміряти затримки поширення сигналів часовим аналізат
з урахуванням як зовнішніх виводів мікросхеми, так і внутрішніх вузлів.

внести до матриці 
вузли, від яких потрібно почати відлічувати затри

Analysis  Source
Source вибрати тип вузлів, н
комбінаційні кола) > установити 
, якщо потрібно продивитися всі 

для очищення закладки 

(інакше відновити її як зазначено в примітці) натиснути піктограму збер
) та натиснути OK

д) Відкрити текстовий файл із таблицею затримок: натиснути пікто
) > Tеxt Editor 

файла у віконці File
набуде вигляду на зразок наведеного фрагменту.

Матриця затримок 
------------------------------------------------------------------- 
SOURCE  DESTINATION  MIN_PATH MAX_PATH 

 
x               dx1n                     4.5ns              6.4ns 
x               dx2n                     4.5ns              6.4ns 
x               dx3                       4.5ns              6.4ns 

Якщо файл з таким ім’ям вже існує, надійде запит: перезаписати 
файл (наприклад, з метою виправити його) чи додати до існуючого.

Файл можна записати і за іншою директорією (наприклад, з м

Виміряти затримки поширення сигналів часовим аналізат
з урахуванням як зовнішніх виводів мікросхеми, так і внутрішніх вузлів.

внести до матриці Delay
відлічувати затри
Source > Type

вибрати тип вузлів, н
комбінаційні кола) > установити 
, якщо потрібно продивитися всі 

для очищення закладки Selected

(інакше відновити її як зазначено в примітці) натиснути піктограму збере-
OK у вікон-

д) Відкрити текстовий файл із таблицею затримок: натиснути піктог-
Editor files > 

файла у віконці Files). Табли-
набуде вигляду на зразок наведеного фрагменту. 

Якщо файл з таким ім’ям вже існує, надійде запит: перезаписати 
файл (наприклад, з метою виправити його) чи додати до існуючого. 

Файл можна записати і за іншою директорією (наприклад, з ме-

Виміряти затримки поширення сигналів часовим аналізато-
з урахуванням як зовнішніх виводів мікросхеми, так і внутрішніх вузлів. 

Delay Ma-
відлічувати затрим-

Type (у цій 
вибрати тип вузлів, на-

комбінаційні кола) > установити 
, якщо потрібно продивитися всі 

Selected Nodes

е-
н-

г-
> 
и-

Якщо файл з таким ім’ям вже існує, надійде запит: перезаписати 

е-

о-

a-
м-

(у цій 
а-

комбінаційні кола) > установити 
, якщо потрібно продивитися всі 

Nodes 



 

>
вузол у віконці Available 
цього вузла до віконця 
вторенням двох останніх дій > 
лений вибір вузлів і вийти з діалогового вікна).

межитися мінімумом вузлів, достатнім для досягнення мети аналізу. Напр
клад, для аналізу детектора фронтів варто вибрати такі джерела: вхід 
виходи буферів ЕХР (:5.

яких закінчується відлік затримки поширення сигналів відносно вибраних 
джерел: меню 
лів, наприклад, 
як у п. 
рів фронтів і двома внутрішніми вузлами 

  

ресати 

іншому елементу (виділиться червоним кольором) 
меню 
або Cutoff (зупин
довжуючи, визначити таким чином всі джерела та адресати 

 

> List для запису доступних вузлів до закладки Available 
вузол у віконці Available 
цього вузла до віконця 
вторенням двох останніх дій > 
лений вибір вузлів і вийти з діалогового вікна).

F Примітка.
межитися мінімумом вузлів, достатнім для досягнення мети аналізу. Напр
клад, для аналізу детектора фронтів варто вибрати такі джерела: вхід 
виходи буферів ЕХР (:5.

б) Внести до матриці 
яких закінчується відлік затримки поширення сигналів відносно вибраних 
джерел: меню 
лів, наприклад, 
як у п. 1.2.
рів фронтів і двома внутрішніми вузлами 

 
F Примітка.

ресати Destination
а) з контекстного меню у графічному файлі: 

іншому елементу (виділиться червоним кольором) 
меню Timing
або Cutoff (зупин
довжуючи, визначити таким чином всі джерела та адресати 

б) у графічному файлі: ввести ім

для запису доступних вузлів до закладки Available 
вузол у віконці Available 
цього вузла до віконця 
вторенням двох останніх дій > 
лений вибір вузлів і вийти з діалогового вікна).

Примітка.
межитися мінімумом вузлів, достатнім для досягнення мети аналізу. Напр
клад, для аналізу детектора фронтів варто вибрати такі джерела: вхід 
виходи буферів ЕХР (:5.

б) Внести до матриці 
яких закінчується відлік затримки поширення сигналів відносно вибраних 
джерел: меню Node
лів, наприклад, Outputs

1.2.3.4, а). Наприклад, можна обмежитися виходами трьох детект
рів фронтів і двома внутрішніми вузлами 

Примітка.
Destination можна й іншими шляхами: 
а) з контекстного меню у графічному файлі: 

іншому елементу (виділиться червоним кольором) 
Timing Analysis

або Cutoff (зупинення
довжуючи, визначити таким чином всі джерела та адресати 

б) у графічному файлі: ввести ім

для запису доступних вузлів до закладки Available 
вузол у віконці Available Nodes
цього вузла до віконця Selected
вторенням двох останніх дій > 
лений вибір вузлів і вийти з діалогового вікна).

Примітка. Аби надмірно не ускладнювати матрицю, доцільно о
межитися мінімумом вузлів, достатнім для досягнення мети аналізу. Напр
клад, для аналізу детектора фронтів варто вибрати такі джерела: вхід 
виходи буферів ЕХР (:5.OUT

б) Внести до матриці 
яких закінчується відлік затримки поширення сигналів відносно вибраних 

Node > Timing
Outputs (виходи) 
. Наприклад, можна обмежитися виходами трьох детект

рів фронтів і двома внутрішніми вузлами 

Примітка. Внести до матриці 
можна й іншими шляхами: 

а) з контекстного меню у графічному файлі: 
іншому елементу (виділиться червоним кольором) 

Analysis > Source
ення) – для вузла, який не треба враховувати в матриці; пр

довжуючи, визначити таким чином всі джерела та адресати 
б) у графічному файлі: ввести ім
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для запису доступних вузлів до закладки Available 
Nodes > натиснути стрілку => для п

Selected Nodes
вторенням двох останніх дій > OK (або 
лений вибір вузлів і вийти з діалогового вікна).

Аби надмірно не ускладнювати матрицю, доцільно о
межитися мінімумом вузлів, достатнім для досягнення мети аналізу. Напр
клад, для аналізу детектора фронтів варто вибрати такі джерела: вхід 

OUT, :6.OUT) з ідентифікаційними номер
б) Внести до матриці Delay Matrix

яких закінчується відлік затримки поширення сигналів відносно вибраних 
Timing Analysis

(виходи) і Combinational
. Наприклад, можна обмежитися виходами трьох детект

рів фронтів і двома внутрішніми вузлами 

Внести до матриці 
можна й іншими шляхами: 

а) з контекстного меню у графічному файлі: 
іншому елементу (виділиться червоним кольором) 

Source – для джерела або 
для вузла, який не треба враховувати в матриці; пр

довжуючи, визначити таким чином всі джерела та адресати 
б) у графічному файлі: ввести ім
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для запису доступних вузлів до закладки Available 
> натиснути стрілку => для п

Nodes > вибрати всі потрібні джерела п
(або Cancel, якщо треба скасувати зро

лений вибір вузлів і вийти з діалогового вікна). 
Аби надмірно не ускладнювати матрицю, доцільно о

межитися мінімумом вузлів, достатнім для досягнення мети аналізу. Напр
клад, для аналізу детектора фронтів варто вибрати такі джерела: вхід 

) з ідентифікаційними номер
Matrix адресати (

яких закінчується відлік затримки поширення сигналів відносно вибраних 
Analysis Destination

Combinational
. Наприклад, можна обмежитися виходами трьох детект

рів фронтів і двома внутрішніми вузлами – виходами

Внести до матриці Delay Matrix
можна й іншими шляхами:  

а) з контекстного меню у графічному файлі: 
іншому елементу (виділиться червоним кольором) 

для джерела або 
для вузла, який не треба враховувати в матриці; пр

довжуючи, визначити таким чином всі джерела та адресати 
б) у графічному файлі: ввести ім’я проекту

для запису доступних вузлів до закладки Available 
> натиснути стрілку => для п

> вибрати всі потрібні джерела п
, якщо треба скасувати зро
 

Аби надмірно не ускладнювати матрицю, доцільно о
межитися мінімумом вузлів, достатнім для досягнення мети аналізу. Напр
клад, для аналізу детектора фронтів варто вибрати такі джерела: вхід 

) з ідентифікаційними номер
адресати (Destination

яких закінчується відлік затримки поширення сигналів відносно вибраних 
Destination, відтак вибрати тип ву

Combinational та виконати такі самі дії, 
. Наприклад, можна обмежитися виходами трьох детект

виходами буферів ЕХР.

Matrix джерела 

а) з контекстного меню у графічному файлі: натиснути 
іншому елементу (виділиться червоним кольором) > вибрати в контекстному 

для джерела або Destination
для вузла, який не треба враховувати в матриці; пр

довжуючи, визначити таким чином всі джерела та адресати 
я проекту > виділити порт чи і

для запису доступних вузлів до закладки Available Nodes  > вибрати 
> натиснути стрілку => для перенесення 

> вибрати всі потрібні джерела п
, якщо треба скасувати зро

Аби надмірно не ускладнювати матрицю, доцільно о
межитися мінімумом вузлів, достатнім для досягнення мети аналізу. Напр
клад, для аналізу детектора фронтів варто вибрати такі джерела: вхід 

) з ідентифікаційними номерами 5 і 6. 
Destination) – 

яких закінчується відлік затримки поширення сигналів відносно вибраних 
, відтак вибрати тип ву
та виконати такі самі дії, 

. Наприклад, можна обмежитися виходами трьох детект
буферів ЕХР.

джерела Source

натиснути В2 по порту чи 
вибрати в контекстному 

Destination – для адресата, 
для вузла, який не треба враховувати в матриці; пр

довжуючи, визначити таким чином всі джерела та адресати або:  
виділити порт чи і

> вибрати 
еренесення 

> вибрати всі потрібні джерела по-
, якщо треба скасувати зроб-

Аби надмірно не ускладнювати матрицю, доцільно об-
межитися мінімумом вузлів, достатнім для досягнення мети аналізу. Напри-
клад, для аналізу детектора фронтів варто вибрати такі джерела: вхід x та 

ами 5 і 6.  
 вузли, на

яких закінчується відлік затримки поширення сигналів відносно вибраних 
, відтак вибрати тип вуз-
та виконати такі самі дії, 

. Наприклад, можна обмежитися виходами трьох детекто-
буферів ЕХР. 

Source та ад-

В2 по порту чи 
вибрати в контекстному 

для адресата, 
для вузла, який не треба враховувати в матриці; про-

виділити порт чи ін-

> вибрати 
еренесення 

о-
б-

б-
и-
та 
 

вузли, на 
яких закінчується відлік затримки поширення сигналів відносно вибраних 

з-
та виконати такі самі дії, 

о-

д-

В2 по порту чи 
вибрати в контекстному 

для адресата, 
о-

н-



 

ший елемент
ing
ла, який не треба враховувати в матриці; продовжуючи, визначити таким 
чином всі джерела та адресати.

зширенням 
1

них є мінімально повн
рюють: 1)
константа нуля.

ням інверторів (далі наводиться варіант

14

13

11

9

7

5

3

1

16

15

верторів відповідно 
Виключне АБО, 4) Заборона, 5) АБО
8)

 

 

ший елемент
ing Analysis
ла, який не треба враховувати в матриці; продовжуючи, визначити таким 
чином всі джерела та адресати.

в) Виконати п. 
зширенням 
1det.tao1. 

 

1. Які системи логічних функцій є функціонально повн
них є мінімально повн
рюють: 1)
константа нуля.

2. Логічну функцію 
ням інверторів (далі наводиться варіант

)14

)13

)11

)9

)7

)5

)3

)1

1

1

1

1

1

1

1

21

xy

xy

xy

xy

xy

xy

xy

xxxy

⊕=

+=

+=

⊕=

+=

+=

⊕=

=

)16

()15

1

1

xy

xy

+=

=

3. Який логічний елемент 
верторів відповідно 
Виключне АБО, 4) Заборона, 5) АБО
8) Імпліка

 а) 

ший елемент > меню
Analysis Destination

ла, який не треба враховувати в матриці; продовжуючи, визначити таким 
чином всі джерела та адресати.

в) Виконати п. 
зширенням .tao) зберегти під іншим іменем, наприклад, 1

 

Які системи логічних функцій є функціонально повн
них є мінімально повн
рюють: 1) операція заборони і константа одиниці, 2) операція імплікації і 
константа нуля. 

Логічну функцію 
ням інверторів (далі наводиться варіант

32

32

432

32

32

432

32

543

xx

xx

xxx

xx

xxx

xxx

xx

xxx

⊕⊕⊕

+++

++

⊕⊕⊕

++

+

⊕⊕

++

)(

32

32

xx

xx

+++

++

Який логічний елемент 
верторів відповідно 
Виключне АБО, 4) Заборона, 5) АБО
Імплікатор? 

 

меню Utilities
Destination – для адресата

ла, який не треба враховувати в матриці; продовжуючи, визначити таким 
чином всі джерела та адресати.

в) Виконати п. 1.2.3.3,
) зберегти під іншим іменем, наприклад, 1

Контрольні питання та завдання
Які системи логічних функцій є функціонально повн

них є мінімально повними? Доведіть, що мінімально 
операція заборони і константа одиниці, 2) операція імплікації і 

Логічну функцію y 
ням інверторів (далі наводиться варіант

54

54

54

4

54

54

98765

xx

АБОxx

Іx

Виклx

xxx

АБОІ

xx

xxxx

−⊕⊕

−+

−−+

−⊕

++

−−

−⊕⊕

−

)

654

654

xxx

xxx

+

−

Який логічний елемент 
верторів відповідно до рис. 1.2
Виключне АБО, 4) Заборона, 5) АБО

 б) 

32

Utilities > Timing
для адресата

ла, який не треба враховувати в матриці; продовжуючи, визначити таким 
чином всі джерела та адресати. 

3.3, г), ґ), д)
) зберегти під іншим іменем, наприклад, 1

Контрольні питання та завдання
Які системи логічних функцій є функціонально повн

? Доведіть, що мінімально 
операція заборони і константа одиниці, 2) операція імплікації і 

 здійснити на заданому елементі з використа
ням інверторів (далі наводиться варіант

.

.

;

.

;

6

АБОВикл

НЕАБО

НЕАБО

НЕАБОВикл

НЕІx

АБО

АБОВикл

I

−

−

−−

−

−−

−

87 xxx

АБОІ

++

−−

Який логічний елемент B (рис. 
1.2, а), б), 

Виключне АБО, 4) Заборона, 5) АБО

 

32 

Timing Analysis
для адресата або Timing

ла, який не треба враховувати в матриці; продовжуючи, визначити таким 

), але матрицю у формі таблиці (з р
) зберегти під іншим іменем, наприклад, 1

Контрольні питання та завдання
Які системи логічних функцій є функціонально повн

? Доведіть, що мінімально 
операція заборони і константа одиниці, 2) операція імплікації і 

здійснити на заданому елементі з використа
ням інверторів (далі наводиться варіант: функція 

.

;

)12;

)10;

)8;

)6

)4;

)2

АБО

НЕ

yНЕ

yНЕ

yНЕ

y

yАБО

xy

=

=

=

=

;

11109 xxx

НЕ

+

−

(рис. 1.2, г) утворюється додаванням і
 в), якщо 

Виключне АБО, 4) Заборона, 5) АБО-НЕ, 6) І-

 в) 

  Source –
Timing Analysis

ла, який не треба враховувати в матриці; продовжуючи, визначити таким 

матрицю у формі таблиці (з р
) зберегти під іншим іменем, наприклад, 1

Контрольні питання та завдання 
Які системи логічних функцій є функціонально повн

? Доведіть, що мінімально повну систему утв
операція заборони і константа одиниці, 2) операція імплікації і 

здійснити на заданому елементі з використа
функція – заданий елемент):

321

21

4321

21

4321

xxxxy

xx

xxxxx

НЕІx

Заборонаxx

xxxx

=

−+=

−−

−

+

АБОІ −−

г) утворюється додаванням і
, якщо A є елемент: 1) АБО, 2) І, 3) 

-НЕ, 7) Виключне АБО

 

– для джерела,
Analysis Cutoff –

ла, який не треба враховувати в матриці; продовжуючи, визначити таким 

матрицю у формі таблиці (з р
) зберегти під іншим іменем, наприклад, 1det

Які системи логічних функцій є функціонально повними
повну систему утв

операція заборони і константа одиниці, 2) операція імплікації і 

здійснити на заданому елементі з використа
заданий елемент):

;

;

54

5

54

НЕIxx

Заборона

АБОx

НЕ

Заборона

АБОx

−−

−

−−

−+

.НЕАБО −
 

г) утворюється додаванням і
є елемент: 1) АБО, 2) І, 3) 
НЕ, 7) Виключне АБО

 

для джерела, Tim-
– для вуз-

ла, який не треба враховувати в матриці; продовжуючи, визначити таким 

матрицю у формі таблиці (з ро-
det1.tao або 

ими? Які з 
повну систему утво-

операція заборони і константа одиниці, 2) операція імплікації і 

здійснити на заданому елементі з використан-
заданий елемент): 

;

;

;

;

НЕ

Заборона

НЕ

АБО

−
 

г) утворюється додаванням ін-
є елемент: 1) АБО, 2) І, 3) 
НЕ, 7) Виключне АБО-НЕ, 

 
 г) 

m-
з-

ла, який не треба враховувати в матриці; продовжуючи, визначити таким 

о-
або 

? Які з 
о-

операція заборони і константа одиниці, 2) операція імплікації і 

н-

н-
є елемент: 1) АБО, 2) І, 3) 

НЕ, 
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Рисунок 1.2 
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2  РЕАЛІЗАЦІЯ ЛОГІЧНИХ ФУНКЦІЙ 
 
Мета роботи: створення проекту за його графічного введення; за-

своєння методики користування електронним довідником для добору пот-
рібної ІС серії 74 і методики настроювання макрофункцій.  

Домашнє завдання 
! 1) Засвоїти теоретичні відомості щодо мінімізації логічних функцій, 

реалізації їх у поширених базисах та способів спрощення логічних схем.  
2) Для заданої згідно з варіантом (див. додаток А, варіанти завдан-

ня 2) логічної функції y: а) побудувати таблицю відповідності і діаграму 
термів (Вайча-Карно); б) навести досконалі (ДДНФ або ДКНФ) та мініма-
льні (МДНФ і МКНФ) форми; в) перетворити мінімальні форми до базисів 
І-НЕ, АБО-НЕ та І-АБО-НЕ; г) мінімізувати схему в базисі І-НЕ чи АБО-
НЕ, який забезпечує меншу складність; ґ)  навести схеми за підпункта-
ми в), г).  

 
2.1  Стислі теоретичні відомості 

2.1.1  Мінімізація логічних функцій 
Мінімізація логічних функцій полягає в перетворенні ДДНФ до мі-

німальної ДНФ (МДНФ) або ДКНФ до мінімальної КНФ (МКНФ) функції. 
Серед формалізованих методів мінімізації найбільшого поширення набув 
метод за допомогою діаграм термів (Вайча – Карно). Для функції y чоти-
рьох змінних (рис. 2.1, а) клітинки діаграми термів (рис. 2.1, б) нумеру-
ються десятковими кодами і вхідних кортежів. Стандартна нумерація клі-
тинок полегшує заповнення власне діаграми функції y (рис. 2.1, в): до діаг-
рами переносять лише одиниці з колонки y таблиці відповідності згідно з 
кодами i вхідних кортежів, а до порожніх клітинок вважаються записаними 
нулі, або, навпаки, переносять лише нулі (рис. 2.1, г), тоді порожні клітин-
ки відповідають значенням y = 1. 

Підсумовуванням мінтермів (сполучень одиниць) дістаємо шукану 
МДНФ  у вигляді 

.43143231 xxxxxxxxy ++=  
Цю ж саму діаграму термів можна використати й для здобуття інве-

рсної функції КНФ 

( ) ( ) ( ) .43143231 xxxxxxxxy ++⋅++⋅+=  
Підсумовуванням макстермів (сполучень нулів) дістаємо шукану 

МДНФ у вигляді 

( )( )( ) .43143231 xxxxxxxxy +++++=  



 

рами, зчитуючи 

логічних елементів у 
МДНФ або в послідовності: НЕ, АБО, І за формулами в МКНФ.

одиниць) 

 
де  

(об’єднанням нулів)

 

і 
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Рисунок

Інверсну
рами, зчитуючи 

 
2.1.
Булів базис

логічних елементів у 
МДНФ або в послідовності: НЕ, АБО, І за формулами в МКНФ.

Базис І
одиниць)  реалізацію звичайно виконують за формулою:

 
де  А, В – кон’юнкції літералів  (змінних

Базис АБО
(об’єднанням нулів)

4x  3x  

0 0 
0 0 
0 0 
0 0 
0 1 
0 1 
0 1 
0 1 
1 0 
1 0 

 1 0 
 1 0 
 1 1 
 1 1 
 1 1 
 1 1 

Рисунок 2.1 –

Інверсну функцію МДНФ також можна отримати з цієї самої діа
рами, зчитуючи сполучення

2.1.2  Реалізація в поширених базисах
Булів базис 

логічних елементів у 
МДНФ або в послідовності: НЕ, АБО, І за формулами в МКНФ.

Базис І-НЕ –
реалізацію звичайно виконують за формулою:

 
кон’юнкції літералів  (змінних

Базис АБО
(об’єднанням нулів)

 2x  1x  

0 0 
0 1 
1 0 
1 1 
0 0 
0 1 
1 0 
1 1 
0 0 
0 1 
1 0 
1 1 
0 0 
0 1 
1 0 
1 1 
а) 

– Мінімізація логічної функції 

функцію МДНФ також можна отримати з цієї самої діа
сполучення нулів так само, як 

y =

Реалізація в поширених базисах
 – функції реалізуються сполученням входів і виходів 

логічних елементів у послідовності: НЕ, І, АБО відповідно до формул у 
МДНФ або в послідовності: НЕ, АБО, І за формулами в МКНФ.

– після мінімізації логічної функції в
реалізацію звичайно виконують за формулою:

 Ay =
кон’юнкції літералів  (змінних

Базис АБО-НЕ –після мінімізації логічної функції в
(об’єднанням нулів) реалізацію звичайно виконують за формулою:

35

 y 

1 
1 
0 
0 
0 
1 
0 
1 
1 
0 
1 
0 
0 
1 
0 
1 

Мінімізація логічної функції 
 

функцію МДНФ також можна отримати з цієї самої діа
нулів так само, як 

231 xxxx +

Реалізація в поширених базисах
функції реалізуються сполученням входів і виходів 
послідовності: НЕ, І, АБО відповідно до формул у 

МДНФ або в послідовності: НЕ, АБО, І за формулами в МКНФ.
після мінімізації логічної функції в

реалізацію звичайно виконують за формулою:

ABA =+
кон’юнкції літералів  (змінних

після мінімізації логічної функції в
реалізацію звичайно виконують за формулою:

35 

Мінімізація логічної функції 
 

функцію МДНФ також можна отримати з цієї самої діа
нулів так само, як сполучення

3143 xxxx +

Реалізація в поширених базисах 
функції реалізуються сполученням входів і виходів 
послідовності: НЕ, І, АБО відповідно до формул у 

МДНФ або в послідовності: НЕ, АБО, І за формулами в МКНФ.
після мінімізації логічної функції в

реалізацію звичайно виконують за формулою:

ABA ⋅=+
кон’юнкції літералів  (змінних  або їх заперечень).

після мінімізації логічної функції в
реалізацію звичайно виконують за формулою:

б) 

в) 

г) 
Мінімізація логічної функції y чотирьох

функцію МДНФ також можна отримати з цієї самої діа
сполучення

.43x  

 
функції реалізуються сполученням входів і виходів 
послідовності: НЕ, І, АБО відповідно до формул у 

МДНФ або в послідовності: НЕ, АБО, І за формулами в МКНФ.
після мінімізації логічної функції в МДНФ (об’єднанням 

реалізацію звичайно виконують за формулою: 

,B⋅  
їх заперечень).

після мінімізації логічної функції в
реалізацію звичайно виконують за формулою:

 

 

чотирьох змінних

функцію МДНФ також можна отримати з цієї самої діа
сполучення одиниць:

функції реалізуються сполученням входів і виходів 
послідовності: НЕ, І, АБО відповідно до формул у 

МДНФ або в послідовності: НЕ, АБО, І за формулами в МКНФ. 
МДНФ (об’єднанням 

 
їх заперечень). 

після мінімізації логічної функції в
реалізацію звичайно виконують за формулою: 

 

 

змінних 

функцію МДНФ також можна отримати з цієї самої діаг-
одиниць: 

функції реалізуються сполученням входів і виходів 
послідовності: НЕ, І, АБО відповідно до формул у 

МДНФ (об’єднанням 

 (2.1)

після мінімізації логічної функції в МДНФ 

г-

функції реалізуються сполученням входів і виходів 
послідовності: НЕ, І, АБО відповідно до формул у 

МДНФ (об’єднанням 

) 

МДНФ 



 36 

 BABABAy +=⋅=⋅= , (2.2) 
де А, В – диз’юнкції літералів. 

Базис І-АБО-НЕ – після мінімізації інверсної логічної функції в 
МДНФ (об’єднанням нулів) перетворення схем виконують алгебрично за 
формулами: 
 ;CEABy +=   CEABy += , (2.3) 
де А, В – кон’юнкції літералів. 

 
2.1.3  Способи спрощення логічних схем 
Серії сучасних ІС містять різні комплекти стандартних логічних 

елементів, у тому числі багатовходових, використання яких дозволяє міні-
мізувати схеми. 

Редукцію в диз'юнктивній формі в загальному вигляді під час мі-
німізації в ДНФ можна виконати доповненням заданої функції у непере-
тинною з нею коригувальною функцією уk таким чином, аби об'єднання D 
цих функцій та сама допоміжна функція уk були якомога простішими. Тоді 
шукану функцію дістаємо з виразу 
 kk yDyDy == \ . (2.4) 

Редукція в кон'юнктивній формі – до нульових клітинок функції у 
з метою спрощення їх сполучень на діаграмі долучаємо ще деякі одиничні 
клітинки, утворюючи допоміжну функцію уk, якщо доповнення об'єднання 
D  цих функцій (тобто сполучення нульових і ще приєднаних одиничних 
клітинок) і нова функція уk виявляються простими. Для здобуття шуканої 
функції необхідно в утвореному об'єднанні відновити одиничні клітинки, 
тобто виконати операцію імплікації 
 .kk yDyDy +=←=  (2.5) 

Алгебричне виконання редукції  у простих випадках можна здійс-
нити за формулами: 
 ;ABABA =  .BAABA ++=+  (2.6) 

Приклади та інші відомості щодо мінімізації логічних функцій, реа-
лізації їх у поширених базисах і схемної мінімізації наведено в [1, 2]. 

 
2.1.4 Макрофункції  
Макрофункція (Мacrofunction) – стандартний блок, здебільшого ви-

сокого рівня, з оптимізованими різноманітними логічними операціями. У 
системі МАХ... запроваджено понад 300 макрофункцій на базі 74-ої серії (з 
цифровою нумерацією 74...), а також специфічних для цієї програми (поз-
начаються маленькими літерами). Макрофункції можуть використовувати-
ся в графічних і текстових файлах разом із примітивами та іншими струк-
турними компонентами. З використанням макрофункцій зручно відпрацьо-



 

вувати про

ліотеки функціональних модулів САПР
ції найзручніше з меню 
сторінк
категорії за функціональним призначенням (21 категорія). Якщо ж потрі
но продивитися дані щодо відомої макрофункції, то зі сторінки
Macrofunctions
Macrofunctions (by 

горій:

тиву 
по шість і вісім буферів з трьома станами виходу;

 

(
рсним виходами, логічний елемент заборони 
дартні логічні елементи, у тому числі комбіновані: І
INV) та І

складністю, але й тим, що
д
лькості входів і виходів (у бік зменшення), а також виконати довільні входи і 
виходи прями

 

вувати про
Макрофункції зосереджено в підкаталозі 

ліотеки функціональних модулів САПР
ції найзручніше з меню 
сторінку Old
категорії за функціональним призначенням (21 категорія). Якщо ж потрі
но продивитися дані щодо відомої макрофункції, то зі сторінки
Macrofunctions
Macrofunctions (by 

У цій лабораторній роботі розглядаються макрофункції двох кат
горій: 

a) буфери
тиву TRI  
по шість і вісім буферів з трьома станами виходу;

 
Рисунок

б) логічні функції (
(Complementary
рсним виходами, логічний елемент заборони 
дартні логічні елементи, у тому числі комбіновані: І
INV) та І-АБО (AND

Макрофункції відрізняються від примітивів не 
складністю, але й тим, що
до всіх їх зовнішніх виводів, та, по
лькості входів і виходів (у бік зменшення), а також виконати довільні входи і 
виходи прями

вувати проекти, що будуються на ІС жорсткої структури.
Макрофункції зосереджено в підкаталозі 

ліотеки функціональних модулів САПР
ції найзручніше з меню 

Old-Style 
категорії за функціональним призначенням (21 категорія). Якщо ж потрі
но продивитися дані щодо відомої макрофункції, то зі сторінки
Macrofunctions (by
Macrofunctions (by N

У цій лабораторній роботі розглядаються макрофункції двох кат

буфери (Buffers, рис. 
  Primitive 

по шість і вісім буферів з трьома станами виходу;

 а) 
Рисунок 2.2 – Макрофункції: а) порти; б) буфери; в) логічні примітиви

б) логічні функції (
Complementary Buffer
рсним виходами, логічний елемент заборони 
дартні логічні елементи, у тому числі комбіновані: І

АБО (AND
Макрофункції відрізняються від примітивів не 

складністю, але й тим, що
о всіх їх зовнішніх виводів, та, по
лькості входів і виходів (у бік зменшення), а також виконати довільні входи і 
виходи прямими чи  інверсними. Завдяки цьому макрофункції набувають п

екти, що будуються на ІС жорсткої структури.
Макрофункції зосереджено в підкаталозі 

ліотеки функціональних модулів САПР
ції найзручніше з меню Help

 Macrofunctions
категорії за функціональним призначенням (21 категорія). Якщо ж потрі
но продивитися дані щодо відомої макрофункції, то зі сторінки

by Function
Number). 

У цій лабораторній роботі розглядаються макрофункції двох кат

(Buffers, рис. 
 з інверсним входом дозволу ОЕ, а 

по шість і вісім буферів з трьома станами виходу;

 
Макрофункції: а) порти; б) буфери; в) логічні примітиви

б) логічні функції (SSI
Buffer), еквівалентний буферу GLOBAL з прямим та інв

рсним виходами, логічний елемент заборони 
дартні логічні елементи, у тому числі комбіновані: І

АБО (AND-OR).  
Макрофункції відрізняються від примітивів не 

складністю, але й тим, що, по
о всіх їх зовнішніх виводів, та, по
лькості входів і виходів (у бік зменшення), а також виконати довільні входи і 

ми чи  інверсними. Завдяки цьому макрофункції набувають п

37

екти, що будуються на ІС жорсткої структури.
Макрофункції зосереджено в підкаталозі 

ліотеки функціональних модулів САПР
Help > Old-Style

Macrofunctions (by
категорії за функціональним призначенням (21 категорія). Якщо ж потрі
но продивитися дані щодо відомої макрофункції, то зі сторінки

Function) можна перейти на сторінку
 

У цій лабораторній роботі розглядаються макрофункції двох кат

(Buffers, рис. 2.2, а), зокрема, 
з інверсним входом дозволу ОЕ, а 

по шість і вісім буферів з трьома станами виходу;

 
Макрофункції: а) порти; б) буфери; в) логічні примітиви

SSI Functions
еквівалентний буферу GLOBAL з прямим та інв

рсним виходами, логічний елемент заборони 
дартні логічні елементи, у тому числі комбіновані: І

Макрофункції відрізняються від примітивів не 
по-перше, вони виконані 

о всіх їх зовнішніх виводів, та, по-друге,
лькості входів і виходів (у бік зменшення), а також виконати довільні входи і 

ми чи  інверсними. Завдяки цьому макрофункції набувають п

37 

екти, що будуються на ІС жорсткої структури.
Макрофункції зосереджено в підкаталозі 

ліотеки функціональних модулів САПР. Для добору потрібної макрофун
Style Macrofunctions
by Function

категорії за функціональним призначенням (21 категорія). Якщо ж потрі
но продивитися дані щодо відомої макрофункції, то зі сторінки

можна перейти на сторінку

У цій лабораторній роботі розглядаються макрофункції двох кат

а), зокрема, 
з інверсним входом дозволу ОЕ, а 

по шість і вісім буферів з трьома станами виходу;

 б) 
Макрофункції: а) порти; б) буфери; в) логічні примітиви

Functions, рис. 2.
еквівалентний буферу GLOBAL з прямим та інв

рсним виходами, логічний елемент заборони inhb
дартні логічні елементи, у тому числі комбіновані: І

Макрофункції відрізняються від примітивів не 
вони виконані 
друге, їх можна 

лькості входів і виходів (у бік зменшення), а також виконати довільні входи і 
ми чи  інверсними. Завдяки цьому макрофункції набувають п

екти, що будуються на ІС жорсткої структури.
Макрофункції зосереджено в підкаталозі \maxplus

Для добору потрібної макрофун
Macrofunctions вийти на довідкову 

Function), де репрезентовано всі їх 
категорії за функціональним призначенням (21 категорія). Якщо ж потрі
но продивитися дані щодо відомої макрофункції, то зі сторінки

можна перейти на сторінку

У цій лабораторній роботі розглядаються макрофункції двох кат

а), зокрема, btri – еквівалентний прим
з інверсним входом дозволу ОЕ, а також ІС, що містять 

по шість і вісім буферів з трьома станами виходу; 

 
Макрофункції: а) порти; б) буфери; в) логічні примітиви

2.2, б), серед яких буфер
еквівалентний буферу GLOBAL з прямим та інв

inhb (Inhibit Gate) та всі ста
дартні логічні елементи, у тому числі комбіновані: І-АБО

Макрофункції відрізняються від примітивів не тільки підвищеною 
вони виконані з портами

їх можна перестроювати
лькості входів і виходів (у бік зменшення), а також виконати довільні входи і 

ми чи  інверсними. Завдяки цьому макрофункції набувають п

екти, що будуються на ІС жорсткої структури. 
maxplus2\max2lib

Для добору потрібної макрофун
вийти на довідкову 

репрезентовано всі їх 
категорії за функціональним призначенням (21 категорія). Якщо ж потрі
но продивитися дані щодо відомої макрофункції, то зі сторінки 

можна перейти на сторінку 

У цій лабораторній роботі розглядаються макрофункції двох кат

еквівалентний прим
також ІС, що містять 

 в)
Макрофункції: а) порти; б) буфери; в) логічні примітиви

б), серед яких буфер
еквівалентний буферу GLOBAL з прямим та інв

(Inhibit Gate) та всі ста
АБО-НЕ (AND

тільки підвищеною 
з портами, приєднаними 
перестроювати

лькості входів і виходів (у бік зменшення), а також виконати довільні входи і 
ми чи  інверсними. Завдяки цьому макрофункції набувають п

lib\mf біб-
Для добору потрібної макрофунк-

вийти на довідкову 
репрезентовано всі їх 

категорії за функціональним призначенням (21 категорія). Якщо ж потріб-
 Old-Style

 Old-Style 

У цій лабораторній роботі розглядаються макрофункції двох кате-

еквівалентний примі-
також ІС, що містять 

 
в) 

Макрофункції: а) порти; б) буфери; в) логічні примітиви 

б), серед яких буфер cbuf
еквівалентний буферу GLOBAL з прямим та інве-

(Inhibit Gate) та всі стан-
НЕ (AND-OR-

тільки підвищеною 
, приєднаними 

перестроювати щодо кі-
лькості входів і виходів (у бік зменшення), а також виконати довільні входи і 

ми чи  інверсними. Завдяки цьому макрофункції набувають пе-

б-
к-

вийти на довідкову 
репрезентовано всі їх 

б-
Style 
Style 

е-

і-
також ІС, що містять 

cbuf 
е-
н-

-

тільки підвищеною 
, приєднаними 

і-
лькості входів і виходів (у бік зменшення), а також виконати довільні входи і 

е-



 

вної універсальності: на їх основі легко утворити не тільки стандартні, але й 
довільні функції.

рацію

них елементах 

то потрібен один нестандартний елемент І (із шістьма входами, три з яких є 
інверсні), який неважко виконати за 

примітивів для заданого варіанту ХХ логічної функції

теки

 

вної універсальності: на їх основі легко утворити не тільки стандартні, але й 
довільні функції.

< 
рацію 

На рівні примітивів таку функцію м
них елементах 

Проте якщо задану функцію перетворити до вигляду

то потрібен один нестандартний елемент І (із шістьма входами, три з яких є 
інверсні), який неважко виконати за 

2.2.
примітивів для заданого варіанту ХХ логічної функції

2.2.
теки примітивів 

а) подвійним клацанням (B**) у полі файла (або одиничним кл

вної універсальності: на їх основі легко утворити не тільки стандартні, але й 
довільні функції. 

 Приклад. 

На рівні примітивів таку функцію м
них елементах – тривходовому АБО

Проте якщо задану функцію перетворити до вигляду

то потрібен один нестандартний елемент І (із шістьма входами, три з яких є 
інверсні), який неважко виконати за 

2.2.1  Засвоїти основи 
примітивів для заданого варіанту ХХ логічної функції

200.

2.2.1.3 Вставити символи 
примітивів \maxplus
а) подвійним клацанням (B**) у полі файла (або одиничним кл

вної універсальності: на їх основі легко утворити не тільки стандартні, але й 

Приклад. З використанням макрофункції виконати логічну оп

y

На рівні примітивів таку функцію м
тривходовому АБО

1xa =

Проте якщо задану функцію перетворити до вигляду

то потрібен один нестандартний елемент І (із шістьма входами, три з яких є 
інверсні), який неважко виконати за 

2.2 Лабораторне завдання
Засвоїти основи 

примітивів для заданого варіанту ХХ логічної функції
1.1 Створити власний графічний файл,

0.gdf 

Вставити символи 
maxplus2\max

а) подвійним клацанням (B**) у полі файла (або одиничним кл

38

вної універсальності: на їх основі легко утворити не тільки стандартні, але й 

З використанням макрофункції виконати логічну оп

21 xxy ++=

На рівні примітивів таку функцію м
тривходовому АБО-НЕ та чотиривходовому І:

;321 xx ++

Проте якщо задану функцію перетворити до вигляду

21 xxxy =

то потрібен один нестандартний елемент І (із шістьма входами, три з яких є 
інверсні), який неважко виконати за допомогою макрофункції (рис.

Лабораторне завдання
Засвоїти основи графічного

примітивів для заданого варіанту ХХ логічної функції
1.1 Створити власний графічний файл,
 (варіант ХХ=0

\max
наведених п
меню): визначити ім’я проекту 
(1.2.
файл (там 
йому ім’я проекту (там 

рядка головного вікна 
рамою або кома
ject > 
формування будь
ня йому імені.

вання
нанести сітку
guidelines, крок якої визначається кома
дою: меню Option

Вставити символи елементів схеми 
max2lib\prim

а) подвійним клацанням (B**) у полі файла (або одиничним кл
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вної універсальності: на їх основі легко утворити не тільки стандартні, але й 

З використанням макрофункції виконати логічну оп

6543 xxxx+

На рівні примітивів таку функцію можна здійснити на двох логі
НЕ та чотиривходовому І:

; 4xay =

Проте якщо задану функцію перетворити до вигляду

,6543 xxxx  

то потрібен один нестандартний елемент І (із шістьма входами, три з яких є 
допомогою макрофункції (рис.

Лабораторне завдання
графічного введення проекту на рівні 

примітивів для заданого варіанту ХХ логічної функції
1.1 Створити власний графічний файл,

(варіант ХХ=0
max2work\rt\
наведених п
меню): визначити ім’я проекту 
1.2.1.4,а)...ґ), від
файл (там само
йому ім’я проекту (там 

ту можна ввести (до верхнього 
рядка головного вікна 
рамою або кома

t > Set Proje
формування будь
ня йому імені.

2.2.1.2
вання у вікні елементів схеми доцільно 
нанести сітку
guidelines, крок якої визначається кома
дою: меню Option
елементів схеми 
prim до створеного графічного файла:

а) подвійним клацанням (B**) у полі файла (або одиничним кл

вної універсальності: на їх основі легко утворити не тільки стандартні, але й 

З використанням макрофункції виконати логічну оп

.6  

ожна здійснити на двох логі
НЕ та чотиривходовому І:

.654 xx  

Проте якщо задану функцію перетворити до вигляду

 

то потрібен один нестандартний елемент І (із шістьма входами, три з яких є 
допомогою макрофункції (рис.

Лабораторне завдання 
введення проекту на рівні 

примітивів для заданого варіанту ХХ логічної функції
1.1 Створити власний графічний файл,

(варіант ХХ=00) з 
\0br\200.gdf

наведених піктограм або командами з 
меню): визначити ім’я проекту 

...ґ), відкрити новий графічний 
само, підпункти

йому ім’я проекту (там 
F Приміт

ту можна ввести (до верхнього 
рядка головного вікна 
рамою або командою з меню File > Pr

Project to Current
формування будь-якого файла та нада
ня йому імені. 

1.2 Для зручності розташ
у вікні елементів схеми доцільно 

нанести сітку: меню Option
guidelines, крок якої визначається кома
дою: меню Options > G
елементів схеми в базисі І

до створеного графічного файла:
а) подвійним клацанням (B**) у полі файла (або одиничним кл

вної універсальності: на їх основі легко утворити не тільки стандартні, але й 

З використанням макрофункції виконати логічну оп

ожна здійснити на двох логі
НЕ та чотиривходовому І: 

Проте якщо задану функцію перетворити до вигляду 

то потрібен один нестандартний елемент І (із шістьма входами, три з яких є 
допомогою макрофункції (рис. 2.

введення проекту на рівні 
примітивів для заданого варіанту ХХ логічної функції 

1.1 Створити власний графічний файл, наприклад, 
) з директорією 

gdf (послідовністю 
ктограм або командами з 

меню): визначити ім’я проекту 
рити новий графічний 
ідпункти д), е) та надати 

йому ім’я проекту (там само, підпункт
Примітка. Ім‘я прое

ту можна ввести (до верхнього 
рядка головного вікна Manager) пікто

дою з меню File > Pr
Current File і після 

якого файла та нада

Для зручності розташ
у вікні елементів схеми доцільно 

: меню Options
guidelines, крок якої визначається кома

Guideline Spacing
в базисі І-НЕ

до створеного графічного файла:
а) подвійним клацанням (B**) у полі файла (або одиничним кл

вної універсальності: на їх основі легко утворити не тільки стандартні, але й 

З використанням макрофункції виконати логічну опе-

ожна здійснити на двох логіч-

то потрібен один нестандартний елемент І (із шістьма входами, три з яких є 
2.2, в).  

введення проекту на рівні 

наприклад, 
директорією 

(послідовністю 
ктограм або командами з 

меню): визначити ім’я проекту 
рити новий графічний 

е) та надати 
ідпункт є). 
Ім‘я проек-

ту можна ввести (до верхнього 
ager) піктог-

дою з меню File > Pro-
File і після 

якого файла та надан-

Для зручності розташу-
у вікні елементів схеми доцільно 

s > Show 
guidelines, крок якої визначається коман-

Spacing. 
НЕ з бібліо-

до створеного графічного файла: 
а) подвійним клацанням (B**) у полі файла (або одиничним кла-

вної універсальності: на їх основі легко утворити не тільки стандартні, але й 

е-

ч-

то потрібен один нестандартний елемент І (із шістьма входами, три з яких є 

введення проекту на рівні 

наприклад, 
директорією 

(послідовністю 
ктограм або командами з 

меню): визначити ім’я проекту 
рити новий графічний 

е) та надати 
є).  
к-

ту можна ввести (до верхнього 
г-
o-

File і після 
н-

у-
у вікні елементів схеми доцільно 

> Show 
н-

о-

а-



 

цанням і командою: меню Symbol > Enter Symbol) викликати діалогове в
кно Enter Symbol (ввести символ);

перейти до бібліотеки примітивів > у віконці  
знайти потрібний елемент (наприклад, 
виділити його й натиснути ОК) повернутися до вікна графічного редактора, 
в якому з’явиться символ 
кут

тньо по одному їх різновиду, наприклад, порт input для  утворення входів, 
по одному елементу 
ганізації виходів.

нути значок стрілки на вертикальній палітрі інструментів): 

поза елементом 

кнопці можна 
Drop

методом “
ба відпускати останньою); 

чайно, 
клацання (у цьому або іншому файлі) та 
стрілка), а також 

робити не можна) або по вертикалі (змінюється позиціонування написів).

 

цанням і командою: меню Symbol > Enter Symbol) викликати діалогове в
кно Enter Symbol (ввести символ);

б) B** у віконці  
перейти до бібліотеки примітивів > у віконці  
знайти потрібний елемент (наприклад, 
виділити його й натиснути ОК) повернутися до вікна графічного редактора, 
в якому з’явиться символ 
кутком у місці клацання в п

в) повторюючи цю процедуру, ввести всі потрібні елементи, дост
тньо по одному їх різновиду, наприклад, порт input для  утворення входів, 
по одному елементу 
ганізації виходів.

(приблизно як на схемі), користуючись інструментом вибору (нати
нути значок стрілки на вертикальній палітрі інструментів): 

а) клац
поза елементом 

б) якщо поставити курсор миші на елемент, то при натиснутій лівій 
кнопці можна 
Drop”);  

в) 
методом “
ба відпускати останньою); 

чайно, вирізати
клацання (у цьому або іншому файлі) та 
стрілка), а також 

робити не можна) або по вертикалі (змінюється позиціонування написів).

цанням і командою: меню Symbol > Enter Symbol) викликати діалогове в
кно Enter Symbol (ввести символ);

б) B** у віконці  
перейти до бібліотеки примітивів > у віконці  
знайти потрібний елемент (наприклад, 
виділити його й натиснути ОК) повернутися до вікна графічного редактора, 
в якому з’явиться символ 

ом у місці клацання в п

в) повторюючи цю процедуру, ввести всі потрібні елементи, дост
тньо по одному їх різновиду, наприклад, порт input для  утворення входів, 
по одному елементу 
ганізації виходів. 

2.2.1.4 Розташувати елементи
(приблизно як на схемі), користуючись інструментом вибору (нати

нути значок стрілки на вертикальній палітрі інструментів): 
а) клацання всередині елемента 

поза елементом – скасовує виділення; 
б) якщо поставити курсор миші на елемент, то при натиснутій лівій 

кнопці можна пересунути

в) скопіювати і
методом “Drang & 
ба відпускати останньою); 

вирізати, скопіювати
клацання (у цьому або іншому файлі) та 
стрілка), а також видалити

ґ) піктограмами горизонтальної панелі виділений елемент 
можна т

робити не можна) або по вертикалі (змінюється позиціонування написів).

цанням і командою: меню Symbol > Enter Symbol) викликати діалогове в
кно Enter Symbol (ввести символ);

б) B** у віконці  Symbol
перейти до бібліотеки примітивів > у віконці  
знайти потрібний елемент (наприклад, 
виділити його й натиснути ОК) повернутися до вікна графічного редактора, 
в якому з’явиться символ цього елемента, що розташується лівим верхнім 

ом у місці клацання в підпункті

в) повторюючи цю процедуру, ввести всі потрібні елементи, дост
тньо по одному їх різновиду, наприклад, порт input для  утворення входів, 
по одному елементу not, nand

1.4 Розташувати елементи
(приблизно як на схемі), користуючись інструментом вибору (нати

нути значок стрілки на вертикальній палітрі інструментів): 
ання всередині елемента 
скасовує виділення; 

б) якщо поставити курсор миші на елемент, то при натиснутій лівій 
пересунути елемент по екрану (звичайний метод “

скопіювати і пересунути
& Drop” при натиснутій і утримуваній клавіші 

ба відпускати останньою);  
г) за допомогою горизонтальної панелі інстр

ментів попередньо виділений елемент можна, як зв
скопіювати

клацання (у цьому або іншому файлі) та 
видалити клавішею Delete; 
ґ) піктограмами горизонтальної панелі виділений елемент 

можна також розвернути по г
робити не можна) або по вертикалі (змінюється позиціонування написів).
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цанням і командою: меню Symbol > Enter Symbol) викликати діалогове в
кно Enter Symbol (ввести символ); 

Symbol Libraries
перейти до бібліотеки примітивів > у віконці  
знайти потрібний елемент (наприклад, 
виділити його й натиснути ОК) повернутися до вікна графічного редактора, 

цього елемента, що розташується лівим верхнім 
ідпункті 2.2.

в) повторюючи цю процедуру, ввести всі потрібні елементи, дост
тньо по одному їх різновиду, наприклад, порт input для  утворення входів, 

nand2 для побудови схеми та порт output для о

1.4 Розташувати елементи
(приблизно як на схемі), користуючись інструментом вибору (нати

нути значок стрілки на вертикальній палітрі інструментів): 
ання всередині елемента 
скасовує виділення; 

б) якщо поставити курсор миші на елемент, то при натиснутій лівій 
елемент по екрану (звичайний метод “

пересунути копію елемента на нове місце можна 
” при натиснутій і утримуваній клавіші 

г) за допомогою горизонтальної панелі інстр
ментів попередньо виділений елемент можна, як зв

скопіювати, вставити
клацання (у цьому або іншому файлі) та 

клавішею Delete; 
ґ) піктограмами горизонтальної панелі виділений елемент 
кож розвернути по г

робити не можна) або по вертикалі (змінюється позиціонування написів).
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цанням і командою: меню Symbol > Enter Symbol) викликати діалогове в

Libraries по рядку 
перейти до бібліотеки примітивів > у віконці  Symbol
знайти потрібний елемент (наприклад, input) і клацанням 
виділити його й натиснути ОК) повернутися до вікна графічного редактора, 

цього елемента, що розташується лівим верхнім 
2.2.1.3, а); 

в) повторюючи цю процедуру, ввести всі потрібні елементи, дост
тньо по одному їх різновиду, наприклад, порт input для  утворення входів, 

2 для побудови схеми та порт output для о

1.4 Розташувати елементи у вікні графічного редактора  
(приблизно як на схемі), користуючись інструментом вибору (нати

нути значок стрілки на вертикальній палітрі інструментів): 
ання всередині елемента виділяє його (червоним кольором), а 
скасовує виділення;  

б) якщо поставити курсор миші на елемент, то при натиснутій лівій 
елемент по екрану (звичайний метод “

копію елемента на нове місце можна 
” при натиснутій і утримуваній клавіші 

г) за допомогою горизонтальної панелі інстр
ментів попередньо виділений елемент можна, як зв

вставити потрібну кількість разів у місцях 
клацання (у цьому або іншому файлі) та скасувати останню дію

клавішею Delete;  
ґ) піктограмами горизонтальної панелі виділений елемент 
кож розвернути по горизонталі (за ДСТУ в схемах цього 

робити не можна) або по вертикалі (змінюється позиціонування написів).

цанням і командою: меню Symbol > Enter Symbol) викликати діалогове в

по рядку \maxplus
Symbol Files

) і клацанням 
виділити його й натиснути ОК) повернутися до вікна графічного редактора, 

цього елемента, що розташується лівим верхнім 

в) повторюючи цю процедуру, ввести всі потрібні елементи, дост
тньо по одному їх різновиду, наприклад, порт input для  утворення входів, 

2 для побудови схеми та порт output для о

у вікні графічного редактора  
(приблизно як на схемі), користуючись інструментом вибору (нати

нути значок стрілки на вертикальній палітрі інструментів): 
його (червоним кольором), а 

б) якщо поставити курсор миші на елемент, то при натиснутій лівій 
елемент по екрану (звичайний метод “

копію елемента на нове місце можна 
” при натиснутій і утримуваній клавіші 

г) за допомогою горизонтальної панелі інстр
ментів попередньо виділений елемент можна, як зв

потрібну кількість разів у місцях 
скасувати останню дію

ґ) піктограмами горизонтальної панелі виділений елемент 
оризонталі (за ДСТУ в схемах цього 

робити не можна) або по вертикалі (змінюється позиціонування написів).

цанням і командою: меню Symbol > Enter Symbol) викликати діалогове в

maxplus2\max
Files прокр

) і клацанням B** по ньому (або 
виділити його й натиснути ОК) повернутися до вікна графічного редактора, 

цього елемента, що розташується лівим верхнім 

в) повторюючи цю процедуру, ввести всі потрібні елементи, дост
тньо по одному їх різновиду, наприклад, порт input для  утворення входів, 

2 для побудови схеми та порт output для о

у вікні графічного редактора  
(приблизно як на схемі), користуючись інструментом вибору (нати

нути значок стрілки на вертикальній палітрі інструментів):  
його (червоним кольором), а 

б) якщо поставити курсор миші на елемент, то при натиснутій лівій 
елемент по екрану (звичайний метод “

копію елемента на нове місце можна 
” при натиснутій і утримуваній клавіші Ctrl

г) за допомогою горизонтальної панелі інстр
ментів попередньо виділений елемент можна, як зв

потрібну кількість разів у місцях 
скасувати останню дію

ґ) піктограмами горизонтальної панелі виділений елемент 
оризонталі (за ДСТУ в схемах цього 

робити не можна) або по вертикалі (змінюється позиціонування написів).

цанням і командою: меню Symbol > Enter Symbol) викликати діалогове ві-

max2lib\prim
прокрчуванням

** по ньому (або 
виділити його й натиснути ОК) повернутися до вікна графічного редактора, 

цього елемента, що розташується лівим верхнім 

в) повторюючи цю процедуру, ввести всі потрібні елементи, доста-
тньо по одному їх різновиду, наприклад, порт input для  утворення входів, 

2 для побудови схеми та порт output для ор-

у вікні графічного редактора  
(приблизно як на схемі), користуючись інструментом вибору (натис-

його (червоним кольором), а 

б) якщо поставити курсор миші на елемент, то при натиснутій лівій 
елемент по екрану (звичайний метод “Drang & 

копію елемента на нове місце можна 
Ctrl (її тре-

г) за допомогою горизонтальної панелі інстру-
ментів попередньо виділений елемент можна, як зви-

потрібну кількість разів у місцях 
скасувати останню дію (зігнена 

ґ) піктограмами горизонтальної панелі виділений елемент 
оризонталі (за ДСТУ в схемах цього 

робити не можна) або по вертикалі (змінюється позиціонування написів). 

і-

prim 
чуванням 

** по ньому (або 
виділити його й натиснути ОК) повернутися до вікна графічного редактора, 

цього елемента, що розташується лівим верхнім 

а-
тньо по одному їх різновиду, наприклад, порт input для  утворення входів, 

р-

у вікні графічного редактора  
с-

його (червоним кольором), а 

б) якщо поставити курсор миші на елемент, то при натиснутій лівій 
& 

копію елемента на нове місце можна 
е-

у-
и-

потрібну кількість разів у місцях 
(зігнена 

ґ) піктограмами горизонтальної панелі виділений елемент 
оризонталі (за ДСТУ в схемах цього 



 

ділений елемент можна так само вирізати зі збереженням у буфері (
скопіювати (
(
калі (

ням з’

виводу елемента чи порту і, коли він набуде форм
кнопку і 
ків, 
та дуги можна ввести й інші різновиди відрізків); 

дпусканням клавіші) на перетині ліній; точку можна
двійним клацанням інструментами вибору або ортогональних ліній на пер
тині ліній; крім того, точку можна ввести, клацну
тиснути інструмент вертикальної панелі „вставити точку” (повторне клаца
ня інструмента 

збереженням або без збереження з’єднувальних ліній,  достатньо скорист
тися двома інструментами палітри Rubberbanding (метод гумової нитки) 
кнопками on та of відповідно.

PIN_NAME порту і коли ці слова виділяться чорним, ввести з клавіатури  
(не звертаючи уваги на курсор) вхідні змінні (x1, x2,...) та вихідні функції 
(y1, ...). Переводити курсор з одного порту на інший того ж типу можна 
клавішею 

 

F Примітка.
ділений елемент можна так само вирізати зі збереженням у буфері (
скопіювати (
(Delete), а також розвернути по горизонталі (
калі (Flip Vertical

2.2.
ням з’єднувальних  ліній інструментами палітри:

а) підвести курсор інструмента вибору (або ортогональних ліній) до 
виводу елемента чи порту і, коли він набуде форм
кнопку і провести
ків, які закінчуються при відпусканні кнопки (інструментами похилої лінії 
та дуги можна ввести й інші різновиди відрізків); 

дпусканням клавіші) на перетині ліній; точку можна
двійним клацанням інструментами вибору або ортогональних ліній на пер
тині ліній; крім того, точку можна ввести, клацну
тиснути інструмент вертикальної панелі „вставити точку” (повторне клаца
ня інструмента 

г) якщо під час редагування схеми потрібно пересунути елемент зі 
збереженням або без збереження з’єднувальних ліній,  достатньо скорист
тися двома інструментами палітри Rubberbanding (метод гумової нитки) 
кнопками on та of відповідно.

2.2.
PIN_NAME порту і коли ці слова виділяться чорним, ввести з клавіатури  
(не звертаючи уваги на курсор) вхідні змінні (x1, x2,...) та вихідні функції 
(y1, ...). Переводити курсор з одного порту на інший того ж типу можна 
клавішею 

Примітка.
ділений елемент можна так само вирізати зі збереженням у буфері (
скопіювати (Copy), 

), а також розвернути по горизонталі (
Vertical) та повернути на певний кут (

2.2.1.5 З’єднати логічні елементи
нувальних  ліній інструментами палітри:
а) підвести курсор інструмента вибору (або ортогональних ліній) до 

виводу елемента чи порту і, коли він набуде форм
провести лінію у вигляді горизонтальних та вертикальних відрі

які закінчуються при відпусканні кнопки (інструментами похилої лінії 
та дуги можна ввести й інші різновиди відрізків); 

дпусканням клавіші) на перетині ліній; точку можна
двійним клацанням інструментами вибору або ортогональних ліній на пер
тині ліній; крім того, точку можна ввести, клацну
тиснути інструмент вертикальної панелі „вставити точку” (повторне клаца
ня інструмента вилучає точ

г) якщо під час редагування схеми потрібно пересунути елемент зі 
збереженням або без збереження з’єднувальних ліній,  достатньо скорист
тися двома інструментами палітри Rubberbanding (метод гумової нитки) 
кнопками on та of відповідно.

2.2.1.6 Позначити назви входів і виходів
PIN_NAME порту і коли ці слова виділяться чорним, ввести з клавіатури  
(не звертаючи уваги на курсор) вхідні змінні (x1, x2,...) та вихідні функції 
(y1, ...). Переводити курсор з одного порту на інший того ж типу можна 
клавішею Enter. 

Примітка. З контекстного меню
ділений елемент можна так само вирізати зі збереженням у буфері (

), вставити   (
), а також розвернути по горизонталі (

) та повернути на певний кут (
єднати логічні елементи

нувальних  ліній інструментами палітри:
а) підвести курсор інструмента вибору (або ортогональних ліній) до 

виводу елемента чи порту і, коли він набуде форм
лінію у вигляді горизонтальних та вертикальних відрі

які закінчуються при відпусканні кнопки (інструментами похилої лінії 
та дуги можна ввести й інші різновиди відрізків); 

слід виділити (червоним к
ням стрілки і клацанням лівою кнопкою та в
далити 
„ножиці” на горизонтальній панелі і
тів, або командою  Delete контекстного меню);

тично 
дпусканням клавіші) на перетині ліній; точку можна
двійним клацанням інструментами вибору або ортогональних ліній на пер
тині ліній; крім того, точку можна ввести, клацну
тиснути інструмент вертикальної панелі „вставити точку” (повторне клаца

вилучає точку);

г) якщо під час редагування схеми потрібно пересунути елемент зі 
збереженням або без збереження з’єднувальних ліній,  достатньо скорист
тися двома інструментами палітри Rubberbanding (метод гумової нитки) 
кнопками on та of відповідно.

Позначити назви входів і виходів
PIN_NAME порту і коли ці слова виділяться чорним, ввести з клавіатури  
(не звертаючи уваги на курсор) вхідні змінні (x1, x2,...) та вихідні функції 
(y1, ...). Переводити курсор з одного порту на інший того ж типу можна 
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контекстного меню
ділений елемент можна так само вирізати зі збереженням у буфері (

вставити   (Paste), вилучити без збереження у буфері 
), а також розвернути по горизонталі (

) та повернути на певний кут (
єднати логічні елементи

нувальних  ліній інструментами палітри:
а) підвести курсор інструмента вибору (або ортогональних ліній) до 

виводу елемента чи порту і, коли він набуде форм
лінію у вигляді горизонтальних та вертикальних відрі

які закінчуються при відпусканні кнопки (інструментами похилої лінії 
та дуги можна ввести й інші різновиди відрізків); 

б) для вилучення зайвого відрізка його 
слід виділити (червоним к
ням стрілки і клацанням лівою кнопкою та в
далити кл
„ножиці” на горизонтальній панелі і
тів, або командою  Delete контекстного меню);

в) точки з
тично після

дпусканням клавіші) на перетині ліній; точку можна
двійним клацанням інструментами вибору або ортогональних ліній на пер
тині ліній; крім того, точку можна ввести, клацну
тиснути інструмент вертикальної панелі „вставити точку” (повторне клаца

ку); 

г) якщо під час редагування схеми потрібно пересунути елемент зі 
збереженням або без збереження з’єднувальних ліній,  достатньо скорист
тися двома інструментами палітри Rubberbanding (метод гумової нитки) 
кнопками on та of відповідно. 

Позначити назви входів і виходів
PIN_NAME порту і коли ці слова виділяться чорним, ввести з клавіатури  
(не звертаючи уваги на курсор) вхідні змінні (x1, x2,...) та вихідні функції 
(y1, ...). Переводити курсор з одного порту на інший того ж типу можна 

40 

контекстного меню (викликається кнопкою В2) в
ділений елемент можна так само вирізати зі збереженням у буфері (

), вилучити без збереження у буфері 
), а також розвернути по горизонталі (Flip

) та повернути на певний кут (
єднати логічні елементи між собою та з портами введе

нувальних  ліній інструментами палітри:
а) підвести курсор інструмента вибору (або ортогональних ліній) до 

виводу елемента чи порту і, коли він набуде форм
лінію у вигляді горизонтальних та вертикальних відрі

які закінчуються при відпусканні кнопки (інструментами похилої лінії 
та дуги можна ввести й інші різновиди відрізків); 

б) для вилучення зайвого відрізка його 
слід виділити (червоним к
ням стрілки і клацанням лівою кнопкою та в

клавішею Delete (або інструментом  
„ножиці” на горизонтальній панелі і
тів, або командою  Delete контекстного меню);

в) точки з’єднань утворюються автом
після закінчення проведення

дпусканням клавіші) на перетині ліній; точку можна
двійним клацанням інструментами вибору або ортогональних ліній на пер
тині ліній; крім того, точку можна ввести, клацну
тиснути інструмент вертикальної панелі „вставити точку” (повторне клаца

г) якщо під час редагування схеми потрібно пересунути елемент зі 
збереженням або без збереження з’єднувальних ліній,  достатньо скорист
тися двома інструментами палітри Rubberbanding (метод гумової нитки) 

Позначити назви входів і виходів
PIN_NAME порту і коли ці слова виділяться чорним, ввести з клавіатури  
(не звертаючи уваги на курсор) вхідні змінні (x1, x2,...) та вихідні функції 
(y1, ...). Переводити курсор з одного порту на інший того ж типу можна 

(викликається кнопкою В2) в
ділений елемент можна так само вирізати зі збереженням у буфері (

), вилучити без збереження у буфері 
Flip Horizontal

) та повернути на певний кут (Rotate). 
між собою та з портами введе

нувальних  ліній інструментами палітри: 
а) підвести курсор інструмента вибору (або ортогональних ліній) до 

виводу елемента чи порту і, коли він набуде форми хреста, натиснути ліву 
лінію у вигляді горизонтальних та вертикальних відрі

які закінчуються при відпусканні кнопки (інструментами похилої лінії 
та дуги можна ввести й інші різновиди відрізків);  

б) для вилучення зайвого відрізка його 
слід виділити (червоним ко
ням стрілки і клацанням лівою кнопкою та в

вішею Delete (або інструментом  
„ножиці” на горизонтальній панелі і
тів, або командою  Delete контекстного меню);

єднань утворюються автом
закінчення проведення

дпусканням клавіші) на перетині ліній; точку можна ввести або вилучити п
двійним клацанням інструментами вибору або ортогональних ліній на пер
тині ліній; крім того, точку можна ввести, клацнувши на перетині ліній та н
тиснути інструмент вертикальної панелі „вставити точку” (повторне клаца

г) якщо під час редагування схеми потрібно пересунути елемент зі 
збереженням або без збереження з’єднувальних ліній,  достатньо скорист
тися двома інструментами палітри Rubberbanding (метод гумової нитки) 

Позначити назви входів і виходів: Клацнути В** 
PIN_NAME порту і коли ці слова виділяться чорним, ввести з клавіатури  
(не звертаючи уваги на курсор) вхідні змінні (x1, x2,...) та вихідні функції 
(y1, ...). Переводити курсор з одного порту на інший того ж типу можна 

(викликається кнопкою В2) в
ділений елемент можна так само вирізати зі збереженням у буфері (

), вилучити без збереження у буфері 
Horizontal) або по верт

між собою та з портами введе

а) підвести курсор інструмента вибору (або ортогональних ліній) до 
хреста, натиснути ліву 

лінію у вигляді горизонтальних та вертикальних відрі
які закінчуються при відпусканні кнопки (інструментами похилої лінії 

б) для вилучення зайвого відрізка його 
ольором) підведе

ням стрілки і клацанням лівою кнопкою та в
вішею Delete (або інструментом  

„ножиці” на горизонтальній панелі ін
тів, або командою  Delete контекстного меню);

єднань утворюються автом
закінчення проведення відрізка (в

ввести або вилучити п
двійним клацанням інструментами вибору або ортогональних ліній на пер

и на перетині ліній та н
тиснути інструмент вертикальної панелі „вставити точку” (повторне клаца

г) якщо під час редагування схеми потрібно пересунути елемент зі 
збереженням або без збереження з’єднувальних ліній,  достатньо скорист
тися двома інструментами палітри Rubberbanding (метод гумової нитки) 

: Клацнути В** 
PIN_NAME порту і коли ці слова виділяться чорним, ввести з клавіатури  
(не звертаючи уваги на курсор) вхідні змінні (x1, x2,...) та вихідні функції 
(y1, ...). Переводити курсор з одного порту на інший того ж типу можна 

(викликається кнопкою В2) ви-
ділений елемент можна так само вирізати зі збереженням у буфері (Cut), 

), вилучити без збереження у буфері 
) або по верти-

між собою та з портами введен-

а) підвести курсор інструмента вибору (або ортогональних ліній) до 
хреста, натиснути ліву 

лінію у вигляді горизонтальних та вертикальних відріз-
які закінчуються при відпусканні кнопки (інструментами похилої лінії 

б) для вилучення зайвого відрізка його 
льором) підведен-

ням стрілки і клацанням лівою кнопкою та ви-
вішею Delete (або інструментом  

нструмен-
тів, або командою  Delete контекстного меню); 

єднань утворюються автома-
відрізка (ві-

ввести або вилучити по-
двійним клацанням інструментами вибору або ортогональних ліній на пере-

и на перетині ліній та на-
тиснути інструмент вертикальної панелі „вставити точку” (повторне клацан-

 

г) якщо під час редагування схеми потрібно пересунути елемент зі 
збереженням або без збереження з’єднувальних ліній,  достатньо скориста-
тися двома інструментами палітри Rubberbanding (метод гумової нитки) – з 

: Клацнути В** на словах
PIN_NAME порту і коли ці слова виділяться чорним, ввести з клавіатури  
(не звертаючи уваги на курсор) вхідні змінні (x1, x2,...) та вихідні функції 
(y1, ...). Переводити курсор з одного порту на інший того ж типу можна 

и-
), 

), вилучити без збереження у буфері 
и-

н-

а) підвести курсор інструмента вибору (або ортогональних ліній) до 
хреста, натиснути ліву 

з-
які закінчуються при відпусканні кнопки (інструментами похилої лінії 

б) для вилучення зайвого відрізка його 
н-
и-

вішею Delete (або інструментом  
н-

 
а-
і-
о-
е-
а-
н-

г) якщо під час редагування схеми потрібно пересунути елемент зі 
а-
з 

словах 
PIN_NAME порту і коли ці слова виділяться чорним, ввести з клавіатури  
(не звертаючи уваги на курсор) вхідні змінні (x1, x2,...) та вихідні функції 
(y1, ...). Переводити курсор з одного порту на інший того ж типу можна 



 

пис інструментом вибору або 
мент у вигляді літери А) та ввести новий.

схеми можна імпортувати і з інших проектів (
системи 

чайн
лівій кнопці), відтак за допомогою інструмента 
піювати і вставити в потрібне місце цього або іншого файла та, у разі по
реби, замінити елементи чи внести інші корек
фрагмент графічного файла в документ 
чний редактор 

ті), наприклад, серії НВІС 
ly

начається автоматично, про що висвічуєт
ляції (п. 

компілятор), пі
мація і пові
добразяться н
тора з розш
успішну (

 

F Примітки
1. Ско

пис інструментом вибору або 
мент у вигляді літери А) та ввести новий.

2. 
схеми можна імпортувати і з інших проектів (
системи OrCAD

3. Фрагменти схеми легко розмножувати: виділити область, як зв
чайно, прямокутником (протягнути стрілкою по діагоналі при натиснутій 
лівій кнопці), відтак за допомогою інструмента 
піювати і вставити в потрібне місце цього або іншого файла та, у разі по
реби, замінити елементи чи внести інші корек
фрагмент графічного файла в документ 
чний редактор 

< Приклад
 
2.2.
2.2.

ті), наприклад, серії НВІС 
ly: MAX3000

F Примітка.
начається автоматично, про що висвічуєт
ляції (п. 2.2.

Saves
компілятор), пі
мація і пові
добразяться н
тора з розш
успішну (su

Примітки
Скоригувати імена портів можна звичайним чином: виділити н

пис інструментом вибору або 
мент у вигляді літери А) та ввести новий.

 Крім бібліотечних компонентів (
схеми можна імпортувати і з інших проектів (

OrCAD (графічні файли з розширенням 
Фрагменти схеми легко розмножувати: виділити область, як зв

о, прямокутником (протягнути стрілкою по діагоналі при натиснутій 
лівій кнопці), відтак за допомогою інструмента 
піювати і вставити в потрібне місце цього або іншого файла та, у разі по
реби, замінити елементи чи внести інші корек
фрагмент графічного файла в документ 
чний редактор Paint

Приклад:

2.2.2  Виконати 
2.2.2.1 Вибрати тип мікросхеми

ті), наприклад, серії НВІС 
3000A > Devises
Примітка.

начається автоматично, про що висвічуєт
2.2.2.2). 

2.2.2.2 Викликати редактор компілятора
Saves … and 

компілятор), після чого у віконці 
мація і пові- домлення про помилки та застереження, а у вікні 
добразяться назви комплекту сформованих файлів (зокрема, файл симул
тора з розширенням .

successful

Примітки: 
ригувати імена портів можна звичайним чином: виділити н

пис інструментом вибору або 
мент у вигляді літери А) та ввести новий.

Крім бібліотечних компонентів (
схеми можна імпортувати і з інших проектів (

(графічні файли з розширенням 
Фрагменти схеми легко розмножувати: виділити область, як зв

о, прямокутником (протягнути стрілкою по діагоналі при натиснутій 
лівій кнопці), відтак за допомогою інструмента 
піювати і вставити в потрібне місце цього або іншого файла та, у разі по
реби, замінити елементи чи внести інші корек
фрагмент графічного файла в документ 

Paint.  
: d:\max2work

Виконати компіляцію 
2.1 Вибрати тип мікросхеми

ті), наприклад, серії НВІС MAX
Devises: EPM

Примітка. Якщо не виконувати п. 
начається автоматично, про що висвічуєт

2.2 Викликати редактор компілятора
 starts the 

ля чого у віконці 
млення про помилки та застереження, а у вікні 
зви комплекту сформованих файлів (зокрема, файл симул
ренням .snf); відтак слід натиснути кнопку 

) компіляцію та закрити 
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ригувати імена портів можна звичайним чином: виділити н
пис інструментом вибору або Enters new
мент у вигляді літери А) та ввести новий.

Крім бібліотечних компонентів (
схеми можна імпортувати і з інших проектів (

(графічні файли з розширенням 
Фрагменти схеми легко розмножувати: виділити область, як зв

о, прямокутником (протягнути стрілкою по діагоналі при натиснутій 
лівій кнопці), відтак за допомогою інструмента 
піювати і вставити в потрібне місце цього або іншого файла та, у разі по
реби, замінити елементи чи внести інші корек
фрагмент графічного файла в документ 

work\tutorial

компіляцію проектованого пристрою
2.1 Вибрати тип мікросхеми

MAX 3000: меню 
EPM3032ALC

Якщо не виконувати п. 
начається автоматично, про що висвічуєт

2.2 Викликати редактор компілятора
 Compiler

ля чого у віконці Messages
млення про помилки та застереження, а у вікні 
зви комплекту сформованих файлів (зокрема, файл симул

); відтак слід натиснути кнопку 
) компіляцію та закрити 

41 

ригувати імена портів можна звичайним чином: виділити н
new text (ввести новий текст 

мент у вигляді літери А) та ввести новий. 
Крім бібліотечних компонентів (\maxplus2

схеми можна імпортувати і з інших проектів (\max2
(графічні файли з розширенням 

Фрагменти схеми легко розмножувати: виділити область, як зв
о, прямокутником (протягнути стрілкою по діагоналі при натиснутій 

лівій кнопці), відтак за допомогою інструмента 
піювати і вставити в потрібне місце цього або іншого файла та, у разі по
реби, замінити елементи чи внести інші корек
фрагмент графічного файла в документ Microsoft

tutorial\2lab\200.gdf 

проектованого пристрою
2.1 Вибрати тип мікросхеми (за змогою найнижчої складно

3000: меню Assign
ALC44-4 (або

Якщо не виконувати п. 2.2.
начається автоматично, про що висвічується повідомлення під час комп

2.2 Викликати редактор компілятора
Compiler (зберегти зміни у файлі і запустити 

Messages – Compiler
млення про помилки та застереження, а у вікні 
зви комплекту сформованих файлів (зокрема, файл симул

); відтак слід натиснути кнопку 
) компіляцію та закрити вікно компілятора. 

ригувати імена портів можна звичайним чином: виділити н
ввести новий текст 

maxplus2\max2lib), елементи 
max2work\

(графічні файли з розширенням .sch).  
Фрагменти схеми легко розмножувати: виділити область, як зв

о, прямокутником (протягнути стрілкою по діагоналі при натиснутій 
лівій кнопці), відтак за допомогою інструмента Copies або з меню 
піювати і вставити в потрібне місце цього або іншого файла та, у разі по
реби, замінити елементи чи внести інші корективи. Вставити виділений 

Microsoft Word зручно через граф

200.gdf (схема 

проектованого пристрою
(за змогою найнижчої складно

Assign > Devise
4 (абоAUTO) > 

2.2.2.1, тип мікросхеми при
ься повідомлення під час комп

2.2 Викликати редактор компілятора
(зберегти зміни у файлі і запустити 

Compiler висвічується інфо
млення про помилки та застереження, а у вікні 
зви комплекту сформованих файлів (зокрема, файл симул

); відтак слід натиснути кнопку 
вікно компілятора. 

ригувати імена портів можна звичайним чином: виділити н
ввести новий текст 

max2lib), елементи 
\tutorial), а також із 

Фрагменти схеми легко розмножувати: виділити область, як зв
о, прямокутником (протягнути стрілкою по діагоналі при натиснутій 

або з меню 
піювати і вставити в потрібне місце цього або іншого файла та, у разі по

тиви. Вставити виділений 
зручно через граф

(схема 1). 

проектованого пристрою 
(за змогою найнижчої складно

Devise > Devise
) > OК. 

2.1, тип мікросхеми при
ься повідомлення під час комп

2.2 Викликати редактор компілятора піктограмою  
(зберегти зміни у файлі і запустити 

висвічується інфо
млення про помилки та застереження, а у вікні Compiler
зви комплекту сформованих файлів (зокрема, файл симул

); відтак слід натиснути кнопку OK у віконці про 
вікно компілятора.  

ригувати імена портів можна звичайним чином: виділити на-
ввести новий текст – інстру-

max2lib), елементи 
), а також із 

Фрагменти схеми легко розмножувати: виділити область, як зви-
о, прямокутником (протягнути стрілкою по діагоналі при натиснутій 

або з меню Edit ско-
піювати і вставити в потрібне місце цього або іншого файла та, у разі пот-

тиви. Вставити виділений 
зручно через графі-

(за змогою найнижчої складнос-
Devise Fami-

2.1, тип мікросхеми приз-
ься повідомлення під час компі-

піктограмою  
(зберегти зміни у файлі і запустити 

висвічується інфор-
Compiler ві-

зви комплекту сформованих файлів (зокрема, файл симуля-
у віконці про 

 

а-
у-

max2lib), елементи 
), а також із 

и-
о, прямокутником (протягнути стрілкою по діагоналі при натиснутій 

о-
т-

тиви. Вставити виділений 
і-

с-
i-

з-
і-

піктограмою  
(зберегти зміни у файлі і запустити 

р-
і-
я-

у віконці про 



 

успішної компіляції, застереження 
врахувати чи проігнорувати, а інформацію
відома на стадії 

натисненням кнопки 
ження змін, дати стве
checks
руч, перш
перевірки на синтаксичні помилки і на відповідність уведеної схеми прав
лам 
ність помилок і друг

час, можливо, для перегляду). Якщо потрібно скомпілювати інший проект, 
слід спочатку відкрити будь
ввести команду з меню File > Proje
ти проект за н

тованого пристрою, 
формування часових діаграм вихідних функцій на основі логічних рівнянь, 
утворених на стадії компіляції.

 

F Примітки
1. Помилки (повідомлення червоним кольором) треба усунути для 

успішної компіляції, застереження 
врахувати чи проігнорувати, а інформацію
відома на стадії 

натисненням кнопки 
ження змін, дати стве
checks (зберегти файл і перевірити його на помилки), що зображена прав
руч, першим
перевірки на синтаксичні помилки і на відповідність уведеної схеми прав
лам реалізації на ВІС, а з
ність помилок і друг

рядку заголовка
час, можливо, для перегляду). Якщо потрібно скомпілювати інший проект, 
слід спочатку відкрити будь
ввести команду з меню File > Proje
ти проект за н

2.2.
тованого пристрою, 
формування часових діаграм вихідних функцій на основі логічних рівнянь, 
утворених на стадії компіляції.

Примітки
Помилки (повідомлення червоним кольором) треба усунути для 

успішної компіляції, застереження 
врахувати чи проігнорувати, а інформацію
відома на стадії конфігурування ВІСПС. 

2
piler, зобр

натисненням кнопки 
ження змін, дати стве

(зберегти файл і перевірити його на помилки), що зображена прав
им натисненн

перевірки на синтаксичні помилки і на відповідність уведеної схеми прав
реалізації на ВІС, а з

ність помилок і друг
3. Компілятор опрацьовує той проект, ім

рядку заголовка
час, можливо, для перегляду). Якщо потрібно скомпілювати інший проект, 
слід спочатку відкрити будь
ввести команду з меню File > Proje
ти проект за назвою поточн

2.2.3 Виконати функціональне моделювання (
тованого пристрою, 
формування часових діаграм вихідних функцій на основі логічних рівнянь, 
утворених на стадії компіляції.

Примітки: 
Помилки (повідомлення червоним кольором) треба усунути для 

успішної компіляції, застереження 
врахувати чи проігнорувати, а інформацію

конфігурування ВІСПС. 
2. Запустити компілятор можна також піктограмою 

, зображеною ліворуч, (або з меню 
натисненням кнопки Start у вікні 
ження змін, дати ствердну відповідь. Крім 

(зберегти файл і перевірити його на помилки), що зображена прав
натисненням кнопки 

перевірки на синтаксичні помилки і на відповідність уведеної схеми прав
реалізації на ВІС, а закритт

ність помилок і другим натисненн
Компілятор опрацьовує той проект, ім

рядку заголовка Manager
час, можливо, для перегляду). Якщо потрібно скомпілювати інший проект, 
слід спочатку відкрити будь
ввести команду з меню File > Proje

звою поточного файла).

3 Виконати функціональне моделювання (
тованого пристрою, яке полягає в імітації його функціонування шляхом 
формування часових діаграм вихідних функцій на основі логічних рівнянь, 
утворених на стадії компіляції.
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Помилки (повідомлення червоним кольором) треба усунути для 
успішної компіляції, застереження (синім 
врахувати чи проігнорувати, а інформацію

конфігурування ВІСПС. 
Запустити компілятор можна також піктограмою 
женою ліворуч, (або з меню 
у вікні Compiler

дну відповідь. Крім 
(зберегти файл і перевірити його на помилки), що зображена прав

кнопки Start
перевірки на синтаксичні помилки і на відповідність уведеної схеми прав

криттям (ОК) віконця з повідомленням про відсу
тисненням кнопки 

Компілятор опрацьовує той проект, ім
Manager (але не той, файл якого відк

час, можливо, для перегляду). Якщо потрібно скомпілювати інший проект, 
слід спочатку відкрити будь-який його файл і натиснути піктограму або 
ввести команду з меню File > Project > 

ого файла).

3 Виконати функціональне моделювання (
яке полягає в імітації його функціонування шляхом 

формування часових діаграм вихідних функцій на основі логічних рівнянь, 
утворених на стадії компіляції. 
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Помилки (повідомлення червоним кольором) треба усунути для 
(синім кольором) 

врахувати чи проігнорувати, а інформацію (зеленим 
конфігурування ВІСПС.  

Запустити компілятор можна також піктограмою 
женою ліворуч, (або з меню 

Compiler та, якщо надійде запит про збер
дну відповідь. Крім того, піктограмою 

(зберегти файл і перевірити його на помилки), що зображена прав
Start у вікні Compiler

перевірки на синтаксичні помилки і на відповідність уведеної схеми прав
(ОК) віконця з повідомленням про відсу
кнопки Start

Компілятор опрацьовує той проект, ім
але не той, файл якого відк

час, можливо, для перегляду). Якщо потрібно скомпілювати інший проект, 
який його файл і натиснути піктограму або 

t > Set Proje
ого файла). 

3 Виконати функціональне моделювання (
яке полягає в імітації його функціонування шляхом 

формування часових діаграм вихідних функцій на основі логічних рівнянь, 

Помилки (повідомлення червоним кольором) треба усунути для 
кольором) –
(зеленим кольором) 

Запустити компілятор можна також піктограмою 
женою ліворуч, (або з меню MAX+

та, якщо надійде запит про збер
того, піктограмою 

(зберегти файл і перевірити його на помилки), що зображена прав
Compiler запускається утиліта 

перевірки на синтаксичні помилки і на відповідність уведеної схеми прав
(ОК) віконця з повідомленням про відсу

Start завершується компіляція.
Компілятор опрацьовує той проект, ім’я якого зазначен

але не той, файл якого відк
час, можливо, для перегляду). Якщо потрібно скомпілювати інший проект, 

який його файл і натиснути піктограму або 
Project to Current File

3 Виконати функціональне моделювання (Simulation
яке полягає в імітації його функціонування шляхом 

формування часових діаграм вихідних функцій на основі логічних рівнянь, 

Помилки (повідомлення червоним кольором) треба усунути для 
– проаналізувати і 

кольором) –

Запустити компілятор можна також піктограмою 
+plus II > Compiler

та, якщо надійде запит про збер
того, піктограмою Saves

(зберегти файл і перевірити його на помилки), що зображена прав
запускається утиліта 

перевірки на синтаксичні помилки і на відповідність уведеної схеми прав
(ОК) віконця з повідомленням про відсу

завершується компіляція.
я якого зазначен

але не той, файл якого відкрито в даний 
час, можливо, для перегляду). Якщо потрібно скомпілювати інший проект, 

який його файл і натиснути піктограму або 
to Current File (установ

Simulation
яке полягає в імітації його функціонування шляхом 

формування часових діаграм вихідних функцій на основі логічних рівнянь, 

 

Помилки (повідомлення червоним кольором) треба усунути для 
проаналізувати і 

– взяти до 

Запустити компілятор можна також піктограмою Com-
Compiler) і 

та, якщо надійде запит про збере-
Saves ... and

(зберегти файл і перевірити його на помилки), що зображена право-
запускається утиліта 

перевірки на синтаксичні помилки і на відповідність уведеної схеми прави-
(ОК) віконця з повідомленням про відсут-

завершується компіляція. 
я якого зазначене в 

рито в даний 
час, можливо, для перегляду). Якщо потрібно скомпілювати інший проект, 

який його файл і натиснути піктограму або 
(установи-

Simulation) проек-
яке полягає в імітації його функціонування шляхом 

формування часових діаграм вихідних функцій на основі логічних рівнянь, 

 

Помилки (повідомлення червоним кольором) треба усунути для 
проаналізувати і 

взяти до 

m-
) і 
е-

and 
о-

запускається утиліта 
и-
т-

в 
рито в даний 

час, можливо, для перегляду). Якщо потрібно скомпілювати інший проект, 
який його файл і натиснути піктограму або 

и-

к-
яке полягає в імітації його функціонування шляхом 

формування часових діаграм вихідних функцій на основі логічних рівнянь, 
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2.2.3.1 Створити файл часових діаграм і надати йому 
ім’я з розширенням  .scf  за активного потрібного проекту (в 

рядку заголовка Manager) послідовністю піктограм або командами з меню 
(підпункт 1.2.1.4, д), е), є), після чого у вікні цього файла автоматично ві-
добразиться назва 2XX.scf. 

2.2.3.2 Задати параметри часових діаграм згідно з таблицею відпо-
відності. Сітку моделювання (якщо не задано  частоту сигналів)  доцільно 

вибрати кратною десяти, 
наприклад, Δt = 20 ns, а 
весь інтервал моделюван-
ня – виходячи з кількості 
вхідних кортежів (наборів 

змінних), наприклад, при чотирьох змінних Т = 16Δt = 320 ns. Ці параметри 
можна ввести в довільній послідовності, наприклад, меню File > End Time > 

320 ns (виправити us = мкс на ns = нс) > OK, відтак меню Options > 
Grid Size > 20 ns > OK, після чого інструментом палітри Changes … 

розташувати все зображення у вікні. 
2.2.3.3 Ввести тестові вектори (на часових діаграмах позначити 

координати сигналів) зі створеного компілятором SNF-файла: меню Node > 
Enter Nodes from SNF > кнопка List > кнопкою => скопіювати сигнали з лі-
вого віконця (доступні вузли) до правого (вибрані вузли) > OK. У вікні ре-
дактора Waveform відобразяться (після натиснення ОК) порожні смуги для 
вхідних сигналів та заштриховані (ознака невизначеності) – для вихідних. 

F Примітки: 
1. У разі потреби, у вікні Enter Nodes from SNF можна перенести не 

весь список (List) доступних вузлів-сигналів (ліве віконце) до списку виб-
раних вузлів (праве віконце), а вибірково – клацанням по назві сигналу 
мишею і натисканням кнопки => (для списку – протягуванням у лівому ві-
конці натиснутою лівою клавішею). 

2. За замовчуванням до тестових векторів входять сигнали всіх вхі-
дних і вихідних портів. Якщо потрібно з метою дослідження переглянути 
також сигнали в проміжних точках схеми, їх можна вибрати в діалоговому 
вікні Enter Nodes from SNF ввімкненням попередньо прапорця Combina-
tional або All та натисненням List. 

3. Розташування сигналів на часових діаграмах легко змінити: до-
сить взятися за позначку порту в полі Name тa (коли виділиться рядок і 
з’явиться прямокутничок) перетягнути його в потрібну позицію, яка висві-
чується блакитною лінією. 

2.2.3.4 Ввести значення змінних за таблицею відповідності. Для 
цього за допомогою інструмента палітри вибору (стрілка) або 
інструмента виділення значень (подвійна горизонтальна стрілка) 

слід ввести рівні вхідних сигналів із секції значень на цій самій палітрі. 



 

Починати зручно з м
дповідає одному із 16 вхідних кортежів, послідовно набуває значень логі
них 0 та 1. 

послідовності таким чином: 

що за 
ший); помножити на (

x

льшуючи вдвічі період послідовності в міру зростання номерів розрядів 
змінних введенням коефіцієнтів множення (

протягуємо інстру
віссю змінної на одному кроці або кількох кроках ча
нутій лівій кно
ємо потрібне зна
палітрі, напри

 

Починати зручно з м
дповідає одному із 16 вхідних кортежів, послідовно набуває значень логі
них 0 та 1. 

Найшвидше такий сигнал ввести за допомогою кнопки періодичної 
послідовності таким чином: 

що за замовч
ший); помножити на (

в) нати
x1 у формі меанд

г) повторюємо кроки 
льшуючи вдвічі період послідовності в міру зростання номерів розрядів 
змінних введенням коефіцієнтів множення (

F Примітки
1. Ввести значення змінних можна та

протягуємо інстру
віссю змінної на одному кроці або кількох кроках ча
нутій лівій кно
ємо потрібне зна
палітрі, напри

Починати зручно з м
дповідає одному із 16 вхідних кортежів, послідовно набуває значень логі
них 0 та 1.  

Найшвидше такий сигнал ввести за допомогою кнопки періодичної 
послідовності таким чином: 

мовчуванням дорівнює крокові сітки (у разі потреби ввести і
ший); помножити на (

в) натисненням у цьому вікні ОК вводимо ча
у формі меандра;

г) повторюємо кроки 
льшуючи вдвічі період послідовності в міру зростання номерів розрядів 
змінних введенням коефіцієнтів множення (

Примітки
Ввести значення змінних можна та

протягуємо інструментом виділення значень або інстру
віссю змінної на одному кроці або кількох кроках ча
нутій лівій кнопці –
ємо потрібне значення натисненням кнопки секції зна
палітрі, наприклад, логічна 1. У такий самий спосіб вводимо потрібні рівні 

Починати зручно з молодшої
дповідає одному із 16 вхідних кортежів, послідовно набуває значень логі

Найшвидше такий сигнал ввести за допомогою кнопки періодичної 
послідовності таким чином:  

анням дорівнює крокові сітки (у разі потреби ввести і
ший); помножити на (Multiplied

ням у цьому вікні ОК вводимо ча
; 

г) повторюємо кроки 
льшуючи вдвічі період послідовності в міру зростання номерів розрядів 
змінних введенням коефіцієнтів множення (

Примітки: 
Ввести значення змінних можна та

ментом виділення значень або інстру
віссю змінної на одному кроці або кількох кроках ча

– виділений ін
чення натисненням кнопки секції зна

клад, логічна 1. У такий самий спосіб вводимо потрібні рівні 
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лодшої змінної x
дповідає одному із 16 вхідних кортежів, послідовно набуває значень логі

Найшвидше такий сигнал ввести за допомогою кнопки періодичної 
 

а) клацнути 
чень (Value

б) натисненням кнопки періодичної 
послідовності викликати діалогове вікно 
значень накладання записів (
Value), в якому ввести потрібні параметри 
послідовності, зокрема, початковий рівень 
сигналу (
потреби ввести 1); півперіод послідовності 
імпульсів (

анням дорівнює крокові сітки (у разі потреби ввести і
Multiplied By) – 

ням у цьому вікні ОК вводимо ча

г) повторюємо кроки а), б), в) 
льшуючи вдвічі період послідовності в міру зростання номерів розрядів 
змінних введенням коефіцієнтів множення (

Ввести значення змінних можна та
ментом виділення значень або інстру

віссю змінної на одному кроці або кількох кроках ча
виділений інтервал заливається чорним. Відтак фікс

чення натисненням кнопки секції зна
клад, логічна 1. У такий самий спосіб вводимо потрібні рівні 
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x1, яка на кожному кроці сітки, що в
дповідає одному із 16 вхідних кортежів, послідовно набуває значень логі

Найшвидше такий сигнал ввести за допомогою кнопки періодичної 

а) клацнути 
Value), рядок якої вид
б) натисненням кнопки періодичної 

послідовності викликати діалогове вікно 
значень накладання записів (

), в якому ввести потрібні параметри 
послідовності, зокрема, початковий рівень 
сигналу (Starting 
потреби ввести 1); півперіод послідовності 
імпульсів (Count 

анням дорівнює крокові сітки (у разі потреби ввести і
 залишити

ням у цьому вікні ОК вводимо ча

 для всіх інших вхідних сигналів, зб
льшуючи вдвічі період послідовності в міру зростання номерів розрядів 
змінних введенням коефіцієнтів множення (Multiplied

Ввести значення змінних можна також в інший спосіб. Для цього 
ментом виділення значень або інстру

віссю змінної на одному кроці або кількох кроках ча
тервал заливається чорним. Відтак фікс

чення натисненням кнопки секції зна
клад, логічна 1. У такий самий спосіб вводимо потрібні рівні 

, яка на кожному кроці сітки, що в
дповідає одному із 16 вхідних кортежів, послідовно набуває значень логі

Найшвидше такий сигнал ввести за допомогою кнопки періодичної 

а) клацнути на змінній
, рядок якої вид

б) натисненням кнопки періодичної 
послідовності викликати діалогове вікно 
значень накладання записів (

), в якому ввести потрібні параметри 
послідовності, зокрема, початковий рівень 

 Value) – залишити 0 (у разі 
потреби ввести 1); півперіод послідовності 

 Every) –
анням дорівнює крокові сітки (у разі потреби ввести і

залишити 1;  
ням у цьому вікні ОК вводимо часову діаграму змінної 

для всіх інших вхідних сигналів, зб
льшуючи вдвічі період послідовності в міру зростання номерів розрядів 

Multiplied By

кож в інший спосіб. Для цього 
ментом виділення значень або інструментом вибору над 

віссю змінної на одному кроці або кількох кроках часової сітки при нат
тервал заливається чорним. Відтак фікс

чення натисненням кнопки секції значень на вертикаль
клад, логічна 1. У такий самий спосіб вводимо потрібні рівні 

, яка на кожному кроці сітки, що в
дповідає одному із 16 вхідних кортежів, послідовно набуває значень логі

Найшвидше такий сигнал ввести за допомогою кнопки періодичної 

на змінній x1 в полі
, рядок якої виділиться чорним; 

б) натисненням кнопки періодичної 
послідовності викликати діалогове вікно 
значень накладання записів (Overwrite

), в якому ввести потрібні параметри 
послідовності, зокрема, початковий рівень 

залишити 0 (у разі 
потреби ввести 1); півперіод послідовності 

– залишити таким, 
анням дорівнює крокові сітки (у разі потреби ввести і

сову діаграму змінної 

для всіх інших вхідних сигналів, зб
льшуючи вдвічі період послідовності в міру зростання номерів розрядів 

By) на 2, 4, 8 і т. д. 

кож в інший спосіб. Для цього 
ментом вибору над 

сової сітки при нат
тервал заливається чорним. Відтак фікс

чень на вертикаль
клад, логічна 1. У такий самий спосіб вводимо потрібні рівні 

, яка на кожному кроці сітки, що ві-
дповідає одному із 16 вхідних кортежів, послідовно набуває значень логіч-

 
Найшвидше такий сигнал ввести за допомогою кнопки періодичної 

в полі зна-
литься чорним;  

б) натисненням кнопки періодичної 
послідовності викликати діалогове вікно 

Overwrite Count
), в якому ввести потрібні параметри 

послідовності, зокрема, початковий рівень 
залишити 0 (у разі 

потреби ввести 1); півперіод послідовності 
залишити таким, 

анням дорівнює крокові сітки (у разі потреби ввести ін-

сову діаграму змінної 

для всіх інших вхідних сигналів, збі-
льшуючи вдвічі період послідовності в міру зростання номерів розрядів 

) на 2, 4, 8 і т. д.  

кож в інший спосіб. Для цього 
ментом вибору над 

сової сітки при натис-
тервал заливається чорним. Відтак фіксу-

чень на вертикальній 
клад, логічна 1. У такий самий спосіб вводимо потрібні рівні 

і-
ч-

 
Найшвидше такий сигнал ввести за допомогою кнопки періодичної 

а-
 

б) натисненням кнопки періодичної 
послідовності викликати діалогове вікно 

Count 
), в якому ввести потрібні параметри 

послідовності, зокрема, початковий рівень 
залишити 0 (у разі 

потреби ввести 1); півперіод послідовності 
залишити таким, 

н-

сову діаграму змінної 

і-
льшуючи вдвічі період послідовності в міру зростання номерів розрядів 

кож в інший спосіб. Для цього 
ментом вибору над 

с-
у-
ній 

клад, логічна 1. У такий самий спосіб вводимо потрібні рівні 
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на всіх інших ділянках часових діаграм. Для виправлення помилково вве-
деного рівня слід так само виділити чорним хибний інтервал і зафіксувати 
кнопкою потрібний рівень, наприклад, замінити логічну 1 на логічний 0. 

2. Якщо в меню Options виставлено прапорець Snap to Grid 
(прив’язка до часової сітки), то ділянки часових діаграм виділяються (отже 
і фіксуються на них рівні) на інтервалах, кратних кроку часової сітки. Для 
введення значень на довільних інтервалах незалежно від кроку сітки слід 
зняти зазначений прапорець. 

3. Крок сітки можна змінити (для зручності введення або перегляду) 
у будь-який час, це не впливає на моделювання. Відображення сітки на ек-
рані, як і в графічному файлі, включається та виключається прапорцем 
Show Grid в меню Options. 

2.2.3.5 Зберегти зміни, внесені до файла часових діаграм, і запус-
тити редактор функціонального моделювання (Simulator):  

 а) піктограмою (зображена зліва) Saves ... and starts the 
Simulator (зберегти відкриті файли часових діаграм і запустити 

імітатор – редактор функціонального моделювання) викликати діалогове 
вікно Simulator: Timing Simulation, в якому переконатися, що моделюється 
файл потрібного проекту, перевірити значення початку (Start Time) і кінця 
(End Time) процесу моделювання; 

б) в інформаційному віконці MAX+plus II – Simulator з повідомлен-
ням про відсутність помилок (errors) та застережень (warnings) натиснути 
ОК (усунувши, у разі потреби, хиби, що було виявлено) та закрити діало-
гове вікно Simulator: Timing Simulation. 



 

можна також піктограмою (зображена в п
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MAX
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льному місці р

них
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d
моделювання, доповнивши часові діаграми вихідним сигналом нової схеми.

них схем  з таблицею відповідності
чись часовим маркером (

 

F Примітка.
можна також піктограмою (зображена в п
Opens the 
MAX+plus
tion натиснути кнопку

Приклад

діаграм або відредагувати існуючий текст можна інструментом 
ters new text
льному місці р

2.2.
них елементних базисах примітивів

2.2.
АБО-НЕ 
d:\max2work
моделювання, доповнивши часові діаграми вихідним сигналом нової схеми.

2.2.
них схем  з таблицею відповідності
чись часовим маркером (

2.2.
(часовим аналізатором) та зберегти результати часового аналізу в 
текст

Примітка.
можна також піктограмою (зображена в п

 Simulator 
plus II > Simulator

натиснути кнопку

Приклад: \max2

F Примітка.
діаграм або відредагувати існуючий текст можна інструментом 

text: натиснути зазначений інструмент, клацнути ним рядок 
льному місці робочого поля і ввести текст.

2.2.4 Проаналізувати результати проектування пристрою в рі
елементних базисах примітивів

2.2.4.1 Доповнити
 зі спільними вхідними портами (див. приклад: проект 

work\tutorial
моделювання, доповнивши часові діаграми вихідним сигналом нової схеми.

2.2.4.2 Перевірити, чи узгоджуються вихідні функції реалізов
них схем  з таблицею відповідності
чись часовим маркером (

2.2.4.3 Виміряти швидкодію
(часовим аналізатором) та зберегти результати часового аналізу в 
текстовому файлі  (п.

Примітка. Запустити редактор
можна також піктограмою (зображена в п

Simulator – відкрити імітатор (або з меню 
Simulator) та в діалоговому вікні 

натиснути кнопку Start. 

max2work\

Примітка. Вставити рядок коментарів до файла часових 
діаграм або відредагувати існуючий текст можна інструментом 

тиснути зазначений інструмент, клацнути ним рядок 
бочого поля і ввести текст.

4 Проаналізувати результати проектування пристрою в рі
елементних базисах примітивів

4.1 Доповнити той самий графічний файл 
зі спільними вхідними портами (див. приклад: проект 

tutorial\2lab\200), скомпілювати та виконати функціональне 
моделювання, доповнивши часові діаграми вихідним сигналом нової схеми.

4.2 Перевірити, чи узгоджуються вихідні функції реалізов
них схем  з таблицею відповідності
чись часовим маркером (п. 1.2.

4.3 Виміряти швидкодію
(часовим аналізатором) та зберегти результати часового аналізу в 

вому файлі  (п. 
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Запустити редактор
можна також піктограмою (зображена в п

відкрити імітатор (або з меню 
) та в діалоговому вікні 

 

\tutorial\2lab

Вставити рядок коментарів до файла часових 
діаграм або відредагувати існуючий текст можна інструментом 

тиснути зазначений інструмент, клацнути ним рядок 
бочого поля і ввести текст.

4 Проаналізувати результати проектування пристрою в рі
елементних базисах примітивів 

той самий графічний файл 
зі спільними вхідними портами (див. приклад: проект 

200), скомпілювати та виконати функціональне 
моделювання, доповнивши часові діаграми вихідним сигналом нової схеми.

4.2 Перевірити, чи узгоджуються вихідні функції реалізов
них схем  з таблицею відповідності

п. 1.2.2.1).   
4.3 Виміряти швидкодію за часовими діаграмами автоматично 

(часовим аналізатором) та зберегти результати часового аналізу в 
 1.2.3). 
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Запустити редактор функц
можна також піктограмою (зображена в підпункті

відкрити імітатор (або з меню 
) та в діалоговому вікні 

2lab\200.scf

Вставити рядок коментарів до файла часових 
діаграм або відредагувати існуючий текст можна інструментом 

тиснути зазначений інструмент, клацнути ним рядок 
бочого поля і ввести текст.  

4 Проаналізувати результати проектування пристрою в рі
 

той самий графічний файл 
зі спільними вхідними портами (див. приклад: проект 

200), скомпілювати та виконати функціональне 
моделювання, доповнивши часові діаграми вихідним сигналом нової схеми.

4.2 Перевірити, чи узгоджуються вихідні функції реалізов
них схем  з таблицею відповідності на всіх наборах змінних, користу

за часовими діаграмами автоматично 
(часовим аналізатором) та зберегти результати часового аналізу в 

функціонального моделювання 
ідпункті 2.3.3.5,

відкрити імітатор (або з меню File
) та в діалоговому вікні Simulator

00.scf. 

Вставити рядок коментарів до файла часових 
діаграм або відредагувати існуючий текст можна інструментом 

тиснути зазначений інструмент, клацнути ним рядок 

4 Проаналізувати результати проектування пристрою в рі

той самий графічний файл 
зі спільними вхідними портами (див. приклад: проект 

200), скомпілювати та виконати функціональне 
моделювання, доповнивши часові діаграми вихідним сигналом нової схеми.

4.2 Перевірити, чи узгоджуються вихідні функції реалізов
на всіх наборах змінних, користу

за часовими діаграмами автоматично 
(часовим аналізатором) та зберегти результати часового аналізу в 

іонального моделювання 
3.5, а) друга зліва
File > Save

Simulator: Timing

Вставити рядок коментарів до файла часових 
діаграм або відредагувати існуючий текст можна інструментом 

тиснути зазначений інструмент, клацнути ним рядок 

4 Проаналізувати результати проектування пристрою в рі

той самий графічний файл схемою в 
зі спільними вхідними портами (див. приклад: проект 

200), скомпілювати та виконати функціональне 
моделювання, доповнивши часові діаграми вихідним сигналом нової схеми.

4.2 Перевірити, чи узгоджуються вихідні функції реалізов
на всіх наборах змінних, користу

за часовими діаграмами автоматично 
(часовим аналізатором) та зберегти результати часового аналізу в 

іонального моделювання 
друга зліва)  

Save і меню 
Timing Simula-

 

Вставити рядок коментарів до файла часових 
діаграм або відредагувати існуючий текст можна інструментом En-

тиснути зазначений інструмент, клацнути ним рядок у ві-

4 Проаналізувати результати проектування пристрою в різ-

схемою в базисі 
зі спільними вхідними портами (див. приклад: проект 

200), скомпілювати та виконати функціональне 
моделювання, доповнивши часові діаграми вихідним сигналом нової схеми. 

4.2 Перевірити, чи узгоджуються вихідні функції реалізова-
на всіх наборах змінних, користую-

за часовими діаграмами автоматично 
(часовим аналізатором) та зберегти результати часового аналізу в 

іонального моделювання 
)  

і меню 
a-

 
Вставити рядок коментарів до файла часових 

n-
і-

з-

базисі 
зі спільними вхідними портами (див. приклад: проект 

200), скомпілювати та виконати функціональне 
 
а-
ю-

за часовими діаграмами автоматично 
(часовим аналізатором) та зберегти результати часового аналізу в 
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< Приклад: d:\max2work\tutorial\2lab\\200.gdf (схема 2), .scf, .tao.  
2.2.5 Засвоїти основи створення проекту за його графічного вве-

дення на рівні макрофункцій 
2.2.5.1 Ознайомитися з різновидами логічних елементів бібліоте-

ки бази даних (файл 2libr.gdf): макрофункціями буферів (Buffers) і логіч-
них функцій (SSI Functions). Розглянути принципові електричні схеми: на-
тиснувши В** по символу, який виділяється червоним кольором, і табли-

цею відповідності: натиснути піктограму після чого клацнути по си-
мволу. (У звіті навести типові макрофункції з двох груп та дати тлу-

мачення їх змісту). 
2.2.5.2 Засвоїти методику користування електронним довідни-

ком системи МАХ+... для добору потрібної стандартної ІС 74-ої серії (або 
елемента, специфічного для цієї системи). Розгляд вестимемо на прикладі 
реалізації логічної функції (10) у базисі І-АБО-НЕ, яка належить до катего-
рії SSI Functions (логічні функції). 

а) Дібрати придатну для 
нашої мети ІС: вікно Manager 
> меню Help > Old-Style 
Macrofunctions > зі списку 
Macrofunction  Categories  виб-
рати  потрібну категорію (у 
прикладі – SSI Functions) > ко-
ристуючись колонкою опису 

(Description), дібрати потрібну ІС 74-ої серії або іншу макрофункцію (на-
приклад, 7451 Dual AND-OR-INVERT Gate – два елементи І-АБО-НЕ) та 
курсором натиснути її ім’я (7451) > ознайомитися з таблицею відповіднос-
ті, нумерацією виводів та іншою текстовою інформацією. 

б) Вставити символ дібраної ІС з бібліотеки макрофункцій \maxplus2\ 
\max2lib\mf до свого варіанта графічного файла: відкрити вікно цього файла 
натиснувши > B** у місці розташування символу в лівому верхньому кутку 
(або одиничним клацанням у цьому місці і командою: меню Symbol > Enter 
Symbol) викликати діалогове вікно Enter Symbol > ввести у віконці Symbol 
Name (або вставити кнопкою В2 попередньо скопійоване в довідці) ім’я мак-
рофункції > ОК (або інакше: натиснувши B** у віконці  Symbol Libraries на 
рядку \maxplus2\max2lib\mf перейти до бібліотеки макрофункцій > у віконці  
Symbol Files знайти потрібний елемент і клацнути B** на ньому) і тим самим 
повернутися до вікна графічного редактора, в якому з’явиться символ макро-
функції.  

в) Дістати довідку щодо макрофункції, зображеної символом:  
– B** на символі (який виділяється червоним кольором) викликати 



 

граф
йомитися з нею, зокрема, з нумерацією портів (схемою можна скористат
ся і для побудови власного графічного файла: скопіювавши, вилучити або 
перейменувати порти, взяти лише якусь її частину тощо,
скопіювати та вставити до свого файла) та, 
тися до свого файла;

логове вікно 
відковому вікні (тому ж самому, що викликається з меню 
таблицю відп
повернутися до свого файла.

сненням 
Ports
ловина (

скористатися
(віконце 
ристовуваний або 
необхідність інвертувати (

функції 7451; у діалоговому вікні входи 1А, 1В не редагуємо, а вхід 1С в
лучаємо: виділяємо його і вмикаємо перемикач 
мо незмінними входи 
і, нарешті, вихід 2

 

графічний файл з принциповою електричною схемою макрофункції, озн
йомитися з нею, зокрема, з нумерацією портів (схемою можна скористат
ся і для побудови власного графічного файла: скопіювавши, вилучити або 
перейменувати порти, взяти лише якусь її частину тощо,
скопіювати та вставити до свого файла) та, 
тися до свого файла;

ком зап
логове вікно 
відковому вікні (тому ж самому, що викликається з меню 
таблицю відп
повернутися до свого файла.

2.2.
1) клацанням В2 

сненням Edit
Ports/Parameters
ловина (Ports

2) користуючись іменами або нумерацією виводів ІС (у разі потреби 
скористатися
(віконце Name
ристовуваний або 
необхідність інвертувати (

< 
функції 7451; у діалоговому вікні входи 1А, 1В не редагуємо, а вхід 1С в
лучаємо: виділяємо його і вмикаємо перемикач 
мо незмінними входи 
і, нарешті, вихід 2

ічний файл з принциповою електричною схемою макрофункції, озн
йомитися з нею, зокрема, з нумерацією портів (схемою можна скористат
ся і для побудови власного графічного файла: скопіювавши, вилучити або 
перейменувати порти, взяти лише якусь її частину тощо,
скопіювати та вставити до свого файла) та, 
тися до свого файла;

– викликати довідковий файл: натиснути піктограму зі зн
ком запитання і 

логове вікно Edit Ports
відковому вікні (тому ж самому, що викликається з меню 
таблицю відповідності та інші текстові дані > 
повернутися до свого файла.

2.2.5.3 Настроїти макрофункцію:
) клацанням В2 
Edit Ports/

Parameters, в якому для макрофункції доступною є лише верхня п
Ports); 

2) користуючись іменами або нумерацією виводів ІС (у разі потреби 
скористатися довідк

Name), у закладці 
ристовуваний або Unused
необхідність інвертувати (

 Приклад. До файла 200.
функції 7451; у діалоговому вікні входи 1А, 1В не редагуємо, а вхід 1С в
лучаємо: виділяємо його і вмикаємо перемикач 
мо незмінними входи 
і, нарешті, вихід 2YN

ічний файл з принциповою електричною схемою макрофункції, озн
йомитися з нею, зокрема, з нумерацією портів (схемою можна скористат
ся і для побудови власного графічного файла: скопіювавши, вилучити або 
перейменувати порти, взяти лише якусь її частину тощо,
скопіювати та вставити до свого файла) та, 
тися до свого файла; 

викликати довідковий файл: натиснути піктограму зі зн
тання і потім 

Ports/Parameters
відковому вікні (тому ж самому, що викликається з меню 

відності та інші текстові дані > 
повернутися до свого файла.

5.3 Настроїти макрофункцію:
) клацанням В2 на вставленому символ

/Parameters
, в якому для макрофункції доступною є лише верхня п

2) користуючись іменами або нумерацією виводів ІС (у разі потреби 
довідкою – п. 
), у закладці Port

Unused – 
необхідність інвертувати (None

. До файла 200.
функції 7451; у діалоговому вікні входи 1А, 1В не редагуємо, а вхід 1С в
лучаємо: виділяємо його і вмикаємо перемикач 
мо незмінними входи 1D, 1E

YN інвертуємо: виділяємо його рядок і натискаємо
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ічний файл з принциповою електричною схемою макрофункції, озн
йомитися з нею, зокрема, з нумерацією портів (схемою можна скористат
ся і для побудови власного графічного файла: скопіювавши, вилучити або 
перейменувати порти, взяти лише якусь її частину тощо,
скопіювати та вставити до свого файла) та, 

викликати довідковий файл: натиснути піктограму зі зн
потім клацнути 
Parameters > натиснути кнопку 

відковому вікні (тому ж самому, що викликається з меню 
відності та інші текстові дані > 

повернутися до свого файла. 
5.3 Настроїти макрофункцію:

вставленому символ
Parameters викликати діалогове вікно редагування 

, в якому для макрофункції доступною є лише верхня п

2) користуючись іменами або нумерацією виводів ІС (у разі потреби 
п. 2.2.5.2, в), редагуємо порти: виділяємо порт 
Port Status 
 невикористовуваний)

None – не інвертувати або 

. До файла 200.gdf
функції 7451; у діалоговому вікні входи 1А, 1В не редагуємо, а вхід 1С в
лучаємо: виділяємо його і вмикаємо перемикач 

E та 2A … 2
інвертуємо: виділяємо його рядок і натискаємо
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ічний файл з принциповою електричною схемою макрофункції, озн
йомитися з нею, зокрема, з нумерацією портів (схемою можна скористат
ся і для побудови власного графічного файла: скопіювавши, вилучити або 
перейменувати порти, взяти лише якусь її частину тощо,
скопіювати та вставити до свого файла) та, закривши

викликати довідковий файл: натиснути піктограму зі зн
клацнути на символ

> натиснути кнопку 
відковому вікні (тому ж самому, що викликається з меню 

відності та інші текстові дані > 

5.3 Настроїти макрофункцію: 
вставленому символ
викликати діалогове вікно редагування 

, в якому для макрофункції доступною є лише верхня п

2) користуючись іменами або нумерацією виводів ІС (у разі потреби 
в), редагуємо порти: виділяємо порт 
 призначаємо його стан (

невикористовуваний)
не інвертувати або 

gdf (схема 3) вставляємо символ макр
функції 7451; у діалоговому вікні входи 1А, 1В не редагуємо, а вхід 1С в
лучаємо: виділяємо його і вмикаємо перемикач 

… 2D і вихід 1
інвертуємо: виділяємо його рядок і натискаємо

ічний файл з принциповою електричною схемою макрофункції, озн
йомитися з нею, зокрема, з нумерацією портів (схемою можна скористат
ся і для побудови власного графічного файла: скопіювавши, вилучити або 
перейменувати порти, взяти лише якусь її частину тощо,

закривши файл схеми, поверн

викликати довідковий файл: натиснути піктограму зі зн
символі (або В2 

> натиснути кнопку Help
відковому вікні (тому ж самому, що викликається з меню 

відності та інші текстові дані > закривши

вставленому символі (див. п. 
викликати діалогове вікно редагування 

, в якому для макрофункції доступною є лише верхня п

2) користуючись іменами або нумерацією виводів ІС (у разі потреби 
в), редагуємо порти: виділяємо порт 
призначаємо його стан (

невикористовуваний), а в закладці 
не інвертувати або All –

(схема 3) вставляємо символ макр
функції 7451; у діалоговому вікні входи 1А, 1В не редагуємо, а вхід 1С в
лучаємо: виділяємо його і вмикаємо перемикач Unused; так само залиша

і вихід 1YN, а вхід 1
інвертуємо: виділяємо його рядок і натискаємо

ічний файл з принциповою електричною схемою макрофункції, озн
йомитися з нею, зокрема, з нумерацією портів (схемою можна скористат
ся і для побудови власного графічного файла: скопіювавши, вилучити або 
перейменувати порти, взяти лише якусь її частину тощо, відтак виділити, 

файл схеми, поверн

викликати довідковий файл: натиснути піктограму зі зн
(або В2 на символ

Help on 7451) > у д
відковому вікні (тому ж самому, що викликається з меню Help) розглянути 

закривши довідкове вікно, 

(див. п. 2.2.5.2, б) та нат
викликати діалогове вікно редагування 

, в якому для макрофункції доступною є лише верхня п

2) користуючись іменами або нумерацією виводів ІС (у разі потреби 
в), редагуємо порти: виділяємо порт 
призначаємо його стан (Used

, а в закладці Inversion
– інвертувати).

(схема 3) вставляємо символ макр
функції 7451; у діалоговому вікні входи 1А, 1В не редагуємо, а вхід 1С в

; так само залиша
, а вхід 1F вилучаємо; 

інвертуємо: виділяємо його рядок і натискаємо

ічний файл з принциповою електричною схемою макрофункції, озна-
йомитися з нею, зокрема, з нумерацією портів (схемою можна скористати-
ся і для побудови власного графічного файла: скопіювавши, вилучити або 

відтак виділити, 
файл схеми, поверну-

викликати довідковий файл: натиснути піктограму зі зна-
символі > діа-
7451) > у до-
) розглянути 

довідкове вікно, 

б) та нати-
викликати діалогове вікно редагування Edit

, в якому для макрофункції доступною є лише верхня по-

2) користуючись іменами або нумерацією виводів ІС (у разі потреби 
в), редагуємо порти: виділяємо порт 

Used – вико-
Inversion –

інвертувати). 

(схема 3) вставляємо символ макро-
функції 7451; у діалоговому вікні входи 1А, 1В не редагуємо, а вхід 1С ви-

; так само залишає-
вилучаємо; 

інвертуємо: виділяємо його рядок і натискаємо All,  

а-
и-

ся і для побудови власного графічного файла: скопіювавши, вилучити або 
відтак виділити, 

у-

а-
а-
о-

) розглянути 
довідкове вікно, 

и-
Edit 
о-

2) користуючись іменами або нумерацією виводів ІС (у разі потреби 
в), редагуємо порти: виділяємо порт 

о-
– 

 
о-
и-
є-

вилучаємо; 
,  
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щоб подвійним  запереченням скасувати інверсію на виході (з’явиться си-
ня одиничка біля кола інверсії, яка означає в даному випадку, що вона сто-
сується одного виводу символу). У підсумку після закриття (ОК) вікна Edit 
Ports/Parameters отримуємо настроєну макрофункцію (показана у файлі 
d:\max2work\tutorial\2lab\200.gdf, схема 3).   

F Примітка. У випадку редагування шин для інвертування окремих 
їх розрядів користуємося кодами в одній із систем числення (останнє віко-
нце, закрите під час виділення одиничних виводів ІС). 

2.2.5.4 Вставити до графічного файла інші потрібні елементи, 
з’єднати їх згідно з логічною формулою, виконати компіляцію і моделю-
вання так само, як і в проекті з примітивами (п. 2.2.1–2.2.3). 

< Приклад: d:\max2work\tutorial\2lab\200.gdf, .scf  (схема 3). 
2.2.5.5 Доповнити той самий графічний файл мінімізованою 

схемою в базисі одного елемента (АБО-НЕ чи І-НЕ, що забезпечує меншу 
складність) на макрофункціях (п. 2.2.5.2, б); 2.2.5.3; 2.2.5.4) та проаналізу-
вати результати проектування на різних макрофункціях аналогічно п. 2.2.4.  

< Приклад: d:\max2work\tutorial\2lab\200.gdf, .scf  (схема 4). 
   

Контрольні питання та завдання 
1  Які є відмінні риси зображення логічних функцій, притаманні та-

ким формам: мішаній, ДФ, ДНФ, ДДНФ, МДНФ, КФ, КНФ, ДКНФ, 
МКНФ? 

2  Спростіть вирази: 

1) ( )( )( )323121 xxxxxx +++ ;                        2) 32213121 xxxxxxxx +++ ; 

3) ( )( )( )323121 xxxxxx +++ ;                        4) ( )( )( )( )32312121 xxxxxxxx ++++ ;  

5) ( )( )( )( )32312121 xxxxxxxx ++++ ;             6) 4232413121 xxxxxxxxxx ++++ ; 

7) 321213312321 xxxxxxxxxxxx ++++++++ ; 

8) ( )( )( )( )( )( )( )54535251413121 xxxxxxxxxxxxxx +++++++ .  
Вказівка. За необхідності, скористайтеся діаграмами термів. 
3  Виконайте спільну мінімізацію чотирьох вихідних функцій, що 

здійснюють перетворення ДДК 8421 у такі коди: а) 2421, б) 7421, в) 8421+3 
(з надлишком три), г) код Ґрея (перші десять цифр X10=0...9 чотирирозряд-
ного коду). Вказівки. На заборонених кортежах X10 > 9 вважати функції не-
визначеними. Схему мінімальної складності реалізуйте на довільних логі-
чних елементах. 



 

го коду, двійкових дешифраторів, демультиплексорів, шифраторів; поб
дова ЦКП на дешифраторах; створення проекту за його текстового введе
ня, засвоєнн
типів і символів у текстовому редакторі.

ектувати: 1) перетворювач двійкового коду 
тора для відображення вказаних знаків на дешифраторах різної розрядно
ті та вибрати оптимальний варіант; 2) двійковий дешифратор та  дешифр
тор
ня 2

вої інформації з однієї форми 
ку  вхідний
ними 

каторів відображення інформації. Символи на індикаторній панелі форм
ються на основі рідких кристалів або світлодіодів шляхом 7
14
в малогабаритних пристроях 7
ми а, b, с, d, е, f, g (рис. 
частини панелі активізуються, наприклад, 
сегментів, темнішають на сріблястому тлі, утворюючи зображення потріб
ного символу. Якщо не активізовано сегменти f та с, індикується цифра 2, а 
якщо b та е 

 

Мета роботи
го коду, двійкових дешифраторів, демультиплексорів, шифраторів; поб
дова ЦКП на дешифраторах; створення проекту за його текстового введе
ня, засвоєнн
типів і символів у текстовому редакторі.

! 
ектувати: 1) перетворювач двійкового коду 
тора для відображення вказаних знаків на дешифраторах різної розрядно
ті та вибрати оптимальний варіант; 2) двійковий дешифратор та  дешифр
тор-демультиплексор; 3)
ня 2 перетворити  мовою опису апаратури 

3.1.
Перетворювачі кодів є ЦКП, що здійснюють перетворення  цифр

вої інформації з однієї форми 
ку  вхідний
ними – як числовими, так і комбінаторними.

Прикладом нечислових комбінаторних кодів є коди цифрових інд
каторів відображення інформації. Символи на індикаторній панелі форм
ються на основі рідких кристалів або світлодіодів шляхом 7
14-сегментного чи мозаїчного розкладу зображення. Сегменти поширеного 
в малогабаритних пристроях 7
ми а, b, с, d, е, f, g (рис. 
частини панелі активізуються, наприклад, 
сегментів, темнішають на сріблястому тлі, утворюючи зображення потріб
ного символу. Якщо не активізовано сегменти f та с, індикується цифра 2, а 
якщо b та е 

 

3  ДЕШИФРАТОРИ І ШИФРАТОРИ
Мета роботи

го коду, двійкових дешифраторів, демультиплексорів, шифраторів; поб
дова ЦКП на дешифраторах; створення проекту за його текстового введе
ня, засвоєння основних операторів логічної секції та запровадження прот
типів і символів у текстовому редакторі.

 Для заданого варіант
ектувати: 1) перетворювач двійкового коду 
тора для відображення вказаних знаків на дешифраторах різної розрядно
ті та вибрати оптимальний варіант; 2) двійковий дешифратор та  дешифр
демультиплексор; 3)
перетворити  мовою опису апаратури 

3.1.1 Перетворювачі кодів
Перетворювачі кодів є ЦКП, що здійснюють перетворення  цифр

вої інформації з однієї форми 
ку  вхідний m-розрядний і вихідний 

як числовими, так і комбінаторними.
Прикладом нечислових комбінаторних кодів є коди цифрових інд

каторів відображення інформації. Символи на індикаторній панелі форм
ються на основі рідких кристалів або світлодіодів шляхом 7

егментного чи мозаїчного розкладу зображення. Сегменти поширеного 
в малогабаритних пристроях 7
ми а, b, с, d, е, f, g (рис. 
частини панелі активізуються, наприклад, 
сегментів, темнішають на сріблястому тлі, утворюючи зображення потріб
ного символу. Якщо не активізовано сегменти f та с, індикується цифра 2, а 
якщо b та е – цифра 5 і т. ін. 

ДЕШИФРАТОРИ І ШИФРАТОРИ
Мета роботи: дослідження типових дешифраторів семисегментн

го коду, двійкових дешифраторів, демультиплексорів, шифраторів; поб
дова ЦКП на дешифраторах; створення проекту за його текстового введе

я основних операторів логічної секції та запровадження прот
типів і символів у текстовому редакторі.

Домашнє завдання
Для заданого варіант

ектувати: 1) перетворювач двійкового коду 
тора для відображення вказаних знаків на дешифраторах різної розрядно
ті та вибрати оптимальний варіант; 2) двійковий дешифратор та  дешифр
демультиплексор; 3) первісний вираз функції зі свого варіант
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розрядний і вихідний 
як числовими, так і комбінаторними.
Прикладом нечислових комбінаторних кодів є коди цифрових інд

каторів відображення інформації. Символи на індикаторній панелі форм
ються на основі рідких кристалів або світлодіодів шляхом 7

егментного чи мозаїчного розкладу зображення. Сегменти поширеного 
в малогабаритних пристроях 7
ми а, b, с, d, е, f, g (рис. 3.1, а). Під керуванням перетворювача кодів окремі 
частини панелі активізуються, наприклад, 
сегментів, темнішають на сріблястому тлі, утворюючи зображення потріб
ного символу. Якщо не активізовано сегменти f та с, індикується цифра 2, а 

цифра 5 і т. ін.  
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Для відтворення стандартних знаків, зокрема, цифр 0...9 двійково-
десяткового коду (ДДК (BCD) налагоджено випуск серійних ІС – перетво-
рювачів кодів, які в довідковій літературі називають дешифраторами  7-
сегментного коду (рис. 3.1, б). Крім інформаційних входів тетради ДДК 
а[3..0] = D, C, B, A та сегментних виходів a…g = OA…OG такі дешифрато-
ри мають інверсний вхід гасіння BIN, яким всі сегменти обнуляються (ін-
дикатор гасне).  

Окремим випадком перетворювачів кодів є пристрої, для яких вхід-
ним або вихідним є так званий унітарний код “1 із К”, в якому активний 
рівень може існувати тільки в одному розряді. Якщо активним є  рівень ло-
гічної 1, то код називають прямим, а якщо логічний 0 – інверсним. Прик-
ладом є унітарний десятковий код “1 з 10” відображення натиснутої циф-
рової клавіші, якщо натиснення більше однієї клавіші заборонено. 

3.1.2 Дешифратори 
Дешифратором (DС – decoder) називається перетворювач m-розряд-

ного двійкового коду до n-розрядного унітарного; при цьому розрядність 
коду розширюється, бо n > m. Дешифратори найчастіше застосовуються 
для вибору (селекції) інтегрованої мікросхеми або іншого пристрою з ме-
тою обміну інформацією, наприклад, для адресування до окремих комірок 
пам’яті.  

За допомогою вхідного m-розрядного коду дешифратор спромож-
ний керувати n = 2m вихідними лініями, що є розрядами унітарного коду. 
Такий дешифратор є повним, а якщо n < 2m – неповним. Наприклад, деши-
фратори 1:2, 2:4, перетворювачі двійкового коду в унітарні вісімковий 3:8 і 
шістнадцятковий 4:16 є повними, а перетворювач тетради ДДК до унітар-
ного десяткового коду 4:10 є неповним. 

Принцип побудови дешифратора розглянемо на прикладі перетво-
рення двійкового коду А=а1а0 в унітарний Y=у3у2у1у0 (рис. 3.2, а). З огляду 
на те, що кожна з вихідних функцій визначається одним мінтермом, вона 
вже є мінімальною: 

 .;;; 013012011010 aayaayaayaay ====  (3.1) 

Взагалі, при m змінних функції повного дешифратора реалізуються 
за допомогою n = 2m елементів І з m входами кожний (рис. 3.2, б). Актив-
ний рівень з’являється тільки на тому виході дешифратора, номер якого ві-
дповідає вхідному кодові. Наприклад, при а1а0 = 102 = 210  дві одиниці при-
кладено до входів тільки одного елемента І з виходом у2, тому у2 = 1, а на 
всіх інших виходах встановлюються рівні логічного 0. Визначити номер 
активного виходу дуже просто: досить скласти ваги розрядів на вхідному 
полі умовного графічного позначення дешифратора (рис. 3.2, в), на яких 
діють рівні логічної 1. 
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4, а), в якій зазначаємо лише припустимі набори 
4 = 16 рядків таблиці буде міститися більш, ніж 

одна одиниця у вхідному коді; визначаємо рівняння вихідних функцій

31 ;yy +=

б).  
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3.5 – Спеціалізовані макрофункції шифраторів
5 Елементи арифметики
5.1 Числа  

Мовою AHDL застосовуються числа у звичайних системах числе
1) для зображення постійних значень (параметрів, змінних, н
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 Цифри

0…9
0, 1, Х
0…F
0...7

5.2 Групи 
Низка однотипних елементів і їх назв для стислості може бути ог

лошена у вигляді окремого модуля, який  позначається символом групи. 
Наприклад, масив адресних сигналів і відповідних їм портів а3, а2, а1, а0 
можна зобразити групою a[3..0].

54

На відміну від унітарного коду “1 із К”, у коді “Х із К” може містит
ся  довільна кількість  одиниць, проте вихідним кодом має  відображатися  
лише одна з них, із найбільшим пріоритетом.

шами, коли можливе натиснення більш ніж однієї з них. Ш
фратор, що перетворює код “Х із К” у двійковий

він може формувати також сигнал запиту на о
, який стає активним за надходження хоча б 

Бібліотека містить пріоритетні шифратори 10:4 і 8:3 (рис.

Спеціалізовані макрофункції шифраторів
5 Елементи арифметики 
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Цифри Приклад

0…9 
0, 1, Х В”11010”

F H”1A”
0...7 Q”32”

Низка однотипних елементів і їх назв для стислості може бути ог
лошена у вигляді окремого модуля, який  позначається символом групи. 
Наприклад, масив адресних сигналів і відповідних їм портів а3, а2, а1, а0 

[3..0]. 
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3.1.5.3 Арифметичні оператори  
Оператори використовуються в арифметичних виразах, щоб оціни-

ти значення функцій, констант і параметрів а також виконати операції по-
рівняння (в останньому випадку арифметичні оператори називають також 
компараторами). Такі вирази не потребують ресурсу ІС і призначені для 
зручності програмування; компілятор виконує обчислення і використовує 
лише результати – числа, які не можуть бути від’ємними. Основні арифме-
тичні оператори і компаратори наведено в табл. 3.2.  
Таблиця 3.2 

Оператор Пріоритет Опис Приклад 
+ (unary – одномісний) 1 додатне число +1 або 1 
–  (unary – одномісний) 1 від’ємне число –1 
^ 1 степінь с ^ 2 
DIV 2 ділення с DIV 2 
* 2 множення с * 2 
LOG2 2 логарифм двійковий LOG2(с) 
+ 3 додавання с + 1 
– 3 віднімання с – 1 
== (numeric) 4 числова рівність а[] == H”1A” 
== (string) 4 рядкова рівність "a" == "b" 
!= 4 не дорівнює с != а + 2 
> 4 більше с > LOG2(а) 
>= 4 більше або дорівнює с >= а DIV 2   
< 4 менше с < а ^ 2 
<= 4 менше або дорівнює с <= а – 2 

F Примітка. Для обчислення кількості розрядів пристроїв широко 
застосовується операція LOG2. Тому якщо її підсумок є неціле число, під-
сумок автоматично округляється до більшого цілого числа. Приклади: 
LOG2(8) = 3; LOG2(9) = 4 – демонструють, зокрема, розрядність повного 
дешифратора 3:8 і неповного 4:9. Для операцій LOG2 і DIV застосовують-
ся також оператори CEIL (стеля) і FLOOR (підлога). CEIL – те саме, що й 
зазначене округлення до більшого цілого числа: CEIL(LOG2(9)) = 4, а 
FLOOR – округлення до меншого цілого числа: FLOOR(LOG2(9)) = 3. 

3.1.6 Основні складники проекту текстового редактора 
Текстовий опис проекту мовами програмування високого рівня  

HDL, зокрема, мовою AHDL, містить розгалужену систему засобів, таких 
як логічні рівняння, таблиці відповідності і т. ін. Пристрій, створений у те-
кстовому редакторі, можна згорнути до символу і ввести до графічного 
файла. З іншого боку, графічні об’єкти, наприклад, макрофункції можна як 
готові модулі вводити до текстових файлів. 
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Структурно проект (Design) складається із секцій (Section), багато з 
яких в свою чергу поділяються на оператори або підсекції (Statement). Ко-
жний такий структурний блок (їх біля трьох десятків) має суворо відпові-
дати правилам свого синтаксису. Аби пришвидшити складання текстового 
файла (з розширенням .tdf або TDF-файла) і, головним чином, уникнути чи 
зменшити кількість синтаксичних помилок, введення здійснюється за до-
помогою шаблонів (Template) для певної мови, зокрема, мови AHDL 
(AHDL-Template). У шаблоні позначено комірки для введення тексту і, що 
є важливим, містяться необхідні за синтаксисом розділові знаки. Помилки 
виявляються під час компіляції і локалізуються процесором повідомлень 
(Message Processor). 

Обов’язковими для кожного TDF-файла є дві секції: секція підпроек-
ту (Subdesign Section), призначена для оголошення вхідних та вихідних по-
ртів, і логічна секція (Logic Section), яка визначає залежність вихідних сиг-
налів від вхідних з використанням інших змінних, оголошених у файлі. Ло-
гічна секція складається з низки операторів, найважливішими серед яких є 
оператор булевих рівнянь (Boolean Equation), оператор таблиці відповідно-
сті (Truth Table Statement), умовний оператор (If Then Statement ) та опе-
ратор вибору (Case Statement). Оператори If Then і Case подібні і в багатьох 
випадках може використовуватися будь-який з них. Проте в операторі If 
Then діють вирази, а в операторі Case – константи, які порівнюються з єди-
ним виразом умови. 

Інші секції використовуються, здебільшого, залежно від вибраної 
елементної бази та вибраних засобів проектування. Оператор прототипу фун-
кцій (Function Prototype Statement) у текстовому файлі відіграє роль, анало-
гічну символу в графічному файлі з тими ж самими іменами входів і виходів. 
Наприклад, прототип макрофункції дешифратора 74139 на ІС серії 74 повто-
рює його символ (див. рис. 3.3): FUNCTION 74139 (g1n, b1, a1, g2n, b2, a2) 
RETURNS (y10n, y11n, y12n, y13n, y20n, y21n, y22n, y23n); на графічних сим-
волах макрофункцій входи і виходи позначаються великими літерами, а в 
прототипах – маленькими, проте компілятор такої різниці не помічає. 

Секція змінних (Variable Section) складається з низки підсекцій для 
оголошення змінних різного типу. Змінна мовою програмування високого 
рівня може означати як просто сигнал, так і деякий внутрішній щодо про-
грамного забезпечення логічний модуль, наприклад, макрофункцію з бази 
даних або символ, створений користувачем. Підсекція оголошення вузла 
(Node Declaration) дозволяє ввести, зокрема, проміжні вузли (сигнали, 
особливо якщо вони використовуються неодноразово) для застосування в 
логічних рівняннях з метою їх спрощення. Підсекція оголошення модуля 
(Instance Declaration) дозволяє розрізнити окремі екземпляри функціона-
льних вузлів, кожному з них надається символічне власне ім’я, наприклад, 
двом дешифраторам dc1 та dc2. 
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Булеві вирази компонуються мовою AHDL за допомогою операто-
рів, черговість виконання яких визначається пріоритетом (табл. 3.3). 

У найпростішому випадку операнди є однорозрядними змінними, а 
константи в логічних виразах (на відміну від цифр арифметичних виразів) 
мають позначатися як GND (логічний 0) та VCC (логічна 1). 

Приклад на складний вираз:          

[ ] ][ )()()()( 2414124310 cbxaxxxxxxxxy ++=⊕++++= , 

де .;; 4141431 xxcxxbxxxa ⊕==++=  

Задля спрощення запису до форми AHDL можна перейти частинами: 
y0 = a !& (x2 # (b !# c)) = (x1 # x3 # !x4) !& (x2 # (x1&x4 !# x1$x4)). 
Проте з метою уникнення помилок і забезпечення легкості читання 

вирази можна вводити до логічної секції складниками 
a = x1 # x3 # !x4;  b = x1 & x4;  c = x1 $ x4; y0 = a !& (x2 # (b !# c)) 

за умови, що проміжні вузли a, b, c було попередньо оголошено операто-
ром Node Declaration секції змінних Variable Section.   

Змінити порядок виконання операцій можна, як звичайно, за допо-
могою дужок. Припускається також ліву частину зображати в інверсному 
вигляді, наприклад, 

!y0 = a & (x2 # (b !# c)). 
Таблиця 3.3 

Операція Пріоритет Приклад 
Знак Назва Булів вираз Вираз AHDL 

! 
(оклику) 

НЕ 
(NOT) 

1 
1x  !x1 

& 
(амперсанд) 

І 
(AND) 

2 21xx  x1 & x2 

!& І-НЕ 
(NAND) 

2  x1 !& x2 

$ 
(долар) 

Виключне 
АБО (XOR) 

3  x1 $ x2 

!$ Виключне АБО- 
НЕ (XNOR) 

3 
21 xx ⊕  x1 !$ x2 

# 
(дієз) 

АБО 
(OR) 

4 21 xx +  x1 # x2 

!# АБО-НЕ 
(NOR) 

4 
21 xx +  x1 !# x2 

  

21xx

21 xx ⊕
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Лабораторне завдання

1 Дослідити типові дешифратори і шифратори. 
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1.2 Ознайомитися зі стандартними дешифраторами та 
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ципових електричних схем з д
файлів, серед них принципових електр
чних схем макрофункцій.

відповідності: 
діаграм .scf (або графічний файл .gdf і 
натиснути піктограму Simulator) > меню
File > Create Table File > ОК у віконці 
Create Table File > ОК у віконці повідо
млення про успішне генерування файла. 
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Лабораторне завдання
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и-
и-
н-

ступних 
и-

творити файл таблиці 
відкрити файл часових 

діаграм .scf (або графічний файл .gdf і 
натиснути піктограму Simulator) > меню 
File > Create Table File > ОК у віконці 

-
млення про успішне генерування файла. 



 

Відтак 
ний автоматично текстовим редактором: піктограма
меню File > Open) > Text Editor files > *.tbl > B** 
Files. Порівняти цю таблицю з рівнями сигналів на відповідних інтервалах 
часо

тори (вхідні змінні і вихідні функції) у тому ж порядку, що й у списку під 
час введення до 
бачити заздалегідь.

 

Відтак відкрити файл
ний автоматично текстовим редактором: піктограма
меню File > Open) > Text Editor files > *.tbl > B** 
Files. Порівняти цю таблицю з рівнями сигналів на відповідних інтервалах 
часових діаграм і скласти скорочену таблицю.

< Приклад 

F Примітка.
тори (вхідні змінні і вихідні функції) у тому ж порядку, що й у списку під 
час введення до 
бачити заздалегідь.

3.2.

відкрити файл
ний автоматично текстовим редактором: піктограма
меню File > Open) > Text Editor files > *.tbl > B** 
Files. Порівняти цю таблицю з рівнями сигналів на відповідних інтервалах 

вих діаграм і скласти скорочену таблицю.
Приклад 

Примітка.
тори (вхідні змінні і вихідні функції) у тому ж порядку, що й у списку під 
час введення до імітатора  Simulator, отже, їх розташування можна пере
бачити заздалегідь. 

3.2.2.3 Створити символьний файл

відкрити файл таблиці відпові
ний автоматично текстовим редактором: піктограма
меню File > Open) > Text Editor files > *.tbl > B** 
Files. Порівняти цю таблицю з рівнями сигналів на відповідних інтервалах 

вих діаграм і скласти скорочену таблицю.
Приклад  (файл d:\

Примітка. За замовчуванням
тори (вхідні змінні і вихідні функції) у тому ж порядку, що й у списку під 

імітатора  Simulator, отже, їх розташування можна пере
 

творити символьний файл
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таблиці відпові
ний автоматично текстовим редактором: піктограма
меню File > Open) > Text Editor files > *.tbl > B** 
Files. Порівняти цю таблицю з рівнями сигналів на відповідних інтервалах 

вих діаграм і скласти скорочену таблицю.
\max2work

замовчуванням
тори (вхідні змінні і вихідні функції) у тому ж порядку, що й у списку під 

імітатора  Simulator, отже, їх розташування можна пере

творити символьний файл
фратора до символу: відкрити файл, який 
треба згорнути до символу > ввести ім’я 
проекту (піктограмою або з меню File > 
Project > Set  Project to Current File), якщо в 
рядку заголовка Manager зазначено інший 
проект > меню File > Create Default 
Symbol. Відтак 
файл
томатично  символьним редактором: пі
тограма відкриття файла
files > B** 
Порівняти цей символ з принцип
ктричною

символі відображаються всі входи і виходи 
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таблиці відповідності 
ний автоматично текстовим редактором: піктограма
меню File > Open) > Text Editor files > *.tbl > B** 
Files. Порівняти цю таблицю з рівнями сигналів на відповідних інтервалах 

вих діаграм і скласти скорочену таблицю. 
work\tutorial\3

замовчуванням у таблиці відображаються всі ве
тори (вхідні змінні і вихідні функції) у тому ж порядку, що й у списку під 

імітатора  Simulator, отже, їх розташування можна пере

творити символьний файл шляхом згортання схеми деш
фратора до символу: відкрити файл, який 
треба згорнути до символу > ввести ім’я 
проекту (піктограмою або з меню File > 
Project > Set  Project to Current File), якщо в 
рядку заголовка Manager зазначено інший 
проект > меню File > Create Default 
Symbol. Відтак 
файл з розширенням 
томатично  символьним редактором: пі
тограма відкриття файла
files > B** на
Порівняти цей символ з принцип
ктричною схемою.

F Примітка.
символі відображаються всі входи і виходи 

 з розширенням 
ний автоматично текстовим редактором: піктограма відкриття файла (або 
меню File > Open) > Text Editor files > *.tbl > B** на імені файла у списку 
Files. Порівняти цю таблицю з рівнями сигналів на відповідних інтервалах 

3lab\300.tbl):

у таблиці відображаються всі ве
тори (вхідні змінні і вихідні функції) у тому ж порядку, що й у списку під 

імітатора  Simulator, отже, їх розташування можна пере

шляхом згортання схеми деш
фратора до символу: відкрити файл, який 
треба згорнути до символу > ввести ім’я 
проекту (піктограмою або з меню File > 
Project > Set  Project to Current File), якщо в 
рядку заголовка Manager зазначено інший 
проект > меню File > Create Default 
Symbol. Відтак відкрити символьний 

з розширенням .sym
томатично  символьним редактором: пі
тограма відкриття файла

на імені файла у списку Files. 
Порівняти цей символ з принцип

схемою. 
Примітка. За 

символі відображаються всі входи і виходи 

з розширенням .tbl
відкриття файла (або 
імені файла у списку 

Files. Порівняти цю таблицю з рівнями сигналів на відповідних інтервалах 

300.tbl): 

у таблиці відображаються всі ве
тори (вхідні змінні і вихідні функції) у тому ж порядку, що й у списку під 

імітатора  Simulator, отже, їх розташування можна пере

шляхом згортання схеми деш
фратора до символу: відкрити файл, який 
треба згорнути до символу > ввести ім’я 
проекту (піктограмою або з меню File > 
Project > Set  Project to Current File), якщо в 
рядку заголовка Manager зазначено інший 
проект > меню File > Create Default 

відкрити символьний 
.sym, створений а

томатично  символьним редактором: пі
тограма відкриття файла >  Symbol Editor 

імені файла у списку Files. 
Порівняти цей символ з принципо

За замовчуванням
символі відображаються всі входи і виходи 

.tbl, створе-
відкриття файла (або 
імені файла у списку 

Files. Порівняти цю таблицю з рівнями сигналів на відповідних інтервалах 

 
у таблиці відображаються всі век-

тори (вхідні змінні і вихідні функції) у тому ж порядку, що й у списку під 
імітатора  Simulator, отже, їх розташування можна перед-

шляхом згортання схеми деши-
фратора до символу: відкрити файл, який 
треба згорнути до символу > ввести ім’я 
проекту (піктограмою або з меню File > 
Project > Set  Project to Current File), якщо в 
рядку заголовка Manager зазначено інший 
проект > меню File > Create Default 

відкрити символьний 
, створений ав-

томатично  символьним редактором: пік-
>  Symbol Editor 

імені файла у списку Files. 
овою еле-

замовчуванням на 
символі відображаються всі входи і виходи 

е-
відкриття файла (або 
імені файла у списку 

Files. Порівняти цю таблицю з рівнями сигналів на відповідних інтервалах 

  
к-

тори (вхідні змінні і вихідні функції) у тому ж порядку, що й у списку під 
д-

и-
фратора до символу: відкрити файл, який 
треба згорнути до символу > ввести ім’я 
проекту (піктограмою або з меню File > 
Project > Set  Project to Current File), якщо в 
рядку заголовка Manager зазначено інший 
проект > меню File > Create Default 

відкрити символьний 
в-
к-

>  Symbol Editor 
імені файла у списку Files. 

е-

на 
символі відображаються всі входи і виходи 
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незмінними відносно схеми, але їх можна відредагувати або створити символ 
вручну з меню Symbol. 

3.2.2.4 Дібрати і настроїти потрібну макрофункцію дешифра-
тора, зібрати на її основі схему перетворювача до 7-сегментного коду в 
графічному файлі нового проекту 3ХХ_7seg (п. 1.2.1.4), виконати компіля-
цію і функціональне моделювання та перевірити правильність функціону-
вання пристрою за часовими діаграмами.  

< Приклад:  файли d:\max2work\tutorial\3lab\300_7seg.gdf, .scf (схе-
ма 1).  

F Примітка. Аби позиціонування написів у коментарях SCF-файла 
залишилося правильним, його вікно потрібно спочатку розгорнути, а відтак, 
за необхідності, згорнути.  

3.2.2.5 Засвоїти використання символу в графічному редакторі: 
зібрати схему перетворювача до 7-сегментного коду в тому самому графі-
чному файлі, користуючись створеним символом дешифратора (вставля-
ється в графічний файл, як звичайно, але зі списку Symbol Files діалогово-
го вікна Enter Symbol), виконати компіляцію і функціональне моделювання 
та перевірити правильність функціонування пристрою за часовими діагра-
мами.  

< Приклад: файли d:\max2work\tutorial\3lab\300_7seg.gdf, .scf (схе-
ма 2). 

3.2.3 Виконати аналіз функціонування пристрою (з метою пере-
вірки правильності проектування) методом автоматичної компіляції 
за текстового опису проекту апаратною мовою АHDL 

3.2.3.1 Надати нове ім’я проекту: 2XXnode (див. п. 1.2.1.4). 
3.2.3.2 Створити текстовий файл: викликати редактор Text Edi-

tor з меню MAX+plus II > Text Editor (або ярликом відкриття нового файла 
з панелі інструментів > Text Editor file > OK) і надати ім’я з розширенням 
.tdf  безіменному (Untitled) файлу:  File > Save As > OK (або ярлик збере-
ження файла > OK у віконці Save As).  Вікно текстового файла автоматич-
но відобразить назву 2XXnode.tdf. 

3.2.3.3 Рекомендується (але не обов’язково) ввести заголовок логі-
чного блока за допомогою діалогового вікна шаблонів: В2 в полі файла 
(або меню Templates) > AHDL Template (далі ці дії стисло позначатимемо: 
В2 > AT) > Title Statement > OK. Поставити курсор на початку після лапок, 
ввести довільну назву (до 255 будь-яких символів крім крапок), в кінці за-
лишити лапки і крапку з комою, а все інше стерти, наприклад: 

TITLE  "Логічна функція"; 
відтак курсор слід перевести на початок нового рядка. 
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3.2.3.4 Ввести обов’язкову частину Subdesign (підпроект) для ого-
лошення вхідних змінних і вихідних функцій (відповідають портам – зовніш-
нім виводам мікросхеми): В2 > AT >  Subdesign Section > OK та заповнити 
цей розділ: 

 а) після ключового слова Subdesign ввести назву проекту (до 32 сим-
волів) - ту саму, що в заголовку файла без розширення (2XXnode), а інші си-
мволи видалити, наприклад: 

SUBDESIGN 2XXnode  
б) до блока в дужках ввести через кому перелік вхідних змінних і 

вихідних функцій, залишити двокрапку, ключове слово типу виводів та 
крапку з комою (після знаку рівності для входів зазначають, у разі потреби, 
рівні, які слід подати на незадіяні виводи мікросхеми, що становлять за за-
мовчуванням GND чи VCC  для функцій АБО та І відповідно), наприклад: 

( 
 x4, x3, x2, x1    : INPUT ; 
 y0, y1, y2, y3           : OUTPUT; 
) 

всі зайві символи слід видалити, а курсор перевести на початок нового ря-
дка після дужки. 

F Примітка. Підпроект Subdesign може правити або за самостійний 
проект, або за складову частину деякого проекту, який у свою чергу може 
бути підпроектом складнішого суперпроекту і так далі за ієрархією. 

3.2.3.5 У разі необхідності оголосити внутрішні вузли (відповіда-
ють проміжним змінним, не пов’язаним із зовнішніми виводами мікросхеми) 
вводять необов’язкову секцію змінних: В2 > AT > Variable Section > OK (від-
так курсор слід перевести на наступний рядок, рекомендується з відступом 
Tab) та підсекцію оголошення вузлів: В2 > AT > Node Declaration > OK, в яку 
вставляють через кому імена зазначених змінних, залишають двокрапку, 
ключове слово та крапку з комою (відтак всі зайві символи видалити, а кур-
сор  перевести на початок нового рядка): 

VARIABLE 
z : NODE; 

3.2.3.6 Ввести обов’язковий логічний блок (у даному випадку – мі-
німальної конфігурації) з метою пов’язати вихідні функції з вхідними (та, 
якщо є, проміжними) змінними: В2 > AT > Logic Section > OK. Відтак між 
ключовими словами (BEGIN та  END;) розташувати курсор (краще з відс-
тупом Tab), ввести підсекцію Булевих рівнянь: В2 > AT >  Boolean 
Equation та вставити в утворений таким чином шаблон мовою AHDL через 
крапку з комою логічні рівняння, можна в декілька рядків, наприклад: 



 

ванні формул 

клад, (

ром, імена стандартних макро
тора (у тому числі розділові знаки) 
вільна інформація (у тому числі коментарі, оточені з обох боків знаками „%”, 
які компілятор не сприймає) 
влення, це свідчить про те, що файл не включений до проекту або про синт
ксичні (у сенсі мови 
знак (крапка з комою) між операторами. Змінити для певного файла призн
чені за 

та виконати автоматичну 
Check
правити) > 
пішної трансляції > Закрити вікно компілятора.

 

BEGIN
 
 
 
 
 
END; 
F Примітка

ванні формул 
Після цього текстовий файл набуває остаточного вигляду, напр

клад, (d:\max

F Примітка
ром, імена стандартних макро
тора (у тому числі розділові знаки) 
вільна інформація (у тому числі коментарі, оточені з обох боків знаками „%”, 
які компілятор не сприймає) 
влення, це свідчить про те, що файл не включений до проекту або про синт
ксичні (у сенсі мови 
знак (крапка з комою) між операторами. Змінити для певного файла призн
чені за замовчуванням

3.2.
та виконати автоматичну 
Check > OK
правити) > 
пішної трансляції > Закрити вікно компілятора.

F Примітка

BEGIN 
 z = x1 !& x2;
 y0 = (x1 # x3 # !x4) !& (x
 !y1 = (x1 !& !x2) & (!x2 !& x4) & (!(!x1 & !x3 & x4));
 y2 = !((!x1 !# !x2) # (x1 !# x4) # (!x2 !# !x3));
 y3 = (x1 !& z) !& !(z & (x2 !& x3) & x4);
END;  
Примітка

ванні формул покращують легкість для читання та перевірки.
Після цього текстовий файл набуває остаточного вигляду, напр

max2work\

Примітка
ром, імена стандартних макро
тора (у тому числі розділові знаки) 
вільна інформація (у тому числі коментарі, оточені з обох боків знаками „%”, 
які компілятор не сприймає) 
влення, це свідчить про те, що файл не включений до проекту або про синт
ксичні (у сенсі мови 
знак (крапка з комою) між операторами. Змінити для певного файла призн

замовчуванням
3.2.3.7 Зберегти файл, перевірити його на

та виконати автоматичну 
OK в інформаційному віконці за відсутності помилок (інакше в

правити) > Start у вікні компілятора > 
пішної трансляції > Закрити вікно компілятора.

Примітка

1 !& x2; 
y0 = (x1 # x3 # !x4) !& (x
!y1 = (x1 !& !x2) & (!x2 !& x4) & (!(!x1 & !x3 & x4));
y2 = !((!x1 !# !x2) # (x1 !# x4) # (!x2 !# !x3));
y3 = (x1 !& z) !& !(z & (x2 !& x3) & x4);

Примітка. Необов’язкові 
покращують легкість для читання та перевірки.

Після цього текстовий файл набуває остаточного вигляду, напр
\tutorial\2lab

Примітка. У TDF-
ром, імена стандартних макро
тора (у тому числі розділові знаки) 
вільна інформація (у тому числі коментарі, оточені з обох боків знаками „%”, 
які компілятор не сприймає) –
влення, це свідчить про те, що файл не включений до проекту або про синт
ксичні (у сенсі мови AHDL)
знак (крапка з комою) між операторами. Змінити для певного файла призн

замовчуванням кольори мо
3.7 Зберегти файл, перевірити його на

та виконати автоматичну компіляцію
в інформаційному віконці за відсутності помилок (інакше в
у вікні компілятора > 

пішної трансляції > Закрити вікно компілятора.
Примітка. Компіляцію можна виконати так само, як у п. 
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y0 = (x1 # x3 # !x4) !& (x2 # (x1&x4 !# x1$x4));
!y1 = (x1 !& !x2) & (!x2 !& x4) & (!(!x1 & !x3 & x4));
y2 = !((!x1 !# !x2) # (x1 !# x4) # (!x2 !# !x3));
y3 = (x1 !& z) !& !(z & (x2 !& x3) & x4);

Необов’язкові пропуски
покращують легкість для читання та перевірки.

Після цього текстовий файл набуває остаточного вигляду, напр
lab\200node

-файлі ключові слова виділяються синім коль
ром, імена стандартних макро- і мегафункцій 
тора (у тому числі розділові знаки) – чорним, інформація, взята в лапки, і д
вільна інформація (у тому числі коментарі, оточені з обох боків знаками „%”, 

– зеленим. Якщо знаки набувають і
влення, це свідчить про те, що файл не включений до проекту або про синт

) помилки, наприклад, пропущений розділовий 
знак (крапка з комою) між операторами. Змінити для певного файла призн

кольори можна з меню 
3.7 Зберегти файл, перевірити його на

компіляцію
в інформаційному віконці за відсутності помилок (інакше в
у вікні компілятора > 

пішної трансляції > Закрити вікно компілятора.
Компіляцію можна виконати так само, як у п. 

62 

2 # (x1&x4 !# x1$x4));
!y1 = (x1 !& !x2) & (!x2 !& x4) & (!(!x1 & !x3 & x4));
y2 = !((!x1 !# !x2) # (x1 !# x4) # (!x2 !# !x3));
y3 = (x1 !& z) !& !(z & (x2 !& x3) & x4);

пропуски між складниками у формат
покращують легкість для читання та перевірки.

Після цього текстовий файл набуває остаточного вигляду, напр
node.tdf): 

файлі ключові слова виділяються синім коль
мегафункцій – брунатним, дані для компіл

чорним, інформація, взята в лапки, і д
вільна інформація (у тому числі коментарі, оточені з обох боків знаками „%”, 

зеленим. Якщо знаки набувають і
влення, це свідчить про те, що файл не включений до проекту або про синт

помилки, наприклад, пропущений розділовий 
знак (крапка з комою) між операторами. Змінити для певного файла призн

жна з меню Options
3.7 Зберегти файл, перевірити його на

компіляцію проекту: 
в інформаційному віконці за відсутності помилок (інакше в
у вікні компілятора > OK  в інформаційному віконці за у

пішної трансляції > Закрити вікно компілятора.
Компіляцію можна виконати так само, як у п. 

2 # (x1&x4 !# x1$x4));
!y1 = (x1 !& !x2) & (!x2 !& x4) & (!(!x1 & !x3 & x4));
y2 = !((!x1 !# !x2) # (x1 !# x4) # (!x2 !# !x3)); 
y3 = (x1 !& z) !& !(z & (x2 !& x3) & x4); 

між складниками у формат
покращують легкість для читання та перевірки.

Після цього текстовий файл набуває остаточного вигляду, напр

файлі ключові слова виділяються синім коль
брунатним, дані для компіл

чорним, інформація, взята в лапки, і д
вільна інформація (у тому числі коментарі, оточені з обох боків знаками „%”, 

зеленим. Якщо знаки набувають і
влення, це свідчить про те, що файл не включений до проекту або про синт

помилки, наприклад, пропущений розділовий 
знак (крапка з комою) між операторами. Змінити для певного файла призн

Options > Color
3.7 Зберегти файл, перевірити його на синтаксичні помилки

проекту: File > 
в інформаційному віконці за відсутності помилок (інакше в

в інформаційному віконці за у
пішної трансляції > Закрити вікно компілятора. 

Компіляцію можна виконати так само, як у п. 

2 # (x1&x4 !# x1$x4)); 
!y1 = (x1 !& !x2) & (!x2 !& x4) & (!(!x1 & !x3 & x4)); 

між складниками у формат
покращують легкість для читання та перевірки. 

Після цього текстовий файл набуває остаточного вигляду, напр

файлі ключові слова виділяються синім коль
брунатним, дані для компіл

чорним, інформація, взята в лапки, і д
вільна інформація (у тому числі коментарі, оточені з обох боків знаками „%”, 

зеленим. Якщо знаки набувають іншого заба
влення, це свідчить про те, що файл не включений до проекту або про синт

помилки, наприклад, пропущений розділовий 
знак (крапка з комою) між операторами. Змінити для певного файла призн

Color Palette
синтаксичні помилки

> Project > 
в інформаційному віконці за відсутності помилок (інакше в

в інформаційному віконці за у

Компіляцію можна виконати так само, як у п. 

між складниками у формату-

Після цього текстовий файл набуває остаточного вигляду, напри-

файлі ключові слова виділяються синім кольо-
брунатним, дані для компіля-

чорним, інформація, взята в лапки, і до-
вільна інформація (у тому числі коментарі, оточені з обох боків знаками „%”, 

ншого забар-
влення, це свідчить про те, що файл не включений до проекту або про синта-

помилки, наприклад, пропущений розділовий 
знак (крапка з комою) між операторами. Змінити для певного файла призна-

Palette.   
синтаксичні помилки

> Save & 
в інформаційному віконці за відсутності помилок (інакше ви-

в інформаційному віконці за ус-

Компіляцію можна виконати так само, як у п. 2.2.2. 

у-

и-

 
о-
я-
о-

вільна інформація (у тому числі коментарі, оточені з обох боків знаками „%”, 
р-
а-

помилки, наприклад, пропущений розділовий 
а-

синтаксичні помилки 
& 
и-
с-



 

дактора часових діаграм  

п.
одного з порівнюваних файлів (
ся початковими) > меню 
другий 

другого 
ного кольору; на ділянках, де вони не збігаються, діаграми початкового 
файла залишаються чорними. При цьому в полі 
го файла зазначаються в дужках.

тому діаграми додаткових вузлів початкового файла (якщо є) залишаються 
чорними, а другого файла 

гічного блоку на прикладі заданого варіант

вдання 3,б) з використанням 
Table Statement:
файл 3XXtab.tdf; відтак: 

п.

 

3.2.
дактора часових діаграм  

< Приклад: 
3.2.

п. 2.2.3 з метою проаналізувати результати проектування: відкрити вікно 
одного з порівнюваних файлів (
ся початковими) > меню 
другий SCF

 Відтак діаграми початкового файла залишаються незмінними, а 
другого – 
ного кольору; на ділянках, де вони не збігаються, діаграми початкового 
файла залишаються чорними. При цьому в полі 
го файла зазначаються в дужках.

F Примітка
тому діаграми додаткових вузлів початкового файла (якщо є) залишаються 
чорними, а другого файла 

3.2.
гічного блоку на прикладі заданого варіант

3.2.
вдання 3,б) з використанням 
Table Statement:
файл 3XXtab.tdf; відтак: 

1) ввести заголовок (Title Statement); 
2) ввести вхідні і вихідні вектори (Subdesign
3) ввести логічний блок Logic Section (ці дії докладно описано в 

п. 2.2.5; приклад див. нижче); 

3.2.3.8 Виконати
дактора часових діаграм  

Приклад: 
3.2.3.9 Виконати
з метою проаналізувати результати проектування: відкрити вікно 

одного з порівнюваних файлів (
ся початковими) > меню 

SCF-файл (2ХХ.
Відтак діаграми початкового файла залишаються незмінними, а 

 накладаються на діаграми початкового файла і набувають черв
ного кольору; на ділянках, де вони не збігаються, діаграми початкового 
файла залишаються чорними. При цьому в полі 
го файла зазначаються в дужках.

Примітка
тому діаграми додаткових вузлів початкового файла (якщо є) залишаються 
чорними, а другого файла 

3.2.4 Засвоїти синтез із 
гічного блоку на прикладі заданого варіант

3.2.4.1 Здійснити синтез дешифратора
вдання 3,б) з використанням 
Table Statement: надати нове ім’я прое
файл 3XXtab.tdf; відтак: 

1) ввести заголовок (Title Statement); 
2) ввести вхідні і вихідні вектори (Subdesign
3) ввести логічний блок Logic Section (ці дії докладно описано в 

5; приклад див. нижче); 

3.8 Виконати функціональне моделювання
дактора часових діаграм  Waveform

Приклад: MAX+plus
Виконати автоматичне порівняння

з метою проаналізувати результати проектування: відкрити вікно 
одного з порівнюваних файлів (
ся початковими) > меню File

2ХХ.scf) > 
Відтак діаграми початкового файла залишаються незмінними, а 
накладаються на діаграми початкового файла і набувають черв

ного кольору; на ділянках, де вони не збігаються, діаграми початкового 
файла залишаються чорними. При цьому в полі 
го файла зазначаються в дужках.

Примітка. Порівнюються вузли (сигнали) з однаковими іменами, 
тому діаграми додаткових вузлів початкового файла (якщо є) залишаються 
чорними, а другого файла – не відображаються.

4 Засвоїти синтез із 
гічного блоку на прикладі заданого варіант

4.1 Здійснити синтез дешифратора
вдання 3,б) з використанням 

надати нове ім’я прое
файл 3XXtab.tdf; відтак:  

1) ввести заголовок (Title Statement); 
2) ввести вхідні і вихідні вектори (Subdesign
3) ввести логічний блок Logic Section (ці дії докладно описано в 

5; приклад див. нижче); 
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функціональне моделювання
Waveform Editor

plus II -  d:\max2
автоматичне порівняння

з метою проаналізувати результати проектування: відкрити вікно 
одного з порівнюваних файлів (2ХХnode

File > Compare
> OK. 

Відтак діаграми початкового файла залишаються незмінними, а 
накладаються на діаграми початкового файла і набувають черв

ного кольору; на ділянках, де вони не збігаються, діаграми початкового 
файла залишаються чорними. При цьому в полі 
го файла зазначаються в дужках. 

орівнюються вузли (сигнали) з однаковими іменами, 
тому діаграми додаткових вузлів початкового файла (якщо є) залишаються 

не відображаються.
4 Засвоїти синтез із використанням основних операторів л

гічного блоку на прикладі заданого варіант
4.1 Здійснити синтез дешифратора

вдання 3,б) з використанням оператора таблиці відповідності Truth 
надати нове ім’я прое

1) ввести заголовок (Title Statement); 
2) ввести вхідні і вихідні вектори (Subdesign
3) ввести логічний блок Logic Section (ці дії докладно описано в 

5; приклад див. нижче);  
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функціональне моделювання
Editor (п. 2.2.

max2work
автоматичне порівняння

з метою проаналізувати результати проектування: відкрити вікно 
node.scf, діаграми якого вважатимут

Compare... > у діалоговому віконці вибрати 

Відтак діаграми початкового файла залишаються незмінними, а 
накладаються на діаграми початкового файла і набувають черв

ного кольору; на ділянках, де вони не збігаються, діаграми початкового 
файла залишаються чорними. При цьому в полі 

орівнюються вузли (сигнали) з однаковими іменами, 
тому діаграми додаткових вузлів початкового файла (якщо є) залишаються 

не відображаються.
використанням основних операторів л

гічного блоку на прикладі заданого варіанта
4.1 Здійснити синтез дешифратора

оператора таблиці відповідності Truth 
надати нове ім’я проекту 3XXtab і с

1) ввести заголовок (Title Statement);  
2) ввести вхідні і вихідні вектори (Subdesign
3) ввести логічний блок Logic Section (ці дії докладно описано в 

функціональне моделювання 
2.2.3). 

work\tutorial\2
автоматичне порівняння часових діаграм за 

з метою проаналізувати результати проектування: відкрити вікно 
діаграми якого вважатимут

... > у діалоговому віконці вибрати 

Відтак діаграми початкового файла залишаються незмінними, а 
накладаються на діаграми початкового файла і набувають черв

ного кольору; на ділянках, де вони не збігаються, діаграми початкового 
файла залишаються чорними. При цьому в полі Value рівн

орівнюються вузли (сигнали) з однаковими іменами, 
тому діаграми додаткових вузлів початкового файла (якщо є) залишаються 

не відображаються.  
використанням основних операторів л

а дешифрато
4.1 Здійснити синтез дешифратора (додаток А, варіанти 

оператора таблиці відповідності Truth 
кту 3XXtab і ство

2) ввести вхідні і вихідні вектори (Subdesign Section); 
3) ввести логічний блок Logic Section (ці дії докладно описано в 

 за допомогою р

2lab\200node
часових діаграм за 

з метою проаналізувати результати проектування: відкрити вікно 
діаграми якого вважатимут

... > у діалоговому віконці вибрати 

Відтак діаграми початкового файла залишаються незмінними, а 
накладаються на діаграми початкового файла і набувають черв

ного кольору; на ділянках, де вони не збігаються, діаграми початкового 
рівні сигналів друг

орівнюються вузли (сигнали) з однаковими іменами, 
тому діаграми додаткових вузлів початкового файла (якщо є) залишаються 

використанням основних операторів л
дешифратора 
додаток А, варіанти 

оператора таблиці відповідності Truth 
творити текстовий 

Section);  
3) ввести логічний блок Logic Section (ці дії докладно описано в 

за допомогою ре-

node.scf. 
часових діаграм за 

з метою проаналізувати результати проектування: відкрити вікно 
діаграми якого вважатимуть-

... > у діалоговому віконці вибрати 

Відтак діаграми початкового файла залишаються незмінними, а 
накладаються на діаграми початкового файла і набувають черво-

ного кольору; на ділянках, де вони не збігаються, діаграми початкового 
і сигналів друго-

 
орівнюються вузли (сигнали) з однаковими іменами, 

тому діаграми додаткових вузлів початкового файла (якщо є) залишаються 

використанням основних операторів ло-

додаток А, варіанти за-
оператора таблиці відповідності Truth 

рити текстовий 

3) ввести логічний блок Logic Section (ці дії докладно описано в 

е-

часових діаграм за 
з метою проаналізувати результати проектування: відкрити вікно 

ь-
... > у діалоговому віконці вибрати 

Відтак діаграми початкового файла залишаються незмінними, а 
о-

ного кольору; на ділянках, де вони не збігаються, діаграми початкового 
о-

 
орівнюються вузли (сигнали) з однаковими іменами, 

тому діаграми додаткових вузлів початкового файла (якщо є) залишаються 

о-

а-
оператора таблиці відповідності Truth 

рити текстовий 

3) ввести логічний блок Logic Section (ці дії докладно описано в 
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4) між ключовими словами (BEGIN та END;) розташувати курсор 
(краще з відступом Tab) і ввести підсекцію таблиці відповідності: В2 > 
AT > Truth Table Statement та вставити в утворений таким чином шаблон 
мовою AHDL: а) заголовок таблиці (змінні у вигляді масиву або їх перелік 
через кому, потім, після відокремлювальної стрілки шаблона, так само фу-
нкції у вигляді масиву або їх перелік через кому і в кінці залишити крапку 
з комою; б) тіло таблиці, кожний рядок якого відображає або значення 
змінних і функцій у вигляді кодів певної системи числення, або перелік ло-
гічних значень через кому (нагадує звичайну таблицю) і завершується кра-
пкою з комою; у підсумку текстовий файл набуває вигляду як у наведено-
му нижче прикладі;  

5) виконати компіляцію, функціональне моделювання та автомати-
чне порівняння утворених таким чином часових діаграм з п.3.2.3.9 з метою 
проаналізувати результати проектування. 

< Приклади:  d:\max2work\tutorial\3lab\300tab і 300tabl – .gdf, .scf. 
                                                                 %  Коментарі:                                % 
TITLE "Дешифратор 2:4 (таблиця)";  % 1) Title Statement                     % 
SUBDESIGN 300tab                              % 2) Subdesign Section                %  
(                                                                %  Варіант:                                    % 
 a[1..0]  : INPUT;         % (a1, a0            : INPUT;              % 
 y[3..0]   : OUTPUT;               % y3, y2, y1, y0   : OUTPUT);       % 
) 
BEGIN                                                    %       3) Logic Section                   % 
 TABLE                                           %     4) Truth Table Statement   % 
   a[] => y[];    % Варіант заголовку таблиці:   |a1,a0=>y3,y2,y1,y0; %  
                                 %  Варіанти тіла таблиці:         |                                    %   
   0   =>  1;      %  B"00"=>B"0001";|0 => H"1";|0,  0 =>0,  0,  0,  1;    % 
   1   =>  2;       % B"01"=>B"0010";|1 => H"2";|0,  1 =>0,  0,  1,  0;    % 
   2   =>  4;       % B"10"=>B"0100";|2 => H"4";|1,  0 =>0,  1,  0,  0;    %  
   3   =>  8;       % B"11"=>B"1000";|3 => H"8";|1,  1 =>1,  0,  0,  0;    %  
 END TABLE; 
END; 

F Примітки: 
1. Ім’я в секції Subdesign обов’язково має збігатися з ім’ям проекту 

(див. п. 3.2.3.2). 
2. Компілятор використовує лише дані, помічені в текстовому файлі 

чорним (у тому числі розділові знаки), тому ця його частина має точно від-
повідати операторному синтаксису (інакше замість компіляції видається по-
відомлення про помилки та їх локалізацію – зазначаються номери рядків те-
ксту і що в них є помилкове). Ключові слова шаблону (синього кольору) ві-
докремлюють підрозділи. Все інше не має значення: прогалини між симво-
лами, відступи і табуляції, порожні рядки, зокрема, після заголовку таблиці 
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визначають лише стиль оформлення, легкий для читання і розуміння. Проте 
кожний рядок коментарів (довільні написи зеленого кольору, а червоні за-
головки тут виділено нами) має заключатися з обох боків знаками „%”.  

3.2.4.2 Здійснити синтез дешифратора-демультиплексора (див. 
додаток А, варіанти завдання 3,б)  з використанням умовного оператора If 
Then (якщо, тоді) у проекті 3XXif_then шляхом створення текстового фай-
ла (.tdf)  і аналізу результатів так само, як у п.3.2.3.2 за винятком п.3.2.3.6, 
в якому ввести умовний оператор If Then: В2 > AT > If Then Statement та 
вставити в утворений таким чином шаблон мовою AHDL:       

а) між ключовими словами IF та THEN – умову (вираз або змінну), 
за істинності якої (тобто коли вона набуває значення логічної 1) є дійсними 
інструкції (функції у вигляді логічних значень або рівнянь через крапку з 
комою чи таблиці відповідності), що йдуть після слова THEN;    

б) після ключового слова ELSE – інструкції, що є дійсними за неви-
конання зазначеної умови (тобто коли вона набуває значення логічного 0), 
а все інше слід видалити; 

в) виконати так само компіляцію, функціональне моделювання та 
автоматичне порівняння утворених часових діаграм. 

< Приклад:  d:\max2work\tutorial\3lab\300if_then.tdf, .scf. 

TITLE "Дешифратор-демультиплексор 2:4 (умовний оператор)"; 
SUBDESIGN 300if_then 
( 
 a[1..0], G  : INPUT = VCC; 
 y[3..0]                : OUTPUT; 
)  
BEGIN 
  IF G THEN                                      %               Якщо G=1, тоді                     % 
       y0=!a1&!a0; y1=!a1&a0; y2=a1&!a0; y3=a1&a0; % дійсні значення      % 
  ELSE                                                                      % інакше (за умови G=0) % 
       y[] = GND;                                 %                y3=y2=y1=y0=0                    %  
  END IF; 
END;  

F Примітки: 
1. Необов’язкова частина оператора ELSIF THEN (якщо ще, тоді) 

заповнюється так само, як і основна: між цими ключовими словами встав-
ляється додаткова умова, а після – інструкції, які є дійсні за її виконання. 

2. Текстові файли легко модернізувати: скопіювати (все або частину), 
непотрібне вилучити, а додаткове вставити, як звичайно, за допомогою шаб-
лонів AHDL, не забуваючи привести у відповідність назву підпроекту. 
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3.2.4.3 Здійснити синтез дешифратора (див. додаток А, варіант 
завдання 3,a) з використанням оператора вибору Case (випадок) у проекті 
3XXcase шляхом створення текстового файла (.tdf)  і аналізу результатів 
так само, як у п. 3.2.3.2 за винятком п. 3.2.3.6, в якому ввести оператора 
вибору Case: В2 > AT > Case Statement та вставити в утворений таким чи-
ном шаблон мовою AHDL:       

а) між ключовими словами CASE та IS – вираз (зокрема, код чи на-
бір змінних), від значення якого залежать вихідні функції; 

б) після ключового слова WHEN  перед стрілкою „=>” – конкретне 
значення виразу, а після неї – значення функцій (як у таблиці відповіднос-
ті), відтак залишити крапку з комою; цей ланцюжок може повторюватися 
довільну кількість разів; 

в) у необов’язковій частині WHEN OTHERS (коли інше) після стрі-
лки – значення функцій за інших значень виразу (не перелічених у підпун-
кті б); 

г) виконати так само компіляцію, функціональне моделювання та 
автоматичне порівняння утворених часових діаграм; 

д) створити символьний файл (так само, як у п. 3.2.2.3). 
< Приклад: d:\max2work\tutorial\3lab\300case.tdf, .scf, .sym. 

TITLE "Неповний дешифратор з інверсними виходами 2:3 (оператор вибору)"; 

SUBDESIGN 300case   
( 

 a[1..0]  : INPUT; 
 yN[2..0]    : OUTPUT; 

) 
BEGIN                          

      CASE a[] IS                     % при наступних значеннях коду а1а0  маємо: % 
WHEN 0 => yN[]=H"6";  % коли 00, то y2y1y0=110 (тобто лише у0=0) % 
WHEN 1 => yN[]=H"5";   %          01               101              у1                    % 
WHEN 2 => yN[]=H"3";   %          10               011              у2                    % 
WHEN OTHERS => yN[]=X; %    коли (а1а0=3), то довільні значення  % 

END CASE;                                                                                                   
END;  

3.2.5 Засвоїти запровадження макрофункцій і символів у текс-
товий редактор на прикладі реалізації ЦКП виконанням завдання п. 2 

3.2.5.1 Засвоїти включення макрофункції: у новому проекті 
3XX_7macro створити текстовий файл (.tdf), відтак виконати такі дії (для 
наочності див. файл 3ХХ_7seg.gdf).  
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1) Ввести заголовок Title Statement (нижче пунктів подається прик-
лад). 

TITLE "7-сегментний індикатор на макрофункції дешифратора"; 
2) У секції Function Prototype Statement ввести прототип макрофун-

кції дешифратора (можна скопіювати з довідки Help). 
FUNCTION 74139 (g1n, b1, a1, g2n, b2, a2) 
 RETURNS (y10n, y11n, y12n, y13n, y20n, y21n, y22n, y23n); 
3) У секції Subdesign Section повторити ім’я проекту 3XX_7macro та 

оголосити вхідні і вихідні порти. 
SUBDESIGN 300_7macro                        
( 
 a1, a0              : INPUT; 
 a, b, c, d, e, f, g        : OUTPUT; 
) 
4) Ввести секцію змінних Variable Section. 
VARIABLE 
5) Вставити підсекцію оголошення зразка Instance Declaration і на-

дати ім’я зразку (для наочності у прикладі 
d:\max2work\tutorial\3lab\300_7seg.gdf позначено: dc – ім’я зразка дешиф-
ратора) та через двокрапку ввести ім’я макрофункції (74139). 

 dc  :    74139; 
6) Ввести логічний блок Logic Section, між ключовими словами 

(BEGIN та END;) розташувати курсор (краще з відступом Tab), вставити 
підсекцію Boolean Equation та з'єднати рівняннями зразок функції з оголо-
шеними портами INPUT і OUTPUT. 

BEGIN 
 dc.a1 = a0; dc.b1 = a1; 
 a = dc.y11n; b = !dc.y10n; c = dc.y12n; d = dc.y10n; 
 e = VCC;  f = VCC;  g = dc.y12n; 
END; 
F  Примітки: 
1. Логічні зв’язки між виходами та входами макрофункції містяться 

в її прототипі (п. 2.1.4), тому в булевих рівняннях достатньо лише з'єднати 
входи і виходи зразка, що репрезентує макрофункцію в проектованому 
пристрої, з вхідними і вихідними портами пристрою. Входи і виходи зраз-
ка мають такі самі назви, як у макрофункції, але позначаються через крап-
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ку після імені зразка. У лівій частині рівнянь ставляться невідомі величи-
ни, а в правій – відомі, задані вхідними портами INPUT або визначені у 
прототипі (у нас – yі). У разі потреби, додаткові з'єднання виконуються че-
рез зовнішні відносно макрофункції логічні операції.  

2. Імена макрофункції та її параметрів мають суворо відповідати 
формату, про який можна дізнатися з прототипу функції у довідці (Help > 
Old-Style Macrofunctions > Decoders > Iм'я макрофункції > AHDL Function 
Prototype) або з графічного файла (В2 по символу > Edit Ports/Parameters > 
Help on “Iм'я макрофункції” > AHDL Function Prototype). 

7) Виконати компіляцію, функціональне моделювання і перекона-
тися в правильності проектування.  

< Приклад: файли d:\max2work\tutorial\3lab\300_7macro.tdf, .scf. 
3.2.5.2 Засвоїти включення символу: у новому проекті 

3XX_7symbol створити текстовий файл (.tdf), відтак виконати такі самі дії, 
як і в п. 3.2.3.2 (для наочності див. файл d:\max2work\tutorial\3lab\ 
3ХХ_7seg1.gdf) із такими відмінностями: 

а) у п. 3.2.5.1 до шаблону секції Function Prototype Statement ввести 
із заздалегідь створеного текстового файла символу 3ХХcase.tdf  
(п. 3.2.4.3) назву і параметри із секції підпроекту; наприклад, із файла 
d:\max2work\tutorial\3lab\300case.tdf 

SUBDESIGN 300case   
( 
 a[1..0]  : INPUT; 
 yN[2..0]    : OUTPUT; 
) 

вводимо до нашого файла, дотримуючись шаблона, дані: 
FUNCTION 300case(a[1..0]) 
 RETURNS (yN[2..0]); 
б) у секції змінних так само оголошуємо зразок з іменем символу, 

наприклад: 
VARIABLE 
 dc  : 300case; 
в) до логічної секції вставляємо рівняння, дотримуючись імен вхо-

дів і виходів символу, наприклад: 
BEGIN 
     dc.a[1..0]=a[1..0]; 
     a=dc.yN1; b=!dc.yN0; c=dc.yN2; d=dc.yN0; e=VCC; f=VCC; g=dc.yN2; 
END; 



 

(шини): як звичайно виділити ділянку курсором, на палітрі натиснути кн
пку групи 
вій системі числення.

раторі та дешифраторі?

8
дуйте їх схеми.

задано числом у табл. 
ньому рядку 
8421 
ХҐ 
на семисегментному індикаторі знаків: Z
b, C, d, E, F, H, U, O та Z
Таблиця 

 

< Приклад:
F Примітка.

(шини): як звичайно виділити ділянку курсором, на палітрі натиснути кн
пку групи 
вій системі числення.

1. Як слід каскадувати дешифратори з метою збільшення розрядності?
2. Як 

раторі та дешифраторі?
3. Запишіть вирази для вихідних логічних функцій 1) шифратора 

8 × 3, 2) дешифратора 3
дуйте їх схеми.

4. Спроектуйте на дешифраторах перетворювач коду, варіант якого 
задано числом у табл. 
ньому рядку 
8421 → 8421доп. У табл. 
ХҐ – цифри 0...9 чотирирозрядного коду Ґрея, а також коди для відображення 
на семисегментному індикаторі знаків: Z
b, C, d, E, F, H, U, O та Z
Таблиця 3.
Коди 
8421 

8421доп 
8421+3 

2421 
7421 
XҐ 

Приклад:
Примітка.

(шини): як звичайно виділити ділянку курсором, на палітрі натиснути кн
пку групи G і в діалоговому віконці ввести значення коду в шістнадцятк
вій системі числення.

1. Як слід каскадувати дешифратори з метою збільшення розрядності?
2. Як пов’язані між собою кількість входів і виходів у повних ши

раторі та дешифраторі?
3. Запишіть вирази для вихідних логічних функцій 1) шифратора 

3, 2) дешифратора 3
дуйте їх схеми. 

4. Спроектуйте на дешифраторах перетворювач коду, варіант якого 
задано числом у табл. 
ньому рядку – вихідний. Наприклад, варіанту 8 відповідає

8421доп. У табл. 
цифри 0...9 чотирирозрядного коду Ґрея, а також коди для відображення 

на семисегментному індикаторі знаків: Z
b, C, d, E, F, H, U, O та Z

3.4 
Z1 
1 

 9 
 17 

25 
33 
41 

Приклад: файли d:
Примітка. У SCF

(шини): як звичайно виділити ділянку курсором, на палітрі натиснути кн
і в діалоговому віконці ввести значення коду в шістнадцятк

вій системі числення. 

Контрольні  питання
1. Як слід каскадувати дешифратори з метою збільшення розрядності?

в’язані між собою кількість входів і виходів у повних ши
раторі та дешифраторі? 

3. Запишіть вирази для вихідних логічних функцій 1) шифратора 
3, 2) дешифратора 3 × 8, 3) стробованого дешифратора 3

4. Спроектуйте на дешифраторах перетворювач коду, варіант якого 
задано числом у табл. 3.4, де в лівій колонці наведено вхідний код, а у вер

вихідний. Наприклад, варіанту 8 відповідає
8421доп. У табл. 3.4 

цифри 0...9 чотирирозрядного коду Ґрея, а також коди для відображення 
на семисегментному індикаторі знаків: Z
b, C, d, E, F, H, U, O та Z3 – літер кирилиці А, Г, Е, Н, О, П, Р, С, У.

Z2 
2 
10 
18 
26 
34 
42 
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d:\max2work
SCF-файлі дані зручно вводити у вигляді групи 

(шини): як звичайно виділити ділянку курсором, на палітрі натиснути кн
і в діалоговому віконці ввести значення коду в шістнадцятк

 
Контрольні  питання

1. Як слід каскадувати дешифратори з метою збільшення розрядності?
в’язані між собою кількість входів і виходів у повних ши

3. Запишіть вирази для вихідних логічних функцій 1) шифратора 
8, 3) стробованого дешифратора 3

4. Спроектуйте на дешифраторах перетворювач коду, варіант якого 
, де в лівій колонці наведено вхідний код, а у вер

вихідний. Наприклад, варіанту 8 відповідає
 подано: ДДК 8421, 8421

цифри 0...9 чотирирозрядного коду Ґрея, а також коди для відображення 
на семисегментному індикаторі знаків: Z

літер кирилиці А, Г, Е, Н, О, П, Р, С, У.
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, де в лівій колонці наведено вхідний код, а у вер

вихідний. Наприклад, варіанту 8 відповідає
подано: ДДК 8421, 8421

цифри 0...9 чотирирозрядного коду Ґрея, а також коди для відображення 
на семисегментному індикаторі знаків: Z1 – цифр 0...9, Z

літер кирилиці А, Г, Е, Н, О, П, Р, С, У.
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4   МУЛЬТИПЛЕКСОРИ 
 
Мета роботи: дослідження типових мультиплексорів, проектуван-

ня ЦКП на мультиплексорах; групи і шини; мегафункції, основи їх на-
строювання, менеджер автоматичного створення мегафункцій, запрова-
дження мегафункцій до графічного і текстового файлів та застосування їх 
для побудови цифрових пристроїв.  

Домашнє завдання 
! Спроектувати ЦКП для реалізації логічної функції, заданої згідно з 

варіантом завдання (див. додаток А, варіанти завдання 4), на мультиплек-
сорах різної розрядності та вибрати оптимальний варіант.   

 
4.1  Стислі теоретичні відомості 

4.1.1  Принцип побудови мультиплексорів 
Мультиплексором (multiplexеr, MUX) m : 1 (“з m в 1”) називається 

комутатор сигналів з m каналів в один, а стробований мультиплексор нази-
вається також мультиплексором-селектором (multiplexеr-selector, MS). 

Залежно від адреси А = а1а0  (рис. 4.1,а) до виходу у мультиплексора 
має надходити один із вхідних сигналів d0 ... d3, тобто 

,33221100301201101001 dydydydydaadaadaadaay +++=+++=        (4.1) 
де уi - вихідні функції дешифратора.  
 

           
 а) б) в) 

Рисунок 4.1 – Принцип побудови мультиплексора 
Схему за виразом (4.1) можна реалізувати на елементі І-АБО-НЕ 

(рис. 4.1,б): за адресою а1а0 рівень логічної одиниці з’являється на всіх 
входах тільки одного з елементів І, що дозволяє проходити відповідному 
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Рисунок 4.
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до виходу. Стробовий вхід 
4.1, б) при застосуванні елементів з трьома ст
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Рисунок 4.2 
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4.1.2 Групи і шини 
4.1.2.1 Одновимірні групи 
Низка однотипних елементів і їх назв для стислості може бути ого-

лошена у вигляді окремого модуля, який  позначається символом групи. 
Наприклад, масив адресних сигналів і відповідних їм портів а3, а2, а1, а0 
можна зобразити групою a[3..0]. Згідно із синтаксисом мови AHDL групу 
становить символічне ім’я (до 32 символів) і діапазон групи (до 256 склад-
ників, тобто бітів), який подається у квадратних дужках: старший біт, дві 
крапки, молодший біт. Ім’я біта може містити до трьох цифр. Після оголо-
шення діапазону певної групи її можна позначати в наступних виразах 
стенографічно, без зазначення цього діапазону: а[]. 

Прирівнювання груп означає, що складники з’єднуються відповідно 
до позицій у групах, наприклад, рівність груп a[3..0] = sel[7..4]  відповідає 
з’єднанню елементів а3 = sel7, а2 = sel6, а1 = sel5, а0 = sel4. Отже, кількість 
бітів у лівій і правій частинах рівняння має бути однаковою. Проте всю 
групу можна приєднати до одного вузла, тоді всі її складники з’єднуються 
з цим вузлом. Якщо, наприклад, d[6..4] = GND, то d6 = GND, d5 = GND, 
d4 = GND. Але якщо в позначенні група прирівняна до десяткової одиниці: 
d[6..4] = 1, то компілятор розширює число у двійковій системі до розміру 
групи В”001”, отже молодший розряд з’єднується з джерелом живлення, а 
інші – із землею: d[6..4] = 1 = В”001”, тому d6 = GND, d5 = GND, 
d4 = VCC.   

F  Примітки: 
1. Часто використовувану змінну х у текстовому редакторі не мо-

жна застосовувати без індексу, у тому числі для позначення групи типу x[], 
бо ця літера є зарезервованою (невизначений стан).  

2. Своєрідний узагальнений запис типу data[WIDTH-1..0] означає 
групу з кількості елементів WIDTH (ширина), розташованих у порядку від 
старшого біта до молодшого. Такий запис є легітимним, якщо параметр 
WIDTH визначений попередньо в секції Parameters Statement. Наприклад, 
якщо WIDTH = 8, то групу data[WIDTH-1..0]  можна зобразити у вигляді 
data[7..0]. 

3. Діапазон з одного складника, наприклад, а[2] є еквівалентний за-
пису а2. 

4. Звичайний порядок бітів у діапазоні (від старшого до молодшого) 
можна змінити в секції Options Statement шаблону AHDL Template.  

5. Діапазон можна позначати числами в будь-якій системі числення 
або арифметичними виразами, наприклад, а[В”11”..В”00”] або а[log2(8)..0]. 

4.1.2.2 Послідовні групи  
Застосовується також послідовне позначення групи з переліку еле-

ментів, відокремлених комами і взятих у круглі дужки (у текстовому реда-



 

кторі), наприклад, масив адресних (селекторних) входів: 
а2, а1, а0) = а
жок можуть бути елементи, що є
браження є зручним для позначення портів зразка функції, наприклад, вх
дні порти мультиплексора
sel
ни, наприклад, діапазон 

імені і двох діапазонів у квадратних дужках. Наприклад, група 
аналогічно двовимірній матриці складається із 
валентною послідовному зображенню у вигляді множини складників (а

Після оголошення діапазонів групу можна позначати стисло: а

понентами проекту. У графічному редакторі шина позначається грубою л
нією (рис. 
діаграм (рис. 
зонні або послідовні і підпорядкову
Зазначимо тут особливості подання шин у графічному редакторі. 

клад, масив з чотирьох портів а3, а2, а1 та а0 
можна позначати лише однодіапазонною групою, не припускаються двод
апазонні та послідовні групи в назвах портів.

клад, з’єднання  на рис. 
входи в групі sel[]. Нерозгалужену шину, як у цьому прикладі, можна не 
і
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шин і ліній мають збігатися з назвами з’єднуваних ними портів і вузлів 
(входів та виходів), тому, у разі потреби, імена уз
(рис. 
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валентною послідовному зображенню у вигляді множини складників (а

Окремий вузол такої групи може позначатися як 
Після оголошення діапазонів групу можна позначати стисло: а

4.1.
Шиною передаєт

понентами проекту. У графічному редакторі шина позначається грубою л
нією (рис. 
діаграм (рис. 
зонні або послідовні і підпорядкову
Зазначимо тут особливості подання шин у графічному редакторі. 

Приєднання шини до примітива утворює масив примітивів, напр
клад, масив з чотирьох портів а3, а2, а1 та а0 
можна позначати лише однодіапазонною групою, не припускаються двод
апазонні та послідовні групи в назвах портів.

З’єднувати шинами можна групи лише однакового діапазону, напр
клад, з’єднання  на рис. 
входи в групі sel[]. Нерозгалужену шину, як у цьому прикладі, можна не 
іменувати: розряди масивів а[] і sel[] з’єднуються відповідно до їх позицій у 
групах. Проте шина, що живить множину примітивів (рис. 
нуватися, бо діа
ді перші входи 16
входи паралельно подано сигнал С.

У випадку розгалужених шин мають іменуватися як шини, так і 
окремі лінії до і після місця розгалуження (рис. 
шин і ліній мають збігатися з назвами з’єднуваних ними портів і вузлів 
(входів та виходів), тому, у разі потреби, імена уз
(рис. 4.4, 

кторі), наприклад, масив адресних (селекторних) входів: 
а2, а1, а0) = а[3..0]. При комбінованому запису групи в межах круглих д
жок можуть бути елементи, що є
браження є зручним для позначення портів зразка функції, наприклад, вх
дні порти мультиплексора

d[15..0]). Крім того, діапазон групи можна поділити на піддіапаз
ни, наприклад, діапазон 

4.1.2.3 Двовимірні групи
Дводіапазонні або двовимірні групи складаються із символічного 

імені і двох діапазонів у квадратних дужках. Наприклад, група 
аналогічно двовимірній матриці складається із 
валентною послідовному зображенню у вигляді множини складників (а

Окремий вузол такої групи може позначатися як 
Після оголошення діапазонів групу можна позначати стисло: а

4.1.2.4 Шини
Шиною передаєт

понентами проекту. У графічному редакторі шина позначається грубою л
нією (рис. 4.4, а), а в текстовому редакторі (рис. 
діаграм (рис. 4.4, в) 
зонні або послідовні і підпорядкову
Зазначимо тут особливості подання шин у графічному редакторі. 

Приєднання шини до примітива утворює масив примітивів, напр
клад, масив з чотирьох портів а3, а2, а1 та а0 
можна позначати лише однодіапазонною групою, не припускаються двод
апазонні та послідовні групи в назвах портів.

З’єднувати шинами можна групи лише однакового діапазону, напр
клад, з’єднання  на рис. 
входи в групі sel[]. Нерозгалужену шину, як у цьому прикладі, можна не 
менувати: розряди масивів а[] і sel[] з’єднуються відповідно до їх позицій у 
групах. Проте шина, що живить множину примітивів (рис. 
нуватися, бо діапазон групи в її назві визначає їх кількість. У цьому прикл
ді перші входи 16-ти елементів І з’єднано із сигналами 
входи паралельно подано сигнал С.

У випадку розгалужених шин мають іменуватися як шини, так і 
окремі лінії до і після місця розгалуження (рис. 
шин і ліній мають збігатися з назвами з’єднуваних ними портів і вузлів 
(входів та виходів), тому, у разі потреби, імена уз

 д). Так, шина, що виходить з масиву портів 

кторі), наприклад, масив адресних (селекторних) входів: 
. При комбінованому запису групи в межах круглих д

жок можуть бути елементи, що є
браження є зручним для позначення портів зразка функції, наприклад, вх
дні порти мультиплексора-селектора 16:1 зручно позначити групою мх

Крім того, діапазон групи можна поділити на піддіапаз
ни, наприклад, діапазон d[15..

Двовимірні групи
Дводіапазонні або двовимірні групи складаються із символічного 

імені і двох діапазонів у квадратних дужках. Наприклад, група 
аналогічно двовимірній матриці складається із 
валентною послідовному зображенню у вигляді множини складників (а

Окремий вузол такої групи може позначатися як 
Після оголошення діапазонів групу можна позначати стисло: а

Шини 
Шиною передається множина сигналів від 2 до 256 біт

понентами проекту. У графічному редакторі шина позначається грубою л
а), а в текстовому редакторі (рис. 
в) – групою. Назви шин можуть бути одно

зонні або послідовні і підпорядкову
Зазначимо тут особливості подання шин у графічному редакторі. 

Приєднання шини до примітива утворює масив примітивів, напр
клад, масив з чотирьох портів а3, а2, а1 та а0 
можна позначати лише однодіапазонною групою, не припускаються двод
апазонні та послідовні групи в назвах портів.

З’єднувати шинами можна групи лише однакового діапазону, напр
клад, з’єднання  на рис. 4.4
входи в групі sel[]. Нерозгалужену шину, як у цьому прикладі, можна не 
менувати: розряди масивів а[] і sel[] з’єднуються відповідно до їх позицій у 
групах. Проте шина, що живить множину примітивів (рис. 

пазон групи в її назві визначає їх кількість. У цьому прикл
ти елементів І з’єднано із сигналами 

входи паралельно подано сигнал С.
У випадку розгалужених шин мають іменуватися як шини, так і 

окремі лінії до і після місця розгалуження (рис. 
шин і ліній мають збігатися з назвами з’єднуваних ними портів і вузлів 
(входів та виходів), тому, у разі потреби, імена уз

д). Так, шина, що виходить з масиву портів 
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кторі), наприклад, масив адресних (селекторних) входів: 
. При комбінованому запису групи в межах круглих д

жок можуть бути елементи, що є, у свою чергу
браження є зручним для позначення портів зразка функції, наприклад, вх

селектора 16:1 зручно позначити групою мх
Крім того, діапазон групи можна поділити на піддіапаз

[15..0] еквівалентний формі (
Двовимірні групи 

Дводіапазонні або двовимірні групи складаються із символічного 
імені і двох діапазонів у квадратних дужках. Наприклад, група 
аналогічно двовимірній матриці складається із 
валентною послідовному зображенню у вигляді множини складників (а

Окремий вузол такої групи може позначатися як 
Після оголошення діапазонів групу можна позначати стисло: а

ься множина сигналів від 2 до 256 біт
понентами проекту. У графічному редакторі шина позначається грубою л

а), а в текстовому редакторі (рис. 
групою. Назви шин можуть бути одно

зонні або послідовні і підпорядковувати
Зазначимо тут особливості подання шин у графічному редакторі. 

Приєднання шини до примітива утворює масив примітивів, напр
клад, масив з чотирьох портів а3, а2, а1 та а0 
можна позначати лише однодіапазонною групою, не припускаються двод
апазонні та послідовні групи в назвах портів.

З’єднувати шинами можна групи лише однакового діапазону, напр
4, а) означає, що мультипл

входи в групі sel[]. Нерозгалужену шину, як у цьому прикладі, можна не 
менувати: розряди масивів а[] і sel[] з’єднуються відповідно до їх позицій у 
групах. Проте шина, що живить множину примітивів (рис. 

пазон групи в її назві визначає їх кількість. У цьому прикл
ти елементів І з’єднано із сигналами 

входи паралельно подано сигнал С.  
У випадку розгалужених шин мають іменуватися як шини, так і 

окремі лінії до і після місця розгалуження (рис. 
шин і ліній мають збігатися з назвами з’єднуваних ними портів і вузлів 
(входів та виходів), тому, у разі потреби, імена уз

д). Так, шина, що виходить з масиву портів 
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кторі), наприклад, масив адресних (селекторних) входів: 
. При комбінованому запису групи в межах круглих д

у свою чергу
браження є зручним для позначення портів зразка функції, наприклад, вх

селектора 16:1 зручно позначити групою мх
Крім того, діапазон групи можна поділити на піддіапаз

алентний формі (

Дводіапазонні або двовимірні групи складаються із символічного 
імені і двох діапазонів у квадратних дужках. Наприклад, група 
аналогічно двовимірній матриці складається із 
валентною послідовному зображенню у вигляді множини складників (а

Окремий вузол такої групи може позначатися як 
Після оголошення діапазонів групу можна позначати стисло: а

ься множина сигналів від 2 до 256 біт
понентами проекту. У графічному редакторі шина позначається грубою л

а), а в текстовому редакторі (рис. 
групою. Назви шин можуть бути одно

ватися правилам, викладеним у п. 
Зазначимо тут особливості подання шин у графічному редакторі. 

Приєднання шини до примітива утворює масив примітивів, напр
клад, масив з чотирьох портів а3, а2, а1 та а0 
можна позначати лише однодіапазонною групою, не припускаються двод
апазонні та послідовні групи в назвах портів. 

З’єднувати шинами можна групи лише однакового діапазону, напр
означає, що мультипл

входи в групі sel[]. Нерозгалужену шину, як у цьому прикладі, можна не 
менувати: розряди масивів а[] і sel[] з’єднуються відповідно до їх позицій у 
групах. Проте шина, що живить множину примітивів (рис. 

пазон групи в її назві визначає їх кількість. У цьому прикл
ти елементів І з’єднано із сигналами 

У випадку розгалужених шин мають іменуватися як шини, так і 
окремі лінії до і після місця розгалуження (рис. 
шин і ліній мають збігатися з назвами з’єднуваних ними портів і вузлів 
(входів та виходів), тому, у разі потреби, імена уз

д). Так, шина, що виходить з масиву портів 

кторі), наприклад, масив адресних (селекторних) входів: 
. При комбінованому запису групи в межах круглих д

у свою чергу, також групами. Таке з
браження є зручним для позначення портів зразка функції, наприклад, вх

селектора 16:1 зручно позначити групою мх
Крім того, діапазон групи можна поділити на піддіапаз

алентний формі (d[15..

Дводіапазонні або двовимірні групи складаються із символічного 
імені і двох діапазонів у квадратних дужках. Наприклад, група 
аналогічно двовимірній матриці складається із шістьох елементів і є екв
валентною послідовному зображенню у вигляді множини складників (а

Окремий вузол такої групи може позначатися як 
Після оголошення діапазонів групу можна позначати стисло: а

ься множина сигналів від 2 до 256 біт
понентами проекту. У графічному редакторі шина позначається грубою л

а), а в текстовому редакторі (рис. 4.4, б) і редакторі часових 
групою. Назви шин можуть бути одно

правилам, викладеним у п. 
Зазначимо тут особливості подання шин у графічному редакторі. 

Приєднання шини до примітива утворює масив примітивів, напр
клад, масив з чотирьох портів а3, а2, а1 та а0 на рис. 4.
можна позначати лише однодіапазонною групою, не припускаються двод

З’єднувати шинами можна групи лише однакового діапазону, напр
означає, що мультиплексор має 4 адресні 

входи в групі sel[]. Нерозгалужену шину, як у цьому прикладі, можна не 
менувати: розряди масивів а[] і sel[] з’єднуються відповідно до їх позицій у 
групах. Проте шина, що живить множину примітивів (рис. 

пазон групи в її назві визначає їх кількість. У цьому прикл
ти елементів І з’єднано із сигналами d

У випадку розгалужених шин мають іменуватися як шини, так і 
окремі лінії до і після місця розгалуження (рис. 4.4, ґ). При цьому імена 
шин і ліній мають збігатися з назвами з’єднуваних ними портів і вузлів 
(входів та виходів), тому, у разі потреби, імена узгоджують буферами 

д). Так, шина, що виходить з масиву портів x

кторі), наприклад, масив адресних (селекторних) входів: (d, c, b, 
. При комбінованому запису групи в межах круглих д

також групами. Таке з
браження є зручним для позначення портів зразка функції, наприклад, вх

селектора 16:1 зручно позначити групою мх
Крім того, діапазон групи можна поділити на піддіапаз

[15..9]), d8,

Дводіапазонні або двовимірні групи складаються із символічного 
імені і двох діапазонів у квадратних дужках. Наприклад, група a[3..1][1..0] 

шістьох елементів і є екв
валентною послідовному зображенню у вигляді множини складників (а

Окремий вузол такої групи може позначатися як a2_1 або
Після оголошення діапазонів групу можна позначати стисло: а[][].

ься множина сигналів від 2 до 256 бітів 
понентами проекту. У графічному редакторі шина позначається грубою л

б) і редакторі часових 
групою. Назви шин можуть бути одно- та дводіап

правилам, викладеним у п. 
Зазначимо тут особливості подання шин у графічному редакторі.  

Приєднання шини до примітива утворює масив примітивів, напр
4.4, а). Проте порт 

можна позначати лише однодіапазонною групою, не припускаються двод

З’єднувати шинами можна групи лише однакового діапазону, напр
ексор має 4 адресні 

входи в групі sel[]. Нерозгалужену шину, як у цьому прикладі, можна не 
менувати: розряди масивів а[] і sel[] з’єднуються відповідно до їх позицій у 
групах. Проте шина, що живить множину примітивів (рис. 4.4, г), має 

пазон групи в її назві визначає їх кількість. У цьому прикл
d15…d0, а на другі 

У випадку розгалужених шин мають іменуватися як шини, так і 
ґ). При цьому імена 

шин і ліній мають збігатися з назвами з’єднуваних ними портів і вузлів 
годжують буферами 

x[4..1], має ту саму 

, a) = (а3, 
. При комбінованому запису групи в межах круглих ду-

також групами. Таке зо-
браження є зручним для позначення портів зразка функції, наприклад, вхі-

селектора 16:1 зручно позначити групою мх.(g, 
Крім того, діапазон групи можна поділити на піддіапазо-

8, d[7..0]). 

Дводіапазонні або двовимірні групи складаються із символічного 
[3..1][1..0] 

шістьох елементів і є екві-
валентною послідовному зображенню у вигляді множини складників (аi_j): 

 
або a[2][1].

[][]. 

 між ком-
понентами проекту. У графічному редакторі шина позначається грубою лі-

б) і редакторі часових 
та дводіапа-

правилам, викладеним у п. 4.1.2. 
 

Приєднання шини до примітива утворює масив примітивів, напри-
. Проте порт 

можна позначати лише однодіапазонною групою, не припускаються дводі-

З’єднувати шинами можна групи лише однакового діапазону, напри-
ексор має 4 адресні 

входи в групі sel[]. Нерозгалужену шину, як у цьому прикладі, можна не 
менувати: розряди масивів а[] і sel[] з’єднуються відповідно до їх позицій у 

г), має іме-
пазон групи в її назві визначає їх кількість. У цьому прикла-

а на другі 

У випадку розгалужених шин мають іменуватися як шини, так і 
ґ). При цьому імена 

шин і ліній мають збігатися з назвами з’єднуваних ними портів і вузлів 
годжують буферами Wire

[4..1], має ту саму 

= (а3, 
у-
о-
і-
, 
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Дводіапазонні або двовимірні групи складаються із символічного 
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ексор має 4 адресні 

входи в групі sel[]. Нерозгалужену шину, як у цьому прикладі, можна не 
менувати: розряди масивів а[] і sel[] з’єднуються відповідно до їх позицій у 
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а на другі 

У випадку розгалужених шин мають іменуватися як шини, так і 
ґ). При цьому імена 

шин і ліній мають збігатися з назвами з’єднуваних ними портів і вузлів 
Wire 

[4..1], має ту саму 



 

назву 
data
ліній х3 і 

жок, наприклад, група у вигляді: data7, data[5..0] на рис. 

товому 
повне позначення групи типу

 

назву x[4..1], а шина, що з’єднує 8 інформаційних входів мультиплексора 
data[] з джерелами, також називається 
ліній х3 і da

F  Примітки
1. У графічному редакторі

жок, наприклад, група у вигляді: data7, data[5..0] на рис. 
2. Стенографічне позначення типу 

товому редакторі, а в графічному редакторі для шин завжди застосовується 
повне позначення групи типу

[4..1], а шина, що з’єднує 8 інформаційних входів мультиплексора 
[] з джерелами, також називається 

data6 узгоджуються буфером 
Примітки
У графічному редакторі

жок, наприклад, група у вигляді: data7, data[5..0] на рис. 
Стенографічне позначення типу 
редакторі, а в графічному редакторі для шин завжди застосовується 

повне позначення групи типу

г)

[4..1], а шина, що з’єднує 8 інформаційних входів мультиплексора 
[] з джерелами, також називається 

6 узгоджуються буфером 
Примітки: 
У графічному редакторі

жок, наприклад, група у вигляді: data7, data[5..0] на рис. 
Стенографічне позначення типу 
редакторі, а в графічному редакторі для шин завжди застосовується 

повне позначення групи типу 

in[4..1] 

)                                                               
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[4..1], а шина, що з’єднує 8 інформаційних входів мультиплексора 
[] з джерелами, також називається 

6 узгоджуються буфером 

У графічному редакторі послідовні групи позначаються без д
жок, наприклад, група у вигляді: data7, data[5..0] на рис. 

Стенографічне позначення типу 
редакторі, а в графічному редакторі для шин завжди застосовується 

 sel[2..0]. 

а)
in[4..1]          

б

в)

                                                               

е)
Рисунок
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[4..1], а шина, що з’єднує 8 інформаційних входів мультиплексора 
[] з джерелами, також називається data[7..0]. Тому імена з’єднуваних 

6 узгоджуються буфером Wire. 

послідовні групи позначаються без д
жок, наприклад, група у вигляді: data7, data[5..0] на рис. 

Стенографічне позначення типу sel[] є припустимим тільки в тек
редакторі, а в графічному редакторі для шин завжди застосовується 
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б) 
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Рисунок 4.4 
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послідовні групи позначаються без д
жок, наприклад, група у вигляді: data7, data[5..0] на рис. 4.
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послідовні групи позначаються без ду-
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у-

с-
редакторі, а в графічному редакторі для шин завжди застосовується 

 

 



 

з’єднання іменованих шин і ліній можна не зображати взагалі, їх зображ
ють лише для наочності схеми. Отже, і точки з’єднань показувати не
бов’язково. Виняток становлять шини, на яких без точок з’єднань утвор
ютьс
б дві назви: “

ного блоку високого рівня, що
настроювання може використовуватися як компонент схеми поряд із пр
мітивами і макрофункціями. Від макрофункції мегафункція відрізняється 
гнучкішими можливостями для настроювання параметрів і тим, що сигн
ли з’єдную
видів макрофункцій також зображено шинами). Мегафункції містяться в 
директорії 
дулів (LPM 
функція вставляється як звичайний елемент, але із зазначеної директорії, а 
до текстового редактора 
ром 

Відо
> 
рактеризуємо стисло деякі різновиди мегафункцій, наведених у файлі 
4libre_mega.gdf.

 

3. Шини 
з’єднання іменованих шин і ліній можна не зображати взагалі, їх зображ
ють лише для наочності схеми. Отже, і точки з’єднань показувати не
бов’язково. Виняток становлять шини, на яких без точок з’єднань утвор
ються різні імена, як, наприклад, на нижній лінії рис. 
б дві назви: “

 
4.1.
4.1.
Мегафункцією називається структурна модель у вигляді стандар

ного блоку високого рівня, що
настроювання може використовуватися як компонент схеми поряд із пр
мітивами і макрофункціями. Від макрофункції мегафункція відрізняється 
гнучкішими можливостями для настроювання параметрів і тим, що сигн
ли з’єдную
видів макрофункцій також зображено шинами). Мегафункції містяться в 
директорії 
дулів (LPM 
функція вставляється як звичайний елемент, але із зазначеної директорії, а 
до текстового редактора 
ром Include

Мегафункції поділяються на три основні і одну додаткову групи. 
Відомості про потрібну мегафункцію можна дістати з довідки: меню 
> Megafunctions
рактеризуємо стисло деякі різновиди мегафункцій, наведених у файлі 
4libre_mega.gdf.

4.1.
Мегафункції логічних елементів подано в категорії Gates (ворота). 

Шини пов’язані з 
з’єднання іменованих шин і ліній можна не зображати взагалі, їх зображ
ють лише для наочності схеми. Отже, і точки з’єднань показувати не
бов’язково. Виняток становлять шини, на яких без точок з’єднань утвор

я різні імена, як, наприклад, на нижній лінії рис. 
б дві назви: “x[2..1]” 

4.1.3  Мегафункції
4.1.3.1 Означення
Мегафункцією називається структурна модель у вигляді стандар

ного блоку високого рівня, що
настроювання може використовуватися як компонент схеми поряд із пр
мітивами і макрофункціями. Від макрофункції мегафункція відрізняється 
гнучкішими можливостями для настроювання параметрів і тим, що сигн
ли з’єднуються з нею, як правило, групами й шинами (вузли деяких різн
видів макрофункцій також зображено шинами). Мегафункції містяться в 
директорії \maxplus2
дулів (LPM – Library of Parameterized Modules). До графічног
функція вставляється як звичайний елемент, але із зазначеної директорії, а 
до текстового редактора 

Include Statement
Мегафункції поділяються на три основні і одну додаткову групи. 

мості про потрібну мегафункцію можна дістати з довідки: меню 
Megafunctions/LPM
рактеризуємо стисло деякі різновиди мегафункцій, наведених у файлі 
4libre_mega.gdf. 

4.1.3.2 Логічні функції
Мегафункції логічних елементів подано в категорії Gates (ворота). 

Рисунок 4.5

в’язані з вузлами (компонентами) тільки іменами, тому 
з’єднання іменованих шин і ліній можна не зображати взагалі, їх зображ
ють лише для наочності схеми. Отже, і точки з’єднань показувати не
бов’язково. Виняток становлять шини, на яких без точок з’єднань утвор

я різні імена, як, наприклад, на нижній лінії рис. 
[2..1]” i “x4, x[2..1]”.  

Мегафункції 
3.1 Означення мегафункції

Мегафункцією називається структурна модель у вигляді стандар
ного блоку високого рівня, що
настроювання може використовуватися як компонент схеми поряд із пр
мітивами і макрофункціями. Від макрофункції мегафункція відрізняється 
гнучкішими можливостями для настроювання параметрів і тим, що сигн

ться з нею, як правило, групами й шинами (вузли деяких різн
видів макрофункцій також зображено шинами). Мегафункції містяться в 

maxplus2\max2lib
Library of Parameterized Modules). До графічног

функція вставляється як звичайний елемент, але із зазначеної директорії, а 
до текстового редактора – за допомогою файла включення (

Statement. 
Мегафункції поділяються на три основні і одну додаткову групи. 

мості про потрібну мегафункцію можна дістати з довідки: меню 
LPM > вибрати з групи і натиснути ім’я мегафункції. Сх

рактеризуємо стисло деякі різновиди мегафункцій, наведених у файлі 

Логічні функції
Мегафункції логічних елементів подано в категорії Gates (ворота). 

а) 

б) 
Рисунок 4.5 
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вузлами (компонентами) тільки іменами, тому 
з’єднання іменованих шин і ліній можна не зображати взагалі, їх зображ
ють лише для наочності схеми. Отже, і точки з’єднань показувати не
бов’язково. Виняток становлять шини, на яких без точок з’єднань утвор

я різні імена, як, наприклад, на нижній лінії рис. 
[2..1]”.   

мегафункції
Мегафункцією називається структурна модель у вигляді стандар

ного блоку високого рівня, що реально не існує, але після попереднього 
настроювання може використовуватися як компонент схеми поряд із пр
мітивами і макрофункціями. Від макрофункції мегафункція відрізняється 
гнучкішими можливостями для настроювання параметрів і тим, що сигн

ться з нею, як правило, групами й шинами (вузли деяких різн
видів макрофункцій також зображено шинами). Мегафункції містяться в 

max2lib\mega_lpm бібліотеки параметризованих м
Library of Parameterized Modules). До графічног

функція вставляється як звичайний елемент, але із зазначеної директорії, а 
за допомогою файла включення (

Мегафункції поділяються на три основні і одну додаткову групи. 
мості про потрібну мегафункцію можна дістати з довідки: меню 

> вибрати з групи і натиснути ім’я мегафункції. Сх
рактеризуємо стисло деякі різновиди мегафункцій, наведених у файлі 

Логічні функції  
Мегафункції логічних елементів подано в категорії Gates (ворота). 
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вузлами (компонентами) тільки іменами, тому 
з’єднання іменованих шин і ліній можна не зображати взагалі, їх зображ
ють лише для наочності схеми. Отже, і точки з’єднань показувати не
бов’язково. Виняток становлять шини, на яких без точок з’єднань утвор

я різні імена, як, наприклад, на нижній лінії рис. 

мегафункції 
Мегафункцією називається структурна модель у вигляді стандар

реально не існує, але після попереднього 
настроювання може використовуватися як компонент схеми поряд із пр
мітивами і макрофункціями. Від макрофункції мегафункція відрізняється 
гнучкішими можливостями для настроювання параметрів і тим, що сигн

ться з нею, як правило, групами й шинами (вузли деяких різн
видів макрофункцій також зображено шинами). Мегафункції містяться в 

mega_lpm бібліотеки параметризованих м
Library of Parameterized Modules). До графічног

функція вставляється як звичайний елемент, але із зазначеної директорії, а 
за допомогою файла включення (

Мегафункції поділяються на три основні і одну додаткову групи. 
мості про потрібну мегафункцію можна дістати з довідки: меню 

> вибрати з групи і натиснути ім’я мегафункції. Сх
рактеризуємо стисло деякі різновиди мегафункцій, наведених у файлі 

Мегафункції логічних елементів подано в категорії Gates (ворота). 

 

 

вузлами (компонентами) тільки іменами, тому 
з’єднання іменованих шин і ліній можна не зображати взагалі, їх зображ
ють лише для наочності схеми. Отже, і точки з’єднань показувати не
бов’язково. Виняток становлять шини, на яких без точок з’єднань утвор

я різні імена, як, наприклад, на нижній лінії рис. 4.4,

Мегафункцією називається структурна модель у вигляді стандар
реально не існує, але після попереднього 

настроювання може використовуватися як компонент схеми поряд із пр
мітивами і макрофункціями. Від макрофункції мегафункція відрізняється 
гнучкішими можливостями для настроювання параметрів і тим, що сигн

ться з нею, як правило, групами й шинами (вузли деяких різн
видів макрофункцій також зображено шинами). Мегафункції містяться в 

mega_lpm бібліотеки параметризованих м
Library of Parameterized Modules). До графічног

функція вставляється як звичайний елемент, але із зазначеної директорії, а 
за допомогою файла включення (

Мегафункції поділяються на три основні і одну додаткову групи. 
мості про потрібну мегафункцію можна дістати з довідки: меню 

> вибрати з групи і натиснути ім’я мегафункції. Сх
рактеризуємо стисло деякі різновиди мегафункцій, наведених у файлі 

Мегафункції логічних елементів подано в категорії Gates (ворота). 
Мегафункція lpm_inv 
(рис. 4.5, 
масивом 
раметром LPM_WIDTH, 
який визначає кількість 
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макрофункцій. Відмінність полягає тільки в тому, що інверсії задаються 
для всієї групи кодом (на символі відображається шістнадцятковий код, а 
вводити можна також двійковий або десятковий код). У цьому коді розряд, 
що інвертується, позначається одиницею, а який залишається без інверсії – 
нулем. У прикладі (див. рис. 4.5) подвійним запереченням (відображено 
кружком з шістнадцятковим числом 5 на виході символу мегафункції) усу-
нуто інверсію розрядів х2 та х0 кодом 1012 = 516. 

 
а) 

 
б) 

 
в) 

Рисунок 4.6 
Усі інші логічні елементи, що є багатовходовими, репрезентовано 

мегафункціями lpm_or,  lpm_and та lpm_xor (рис. 4.6, а). Такі мегафункції  
характеризуються параметрами: LPM_WIDTH – кількість елементів масиву, 
отже, кількість вхідних шин і розрядність вихідної шини, наприклад, для 
мегафункції lpm_and при LPM_WIDTH = 3 (рис. 4.6, б) маємо 3 елементи з 
виходами у2, у1, у0 (рис. 4.6, в); LPM_SIZE – кількість входів кожного елеме-
нта, отже і розрядність вхідних шин, наприклад, при LPM_SIZE = 2 маємо 
двовходові елементи зі входами х1j, x0j, де j = 2, 1, 0 (див. рис. 4.6, б), в). 
Шляхом інвертування входів шістнадцятковим кодом Н”15” отримуємо три 
елементи заборони.  

 
4.1.3.3 Дешифратор 
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Для прикладу на рис. 4.7 зображено настроєний дешифратор 2:4. 
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рюється у звичайний мультиплексор (див. рис. 4.8, а), який перемикає одну 
з LPM_SIZE ліній до однодротового виходу. Але згідно з форматом її про-
тотипу позначати вхідні лінії все одно потрібно двовимірним кодом 
data[][], в якому другий складник є 0. Настроювання значно спрощується з 
використанням спеціальної підпрограми – менеджера створювання мега-
функцій. Ця методика докладно викладається в лабораторному завданні.  

F Примітка. Інші параметри мегафункцій дешифратора і мультип-
лексора, що застосовуються в послідовнісних пристроях, зокрема, 
LPM_PIPELINE (конвеєрний режим) не є обов’язковими і під час настрою-
вання їх можна не визначати. 

4.2  Лабораторне завдання 
4.2.1  Дослідити типові мультиплексори 
4.2.1.1 За принциповою електричною схемою та осцилограмами си-

гналів (4prim.gdf, .scf) мультиплексора з трьома станами виходу на ло-
гічних елементах скласти таблицю відповідності і рівняння вихідної фун-
кції, виміряти затримку вихідних імпульсів. (У звіті навести схему, умовне 
графічне позначення за ДСТУ, таблицю відповідності, рівняння вихідної 
функції, часові діаграми, затримку, стислі пояснення принципу дії такого 
ЦКП з трьома станами виходу). 

4.2.1.2 Ознайомитися з макрофункціями стандартних мультипле-
ксорів серії 74, у тому числі з трьома станами виходу (файл d:\max2work\ 
tutorial\4lab\4lіbr_macro.gdf, рис. 4.1...4.4). Розглянути принципові електри-

чні схеми (В** по символу) та таблиці відповідності (клацнути пік-
тограмою по символу) різновидів мультиплексорів. (У звіті навести 

два-три символи з різних груп, пояснити призначення та особливості вхо-
дів і виходів). 

4.2.1.3 Ознайомитися з дібраними елементами бібліотеки мега-
функцій (файл d:\max2work\tutorial\4lab\4libr_mega.gdf): 1) буфер, 2) логіч-
ні функції, 3) дешифратор, 4) мультиплексори та пояснювальними прикла-

дами 1...10. Розглянути виконувані функції в текстовому (В** по 
символу) та довідковому (клацнути піктограмою по символу) фай-

лах, у довідці звернути увагу на приклади (Example) і розділ функції 
(Function) та дати тлумачення сенсу кожної з чотирьох груп мегафункцій і 
їхніх параметрів. (У звіті навести принаймні по одному символу з кожної 
групи, пояснити призначення та особливості входів і виходів та дати стис-
ле тлумачення основних параметрів). 

4.2.2 Застосувати макрофункції мультиплексорів для реалізації 
заданого варіанту (ХХ=01, 02, …) логічної функції y 

4.2.2.1 У графічному файлі проекту 4ХХgr_macro дібрати макро-
функції, потрібні для реалізації логічної функції на мультиплексорах різної 



 

розрядності, настроїти їх, доповнити схеми іншими елементами, виконати 
компіляцію і функціональне моделювання, переконатися в прав
ектування та вибрати оптимальний варіант схеми на ІС жорсткої логі

ми

з’єднаних з ними ліній: курсором (інструменти 
шині (лінії) позначити миготливу точку і ввести текст (або ввести його у в
льному місці і перетягнути інструментом 
цьому назви розгалужених шин (ліній) мають збігатися з назвами 
з’єднуваних ними вузлів (входів, виходів), інакше узгоджуємо імена за доп
могою буферів 

тку змоделювати схему 1, відтак доповнити її схемою 2 і повторити мод
лювання і т. д.

один з варіантів

значеного стану), тому без індексу
вати; отже, для позначення груп слід вживати імена типу х

гафункцій за допомогою менеджера 
прикладі синтезу мультиплексора найбільшої  розрядності 
для реалізації заданого варіанту 
400

сті відкритого якогось файла): меню 
відповісти на запитання в діалогових вікнах.

створити (
існуючий 

 

розрядності, настроїти їх, доповнити схеми іншими елементами, виконати 
компіляцію і функціональне моделювання, переконатися в прав
ектування та вибрати оптимальний варіант схеми на ІС жорсткої логі

< Приклад
ми 1...4). 

2. У ви
з’єднаних з ними ліній: курсором (інструменти 
шині (лінії) позначити миготливу точку і ввести текст (або ввести його у в
льному місці і перетягнути інструментом 
цьому назви розгалужених шин (ліній) мають збігатися з назвами 
з’єднуваних ними вузлів (входів, виходів), інакше узгоджуємо імена за доп
могою буферів 

3. Компіляцію і мод
тку змоделювати схему 1, відтак доповнити її схемою 2 і повторити мод
лювання і т. д.

4.2.
один з варіантів

< Приклад
F  Примітка. 

значеного стану), тому без індексу
вати; отже, для позначення груп слід вживати імена типу х

4.2.
гафункцій за допомогою менеджера 
прикладі синтезу мультиплексора найбільшої  розрядності 
для реалізації заданого варіанту 
400gr_macro

4.2.
сті відкритого якогось файла): меню 
відповісти на запитання в діалогових вікнах.

4.2.
створити (
існуючий 

розрядності, настроїти їх, доповнити схеми іншими елементами, виконати 
компіляцію і функціональне моделювання, переконатися в прав
ектування та вибрати оптимальний варіант схеми на ІС жорсткої логі

Приклад: 

масиви примітивів вводимо у вигляді одного елемента, ім’я 
якого позначається діапазоном групи, а з’єднувальні шини з
бражаємо грубими лініями (тип лінії вибирається з верхньої 
панелі інструментів). 

У випадку розгалужених шин треба вводити їх імена, а також імена 
з’єднаних з ними ліній: курсором (інструменти 
шині (лінії) позначити миготливу точку і ввести текст (або ввести його у в
льному місці і перетягнути інструментом 
цьому назви розгалужених шин (ліній) мають збігатися з назвами 
з’єднуваних ними вузлів (входів, виходів), інакше узгоджуємо імена за доп
могою буферів Wire

Компіляцію і мод
тку змоделювати схему 1, відтак доповнити її схемою 2 і повторити мод
лювання і т. д. 

4.2.2.2 У текстовому файлі
один з варіантів, еквівалентний схемам за п. 

Приклад: 
Примітка. 

значеного стану), тому без індексу
вати; отже, для позначення груп слід вживати імена типу х

4.2.3 Засвоїти основи автоматичного створення різновидів м
гафункцій за допомогою менеджера 
прикладі синтезу мультиплексора найбільшої  розрядності 
для реалізації заданого варіанту 

macro.gdf, схема 1)
4.2.3.1 Запустити 

сті відкритого якогось файла): меню 
відповісти на запитання в діалогових вікнах.

4.2.3.2 На сторінці 1 (
створити (Create …) новий різновид 
існуючий різновид > 

розрядності, настроїти їх, доповнити схеми іншими елементами, виконати 
компіляцію і функціональне моделювання, переконатися в прав
ектування та вибрати оптимальний варіант схеми на ІС жорсткої логі

: d:\max2

F Примітки
1. Відмінність застосування груп полягає в тому, що 

масиви примітивів вводимо у вигляді одного елемента, ім’я 
якого позначається діапазоном групи, а з’єднувальні шини з
бражаємо грубими лініями (тип лінії вибирається з верхньої 
панелі інструментів). 
падку розгалужених шин треба вводити їх імена, а також імена 

з’єднаних з ними ліній: курсором (інструменти 
шині (лінії) позначити миготливу точку і ввести текст (або ввести його у в
льному місці і перетягнути інструментом 
цьому назви розгалужених шин (ліній) мають збігатися з назвами 
з’єднуваних ними вузлів (входів, виходів), інакше узгоджуємо імена за доп

Wire, які ресурсу не потребують, бо реально не існують.
Компіляцію і моделювання доцільно виконувати кроками: споч

тку змоделювати схему 1, відтак доповнити її схемою 2 і повторити мод

2.2 У текстовому файлі
, еквівалентний схемам за п. 

: d:\max2work
Примітка. У текстових файлах літера „х” зарезервована (для нев

значеного стану), тому без індексу
вати; отже, для позначення груп слід вживати імена типу х

3 Засвоїти основи автоматичного створення різновидів м
гафункцій за допомогою менеджера 
прикладі синтезу мультиплексора найбільшої  розрядності 
для реалізації заданого варіанту 

, схема 1).  
3.1 Запустити менеджер мегафункцій

сті відкритого якогось файла): меню 
відповісти на запитання в діалогових вікнах.

На сторінці 1 (
…) новий різновид 

різновид > Next.  
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розрядності, настроїти їх, доповнити схеми іншими елементами, виконати 
компіляцію і функціональне моделювання, переконатися в прав
ектування та вибрати оптимальний варіант схеми на ІС жорсткої логі

2work\tutorial

Примітки: 
Відмінність застосування груп полягає в тому, що 

масиви примітивів вводимо у вигляді одного елемента, ім’я 
якого позначається діапазоном групи, а з’єднувальні шини з
бражаємо грубими лініями (тип лінії вибирається з верхньої 
панелі інструментів).  
падку розгалужених шин треба вводити їх імена, а також імена 

з’єднаних з ними ліній: курсором (інструменти 
шині (лінії) позначити миготливу точку і ввести текст (або ввести його у в
льному місці і перетягнути інструментом 
цьому назви розгалужених шин (ліній) мають збігатися з назвами 
з’єднуваних ними вузлів (входів, виходів), інакше узгоджуємо імена за доп

, які ресурсу не потребують, бо реально не існують.
елювання доцільно виконувати кроками: споч

тку змоделювати схему 1, відтак доповнити її схемою 2 і повторити мод

2.2 У текстовому файлі 
, еквівалентний схемам за п. 

work\tutorial
У текстових файлах літера „х” зарезервована (для нев

значеного стану), тому без індексу на кшталт 
вати; отже, для позначення груп слід вживати імена типу х

3 Засвоїти основи автоматичного створення різновидів м
гафункцій за допомогою менеджера 
прикладі синтезу мультиплексора найбільшої  розрядності 
для реалізації заданого варіанту функції (див. 

менеджер мегафункцій
сті відкритого якогось файла): меню 
відповісти на запитання в діалогових вікнах.

На сторінці 1 (page 1) вибрати дію, яку треба виконати
…) новий різновид мегафункції або редагувати (
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розрядності, настроїти їх, доповнити схеми іншими елементами, виконати 
компіляцію і функціональне моделювання, переконатися в прав
ектування та вибрати оптимальний варіант схеми на ІС жорсткої логі

tutorial\4lab\400

Відмінність застосування груп полягає в тому, що 
масиви примітивів вводимо у вигляді одного елемента, ім’я 
якого позначається діапазоном групи, а з’єднувальні шини з
бражаємо грубими лініями (тип лінії вибирається з верхньої 

падку розгалужених шин треба вводити їх імена, а також імена 
з’єднаних з ними ліній: курсором (інструменти 
шині (лінії) позначити миготливу точку і ввести текст (або ввести його у в
льному місці і перетягнути інструментом "стрілка
цьому назви розгалужених шин (ліній) мають збігатися з назвами 
з’єднуваних ними вузлів (входів, виходів), інакше узгоджуємо імена за доп

, які ресурсу не потребують, бо реально не існують.
елювання доцільно виконувати кроками: споч

тку змоделювати схему 1, відтак доповнити її схемою 2 і повторити мод

2.2 У текстовому файлі проекту 4ХХ
, еквівалентний схемам за п. 4.2.

tutorial\4lab\400
У текстових файлах літера „х” зарезервована (для нев

на кшталт x[4..1]
вати; отже, для позначення груп слід вживати імена типу х

3 Засвоїти основи автоматичного створення різновидів м
гафункцій за допомогою менеджера MegaWizard Plug
прикладі синтезу мультиплексора найбільшої  розрядності 

функції (див. 

менеджер мегафункцій
сті відкритого якогось файла): меню File > MegaWizard Plug
відповісти на запитання в діалогових вікнах. 

вибрати дію, яку треба виконати
мегафункції або редагувати (

розрядності, настроїти їх, доповнити схеми іншими елементами, виконати 
компіляцію і функціональне моделювання, переконатися в прав
ектування та вибрати оптимальний варіант схеми на ІС жорсткої логі

400gr_macro

Відмінність застосування груп полягає в тому, що 
масиви примітивів вводимо у вигляді одного елемента, ім’я 
якого позначається діапазоном групи, а з’єднувальні шини з
бражаємо грубими лініями (тип лінії вибирається з верхньої 

падку розгалужених шин треба вводити їх імена, а також імена 
з’єднаних з ними ліній: курсором (інструменти "стрілка" 
шині (лінії) позначити миготливу точку і ввести текст (або ввести його у в

лка" в потрібну позицію). При 
цьому назви розгалужених шин (ліній) мають збігатися з назвами 
з’єднуваних ними вузлів (входів, виходів), інакше узгоджуємо імена за доп

, які ресурсу не потребують, бо реально не існують.
елювання доцільно виконувати кроками: споч

тку змоделювати схему 1, відтак доповнити її схемою 2 і повторити мод

проекту 4ХХtx_macro
4.2.2.1. 
400tx_macro

У текстових файлах літера „х” зарезервована (для нев
[4..1] її не можна використов

вати; отже, для позначення груп слід вживати імена типу х
3 Засвоїти основи автоматичного створення різновидів м

MegaWizard Plug
прикладі синтезу мультиплексора найбільшої  розрядності 

функції (див. d:\max

менеджер мегафункцій (незалежно від наявн
MegaWizard Plug

вибрати дію, яку треба виконати
мегафункції або редагувати (

розрядності, настроїти їх, доповнити схеми іншими елементами, виконати 
компіляцію і функціональне моделювання, переконатися в правильності пр
ектування та вибрати оптимальний варіант схеми на ІС жорсткої логі

macro.gdf, .scf

Відмінність застосування груп полягає в тому, що 
масиви примітивів вводимо у вигляді одного елемента, ім’я 
якого позначається діапазоном групи, а з’єднувальні шини з
бражаємо грубими лініями (тип лінії вибирається з верхньої 

падку розгалужених шин треба вводити їх імена, а також імена 
 або літера 

шині (лінії) позначити миготливу точку і ввести текст (або ввести його у в
в потрібну позицію). При 

цьому назви розгалужених шин (ліній) мають збігатися з назвами 
з’єднуваних ними вузлів (входів, виходів), інакше узгоджуємо імена за доп

, які ресурсу не потребують, бо реально не існують.
елювання доцільно виконувати кроками: споч

тку змоделювати схему 1, відтак доповнити її схемою 2 і повторити мод

macro реалізувати 

macro.tdf, .scf. 
У текстових файлах літера „х” зарезервована (для нев

її не можна використов
вати; отже, для позначення груп слід вживати імена типу хin[], хi[], d

3 Засвоїти основи автоматичного створення різновидів м
MegaWizard Plug-In Manager 

прикладі синтезу мультиплексора найбільшої  розрядності N, необхідного 
max2work\tutorial

(незалежно від наявн
MegaWizard Plug-In Manager і 

вибрати дію, яку треба виконати
мегафункції або редагувати (

розрядності, настроїти їх, доповнити схеми іншими елементами, виконати 
ильності про-

ектування та вибрати оптимальний варіант схеми на ІС жорсткої логіки. 
scf (схе-

Відмінність застосування груп полягає в тому, що 
масиви примітивів вводимо у вигляді одного елемента, ім’я 
якого позначається діапазоном групи, а з’єднувальні шини зо-
бражаємо грубими лініями (тип лінії вибирається з верхньої 

падку розгалужених шин треба вводити їх імена, а також імена 
або літера "А") на 

шині (лінії) позначити миготливу точку і ввести текст (або ввести його у ві-
в потрібну позицію). При 

цьому назви розгалужених шин (ліній) мають збігатися з назвами 
з’єднуваних ними вузлів (входів, виходів), інакше узгоджуємо імена за допо-

, які ресурсу не потребують, бо реально не існують. 
елювання доцільно виконувати кроками: споча-

тку змоделювати схему 1, відтак доповнити її схемою 2 і повторити моде-

реалізувати 

 
У текстових файлах літера „х” зарезервована (для неви-

її не можна використову-
d[] тощо.  

3 Засвоїти основи автоматичного створення різновидів ме-
In Manager на 

, необхідного 
tutorial\4lab\

(незалежно від наявно-
In Manager і 

вибрати дію, яку треба виконати –
мегафункції або редагувати (Edit …) 

розрядності, настроїти їх, доповнити схеми іншими елементами, виконати 
о-

е-

Відмінність застосування груп полягає в тому, що 
масиви примітивів вводимо у вигляді одного елемента, ім’я 

о-
бражаємо грубими лініями (тип лінії вибирається з верхньої 

падку розгалужених шин треба вводити їх імена, а також імена 
) на 
і-

в потрібну позицію). При 
цьому назви розгалужених шин (ліній) мають збігатися з назвами 

о-

а-
е-

реалізувати 

и-
у-
 
е-
на 

, необхідного 
\ 

о-
In Manager і 

– 
…) 



 

рати
тип мови для створюваного файла (
ти ім’я файла 4
ба її змінити: натиснути кнопку 
file
ла і зберегти (у віконці відобразиться директорія з ім’ям) > 

кість інформаційних входів
input 
(зали

заданими конкретними параметрами, зокрема, 
N

 

4.2.3.
рати (натиснути
тип мови для створюваного файла (
ти ім’я файла 4
ба її змінити: натиснути кнопку 
file name прокруткою
ла і зберегти (у віконці відобразиться директорія з ім’ям) > 

реби, можна створити нову папку за допомогою піктограми.
4.2.

кість інформаційних входів
input and '
(залишити 1, але для перемикача шин ввести потрібну їх ширину) > 

4.2.3.5 Відкрити утворені файли нового різновиду мегафункції
заданими конкретними параметрами, зокрема, 
N – кількість інформаційних входів мультиплексора).

4.2.3.3 На сторінці 2а 
натиснути +)

тип мови для створюваного файла (
ти ім’я файла 4XXmuxN
ба її змінити: натиснути кнопку 

прокруткою
ла і зберегти (у віконці відобразиться директорія з ім’ям) > 

F Примітка.
реби, можна створити нову папку за допомогою піктограми.
4.2.3.4 На сторінці 3 в графі 

кість інформаційних входів
'result' output 

шити 1, але для перемикача шин ввести потрібну їх ширину) > 
4.2.3.5 Відкрити утворені файли нового різновиду мегафункції

заданими конкретними параметрами, зокрема, 
кількість інформаційних входів мультиплексора).

На сторінці 2а 
+) категорію 

тип мови для створюваного файла (
XXmuxN, але якщо директорія не відповідає потрібній, тр

ба її змінити: натиснути кнопку 
прокруткою по черзі встановити потрібні папки, ввести ім’я фа

ла і зберегти (у віконці відобразиться директорія з ім’ям) > 

Примітка. У
реби, можна створити нову папку за допомогою піктограми.

На сторінці 3 в графі 
кість інформаційних входів

' output buses 
шити 1, але для перемикача шин ввести потрібну їх ширину) > 

4.2.3.5 Відкрити утворені файли нового різновиду мегафункції
заданими конкретними параметрами, зокрема, 
кількість інформаційних входів мультиплексора).

80

На сторінці 2а зліва зі списку доступних 
категорію (gates

тип мови для створюваного файла (AHDL
, але якщо директорія не відповідає потрібній, тр

ба її змінити: натиснути кнопку Browse
по черзі встановити потрібні папки, ввести ім’я фа

ла і зберегти (у віконці відобразиться директорія з ім’ям) > 

У діалоговому вікні 
реби, можна створити нову папку за допомогою піктограми.

На сторінці 3 в графі How
кість інформаційних входів (входів даних), у графі  

 be? –  ширину в бітах кожного з них і виходу 
шити 1, але для перемикача шин ввести потрібну їх ширину) > 

4.2.3.5 Відкрити утворені файли нового різновиду мегафункції
заданими конкретними параметрами, зокрема, 
кількість інформаційних входів мультиплексора).

80 

зі списку доступних 
gates) і функцію

AHDL) і до віконця 
, але якщо директорія не відповідає потрібній, тр

Browse (огляд) і в діалоговому вікні 
по черзі встановити потрібні папки, ввести ім’я фа

ла і зберегти (у віконці відобразиться директорія з ім’ям) > 

діалоговому вікні 
реби, можна створити нову папку за допомогою піктограми.

How many 
(входів даних), у графі  

ширину в бітах кожного з них і виходу 
шити 1, але для перемикача шин ввести потрібну їх ширину) > 

4.2.3.5 Відкрити утворені файли нового різновиду мегафункції
заданими конкретними параметрами, зокрема, 4
кількість інформаційних входів мультиплексора).

зі списку доступних 
функцію (LPM_
до віконця What

, але якщо директорія не відповідає потрібній, тр
(огляд) і в діалоговому вікні 

по черзі встановити потрібні папки, ввести ім’я фа
ла і зберегти (у віконці відобразиться директорія з ім’ям) > 

діалоговому вікні Select file
реби, можна створити нову папку за допомогою піктограми.

 'data' inputs
(входів даних), у графі  How

ширину в бітах кожного з них і виходу 
шити 1, але для перемикача шин ввести потрібну їх ширину) > 

4.2.3.5 Відкрити утворені файли нового різновиду мегафункції
4XXmuxN

кількість інформаційних входів мультиплексора). 

зі списку доступних мегафункцій
_MUX), а 
What name

, але якщо директорія не відповідає потрібній, тр
(огляд) і в діалоговому вікні 

по черзі встановити потрібні папки, ввести ім’я фа
ла і зберегти (у віконці відобразиться директорія з ім’ям) > Next.  

file name, у разі по
реби, можна створити нову папку за допомогою піктограми.

inputs ...? ввести кіл
How wide should

ширину в бітах кожного з них і виходу 
шити 1, але для перемикача шин ввести потрібну їх ширину) > 

4.2.3.5 Відкрити утворені файли нового різновиду мегафункції
XXmuxN.tdf, .inc, .

 
мегафункцій виб-

), а справа –
name … ввес-

, але якщо директорія не відповідає потрібній, тре-
(огляд) і в діалоговому вікні Select

по черзі встановити потрібні папки, ввести ім’я фай-

, у разі пот-
реби, можна створити нову папку за допомогою піктограми. 

ввести кіль-
should 'data' 

ширину в бітах кожного з них і виходу 
шити 1, але для перемикача шин ввести потрібну їх ширину) > Finish. 

4.2.3.5 Відкрити утворені файли нового різновиду мегафункції із 
, .sym (тут 

б-
– 
с-
е-

Select 
й-

 
т-

ь-
' 

ширину в бітах кожного з них і виходу 
 
із 

(тут 



 

.

ємо на запитання: на сторінці 2
гафункції, на 
ня (

й ручним способом як подано в останньому необов’язковому пункті роботи.

ня

дами з меню): визначити ім’я прое
присвоїти

функції, вхідні та вихідний порти та згрупувати вхідні сигнали в шину.

з’являється автом

мегафункції, в якому виводи зображено компактно, у вигляді
рити його для перегляду.

вання у 

вставити символ
Plug
списку 

 

< Приклад:
.sym, 400mux16_inst.tdf.

F  Примітки
1. З метою відредагувати існуючий різновид мегафункції відповід

ємо на запитання: на сторінці 2
гафункції, на 
ня (Finish), або ще змінюємо директорію на сторінці 4.

2. Різновид мегафункції можна створити не тільки автоматично, але 
й ручним способом як подано в останньому необов’язковому пункті роботи.

4.2.
няя ним у графічних проектах виконанням 

дами з меню): визначити ім’я прое
присвоїти 

б) Ввести до графічного файла символ створеного різновиду мег
функції, вхідні та вихідний порти та згрупувати вхідні сигнали в шину.

ти пр
з’являється автом

г) Командою з меню 
мегафункції, в якому виводи зображено компактно, у вигляді
рити його для перегляду.

< Приклад:
4.2.

вання у графічному
4.2.

вставити символ
Plug-In Manager
списку Symbol

Приклад:
, 400mux16_inst.tdf.

Примітки
З метою відредагувати існуючий різновид мегафункції відповід

ємо на запитання: на сторінці 2
гафункції, на сторінці 3 коригуємо параметри і або завершуємо редагува

), або ще змінюємо директорію на сторінці 4.
Різновид мегафункції можна створити не тільки автоматично, але 

й ручним способом як подано в останньому необов’язковому пункті роботи.
4.2.3.6 Відредагувати символьний файл

я ним у графічних проектах виконанням 

4XXmN
дами з меню): визначити ім’я прое

 йому ім’я.
б) Ввести до графічного файла символ створеного різновиду мег

функції, вхідні та вихідний порти та згрупувати вхідні сигнали в шину.
в) Зберегти файл, перевірити й

ти проект піктограмою та керуванням вікна компілятора, яке 
з’являється автоматично (або командами з меню).

г) Командою з меню 
мегафункції, в якому виводи зображено компактно, у вигляді
рити його для перегляду.

Приклад:
4.2.4 Засвоїти основи настроювання мегафункцій і їх застос
графічному

4.2.4.1 До графічного файла (.
вставити символ

In Manager і відредагованого різновиду мегафункції 
Symbol Files

Приклад: файли 
, 400mux16_inst.tdf. 

Примітки: 
З метою відредагувати існуючий різновид мегафункції відповід

ємо на запитання: на сторінці 2
сторінці 3 коригуємо параметри і або завершуємо редагува

), або ще змінюємо директорію на сторінці 4.
Різновид мегафункції можна створити не тільки автоматично, але 

й ручним способом як подано в останньому необов’язковому пункті роботи.
3.6 Відредагувати символьний файл

я ним у графічних проектах виконанням 
а) Створити новий графічний файл (.

XXmN (послід
дами з меню): визначити ім’я прое

йому ім’я. 
б) Ввести до графічного файла символ створеного різновиду мег

функції, вхідні та вихідний порти та згрупувати вхідні сигнали в шину.
в) Зберегти файл, перевірити й
ект піктограмою та керуванням вікна компілятора, яке 

тично (або командами з меню).
г) Командою з меню 

мегафункції, в якому виводи зображено компактно, у вигляді
рити його для перегляду. 

Приклад: файл d:\max
Засвоїти основи настроювання мегафункцій і їх застос

графічному редакторі 
графічного файла (.

вставити символ створеного за допомогою менеджера
і відредагованого різновиду мегафункції 

Files діалогового вікна 

81

файли d:\max2

З метою відредагувати існуючий різновид мегафункції відповід
ємо на запитання: на сторінці 2b вибираємо тип файла і імена файла та м

сторінці 3 коригуємо параметри і або завершуємо редагува
), або ще змінюємо директорію на сторінці 4.
Різновид мегафункції можна створити не тільки автоматично, але 

й ручним способом як подано в останньому необов’язковому пункті роботи.
3.6 Відредагувати символьний файл

я ним у графічних проектах виконанням 
а) Створити новий графічний файл (.

(послідовністю наведених піктограм або кома
дами з меню): визначити ім’я проекту, відкрити новий графічний файл та 

б) Ввести до графічного файла символ створеного різновиду мег
функції, вхідні та вихідний порти та згрупувати вхідні сигнали в шину.

в) Зберегти файл, перевірити й
ект піктограмою та керуванням вікна компілятора, яке 

тично (або командами з меню).
г) Командою з меню File > Create

мегафункції, в якому виводи зображено компактно, у вигляді

max2work
Засвоїти основи настроювання мегафункцій і їх застос

редакторі (на прикладі варіантів п. 
графічного файла (.
створеного за допомогою менеджера

і відредагованого різновиду мегафункції 
діалогового вікна 

81 

2work\tutorial

З метою відредагувати існуючий різновид мегафункції відповід
вибираємо тип файла і імена файла та м

сторінці 3 коригуємо параметри і або завершуємо редагува
), або ще змінюємо директорію на сторінці 4.
Різновид мегафункції можна створити не тільки автоматично, але 

й ручним способом як подано в останньому необов’язковому пункті роботи.
3.6 Відредагувати символьний файл

я ним у графічних проектах виконанням таких
а) Створити новий графічний файл (.

вністю наведених піктограм або кома
ту, відкрити новий графічний файл та 

б) Ввести до графічного файла символ створеного різновиду мег
функції, вхідні та вихідний порти та згрупувати вхідні сигнали в шину.

в) Зберегти файл, перевірити його на помилки і скомпілюв
ект піктограмою та керуванням вікна компілятора, яке 

тично (або командами з меню).
Create Default

мегафункції, в якому виводи зображено компактно, у вигляді

work\tutorial\4
Засвоїти основи настроювання мегафункцій і їх застос

(на прикладі варіантів п. 
графічного файла (.gdf) нового проекту 4
створеного за допомогою менеджера

і відредагованого різновиду мегафункції 
діалогового вікна Enter Symbol

tutorial\4lab\400mux16.tdf, .inc, 

З метою відредагувати існуючий різновид мегафункції відповід
вибираємо тип файла і імена файла та м

сторінці 3 коригуємо параметри і або завершуємо редагува
), або ще змінюємо директорію на сторінці 4. 
Різновид мегафункції можна створити не тільки автоматично, але 

й ручним способом як подано в останньому необов’язковому пункті роботи.
3.6 Відредагувати символьний файл для зручності користува

таких дій. 
а) Створити новий графічний файл (.

вністю наведених піктограм або кома
ту, відкрити новий графічний файл та 

б) Ввести до графічного файла символ створеного різновиду мег
функції, вхідні та вихідний порти та згрупувати вхідні сигнали в шину.

ого на помилки і скомпілюв
ект піктограмою та керуванням вікна компілятора, яке 

тично (або командами з меню). 
Default Symbol

мегафункції, в якому виводи зображено компактно, у вигляді

lab\400m16.
Засвоїти основи настроювання мегафункцій і їх застос

(на прикладі варіантів п. 
) нового проекту 4

створеного за допомогою менеджера
і відредагованого різновиду мегафункції 

Symbol). 

400mux16.tdf, .inc, 

З метою відредагувати існуючий різновид мегафункції відповід
вибираємо тип файла і імена файла та м

сторінці 3 коригуємо параметри і або завершуємо редагува

Різновид мегафункції можна створити не тільки автоматично, але 
й ручним способом як подано в останньому необов’язковому пункті роботи.

для зручності користува

а) Створити новий графічний файл (.gdf) проекту 
вністю наведених піктограм або кома
ту, відкрити новий графічний файл та 

б) Ввести до графічного файла символ створеного різновиду мег
функції, вхідні та вихідний порти та згрупувати вхідні сигнали в шину.

ого на помилки і скомпілюв
ект піктограмою та керуванням вікна компілятора, яке 

Symbol створити символ 
мегафункції, в якому виводи зображено компактно, у вигляді шин

400m16.gdf, .sym
Засвоїти основи настроювання мегафункцій і їх застос

(на прикладі варіантів п. 4.2.2.1).  
) нового проекту 4XXgr

створеного за допомогою менеджера MegaWizard 
і відредагованого різновиду мегафункції 4ХХm

 
400mux16.tdf, .inc, 

З метою відредагувати існуючий різновид мегафункції відповіда-
вибираємо тип файла і імена файла та ме-

сторінці 3 коригуємо параметри і або завершуємо редагуван-

Різновид мегафункції можна створити не тільки автоматично, але 
й ручним способом як подано в останньому необов’язковому пункті роботи. 

для зручності користуван-

gdf) проекту 
вністю наведених піктограм або коман-
ту, відкрити новий графічний файл та 

б) Ввести до графічного файла символ створеного різновиду мега-
функції, вхідні та вихідний порти та згрупувати вхідні сигнали в шину. 

ого на помилки і скомпілюва-
ект піктограмою та керуванням вікна компілятора, яке 

створити символ 
шин, та відк-

sym. 
Засвоїти основи настроювання мегафункцій і їх застосу-

 
XXgr_mega

MegaWizard 
4ХХmN.sym (зі 

400mux16.tdf, .inc, 

а-
е-
н-

Різновид мегафункції можна створити не тільки автоматично, але 
  
н-

) проекту 
н-

ту, відкрити новий графічний файл та 

а-

а-
ект піктограмою та керуванням вікна компілятора, яке 

створити символ 
к-

у-

mega 
MegaWizard 

(зі 



 

(В2 по символу > 
так само, як і для макрофункцій; відмінності полягають у тому, що тепер к
ристуємося не нумерацією виводів ІС, а іменами портів (віконце 
інвертування окремих розрядів шин застосовуємо числа в одній із систем ч
слення (натиснути 
інвертування). Користуючись, наприклад, еквівалентною схемою на кшталт 
400
за схемою 1
на які слід подати 
дається значення 1, а т
тому код інвертування становитиме у цьому  прикладі 
0111 0010 0010” = Н”3722”, який і вводимо до віконця 
чотирьох систем числення, основу якої вибираємо прокруткою. П
т
добразяться 
ється завжди в шістнадцятковій системі числення). 

ної функції, виконати
натися в правильності проектування.

на мультиплексорах меншої розрядності. 

ми

зміру: наприклад, на схемі 1 чотири порти з’єднано з чотирма 
входами чотирирозрядною шиною. У випадку нерозгалужених шин їх можна 
не йменувати, бо за угодою розряди з’єднуються за старшинством, 
мери розрядів не обов

типлексорах різної розрядності; п
бов’язкові.

 

4.2.
(В2 по символу > 
так само, як і для макрофункцій; відмінності полягають у тому, що тепер к
ристуємося не нумерацією виводів ІС, а іменами портів (віконце 
інвертування окремих розрядів шин застосовуємо числа в одній із систем ч
слення (натиснути 
інвертування). Користуючись, наприклад, еквівалентною схемою на кшталт 
400rys.gdf, з’ясовуємо, що всі інфо
за схемою 1
на які слід подати 
дається значення 1, а т
тому код інвертування становитиме у цьому  прикладі 
0111 0010 0010” = Н”3722”, який і вводимо до віконця 
чотирьох систем числення, основу якої вибираємо прокруткою. П
тя (ОК) діалогового вікна рез
добразяться 
ється завжди в шістнадцятковій системі числення). 

4.2.
ної функції, виконати
натися в правильності проектування.

< Приклад: 
4.2.

на мультиплексорах меншої розрядності. 
< Приклад: 

ми 2, 3). 
F  Примітки
1. У графічному файлі з’єднувати можна шини тільки однакового р

зміру: наприклад, на схемі 1 чотири порти з’єднано з чотирма 
входами чотирирозрядною шиною. У випадку нерозгалужених шин їх можна 
не йменувати, бо за угодою розряди з’єднуються за старшинством, 
мери розрядів не обов

2. У п. 
типлексорах різної розрядності; п
бов’язкові.

4.2.4.2 Настроїти символ
(В2 по символу > Edit
так само, як і для макрофункцій; відмінності полягають у тому, що тепер к
ристуємося не нумерацією виводів ІС, а іменами портів (віконце 
інвертування окремих розрядів шин застосовуємо числа в одній із систем ч
слення (натиснути Patten
інвертування). Користуючись, наприклад, еквівалентною схемою на кшталт 

gdf, з’ясовуємо, що всі інфо
за схемою 1 з метою спрощення можна заземлити, якщо зінвертувати ті з них, 
на які слід подати логічну 1
дається значення 1, а т
тому код інвертування становитиме у цьому  прикладі 
0111 0010 0010” = Н”3722”, який і вводимо до віконця 
чотирьох систем числення, основу якої вибираємо прокруткою. П

(ОК) діалогового вікна рез
добразяться кружечком
ється завжди в шістнадцятковій системі числення). 

4.2.4.3 Увести інші елементи схеми
ної функції, виконати
натися в правильності проектування.

Приклад: 
4.2.4.4 У тому ж графічному файлі виконати п. 

на мультиплексорах меншої розрядності. 
Приклад: 

Примітки
У графічному файлі з’єднувати можна шини тільки однакового р

зміру: наприклад, на схемі 1 чотири порти з’єднано з чотирма 
входами чотирирозрядною шиною. У випадку нерозгалужених шин їх можна 
не йменувати, бо за угодою розряди з’єднуються за старшинством, 
мери розрядів не обов

У п. 4.2.4.4 достатньо 
типлексорах різної розрядності; п
бов’язкові. 

4.2 Настроїти символ
Edit Ports/Parameters

так само, як і для макрофункцій; відмінності полягають у тому, що тепер к
ристуємося не нумерацією виводів ІС, а іменами портів (віконце 
інвертування окремих розрядів шин застосовуємо числа в одній із систем ч

Patten/Radix
інвертування). Користуючись, наприклад, еквівалентною схемою на кшталт 

, з’ясовуємо, що всі інфо
з метою спрощення можна заземлити, якщо зінвертувати ті з них, 

логічну 1. У вікні редагування бітам, що інвертуються, н
дається значення 1, а тим, що залишаються неінвертованими, 
тому код інвертування становитиме у цьому  прикладі 
0111 0010 0010” = Н”3722”, який і вводимо до віконця 
чотирьох систем числення, основу якої вибираємо прокруткою. П

(ОК) діалогового вікна результати редагування (див. виділений символ) в
кружечком інверсії з кодом інвертування (на символі код под

ється завжди в шістнадцятковій системі числення). 

4.3 Увести інші елементи схеми
ної функції, виконати компіляцію та функціональне моделювання, перек
натися в правильності проектування.

Приклад: d:\max2work
У тому ж графічному файлі виконати п. 

на мультиплексорах меншої розрядності. 
Приклад: d:\max2

Примітки: 
У графічному файлі з’єднувати можна шини тільки однакового р

зміру: наприклад, на схемі 1 чотири порти з’єднано з чотирма 
входами чотирирозрядною шиною. У випадку нерозгалужених шин їх можна 
не йменувати, бо за угодою розряди з’єднуються за старшинством, 
мери розрядів не обов’язково 

4.4 достатньо 
типлексорах різної розрядності; п
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4.2 Настроїти символ: викликати діалогов
Parameters

так само, як і для макрофункцій; відмінності полягають у тому, що тепер к
ристуємося не нумерацією виводів ІС, а іменами портів (віконце 
інвертування окремих розрядів шин застосовуємо числа в одній із систем ч

Radix у закладці 
інвертування). Користуючись, наприклад, еквівалентною схемою на кшталт 

, з’ясовуємо, що всі інформаційні входи 
з метою спрощення можна заземлити, якщо зінвертувати ті з них, 

. У вікні редагування бітам, що інвертуються, н
м, що залишаються неінвертованими, 

тому код інвертування становитиме у цьому  прикладі 
0111 0010 0010” = Н”3722”, який і вводимо до віконця 
чотирьох систем числення, основу якої вибираємо прокруткою. П

ультати редагування (див. виділений символ) в
інверсії з кодом інвертування (на символі код под

ється завжди в шістнадцятковій системі числення). 

4.3 Увести інші елементи схеми
компіляцію та функціональне моделювання, перек

натися в правильності проектування. 
work\tutorial

У тому ж графічному файлі виконати п. 
на мультиплексорах меншої розрядності. 

2work\tutorial

У графічному файлі з’єднувати можна шини тільки однакового р
зміру: наприклад, на схемі 1 чотири порти з’єднано з чотирма 
входами чотирирозрядною шиною. У випадку нерозгалужених шин їх можна 
не йменувати, бо за угодою розряди з’єднуються за старшинством, 

зково будуть однакови
4.4 достатньо виконати один

типлексорах різної розрядності; п. 4.2.4.5...4.2.4.7 є факультативні, не
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: викликати діалогов
Parameters) і призначити порти у закладці 

так само, як і для макрофункцій; відмінності полягають у тому, що тепер к
ристуємося не нумерацією виводів ІС, а іменами портів (віконце 
інвертування окремих розрядів шин застосовуємо числа в одній із систем ч

у закладці Inversion
інвертування). Користуючись, наприклад, еквівалентною схемою на кшталт 

рмаційні входи 
з метою спрощення можна заземлити, якщо зінвертувати ті з них, 

. У вікні редагування бітам, що інвертуються, н
м, що залишаються неінвертованими, 

тому код інвертування становитиме у цьому  прикладі 
0111 0010 0010” = Н”3722”, який і вводимо до віконця 
чотирьох систем числення, основу якої вибираємо прокруткою. П

ультати редагування (див. виділений символ) в
інверсії з кодом інвертування (на символі код под

ється завжди в шістнадцятковій системі числення). 

4.3 Увести інші елементи схеми, потрібні для реалізації зад
компіляцію та функціональне моделювання, перек

tutorial\4lab\400
У тому ж графічному файлі виконати п. 

на мультиплексорах меншої розрядності.  
tutorial\4lab\400

У графічному файлі з’єднувати можна шини тільки однакового р
зміру: наприклад, на схемі 1 чотири порти з’єднано з чотирма 
входами чотирирозрядною шиною. У випадку нерозгалужених шин їх можна 
не йменувати, бо за угодою розряди з’єднуються за старшинством, 

однаковими: а3=х4, а2=х3, а1=х2, а0=
виконати один-

. 4.2.4.5...4.2.4.7 є факультативні, не

: викликати діалогове вікно редагування 
) і призначити порти у закладці 

так само, як і для макрофункцій; відмінності полягають у тому, що тепер к
ристуємося не нумерацією виводів ІС, а іменами портів (віконце 
інвертування окремих розрядів шин застосовуємо числа в одній із систем ч

Inversion та ввести до віконця код 
інвертування). Користуючись, наприклад, еквівалентною схемою на кшталт 

рмаційні входи IN[15..0] мультиплексора 
з метою спрощення можна заземлити, якщо зінвертувати ті з них, 

. У вікні редагування бітам, що інвертуються, н
м, що залишаються неінвертованими, 

тому код інвертування становитиме у цьому  прикладі 
0111 0010 0010” = Н”3722”, який і вводимо до віконця Patten
чотирьох систем числення, основу якої вибираємо прокруткою. П

ультати редагування (див. виділений символ) в
інверсії з кодом інвертування (на символі код под

ється завжди в шістнадцятковій системі числення).  

, потрібні для реалізації зад
компіляцію та функціональне моделювання, перек

400gr_mega
У тому ж графічному файлі виконати п. 4.2.

400gr_mega

У графічному файлі з’єднувати можна шини тільки однакового р
зміру: наприклад, на схемі 1 чотири порти з’єднано з чотирма 
входами чотирирозрядною шиною. У випадку нерозгалужених шин їх можна 
не йменувати, бо за угодою розряди з’єднуються за старшинством, 

ми: а3=х4, а2=х3, а1=х2, а0=
-два варіанти схеми на мул

. 4.2.4.5...4.2.4.7 є факультативні, не

е вікно редагування 
) і призначити порти у закладці 

так само, як і для макрофункцій; відмінності полягають у тому, що тепер к
ристуємося не нумерацією виводів ІС, а іменами портів (віконце Name
інвертування окремих розрядів шин застосовуємо числа в одній із систем ч

та ввести до віконця код 
інвертування). Користуючись, наприклад, еквівалентною схемою на кшталт 

[15..0] мультиплексора 
з метою спрощення можна заземлити, якщо зінвертувати ті з них, 

. У вікні редагування бітам, що інвертуються, н
м, що залишаються неінвертованими, – знач

тому код інвертування становитиме у цьому  прикладі IN[15..0] = В”0011 
Patten/Radix

чотирьох систем числення, основу якої вибираємо прокруткою. Після
ультати редагування (див. виділений символ) в

інверсії з кодом інвертування (на символі код под

, потрібні для реалізації зад
компіляцію та функціональне моделювання, перек

mega.gdf (схема 1), .
4.2.3, 4.2.4.1...

mega.gdf, .scf

У графічному файлі з’єднувати можна шини тільки однакового р
зміру: наприклад, на схемі 1 чотири порти з’єднано з чотирма адресними 
входами чотирирозрядною шиною. У випадку нерозгалужених шин їх можна 
не йменувати, бо за угодою розряди з’єднуються за старшинством, 

ми: а3=х4, а2=х3, а1=х2, а0=
два варіанти схеми на мул

. 4.2.4.5...4.2.4.7 є факультативні, не

е вікно редагування 
) і призначити порти у закладці Ports

так само, як і для макрофункцій; відмінності полягають у тому, що тепер ко-
Name) та для 

інвертування окремих розрядів шин застосовуємо числа в одній із систем чи-
та ввести до віконця код 

інвертування). Користуючись, наприклад, еквівалентною схемою на кшталт 
[15..0] мультиплексора 

з метою спрощення можна заземлити, якщо зінвертувати ті з них, 
. У вікні редагування бітам, що інвертуються, на-

значення 0, 
[15..0] = В”0011 

Radix в одній з 
ісля закрит-

ультати редагування (див. виділений символ) ві-
інверсії з кодом інвертування (на символі код пода-

, потрібні для реалізації зада-
компіляцію та функціональне моделювання, переко-

(схема 1), .scf. 
4.1...4.2.4.3 

scf (схе-

У графічному файлі з’єднувати можна шини тільки однакового ро-
адресними 

входами чотирирозрядною шиною. У випадку нерозгалужених шин їх можна 
не йменувати, бо за угодою розряди з’єднуються за старшинством, тому но-

ми: а3=х4, а2=х3, а1=х2, а0=х1.
два варіанти схеми на муль-

. 4.2.4.5...4.2.4.7 є факультативні, нео-

е вікно редагування 
Ports 
о-

) та для 
и-

та ввести до віконця код 
інвертування). Користуючись, наприклад, еквівалентною схемою на кшталт 

[15..0] мультиплексора 
з метою спрощення можна заземлити, якщо зінвертувати ті з них, 

а-
ення 0, 

[15..0] = В”0011 
в одній з 

т-
і-
а-

 
а-
о-

 
4.3 

е-

о-
адресними 

входами чотирирозрядною шиною. У випадку нерозгалужених шин їх можна 
о-
х1. 
ь-
о-



 

мультиплексорі 2:1, користуючись його символом, створеним безпос
ньо менеджером MegaWizard Plug

мегафункції мультиплексора 
один варіант мультиплексора).

бібліотеки мегафункцій 
гове вікно редагування (В2 по символу > 
мегафункції доступними є обидві закладки (

виділяємо параметр у віконці 
Parameter
клавіатури) і фіксуємо в графі 
на 
дуру, призначаємо всі параметри, доступні в графі 
ємо в закладці 
діленому символі наведеного нижче 

перейменувати порти), виконати компіляцію та функціональне модел
вання, пе

 

4.2.
мультиплексорі 2:1, користуючись його символом, створеним безпос
ньо менеджером MegaWizard Plug

< Приклад: 
4.2.

мегафункції мультиплексора 
один варіант мультиплексора).

а) Вставити символ мегафункції до файла звичайним чином, але з 
бібліотеки мегафункцій 
гове вікно редагування (В2 по символу > 
мегафункції доступними є обидві закладки (

б) Зручніше спочатку призначити параметри в закладці 
виділяємо параметр у віконці 
Parameter 
клавіатури) і фіксуємо в графі 
на видалити
дуру, призначаємо всі параметри, доступні в графі 
ємо в закладці 
діленому символі наведеного нижче 

в) Увести інші елементи схеми (за необхідн
перейменувати порти), виконати компіляцію та функціональне модел
вання, переконатися в правильності проектування.   

4.2.4.5 У тому ж графічному файлі
мультиплексорі 2:1, користуючись його символом, створеним безпос
ньо менеджером MegaWizard Plug

Приклад: 
4.2.4.6 У тому ж графічному файлі

мегафункції мультиплексора 
один варіант мультиплексора).

а) Вставити символ мегафункції до файла звичайним чином, але з 
бібліотеки мегафункцій 
гове вікно редагування (В2 по символу > 
мегафункції доступними є обидві закладки (

б) Зручніше спочатку призначити параметри в закладці 
виділяємо параметр у віконці 

 Name, вводимо його значення 
клавіатури) і фіксуємо в графі 
видалити значення, а відтак знов його ввести); повторюючи цю проц

дуру, призначаємо всі параметри, доступні в графі 
ємо в закладці Ports
діленому символі наведеного нижче 

в) Увести інші елементи схеми (за необхідн
перейменувати порти), виконати компіляцію та функціональне модел

реконатися в правильності проектування.   

У тому ж графічному файлі
мультиплексорі 2:1, користуючись його символом, створеним безпос
ньо менеджером MegaWizard Plug

Приклад: d:\max2work
У тому ж графічному файлі

мегафункції мультиплексора 
один варіант мультиплексора).

а) Вставити символ мегафункції до файла звичайним чином, але з 
бібліотеки мегафункцій d:\maxplus
гове вікно редагування (В2 по символу > 
мегафункції доступними є обидві закладки (

б) Зручніше спочатку призначити параметри в закладці 
виділяємо параметр у віконці 

, вводимо його значення 
клавіатури) і фіксуємо в графі 

значення, а відтак знов його ввести); повторюючи цю проц
дуру, призначаємо всі параметри, доступні в графі 

s так само, як і в п. 
діленому символі наведеного нижче 

в) Увести інші елементи схеми (за необхідн
перейменувати порти), виконати компіляцію та функціональне модел

реконатися в правильності проектування.   
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У тому ж графічному файлі
мультиплексорі 2:1, користуючись його символом, створеним безпос
ньо менеджером MegaWizard Plug-In Manager (без спрощення за п. 

work\tutorial
У тому ж графічному файлі

мегафункції мультиплексора mux за ручного її
один варіант мультиплексора). 

а) Вставити символ мегафункції до файла звичайним чином, але з 
maxplus2\max

гове вікно редагування (В2 по символу > 
мегафункції доступними є обидві закладки (

б) Зручніше спочатку призначити параметри в закладці 
виділяємо параметр у віконці Name/Value

, вводимо його значення 
клавіатури) і фіксуємо в графі Value кнопкою 

значення, а відтак знов його ввести); повторюючи цю проц
дуру, призначаємо всі параметри, доступні в графі 

так само, як і в п. 
діленому символі наведеного нижче рисунк

в) Увести інші елементи схеми (за необхідн
перейменувати порти), виконати компіляцію та функціональне модел

реконатися в правильності проектування.   
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У тому ж графічному файлі виконати п. 
мультиплексорі 2:1, користуючись його символом, створеним безпос

In Manager (без спрощення за п. 
tutorial\4lab\400

У тому ж графічному файлі виконати завдання п. 
за ручного її

а) Вставити символ мегафункції до файла звичайним чином, але з 
max2lib\mega

гове вікно редагування (В2 по символу > Edit Ports
мегафункції доступними є обидві закладки (Ports

б) Зручніше спочатку призначити параметри в закладці 
Value, ім’я якого з’являється у віконці 

, вводимо його значення Parame
кнопкою Change

значення, а відтак знов його ввести); повторюючи цю проц
дуру, призначаємо всі параметри, доступні в графі 

так само, як і в п. 4.2.4.2 (результат показано на нев
рисунку). 

в) Увести інші елементи схеми (за необхідн
перейменувати порти), виконати компіляцію та функціональне модел

реконатися в правильності проектування.   

виконати п. 
мультиплексорі 2:1, користуючись його символом, створеним безпос

In Manager (без спрощення за п. 
400gr_mega
виконати завдання п. 

за ручного її настроювання (достатньо 

а) Вставити символ мегафункції до файла звичайним чином, але з 
mega_lpm і викликати діал
Ports/Parameters

Ports і Parameters
б) Зручніше спочатку призначити параметри в закладці 

, ім’я якого з’являється у віконці 
Parameter Value 

Change (кнопкою 
значення, а відтак знов його ввести); повторюючи цю проц

дуру, призначаємо всі параметри, доступні в графі Name
4.2 (результат показано на нев

 

в) Увести інші елементи схеми (за необхідності, розщепити шини і 
перейменувати порти), виконати компіляцію та функціональне модел

реконатися в правильності проектування.    

виконати п. 4.2.4.1...4.2.
мультиплексорі 2:1, користуючись його символом, створеним безпос

In Manager (без спрощення за п. 
mega.gdf (схема 4), .

виконати завдання п. 
настроювання (достатньо 

а) Вставити символ мегафункції до файла звичайним чином, але з 
і викликати діал

Parameters), в якому для 
Parameters). 

б) Зручніше спочатку призначити параметри в закладці Parameters
, ім’я якого з’являється у віконці 

 (прокруткою або з 
(кнопкою Clear

значення, а відтак знов його ввести); повторюючи цю проц
Name. Порти признач

4.2 (результат показано на нев

, розщепити шини і 
перейменувати порти), виконати компіляцію та функціональне модел

4.2.4.3 на 
мультиплексорі 2:1, користуючись його символом, створеним безпосеред-

In Manager (без спрощення за п. 3.2.3.6). 
(схема 4), .scf. 

виконати завдання п. 4.2.2.1 на 
настроювання (достатньо 

а) Вставити символ мегафункції до файла звичайним чином, але з 
і викликати діало-

якому для 

Parameters: 
, ім’я якого з’являється у віконці 

(прокруткою або з 
Clear мож-

значення, а відтак знов його ввести); повторюючи цю проце-
. Порти признача-

4.2 (результат показано на неви-

 
, розщепити шини і 

перейменувати порти), виконати компіляцію та функціональне моделю-

4.3 на 
д-

 
 

2.1 на 
настроювання (достатньо 

а) Вставити символ мегафункції до файла звичайним чином, але з 
о-

якому для 

: 
, ім’я якого з’являється у віконці 

(прокруткою або з 
ж-
е-
а-
и-

 
, розщепити шини і 

ю-
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< Приклад. Для реалізації заданої логічної функції, наприклад, на 
мультиплексорі 8:1 вставляємо до файла мегафункцію mux (див. файл 
d:\max2work\tutorial\4lab\400gr_mega.gdf, схема 5). Викликаємо діалогове 
вікно редагування і в закладці Parameters, у віконці Name/Value, виділяємо 
параметр WIDTH – ширину інформаційної шини, вводимо значення 8 у ві-
конці Parameter Value і фіксуємо його в графі Value кнопкою Change. Від-
так переходимо до наступного параметра WIDTHS – ширини адресної (се-
лекторної – S) шини, яка для мультиплексора 8:1 дорівнює трьом, тому у 
віконці Parameter Value можна або залишити CEIL(LOG2(WIDTH)), або 
для наочності ввести значення 3 і зафіксувати кнопкою Change.  

Відтак редагуємо порти в закладці Ports (див. 
d:\max2work\tutorial\4lab\400rys.gdf, схема 2): вихід result і адресні входи 
sel[WIDTHS-1..0] залишаємо незмінними (Used – використовується, None – 
без інверсії), а розряди інформаційної шини data[WIDTH-1..0]  інвертуємо 
введенням Patten/Radix > 72 hex (або код в іншій системі числення).  

Після закриття діалогового вікна на символі мегафункції відобра-
зяться результати редагування. Інші елементи схеми вводимо як у звичай-
ному графічному файлі. Аби схема не потребувала надлишкового ресурсу 
(7 зайвих виводів pin і кілька комірок логічної матриці, адже немає сенсу 
деякі виводи ззовні закорочувати на землю), шину даних da[7..0] з метою 
зменшення на 7 вхідних портів розщеплюємо: лінію da6 відокремлюємо у 
вхідний порт, а інші її лінії з’єднуємо із землею. Крім того, імена ліній і 
шин узгоджуємо з назвами портів і виводів.  

Після компіляції та функціонального моделювання (файл 
d:\max2work\tutorial\4lab\400gr_mega.scf)  переконуємося в правильності 
проектування: функція y2а узгоджується з таблицею відповідності. 

F  Примітки: 
1. В узагальнених назвах параметра, наприклад, data[WIDTH-1..0] 

або sel[WIDTHS-1..0] цифри 1..0 означають не його величину, а те, що діа-
пазон зазначається стандартно – від старшого розряду до молодшого, на-
приклад, d[7..0], a[2..0].  

2. У мультиплексорах ширина адресної шини WIDTHS за замовчу-
ванням становить CEIL(LOG2(WIDTH)), де CEIL (ceiling – стеля) означає 
найближче ціле число, що не менше виразу в дужках, наприклад, 
CEIL(LOG2(7)) = 3, CEIL(LOG2(9)) = 4.  

3. На символі мегафункції параметри позначаються (вгорі в право-
му кутку бузковим кольором) за ввімкненої опції Show Parameters меню 
Options. 

4.2.4.7 У тому ж графічному файлі виконати завдання п. 4.2.2.1 на 
мегафункції мультиплексора lpm_mux за ручного її настроювання (дос-
татньо один варіант мультиплексора) аналогічно п. 4.6. 
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< Приклад: d:\max2work\tutorial\4lab\400gr_mega.gdf (схема 6), .scf. 
4.2.5 Засвоїти основи застосування мегафункцій у текстовому 

редакторі (на прикладі варіантів п. 4.2.2.1).  
4.2.5.1 У текстовому файлі (.tdf) нового проекту 4XXtx_mega вико-

нати завдання п. 4.2.2.1 на мегафункції зразка мультиплексора найбі-
льшої розрядності 4XXmuxN.inc, .sym, створеного менеджером 
MegaWizard Plug-In Mana-ger (п. 4.2.3), для чого виконати такі дії (задля 
наочності див. файл d:\max2work\tutorial\4lab\400gr_mega.gdf, схема 1 і 
приклад – фрагменти файла 4XXtx_mega.tdf, що наводяться під кожним 
пунктом):  

1) ввести заголовок (Title Statement); 
TITLE "у на основі мегафункцій "; 
2) включити вибрану мегафункцію до складу проекту: вставити ша-

блон оператора включення Include Statement і в лапках ввести ім’я різно-
виду мегафункції 4XXmuxN, надане під час його створення (п. 4.2.3.3), з 
розширенням файла включення .inc; 

INCLUDE "400mux16.inc";  
3) ввести вхідні і вихідні порти в секції підпроекту (Subdesign 

Section), використовуючи замість x[] інші імена змінних, наприклад, in[]; 
SUBDESIGN 400tx_mega 

( 
        in[4..1]     : INPUT; 
        y1             : OUTPUT; 
) 

4) вставити секцію змінних Variable Section; 
VARIABLE 
5) викликати підсекцію оголошення параметризованого зразка 

Instance Declaration (parametererized) і ввести в її шаблон ім’я зразка фу-
нкції (яке ми надаємо модулю настроєної мегафункції в уявній схемі), че-
рез двокрапку –  ім’я  мегафункції та після ключового слова WITH – її па-
раметри (кількість входів даних WIDTH і розрядність адресної шини 
WIDTHS); 

mx1   : 400mux16  
  WITH (WIDTH = 16, WIDTHS = 4); 

6) ввести логічний блок Logic Section; 
BEGIN 
END; 
7) між ключовими словами (BEGIN та END;) ввести оператор буле-

вих рівнянь Boolean Equation та вставити в утворений таким чином шаб-
лон через крапку з комою рівняння, якими з’єднати входи мегафункції з 



 86 

вхідними портами та вихідний порт – з виходом мегафункції.  
BEGIN 

mx1.sel[3..0] = in[4..1]; mx1.data[15..0] = H"3722"; y1 = mx1.result; 
END; 
8) виконати компіляцію та функціональне моделювання і перекона-

тися в правильності проектування (задля наочності див. файли 
d:\max2work\tutorial\4lab\400gr_mega.gdf, схема 1, 400gr_mega.scf).    

Приклад:  d:\max2work\tutorial\4lab\400tx _mega.tdf, .scf.  
F Примітка. Логічні зв’язки між виходами та входами мегафункції 

містяться у файлі її включення (п. 4.2.5.1, підпункт 2), тому в булевих рів-
няннях достатньо лише з'єднати входи і виходи зразка модуля, що репре-
зентує настроєну мегафункцію в проектованому пристрої, з вхідними і ви-
хідними портами пристрою. Входи і виходи зразка мають такі самі назви, 
як у мегафункції, але позначаються через крапку після імені зразка. У лівій 
частині рівнянь ставляться невідомі величини, а в правій – відомі, задані 
вхідними портами INPUT або визначені у файлі включення (у нас – result). 
У разі потреби, додаткові з'єднання виконуються через зовнішні відносно 
мегафункції логічні операції, наприклад, входи даних з’єднано з констан-
тами згідно з таблицею відповідності.  

4.2.5.2 У тому ж текстовому файлі виконати п. 4.2.5.1 на мегафун-
кціях мультиплексорів меншої розрядності, створених менеджером 
MegaWizard Plug-In Manager, шляхом доповнення розділів 2, 3, 5, 7 цього 
пункту потрібними даними (задля наочності див. файл 
d:\max2work\tutorial\4lab\400gr_mega.gdf, схеми 2, 3, 4).   

Приклад:  d:\max2work\tutorial\4lab\400tx _mega.tdf, .scf. 
F Примітка. У п. 4.2.5.2 достатньо виконати один-два варіанти 

схеми на мультиплексорах різної розрядності; п. 4.2.5.3, 4.2.5.4 є факульта-
тивними, необов’язковими. 

4.2.5.3 У тому ж текстовому файлі виконати п. 4.2.5.1 на мегафун-
кції мультиплексора mux шляхом доповнення підпунктів 2, 3, 5, 7 цього 
пункту потрібними даними (задля наочності див. файл d:\max2work\ 
tutorial\4lab\400gr_mega.gdf, схема 5). 

Приклад:  d:\max2work\tutorial\4lab\400tx _mega.tdf, .scf. 
F Примітка. Ім’я  мегафункції та її параметрів мають суворо відпо-

відати формату, які для функції mux можна зчитати безпосередньо з її си-
мволу в графічному файлі. 

5.2.5.4 У тому ж текстовому файлі виконати п. 4.2.5.1 на мегафун-
кції мультиплексора lpm_mux шляхом доповнення підпунктів 2, 3, 5, 7 
цього пункту потрібними даними (задля наочності див. файл 
d:\max2work\tutorial\4lab\400gr_mega.gdf, схема 6).   
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Приклад: d:\max2work\tutorial\4lab\400tx _mega.tdf, .scf. 
F Примітка. Ім’я та параметри мегафункції lpm_mux можна 

зчитати з її прототипу (AHDL Function Prototype) у довідці клацан-
ням по імені в текстовому файлі або по символу в графічному файлі (або з 
меню Help > Mega-functions/LPM > Iм'я мегафункції > AHDL Function 
Prototype, чи з контекстного меню клацанням В2 по графічному символу > 
Edit Ports/Parameters > Help on “Iм'я мегафункції” > AHDL Function 
Prototype). 

 
Контрольні питання та завдання 

1. Самостійно синтезувати мультиплексор за його текстовим опи-
сом:  

а) з використанням оператора таблиці відповідності Truth Table 
Statement (надати нове ім’я проекту 4XХtab, створити текстовий файл 
4XХtab.tdf, до якого ввести заголовок (Title Statement),  вхідні і вихідні векто-
ри (Subdesign Section), логічний блок (Logic Section),  підсекцію таблиці від-
повідності (Truth Table Statement), відтак виконати компіляцію, функціональ-
не моделювання та автоматичне порівняння утворених таким чином часових 
діаграм;  

б) з використанням умовного оператора If Then у проекті 
4XXif_then шляхом створення текстового файла 4XXif_then.tdf  і аналізу 
результатів так само, як у підпункті а), в якому замість таблиці відповідно-
сті ввести оператор If Then Statement;  

в) з використанням оператора вибору Case у проекті 4XXcase шля-
хом створення текстового файла 4XXcase.tdf  і аналізу результатів так само, 
як у підпункті а), в якому замість таблиці відповідності ввести оператор Case 
Statement. 

2. Як слід каскадувати мультиплексори з метою збільшення розряд-
ності?  

3. Як пов’язані між собою кількість адресних і інформаційних вхо-
дів у  мультиплексорі? 

4. Запишіть вираз для вихідної логічної функції мультиплексора 8:1 
та побудуйте його схему. 

5. Спроектуйте на мультиплексорах: 1) ЦКП для реалізації логічної 
функції, що задана варіантом завдання 2; 2) шифратор 4:2; 3) пріоритетний 
шифратор 4:2. 
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5  АРИФМЕТИЧНІ ПРИСТРОЇ 
Мета роботи: дослідження типових арифметичних пристроїв – 

суматорів, арифметико-логічних пристроїв, помножувачів і компараторів; 
побудова ЦКП на суматорах і компараторах; засвоєння основ створення іє-
рархічних проектів. 

Домашнє завдання 
! Спроектувати заданий згідно з варіантом (див. додаток А, варіанти 

завдання 5) пороговий елемент на суматорах і компараторах.  
5.1  Стислі теоретичні відомості 

5.1.1  Двійкові суматори 
Пристрій, що виконує арифметичну операцію додавання двох роз-

рядів а, b двійкових чисел А, В є півсуматором (HS - Halfsum - півсума). 
Його вихідні логічні функції суми s та перенесення (Carry) с до старшого 
розряду (рис. 5.1, а)  

 
а) 

 
б) 

 
в) 

 
г) 

 
д) 

 
е) 

 
ж) 

 
и) 

Рисунок 5.1 
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 abcbababas =⊕=+= ;  (5.1) 
можна реалізувати на елементах виключне АБО та І (рис. 5.1, б) або на 
елементах І-НЕ (рис. 5.1, в). 

Комбінаційний однорозрядний повний суматор або просто суматор 
(SM - Sum - сума) виконує операцію додавання двох розрядів аi, bi та пере-
несення сi  до цього розряду з попереднього (рис. 5.1, г).  Згідно з таблицею 
функції суми  si  у цьому розряді і перенесення до старшого розряду сi+1 
 ,; 1 iiiiiiiiiii cbcabaccbas ++=⊕⊕= +  (5.2) 
виконуються суматором за модулем 2 та мажоритарним елементом       
(рис. 5.1, д). Перетворенням (5.2) з урахуванням (5.1) дістанемо реалізацію 
на двох півсуматорах та елементі АБО (рис. 5.1, е).  

 
а)  

в) 

 
д)  

б)  
г) 

Рисунок 5.2 
Багаторозрядний суматор утворюється шляхом послідовного вві-

мкнення n суматорів, де n - кількість розрядів доданків (рис. 5.1, ж). Вихід 
старшого перенесення можна використати як старший розряд зчитуваної 
суми, для індикації переповнення розрядної сітки, а також для каскадуван-
ня багаторозрядних суматорів з метою збільшення розрядності доданків   
(рис. 5.1, и). З метою підвищення швидкодії групи розрядів можна 
з’єднувати за допомогою спеціальних схем пришвидшеного перенесення. 

Суматори використовуються як для додавання, так і для віднімання, 
якщо двійкові числа (операнди) зображати в оберненому або доповняль-
ному коді. Серед стандартних ІС суматорів найпоширенішими є однороз-
рядні повні суматори (по кілька в корпусі ІС) та дво- і чотирирозрядні  
(рис. 5.2, а), б), в). Бібліотека САПР містить також спеціальну макрофунк-
цію восьмирозрядного суматора (рис. 5.2, г) і мегафункцію суматора-
віднімача (рис. 5.2, д), яку легко настроїти на додавання або віднімання, а 
також на репрезентацію даних зі знаком або без знаку. Вхідний і вихідний 
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переноси можуть позначатися на символах 
або з номером розряду, або зручніше на-
звою відповідно cin (carry input)  та cout  
(carry output).  

Каскадування суматорів із застосу-
вання схем пришвидшеного перенесення 
тут не розглядається, бо за наявності су-
часних програмованих ІС це питання прак-
тично втрачає сенс. 

5.1.2 Комбінаційні помножувачі 
Програмно в мікропроцесорах та 

мікроЕОМ множення двійкових чисел здій-
снюють шляхом зсуву за допомогою ЦПП 
та додавання часткових добутків у сумато-
рах згідно з відомими алгоритмами. Про-
цедура множення виконується протягом 
багатьох тактів, що може спричинити зни-
ження швидкодії в неприйнятних межах, 
зокрема, радіотехнічних пристроїв та сис-

тем з обробкою інформації в реальному масштабі часу. 

 
а) 

 
б) 

Рисунок 5.3 

Таблиця 5.1 
i a1a0b1b0 y3y2y1y0 
0 0 0 0 0 0 0 0 0 
1 0 0 0 1 0 0 0 0 
2 0 0 1 0 0 0 0 0 
3 0 0 1 1 0 0 0 0 
4 0 1 0 0 0 0 0 0 
5 0 1 0 1 0 0 0 1 
6 0 1 1 0 0 0 1 0 
7 0 1 1 1 0 0 1 1 
8 1 0 0 0 0 0 0 0 
9 1 0 0 1 0 0 1 0 
10 1 0 1 0 0 1 0 0 
11 1 0 1 1 0 1 1 0 
12 1 1 0 0 0 0 0 0 
13 1 1 0 1 0 0 1 1 
14 1 1 1 0 0 1 1 0 
15 1 1 1 1 1 0 0 1 
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Підвищення швидкодії було досягнуто апаратно в ІС матрицевих 
помножувачів з ланцюжком суматорів часткових добутків. При цьому 
усталення всього добутку розтягується в часі перемиканням кількості су-
маторів у найдовшій діагоналі матриці суматорів. 

Найвища швидкодія досягається в комбінаційних помножувачах з 
безпосереднім формуванням розрядів остаточного добутку. Розглянемо для 
прикладу множення дворозрядних чисел A=a1a0 та B=b1b0 (табл. 5.1). Розряд-
ність добутку Y= y3y2y1y0 вибирається як сума розрядів співмножників. Функ-
цію для старшого розряду записуємо безпосередньо з таблиці, а інших розря-
дів мінімізуємо за допомогою діаграм термів (рис. 5.3, а) із застосуванням ре-
дукції: 

( ) .;;;;; 00031311230110 bayyyybayybaba =+===== βααββα  
Мінімізована схема (рис. 5.3, б) практично не поступається за шви-

дкодією реалізованій за первісними термами. 

 
а) 

 
б) 

 
в) 

 
г) 

Рисунок 5.4 
Для чисел зі старшим знаковим розрядом A=aza1a0, B=bzb1b0 знак 

добутку Y=yzy3y2y1y0 формується окремо, за допомогою елемента Виключ-
не АБО: .zzz bay ⊕=  

Серед стандартних ІС комбінаційних помножувачів (макрофункцій) 
поширеними є з розрядністю співмножників 2×2, 2×4 та 4×4 
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(рис. 5.4, а), б), в). Старші розряди співмножників a[], b[] та добутку у[] ре-
презентують знак числа, а вхід G є стробовим. Бібліотека САПР містить 
також мегафункцію помножувача lpm_mult (рис. 5.4, г), основними пара-
метрами якої є LPM_WIDTHA, LPM_WIDTHB, LPM_WIDTHP – розряд-
ність відповідно співмножників a[], b[] та добутку у[]. 

 
а) 

 
б) 

 
в) 

Рисунок 5.5 
5.1.3 Арифметико-логічні пристрої 
З метою уніфікації обладнання та спрощення операційних пристро-

їв, призначених для виконання різних арифметичних та логічних операцій, 
у цифровій техніці застосовують багатофункціональні блоки – арифмети-
ко-логічні пристрої АЛП (arithmetic-logic Unit, АLU). 

Подібно до суматора АЛП має входи двох операндів А, В, вхід і ви-
хід перенесення с0, сn та виходи результату F (для прикладу на рис. 5, а)  
наведено ІС чотирирозрядного АЛП, а на рис. 5, б) – типову макрофункцію 
АЛП). Крім функцій  суматора АЛП виконує ще низку логічних функцій, а 
також функцію компаратора з виходом К. 

З метою збільшення розрядності операндів АЛП каскадують так 
само, як і суматори: послідовним з’єднанням перенесень на кшталт пода-
ного на рис. 5.1, и) або для підвищення швидкодії через блоки пришвид-
шеного перенесення за допомогою спеціально для цього призначених ви-
ходів АЛП G, Р генерації та передачі перенесення. Використовувати АЛП 
доцільно на старих ІС жорсткої структури, але бібліотека САПР програмо-
ваних ІС також містить декілька різновидів макрофункцій.  

5.1.4 Цифрові компаратори  
Цифровими компараторами (схемами порівняння) називаються 

пристрої, що виконують кількісне порівняння двійкових чисел. Вони часто 
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використовуються для формування сигналу закінчення певної операції, зо-
крема, ознаки галуження програм. 

Співвідношення між двома двійковими числами 011... aaaA n−=  та 
011... bbbB n−=  встановлюють за допомогою функцій компаратора: A equal to 

B (aeb = 1, якщо А = В та aeb = 0, якщо А ≠ В ),  А less than В (alb = 1, якщо 
А < В та alb = 0, якщо А ≥  В),  А greater than В (agb = 1, якщо А > В та agb= 
=  0, якщо А ≤  В),  А less or equal В (aleb = 1, якщо А ≤  В та aleb = 0, якщо 
А > В),  А greater or equal В (ageb = 1, якщо А ≥ В та ageb = 0, якщо  А < В), 
А  not equal to В (aneb = 1, якщо А ≠ В та aneb = 0, якщо А = В). З усіх фун-
кцій порівняння тільки дві є незалежними, бо через них можна виразити 
інші. Якщо за основні правитимуть, наприклад, функції aeb і  agb, то aneb 
= .;;; albaebalebagebalbagbaebagebaeb +==+==  

 
а) 

 
б) 

 
в) 

 
г) 

Рисунок 5.6 
Зазначені функції порівняння чисел А, В базуються на функціях по-

рівняння двох їхніх розрядів ai, bi однакової ваги типу рівності yрi, більше 
yбi або менше yмi (рис. 5.6, а): 

,;; iіміiібіiірі bауbауbау ==⊕=  
які можна реалізувати на елементах виключне АБО-НЕ та заборона 
(рис. 5.6, б) або на поширеніших елементах (рис. 5.6, в). 

Багаторозрядні компаратори найвищої швидкодії можна синтезу-
вати також шляхом одночасного порівняння всіх розрядів, проте з усклад-
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ненням схеми, яка потребує багатовходових елементів. Цього недоліку 
можна уникнути, але з погіршенням швидкодії багатоступінчастим сполу-
ченням розрядних функцій. Вихідні функції групи розрядів є одночасно 
входами перенесень наступної групи, що зручно для каскадування компа-
раторів на ІС жорсткої структури з метою нарощування їх розрядності 
(рис. 5.6, г). Слід звернути увагу на те, що входи перенесень наймолодшої 
групи з'єднуються з константами як подано на схемі. 

 

 

  
Рисунок 5.7 

Серед стандартних ІС поширеними є компаратори (макрофункції) з 
розрядністю 4 та 8 (рис. 5.7). Бібліотека САПР містить також мегафункцію 
компаратора lpm_compare (див. рис. 7), основним параметром якої є 
LPM_WIDTH – розрядність порівнюваних чисел dataa[] та datab[].  

Крім спеціалізованих ІС ком-
параторів для порівняння чисел мо-
жуть використовуватися й інші 
ЦКП. Типовою є ідея використання 
для порівняння кодів суматорів: від-
німанням одного числа від іншого за 
різницею легко з'ясувати співвідно-
шення між ними. Якщо віднімання 
виконується шляхом додавання в 
оберненому коді (рис. 5.8), то всі ро-

зряди суми S = A +   + (2n – 1 – B) при A = B перетворюються на одиниці S 
= 2n – 1 = 11...1, тобто функцію yA=B = aeb можна сформувати за допомо-
гою елемента збігу. Якщо ж  A > B, то сума  S = A – B  + 2n –  1 ≥ 2n, тобто 
виникає перенесення cn до старшого розряду, яке i є ознакою функції yA>B = 
cn = agb.  Функцію yA<B = alb, як і інші, можна сформувати логічними еле-
ментами. Аналогічно і в АЛП (див. рис. 5.5, а) з'єднання виходів f0...f4 на 
елементі І, виконане всередині ІС, утворює функцію компаратора 
К=yA=B=aeb, шляхом комбінації якої з виходом перенесення за допомогою 
зовнішніх елементів можна утворити потрібні функції порівняння на 
кшталт зображеного на рис. 5.8. 

 
Рисунок 5.8 
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Рисунок
Дисплей ієрархічного проекту (рис. 

вигляді дерева, гілками якого є складові підпроекти. Кожна гілка позначена 
файла і значком відповідного підпроекту, а біля вершини ієрархії ро
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ються. Натисненням вершин дерево можна розгортати і згортати, а з меню 

змінити його орієнтацію – горизонтальну чи вертикальну. 
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Рисунок 5.9 
Дисплей ієрархічного проекту (рис. 5.9) відображає його структуру у 

вигляді дерева, гілками якого є складові підпроекти. Кожна гілка позначена 
файла і значком відповідного підпроекту, а біля вершини ієрархії ро

ташовано також значки допоміжних файлів, зокрема, звітного 
та ін. Подвійним клацанням по значку можна 

хічному дереві відкриті файли поміч
ються. Натисненням вершин дерево можна розгортати і згортати, а з меню 

горизонтальну чи вертикальну. 
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цьовується тільки в графічному редакторі. При цьому пристрій зображ
ється у вигляді, що нагадує структурну або функціональну схему, елеме
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імпульсів. У звіті навести також умовне графічне позначення за ДСТУ таких 
ЦКП зі стислим поясненням принципу їх дії. Розглянути особливості побудо-
ви і перемикання типового багаторозрядного суматора (макрофункції за 
схемою 3) та суматора на мегафункції (схема 4). 

5.2.1.2 Дослідити типовий арифметико-логічний пристрій 
(АЛП) на макрофункції серії 74 (схема 5) у режимах виконання арифмети-
чної операції додавання (при М=0) та логічної операції кон’юнкції (при 
М=1). 

5.2.1.3 Дослідити компаратори: за принциповими електричними 
схемами (файл d:\max2work\tutorial\5lab\5comp.gdf) та осцилограмами сиг-
налів (d:\max2work\tutorial\5lab\5comp.scf) однорозрядного компаратора 
(схема 1) на логічних елементах та типового багаторозрядного компара-
тора (макрофункції за схемою 2) скласти таблиці відповідності і рівняння 
вихідних функцій, виміряти затримку вихідних імпульсів. Розглянути осо-
бливості побудови і перемикання компаратора  на мегафункції (схема 3) та 
виконання функцій компаратора на основі багаторозрядного cуматора 
(схема 4). 

5.2.1.4 Ознайомитися зі стандартними арифметичними при-
строями серії 74 (макрофункціями) та параметризованими мегафункціями 
(файл d:\max2work\tutorial\5lab\5lіbr.gdf): суматорів і суматора-віднімача 
(Adder Macrofunctions, Parame-terized Adder/Subtractor Megafunctions); АЛП 
(Arithmetic Logic Unit Macro-functions); помножувачів (Multiplier 
Macrofunctions, Parameterized Multiplier Megafunctions) та компараторів 
(Comparator Macrofunctions, Parameterized Comparator Megafunction). Розг-
лянути функціональні прототипи, параметри, таблиці виконуваних функ-
цій різновидів арифметичних пристроїв (достатньо по одному з кожної 
групи), пояснити призначення та особливості входів і виходів. 

5.2.2 Застосувати арифметичні пристрої в графічному редакторі 
для побудови порогового елемента, заданого згідно з варіантом ХХ 

5.2.2.1 Скласти пристрій для підсумовування кількості N одинич-
них рівнів вхідних сигналів на макрофункціях суматорів вибраного типу в 
графічному файлі d:\max2work\tutorial\5lab\5XXsum.gdf проекту 5XХsum, 
виконати компіляцію і моделювання, переконатися в правильності функці-
онування пристрою за часовими діаграмами d:\max2work\tutorial\5lab\ 
5XXsum.sсf та створити символьний файл 5XXsum.sym (див. п. 3.2). 

F Примітка. Входи суматорів можна з’єднувати з розрядами чисел 
лише відповідної ваги (яка не завжди відображається на символах у назвах 
входів і виходів). 

< Приклад: d:\max2work\tutorial\5lab\500sum.gdf, .sсf, .sym. 
5.2.2.2 Скласти пороговий елемент у новому графічному файлі 
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5XXp_el.gdf проекту 5XХp_el, для чого скопіювати і вставити до цього 
файла суматор 5XXsum.gdf (п. 5.2.2.1) і доповнити файл компаратором: 
1) на логічних елементах, 2) на налаштованій макрофункції компаратора 
дібраного типу, 3) на налаштованій мегафункції компаратора, 4) на авто-
матично створеному за допомогою менеджера MegaWizard Plug-In Manager 
різновиді мегафункції компаратора 5XXcmp.sym (п. 4.2). Відтак виконати 
компіляцію і моделювання та переконатися в правильності функціонуван-
ня пристрою за часовими діаграмами 5XХp_el.sсf.  

< Приклад: d:\max2work\tutorial\5lab\500p_el.gdf, .sсf, 500cmp.sym.  
5.2.3 Засвоїти основи сумісного застосування макро- і мегафун-

кцій у текстовому редакторі на прикладі виконання завдання п. 5.2.2 
(на зразок схеми 5XXp_el.gdf (п. 5.2.2.2) з четвертим варіантом компарато-
ра). 

1) Створити новий текстовий файл 5XXpe.tdf, включити його до 
проекту 5XХpe і ввести заголовок Title Statement (під кожним пунктом на-
водиться приклад варіанта 00). 

TITLE "Пороговий елемент на SM і CMP";     
2) У секції Include Statement включити до проекту автоматично 

створений різновид мегафункції компаратора 5XXcomp.inc (п. 5.2.2.2). 
INCLUDE "500cmp.inc";          
3) У секції Function Prototype Statement ввести прототипи макрофу-

нкцій суматорів (можна скопіювати з довідки Help). 
FUNCTION 74183 (1cn0, 1b, 1a, 2cn0, 2a, 2b)  
 RETURNS (1sum, 1cn1, 2sum, 2cn1);        
FUNCTION 7482 (a[2..1], b[2..1], c0)         
 RETURNS (sum[2..1], c2);  
4) У секції Subdesign Section повторити ім’я проекту 5XХpe та ого-

лосити вхідні і вихідні порти. 
SUBDESIGN 500pe                              
( 
 x1, x2, x3, x4, x5, x6, x7  :  INPUT; 
 p, N[2..0]                               :  OUTPUT; 
) 
5) Ввести секцію змінних Variable Section. 
VARIABLE                                    
6) Вставити підсекцію Instance Declaration і подати імена зразків 
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(через двокрапку) оголошеним у п. 2), 3) макро- і мегафункціям (для наоч-
ності у прикладі d:\max2work\tutorial\5lab\500p_el.gdf імена зразків позна-
чено для суматорів і четвертого варіанта компаратора). 

 sm1 : 74183;  sm2 : 7482;   cmp : 500cmp; 
7) Викликати логічну секцію Logic Section; 
BEGIN 
END;                
8) Вставити до неї підсекцію Boolean Equation і рівняннями з'єднати 

зразки функцій між собою та з оголошеними портами INPUT і OUTPUT. 
BEGIN                                       
 sm1.1cn0=x1; sm1.1a=x2; sm1.1b=x3;      
 sm1.2cn0=x4; sm1.2a=x5; sm1.2b=x6;      
 sm2.b1=sm1.1sum; sm2.b2=sm1.1cn1;          
 sm2.a1=sm1.2sum; sm2.a2=sm1.2cn1; sm2.c0=x7; 
 cmp.dataa[]=(sm2.c2, sm2.sum2, sm2.sum1); 
 p=cmp.ageb; N[]=(sm2.c2, sm2.sum2, sm2.sum1); 
END; 
8) Відтак виконати компіляцію і моделювання та переконатися в 

правильності функціонування пристрою за часовими діаграмами 
5XХpe.sсf.  

< Приклад: d:\max2work\tutorial\5lab\500pe.tdf, .sсf. 

5.2.4 Засвоїти основи створення ієрархічного проекту виконан-
ням завдання п. 5.2.2 (на зразок схеми 5XXp_el.gdf з четвертим варіан-
том компаратора) 

5.2.4.1 Скласти пороговий елемент у новому графічному файлі 
5XXhier.gdf проекту 5XХhier (на кшталт структурної схеми), для чого 
вставити до цього файла символи пристроїв, створені в графічних і/або те-
кстових файлах проектів нижчого рівня, та, у разі потреби, додаткові будь-
які компоненти (примітиви, макро- чи мегафункції) і з’єднати їх між собою 
належним чином. Для прикладу варіанта 00 потрібно вставити створений у 
графічному файлі символ суматора d:\max2work\tutorial\5lab\500sum.sym 
(п. 5.2.2.1) та створений у текстовому файлі за допомогою менеджера 
MegaWizard Plug-In Manager символ компаратора d:\max2work\tutorial\5lab\ 
500cmp.sym (п. 5.2.2.2), а також вхідні і вихідний порти. 

5.2.4.2 Виконати компіляцію і моделювання та переконатися в 
правиль-ності функціонування пристрою за часовими діаграмами 



 

5

Display), в якому спостерігати 
танням (
також допомі
нтувати дерево для зручного його перегляду та копіювання: меню Option >
Orientation > Vertical / Horizontal. Ознайомитися в загальних рисах зі змі
том основних і допоміжних файлів, зокрема, зі звітного файла 
вати 

можна пікто
файла досить двічі клацнути по його значку на ієрархічному дереві (або 
клацнути В2 > 
світлюються б
смужка від
Shift
можна к
Close
складних проектів. 

 

5XХhier.sсf. 

інстр
Display), в якому спостерігати 
танням (-) його г
також допомі
нтувати дерево для зручного його перегляду та копіювання: меню Option >
Orientation > Vertical / Horizontal. Ознайомитися в загальних рисах зі змі
том основних і допоміжних файлів, зокрема, зі звітного файла 
вати блок-

< Приклад

шини дерева ієрархії) або пересунути його на передній план вікна 
можна пікто
файла досить двічі клацнути по його значку на ієрархічному дереві (або 
клацнути В2 > 
світлюються б
смужка від
Shift виділ
можна командою з мен
Close Editor
складних проектів. 

1. Як слід каскадувати з метою збільшення розрядності 1) суматори, 

XХhier.sсf.  

5.2.4.3 Відкрити файл ієрархічного дисплея
інструментальної панелі (або з меню MAX+plus II > Hierarchy 

Display), в якому спостерігати 
) його гілок із значками основних файлів, що утворюють проект, а 

також допоміжні файли, значки яких розташовані поруч із деревом. Зорі
нтувати дерево для зручного його перегляду та копіювання: меню Option >
Orientation > Vertical / Horizontal. Ознайомитися в загальних рисах зі змі
том основних і допоміжних файлів, зокрема, зі звітного файла 

-схему, нумерацію та призначення виводів
Приклад:
F Примітка.

шини дерева ієрархії) або пересунути його на передній план вікна 
можна піктограмою з інструментальної панелі. Для відкриття будь
файла досить двічі клацнути по його значку на ієрархічному дереві (або 
клацнути В2 > Open
світлюються бузкові смужки. Одноразове клацання виділяє файл чорним, а 
смужка відкритого файла стає червоною; клацанням за натиснутої клавіші 

виділяється декілька файлів. Відкрити всі виділені файли одночасно 
мандою з мен

Editor. Наведені операції особливо корисні під час опрацювання 
складних проектів. 

1. Як слід каскадувати з метою збільшення розрядності 1) суматори, 

4.3 Відкрити файл ієрархічного дисплея
ментальної панелі (або з меню MAX+plus II > Hierarchy 

Display), в якому спостерігати 
лок із значками основних файлів, що утворюють проект, а 

ні файли, значки яких розташовані поруч із деревом. Зорі
нтувати дерево для зручного його перегляду та копіювання: меню Option >
Orientation > Vertical / Horizontal. Ознайомитися в загальних рисах зі змі
том основних і допоміжних файлів, зокрема, зі звітного файла 

схему, нумерацію та призначення виводів
: d:\max2work

Примітка. Відкрити головний проектний файл (файл ве
шини дерева ієрархії) або пересунути його на передній план вікна 

рамою з інструментальної панелі. Для відкриття будь
файла досить двічі клацнути по його значку на ієрархічному дереві (або 

Open Editor), при цьому вгорі значкі
зкові смужки. Одноразове клацання виділяє файл чорним, а 

ритого файла стає червоною; клацанням за натиснутої клавіші 
ється декілька файлів. Відкрити всі виділені файли одночасно 

мандою з меню File
. Наведені операції особливо корисні під час опрацювання 

складних проектів.  

Контрольні питання
1. Як слід каскадувати з метою збільшення розрядності 1) суматори, 

99

4.3 Відкрити файл ієрархічного дисплея
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нтувати дерево для зручного його перегляду та копіювання: меню Option >
Orientation > Vertical / Horizontal. Ознайомитися в загальних рисах зі змі
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Контрольні питання
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том основних і допоміжних файлів, зокрема, зі звітного файла 
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р-
лок із значками основних файлів, що утворюють проект, а 

є-
нтувати дерево для зручного його перегляду та копіювання: меню Option > 

с-
ю-

р-
шини дерева ієрархії) або пересунути його на передній план вікна 

якого 
файла досить двічі клацнути по його значку на ієрархічному дереві (або 

и-
зкові смужки. Одноразове клацання виділяє файл чорним, а 

ритого файла стає червоною; клацанням за натиснутої клавіші 
ється декілька файлів. Відкрити всі виділені файли одночасно 

> 
. Наведені операції особливо корисні під час опрацювання 

1. Як слід каскадувати з метою збільшення розрядності 1) суматори, 
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2) АЛП, 3) компаратори? 

2. Реалізуйте на основі заданих в дужках пристроїв і, за необхіднос-
ті, додаткових логічних елементів таку арифметичну операцію та підра-
хуйте швидкодію її виконання: 

1) a0 + b0 + c0 (І-НЕ), 
2) a0 + b0 + c0 (АБО-НЕ),  
3) a1a0 + b1b0 (виключне АБО),  
4) a1a0 + b1b0 (дешифратор),  
5) a2a1a0 + b2b1b0  (півсуматори),  
6) a2a1a0 + b2b1b0  (повні однорозрядні суматори),      
7) a2a1a0 –  b2b1b0  (повні однорозрядні суматори),  
8) a2a1a0 –  b2b1b0  (чотирирозрядний суматор).  

3. Спроектуйте на основі суматорів: 
а) мажоритарні елементи: 

1) на 5 входів; 
2) на 7 входів; 
3) на 9 входів; 
4) на 11 входів; 

б) порогові елементи: 
1)   2 з 5; 
2)   3 з 6; 
3)   3 з 7; 
4)   4 з 5; 
5)   4 з 6; 
6)   4 з 8; 
7)   4 з 9; 
8)   5 з 7; 
9)   5 з 8; 
10) 6 з 9. 

Підрахуйте, скільки потрібно було б елементів І-НЕ для побудови 
такої схеми. 

4. Спроектуйте на основі мультиплексорів: 
1) мажоритарний елемент на 3 входи,  
2) пороговий елемент 2 з 5,  
3) компаратор рівності трирозрядних кодів,  
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4) півсуматор,  
5) суматор,  
6) компаратор дворозрядних чисел з функціями “рівно” та “більше”. 

5. Реалізуйте цифровий компаратор: 
а) 4-розрядних чисел на: 

1) логічних елементах для двох основних функцій порівняння; 
2) дешифраторі та мультиплексорі для функції рівності; 
3) мультиплексорах для двох функцій порівняння; 
4) АЛП для всіх функцій порівняння; 
5) суматорах для всіх функцій порівняння;, 

б) 12-розрядних чисел для трьох функцій порівняння на основі: 
1) 4-розрядних компараторів; 
2) 4-розрядних суматорів; 
3) 4-розрядних АЛП. 
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6   ТРИГЕРИ 

Мета роботи: дослідження типових тригерів; побудова ЦПП на 
основі тригерів; засвоєння основ застосування тригерів у проектах, вико-
ристання шаблону оголошення регістрів/тригерів (Register Declaration).  

Домашнє завдання 
! За дóзвільного рівня Enable синхроімпульсом Clock записати до 

тригерів дані і сформувати на їхніх виходах логічну функцію, задану варі-
антом завдання 1, але за власним вибором базису (див. додаток А, варіанти 
завдання 6). 

 
6.1  Стислі теоретичні відомості 

6.1.1 Класифікація тригерів 
Тригером (trigger – спусковий гачок вогнепальної зброї) називається 

пристрій з двома стійкими станами, що змінює їх стрибкоподібно під дією 
керувальних сигналів. Один зі стійких станів відповідає інформаційному 
значенню логічного 0, а другий – логічної 1, отже, такий ЦПП здатний за-
пам’ятовувати і зберігати 1 біт інформації, тому найпростіші тригери нази-
вають також бістабільними комірками або елементами пам’яті.  

Рівні сигналів, за яких тригер залишається в режимі збереження, на-
зивають пасивними, а які спричиняють його перемикання – активними. Ві-
дповідно і входи тригера називають прямими, якщо активними є рівні логі-
чної 1, та інверсними, якщо активними є рівні логічного 0.  

За способом запису інформації тригери поділяють на асинхронні та 
синхронні. В асинхронних тригерах перемикання відбувається в той самий 
момент часу, коли змінюється комбінація інформаційних сигналів, а в син-
хронних – лише з надходженням синхроімпульсу. За способом синхроніза-
ції тригери поділяють на два типи. Тригери зі статичним керуванням (ке-
ровані рівнем) перемикаються протягом дії активного рівня синхросигна-
лу: логічної 1 (прямий статичний синхровхід) або логічного 0 (інверсний 
статичний синхровхід). Тригери з динамічним керуванням (керовані фрон-
том) перемикаються лише під час дії активного перепаду напруги синхроі-
мпульсу: від логічного 0 до логічної 1, тобто за його позитивним фронтом 
(прямий динамічний синхровхід), або від логічної 1 до логічного 0, тобто 
за його негативним фронтом чи спадом (інверсний динамічний синхров-
хід). За логікою функціонування практичного значення набули лише декі-
лька типів тригерів. Основними можна вважати тригери типів RS, D, T та 
JK, а всі інші є їх різновидами або  комбінованими тригерами, в яких су-
міщаються функції тригерів кількох типів. 
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6.1.2  Асинхронні тригери  
6.1.2.1 RS-тригери 
RS-тригерами називають тригери з роздільним установленням (за-

пуском) за допомогою двох входів: S (Set – установлення) – вхід установ-
лення до одиничного стану Q = 1 та R (Reset – повернення, скидання) – 
вхід скидання до нульового стану Q = 0. Часто застосовують скорочені на-
зви асинхронних тригерів: типу RS для тригерів з прямими входами 
(рис. 6.1, а) та типу SR  для тригерів з інверсними входами (рис. 6.1, б), в). 
Правила функціонування тригера зручно задавати таблицею відповідності, 
яку називають також  перемикальною таблицею або таблицею станів. Для   
RS тригера з прямими входами таку таблицю наведено на рис. 6.1, г). Вона 
визначає стан Q+,  до якого має перейти тригер з попереднього стану Q,  
якщо на його входи  R,  S  подати зазначену комбінацію сигналів. За пасив-
них рівнів  R = S = 0  (вхідні кортежі  i = 0, 1) тригер  перебуває в режимі 
схову Q+ = Q; установлення до одиничного стану (i = 2, 3) та скидання до 
нульового (i = 4, 5) здійснюється активними рівнями відповідно S = 1 та R 
= 1 однойменних сигналів, причому цей стан або підтверджується (i = 3, 4), 
або тригер до нього перемикається (i = 2, 5); комбінація   R⋅ S  = 1 (i = 6, 7) 
є забороненою, бо надходження активних рівнів на обидва входи може 
призвести після одночасного припинення їх дії до невизначеного тану Q+ = 
Х. У кінцевому підсумку правила функціонування тригера можна описати 
за допомогою вкороченої перемикальної таблиці (рис. 6.1, д).  

 
а) 

 
г) 

 
д) 

 
б) 

 
е) 

 
в) 

 
ж) 

 
и) 

 
к) 

Рисунок 6.1 
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Із перемикальної таблиці для SR -тригера з інверсними входами       
(рис. 6.1, е) випливає, що рівні  логічної 1 для  нього є пасивними: при R
 = S  = 1 тригер перебуває в режимі схову Q+ = Q, активними рівнями R  = 0 
та S = 0 він відповідно скидається та встановлюється, а комбінація R  + S  
= 0 є забороненою. Тригери з прямими і інверсними входами є дуальні, бо 
інвертуванням змінних їх перемикальні таблиці перетворюються одна в 
одну.  

Внаслідок цього RS- та SR -тригери аналітично описуються одна-
ковими логічними функціями Q+ (R, S, Q), що відображають залежність 
вихідного сигналу Q+ від зовнішніх змінних – сигналів R, S та внутрішньої 
змінної – попереднього стану Q. Такі функції називаються характеристи-
чними рівняннями. Для їх мінімізації за допомогою таблиці станів (див. 
рис. 6.1, г) або безпосередньо за правилами функціонування тригера буду-
ємо діаграму термів (рис. 6.1, ж). Довизначаючи факультативні значення 
функції до Х = 1 та об’єднуючи одиниці, отримуємо характеристичне рів-
няння тригера 
 Q+ = S + Q R , якщо RS = 0. (6.1) 

Підставляючи можливі комбінації змінних, крім забороненої, яка 
подана обмежувальною умовою в (6.1), неважко переконатись, що це рів-
няння описує аналітично правила функціонування тригера. 

Під час синтезу послідовнісних пристроїв з використанням тригерів 
як елементної бази доводиться розв'язувати завдання, обернене аналізу, 
коли вихідні сигнали стають аргументами, а вхідні – функціями, які нази-
ваються функціями збудження. Отримання їх полегшується за допомогою 
таблиці переходів (рис. 6.1, и), що визначає, яку комбінацію  сигналів не-
обхідно подати на входи тригера, аби він перейшов зі стану Q до стану Q+. 
Так, із таблиці станів RS-тригера (див. рис. 6.1, г) визначаємо, що перехо-
дові Q →  Q+ = 0 → 0 відповідають комбінації RS = 00 (кортеж i = 0) або 
RS = 10 (i = 4), тому в першому рядку таблиці занотовуємо код RS = Х0, де,  
як завжди, Х = 0 або 1. Так само заповнюємо й інші рядки таблиці перехо-
дів RS-тригера, а для SR -тригера досить зінвертувати значення змінних. 
Довизначаючи в цій таблиці Х = 1, можна виразити мінімальні функції 
збудження RS-тригера через стан Q+, до якого він має перейти за довільно-
го початкового стану:  
 R = Q +; S = Q+ при Q = Х. (6.2) 

Наочніше переходи від одного стану до іншого, подані таблицею 
переходів, можна відобразити графічно – за допомогою спрямованого сиг-
нального графа (або просто графа) тригера (рис. 6.1, к). У його вершинах, 
зображених колами, зазначають стани тригера Q = 0  та 1, а біля гілок (ре-
бер, дуг) – коди сигналів RS, що відповідають даному переходові. Гілки, 
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які замикаються біля однієї вершини, утворюють петлі, що відображають 
стійкі стани тригера. Так, петлі RS = Х0 відповідає режим збереження 
Q = 0, гілці RS = 01 – перехід тригера до стійкого стану Q = 1, в якому він 
перебуває, і при повторенні цієї комбінації сигналів, що відображається 
петлею 0Х. Відсутність на графі комбінації RS = 11 означає, що вона є за-
боронена.  

6.1.2.2 Схемна реалізація асинхронних RS-тригерів. Побудова 
тригерів базується на створенні позитивного зворотного зв’язку (ПЗЗ) 
шляхом перехресного з’єднання виходів і входів логічних елементів 
(рис. 6.2, а), б). Коли під час перемикання тригера обидва елементи опи-
няються в активному режимі, тобто стають підсилювачами, внаслідок дії 
ПЗЗ виконуються умови самозбудження. Завдяки цьому стан тригера вияв-
ляється нестійким, тимчасово пристрій стає генератором (релаксатором – 
джерелом розривних, негармонічних коливань) і в ньому виникає регене-
ративний процес лавиноподібного перемикання (перекидання) до одного зі 
стійких станів. Регенеративний процес припиняється, коли один з елемен-
тів опиняється в режимі відсічки або інший – у режимі насичення, бо при 
цьому порушується баланс амплітуд (як відомо, в обох зазначених режи-
мах коефіцієнт підсилення за змінним струмом дорівнює нулю). 

Для SR -тригера на елементах І-НЕ (див. рис. 6.2, а) згідно з аксіо-
мою алгебри логіки х ⋅ 1 = х пасивними є рівні логічної 1, тому він функці-
онує за перемикальною таблицею на рис. 6.1, е). Якщо при  R  = S  = 1 аси-
нхронний SR -тригер перебуває в режимі збереження, наприклад, у стані 
Q = 0, як показано на схемі рис. 6.2, а) кодами в першій позиції станів та 
рівнями сигналів на часових діаграмах рис. 6.2, в) при t < t1, то з надхо-
дженням у момент t1 активного рівня логічного 0 до входу S  (у другій по-
зиції станів верхнім індексом нуль S  = 00 позначено, що від цього моменту 
відлічується час перемикання елементів схеми) спочатку перемикається 
плече Q з однією затримкою tз.п (верхній індекс 1), а відтак плече Q  з дво-
ма затримками tз.п (індекс 2) відносно появи рівня S  = 0. Кількість затри-
мок tз.п на ідеалізованих часових діаграмах для спрощення показано циф-
рами 1, 2. Аналогічно відбувається й скидання тригера до стану Q = 0 рів-
нем R  = 0, як показано в третій позиції станів на схемі та на часових діаг-
рамах, починаючи з моменту t2. 

Отже, час затримки поширення сигналу від входів до виходів триге-
ра, тобто тривалість його перемикання до повного усталення вихідного коду 
при переході від стану 0 до стану 1 та навпаки, становить t01 = t10 = tT = 2tз.п. 
Тригер надійно спрацює, тобто не зможе повернутися до попереднього ста-
ну за зникнення активного рівня вхідного сигналу, якщо цей сигнал трива-
тиме до закінчення  процесу  регенеративного  перемикання: ti ≥ 2tз.п. Проте, 
якщо активний сигнал на другому вході  з’явиться одразу ж після переми-
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За діаграмою термів RSC-тригера (рис. 6.7, д), складеною, як і ра-
ніше, з урахуванням попереднього стану Q, мінімізуємо характеристичне 
рівняння 

 Q+ = СS + CR Q, якщо СRS = 0, (6.5) 
з обмежувальною умовою, що виключає заборонену комбінацію вхідних 
сигналів СRS = 1. З рівняння виходить, що при С = 0 у тригері забезпечу-
ється режим схову Q+ = Q, а при С = 1 вираз (6.5) перетворюється до (6.1).  

 
а) 

 
в) 

 
г) 

 
д) 

 
б) 

 
е) 

 
ж) 

 
и) 

Рисунок 6.7 
Таблиця переходів і граф RSC-тригера (рис. 6.7, е), ж) відрізняють-

ся лише доповненням стійких станів при С = 0 та сигналу C = 1 при інших 
переходах. Часто користуються вкороченою таблицею переходів, яка вка-
зує переходи Q → Q+ тільки при C=1; тоді вона збігається з таблицею 
RS-тригера (див. рис. 6.1, и) і функції збудження при C = 1 збігаються з 
(6.2). 

За допомогою паралельних входів кінцевого асинхронного тригера 
(див. рис. 6.1, в), 6.2, а) синхронні тригери різних типів можуть виконува-
тися з одним, наприклад, R′ або двома R′ /, S′ / установлювальними входа-
ми (рис. 6.7, и), призначеними для асинхронного (незалежно від рівнів усіх 
інших сигналів) установлення до визначеного стану, найчастіше для ски-
дання до Q = 0 перед виконанням певної операції. Синхронні тригери типів 
RC, SC, ЕС при C = 0 зберігають початковий стан, а при C = 1 функціону-
ють за  правилами відповідних асинхронних тригерів (п. 6.1.2.2). 
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6.1.3.5 Схемна реалізація RSC-тригерів. Двофазний RSC-тригер зі 
статичним керуванням аналогічно однофазному D-тригеру будується за уза-
гальненою схемою рис. 6.8, а). Логічними елементами пристрою керування 
ПК з вхідних сигналів Х формуються сигнали R0, S0 на входах комірки 
пам’яті. У RSC-тригері (рис. 6.8, б) вхідні елементи з надходженням активно-
го рівня C = 1 виконують функції інверторів інформаційних сигналів, тому 
однойменні входи всього пристрою S, R стають  прямими і тригер функціо-
нує за перемикальною таблицею на рис. 6.7, в). За допомогою додаткових 
входів асинхронного тригера (пунктир) виконують тригери з установлюваль-
ними входами.  

 
а) 

 
г) 

 
б) 

 
д) 

 
в) 

 
е) 

 
ж) 

Рисунок 6.8 
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Внаслідок додаткової затримки сигналів у вхідних елементах І-НЕ, 
як зазначено позиціями кодів на схемі рис. 6.8, б) та кількістю затримок 
tз.п на часових діаграмах рис. 6.8, в) тривалість перемикання синхронного 
тригера збільшується на одну затримку порівняно з асинхронним і стано-
вить tT =3tз.п, тому потрібна тривалість синхроімпульсів і робоча частота 
такі самі, як у D-тригера. 

Дуальний CSR -тригер виконується на елементах АБО-НЕ 
(рис. 6.8, г), а використання інверсного входу елемента І-НЕ (елемент за-
борони з інверсією або імплікатор у схемотехніці Т-ТТЛ) дозволяє досить 
просто побудувати RSC-тригер з інверсним синхровходом (рис. 6.8, д) на 
елементах того самого типу технології (ТТЛ), що й тригер з прямими вхо-
дами. Шляхом суміщення функцій вхідних елементів і комірки пам’яті 
можна побудувати синхронні RS-тригери на елементах І-АБО-НЕ з пря-
мими та інверсними входами (рис. 6.8, е), ж). Завдяки різнополярному ке-
руванню парами тригерів на рис. 6.8, б), г) та рис. 6.8, е), ж) спрощується 
виконання на них двоступінчастих тригерів в єдиному технологічному ци-
клі. У сучасних серіях ІС статичні RSC-тригери окремо майже не випус-
каються, вони широко застосовуються у складі тригерів з динамічним ке-
руванням.   

6.1.4  Тригери з динамічним керуванням  
6.1.4.1 Т-тригери. Т-тригером (від Togle – перемикач станів) нази-

вається тригер з лічильним входом С (рис. 6.9, а), який при С = 0 перебуває 
в режимі  схову Q+ = Q (рис. 6.9, б), а з надходженням активної частини 
чергового імпульсу (позначеної як С = 1) змінює свій стан на протилежний 
Q+ = Q . Т-тригер здійснює лічбу за модулем 2, бо з кожним вхідним імпу-
льсом перемикається між двома станами 0 та 1, тому називається також лі-
чильним тригером. 

 
а) 

 
б) 

 
г) 
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Рисунок 6.9 
Згідно з діаграмою термів (рис. 6.9, в) його характеристичне рів-

няння можна виразити через операцію додавання за модулем 2: 
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 Q+ = С Q  + C Q  =  С  ⊕ Q, (6.6) 

що відповідає таблиці переходів (рис. 6.9, г). Підставляючи до (6.6) Q = 0, 
отримаємо С = Q+, а при Q = 1 маємо С = +Q , що можна коротко відобра-
зити у вигляді функції збудження: 
 С = Q+,  якщо Q = 0;  С = +Q , якщо Q = 1. (6.7) 

Граф тригера (рис. 6.9, д), побудованого на одному елементарному 
потенціальному тригері з двома можливими станами 0 та 1, при С = 1 
утворює замкнене коло (заштриховане), тобто тригер переходитиме безпе-
рервно з одного стану до іншого, поки С = 1, як автоколивальний генера-
тор. Отже, тригер буде нестійким, якщо його граф утворює замкнене коло 
з однаковими сигналами біля гілок (крім петель). Тому не можна побудува-
ти стійкий тригер на одному елементарному потенціальному тригері, якщо 
його перемикальна таблиця містить перехід Q+ = Q . 

Усунути цей недолік і, отже, реалізувати стійкий лічильний тригер 
можна, якщо активна частина імпульсу С закінчиться після його переходу з 
одного стану до іншого, тобто за допомогою динамічного керування 
(рис. 6.9, е). Інший шлях полягає в доповненні графа більшою кількістю ста-
нів (завдяки чому замкнене коло розривається), що можна здійснити в триге-
рному пристрої, складеному, наприклад, з двох потенціальних тригерів. 

ТЕ-тригер (рис. 6.9, ж) з додатковим входом Е (від Enable –дозвіл) 
дозволяє гнучкіше будувати послідовнісні пристрої. Якщо вхід Е викорис-
товувати як керувальний, під час Е = 0 тригер не перемикається, а при Е = 
1 функціонує як лічильний тригер. За використання входу Е як синхровхо-
ду утворюється синхронний лічильний тригер, моменти перемикання якого 
задаються не зміною інформації на лічильному вході, а надходженням си-
нхроімпульсів.  

6.1.4.2 JК-тригери. Аналогічно RSC-тригерам JK-тригери 
(рис. 6.10, а) мають крім синхровходу С два інформаційні входи: J (Jerk – 
раптове вмикання) – вхід установлення до стану логічної 1 та К (Kill – рап-
тове вимикання) – вхід скидання до стану логічного 0, тобто вхід J відпо-
відає входові S тригера типу RSC, а вхід K – входові R. Поширений різно-
вид JKЕ-тригера (рис. 6.10, б) має, як і ТЕ-тригер, вхід дозволу Е. 
JK тригер функціонує як RSC-тригер (на рис. 6.10, в) наявність активного 
перепаду синхроімпульсу позначено стрілкою, а його відсутність – рис-
кою), але на відміну від нього не має забороненої комбінації вхідних сиг-
налів: при СJK = 1 (у рівняннях наявність активного перепаду синхроімпу-
льсу позначатимемо як С = 1, а його відсутність – як С = 0) він перемика-
ється до протилежного стану Q+ = Q , тобто як Т-тригер. Внаслідок цього 
для забезпечення стійкості JK-тригери виконуються з динамічним керу-
ванням, наприклад, за двоступінчастою схемою, як зазначено на 
рис. 6.10, б). 
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Рисунок 6.10 
Із характеристичного рівняння JK-тригера, мінімізованого за допо-

могою діаграми термів (рис. 6.10, г) 
 Q+ = CJQ  + СQ + К Q = CJQ  + CК Q, (6.8) 

та перетвореного при С = 1 до рівняння асинхронного JK-тригера 
 Q+ = J Q  + К Q, (6.9) 

можна визначити, які сигнали необхідно подати на його інформаційні вхо-
ди аби з надходженням синхроімпульсу він перемикався до потрібного 
стану Q+. Так, якщо Q = 0, з (6.9) дістанемо J = Q+ при довільному значенні 
K = Х, а якщо Q = 1, то K = +Q  при J = Х. Лаконічно це можна відобразити 
у вигляді функцій збудження 

 J = Q+, K = Х, якщо Q = 0;  J = Х,  K = +Q , якщо Q = 1, (6.10) 

або вкороченої таблиці переходів (рис. 6.10, д), дійсної при С = 1. З таблиці 
видно, що переходи Q → Q+ до протилежного стану можуть відбуватись у 
режимі як RS-тригера, так і Т-тригера при  J = K = 1. 

Для JKЕ-тригера (див. рис. 6.10, б) перемикальна таблиця 
(рис. 6.10, е) при Е = 1 відповідає таблиці JK-тригера, а при Е = 0 зберіга-
ється початковий стан Q+ = Q. 

6.1.4.3 Реалізація динамічних тригерів за двоступеневою схемою 
МS. У мікросхемотехніці набули поширення універсальні потенціальні 
тригери за двоступеневою схемою МS (Master-Slave – господар-невільник, 
основний-допоміжний). Ідея побудови такої схеми ґрунтується на двотак-
тному принципі дії пристрою, складеному з двох синхронних тригерів М 
та S зі статичним керуванням (рис. 6.11, а). 

У тригері за схемою MS з інвертором синхроімпульси C та С  на вхо-
дах тригерів М, S рознесено в часі, тому вони перемикатимуться по черзі. У 
першому такті при C = 1, С  = 0 вхідна інформація записується до тригера М, 
а тригер S залишається в початковому стані; у другому – при C = 0, С  = 1, 
навпаки, тригер М перебуває в режимі схову, а інформація з його виходів пе-
реписується до тригера S. Уведенням перехресних зворотних зв’язків з вихо-
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дів на входи (пунктир) можна реалізувати режим Т-тригера: за кожні два так-
ти пристрій перемикатиметься до протилежного стану. Головна особливість 
схеми полягає в тому, що під час перемикання кожного тригера інформація 
на його входах залишатиметься сталою, бо коли перемикається один з них, 
другий перебуває в режимі схову. Це зумовлює стійку роботу пристрою, 
який, на відміну від одноступінчастого потенціального тригера зі зворотними 
зв’язками, не зможе перемкнутись протягом такту більше одного разу. 

Розглянемо докладніше функціонування схеми в режимі 
RSC-тригера (без пунктирних зворотних зв’язків на рис. 6.11, а). 

 
а) 

 
в) 

 
б) 

Рисунок 6.11 
Хай у початковому стані, позначеному першою позицією кодів на 

схемі та рівнями напруг при t < t1 на часових діаграмах (рис. 6.11, б), за від-
сутності синхроімпульсу тригер М перебуває в режимі схову, наприклад, 
Q1= 0, а рівнем C  = 0 тригер S підтримується в стані тригера М: Q = Q1=0. 

На етапі підготовки (друга позиція кодів, момент t ≥ t1) з надхо-
дженням синхроімпульсу С інформація зі входів J ≡ S та К ≡ R запису-
ється до тригера М як у звичайному RSC-тригері (див. рис. 8,а,б), тому 
етап підготовки продовжується протягом tT1 = 3tз.п і для надійного переми-
кання тригера тривалість синхроімпульсів має бути ti > 3tз.п. При цьому рі-
внем C  = 0 тригер S підтримується в початковому стані. 
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На етапі перемикання (третя позиція кодів, t ≥ t2), після закінчення 
синхроімпульсу тригер М залишається в режимі схову, а рівнем C  = 1 
тригер S перемикається до стану М. Через наявність інвертора в колі синх-
роімпульсу етап перемикання збільшується на одну затримку і триває 
tT2 = 4tз.п. Отже, разом час затримки перемикання тригера становить 
tT = tT1+ t  = 7tз.п. Проте, він встигне перемкнутись, якщо пауза між  синхро-
імпульсами буде 3tз.п, тому мінімальний період синхроімпульсів становить 
T = 6tз.п і максимальна робоча частота f = 1/6tз.п. Перемикання тригера у 
зворотному напрямку в моменти t3, t4 відбувається аналогічно. 

Отже, за позитивним фронтом синхроімпульсу вхідна інформація 
записується до тригера М, а за негативним його фронтом – до  тригера S. 
Якщо синхронізувати тригер короткими позитивними імпульсами С, то з 
точки зору споживача вихідної інформації Q вона затримується на трива-
лість імпульсу ti, тому такі тригери називають тригерами з внутрішньою 
затримкою або з внутрішньою пам’яттю. Час затримки поширення сигналу 
в розглянутому тригері відносно негативного фронту синхроімпульсу ста-
новить tT = tT2 = 4tз.п. 

У RSC-тригері, як звичайно, не можна одночасно подавати рівні логі-
чної 1 на обидва інформаційні входи. Якщо ввести перехресні зворотні 
зв’язки (пунктир), отримаємо JK-тригер, який функціонує аналогічно 
RSC тригеру. У стані, наприклад, Q = 0 при J = 1, К = 0 з надходженням син-
хроімпульсу сигналами на входах першого ступеня S1 = JQ  = 1, R1 = КQ = 0 
він так само, у два етапи, перемикається до стану Q = 1. Після перемикання 
тригера М, при С = 1, зміна вхідної інформації не сприйматиметься. Дійсно, 
рівнем C = 0 тригер S підтримується в певному стані, наприклад, Q = 0, тому 
кон’юнкція на вході R1= 0 не залежить від рівня К, а на вході S1= J (бо Q = 1) 
сигнал завади не здатний перемкнути тригер М: за обох можливих комбіна-
цій S1 = 1, R1 = 0 та S1 = R1 = 0 лише підтверджується стан Q1 = 1, тобто схема 
функціонує як тригер з динамічним керуванням.  

Перевагою JK-тригера є некритичність до зміни інформації на вхо-
дах: її заборонено змінювати лише протягом 3tз.п після надходження пози-
тивного фронту синхроімпульсу, коли перемикається тригер М; якщо ім-
пульси С короткі, можна цю вимогу спростити, дозволивши зміну сигналів 
J, К в паузах між синхроімпульсами. 

Друга відміна від RSC-тригера полягає в тому, що при J = K = 1 
схема зі зворотними зв’язками функціонує як Т-тригер. Дійсно, рівні логі-
чної 1 на інформаційних входах не змінюють кон’юнкцію, тому інформа-
ція зчитуватиметься зі зворотних зв’язків. У стані Q = 0 сигналами на вхо-
дах S1 = JQ  = 1, R1 = КQ = 0 з надходженням синхроімпульсу в момент t1 
тригер перемкнеться до протилежного стану Q = 1 так само, як показано на 
діаграмах (тільки рівні J = K = 1 залишаються сталими), а в момент tз – до 
стану Q = 0. 
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Під час функціонування схеми на входах асинхронного тригера у 
складі ступеня М – у точках А,В ( 00 , SR  на рис. 6.8, а) формуються імпуль-
си, які можна використати для синхронізації другого ступеня, скоротивши 
інвертор (рис. 6.11, в). Утворений таким чином різновид схеми МS із забо-
роненими зв'язками функціонує аналогічно схемі МS з інвертором: під час 
перемикання тригера М хоча б один із сигналів 00 , SR  дорівнює логічному 
0, який подібно до сигналу C = 0 забороняє перемикання тригера S, а в 
проміжках між синхроімпульсами встановлюються рівні 00 SR = = 1 і три-
гер S переходить до стану М. 

У схемі МS з різнополярним керуванням (рис. 6.11, г) використовують-
ся тригери М та S із протилежним активним рівнем С (див. рис. 6.8, а), д), то-
му при безпосередньому з’єднанні синхровходів до одного з цих тригерів до-
зволено запис інформації, а другий перебуває в режимі схову. 

З огляду на відсутність інвертора в схемах на рис. 6.11, в), г) час за-
тримки тригера становить tT = tT1 = tT2 = 3tз.п, проте мінімальний період і 
робоча частота синхроімпульсів такі ж самі: tT = 6tз.п, f = 1/6tз.п.  

6.1.4.4 Перетворення тригерів з динамічним керуванням. В інтег-
ральній схемотехніці з-поміж тригерів з динамічним керуванням найбіль-
шого поширення набули тригери типів JK та D, які є універсальними, бо 
з’єднанням їх входів безпосередньо або за допомогою зовнішніх елементів 
можна побудувати тригери потрібного типу. 

 
а) 

 
б) 

 
в) 

 
г) 

 
д) 

 
е) 

 
ж) 

 
и) 

Рисунок 6.12 
Тригери типу RSС або JK перетворюються до однофазного 

D-тригера з використанням зовнішнього інвертора (рис. 6.12, а). Якщо вхід 
D має бути інверсним, досить інвертор ввімкнути до протилежного входу 
двофазного тригера відносно рис. 6.12, а) або просто перейменувати вихо-
ди тригера (рис. 6.12, б). Природно, такі перетворення придатні для триге-
рів як зі статичним, так і з динамічним керуванням. 
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Від RSC-тригера з динамічним входом С легко перейти до 
JK-тригера за допомогою дубльованих входів (пунктир на рис. 6.11, а) або 
зовнішніх елементів І. JK-тригер безпосередньо виконує функції 
RSC-тригера з динамічним керуванням (фрагмент умовного позначення на 
рис. 6.12, в), якщо заборонити комбінацію CJK = 1. Реалізація Т-тригера на 
JK-тригері (рис. 6.12, г) очевидна: при J = K = 1 характеристичне рівняння 
(6.8) JK-тригера перетворюється до характеристичного рівняння (6.6) 
Т-тригера. На підставі того, що при J = K = 0 тригер залишається в режимі 
схову, а при J = K = 1 перемикається до протилежного стану, реалізується 
ТЕ-тригер (рис. 6.12, д). Аналогічно рис. 6.8, а) за допомогою асинхронних 
входів, наприклад, R, S (рис. 6.12, е) утворюються тригери з установлюва-
льними входами типів JKRS, TRS, DRS тощо. 

Якщо в D-тригері з динамічним керуванням вхід D з’єднати з вихо-
дом Q , то при D = Q  його рівняння (6.3) перетворюється в (6.6), тобто 
схема стає Т-тригером (рис. 6.12, ж). За допомогою зовнішнього елемента 
І-НЕ організується ТЕ-тригер (рис. 6.12, и), який перемикатиметься за не-
гативним фронтом синхроімпульсів, бо при Е = 1 вони потрапляють до 
прямого динамічного входу С через інвертор. 

6.1.4.5 Примітиви і макрофункції тригерів з динамічним керу-
ванням. Бібліотека програмного комплекту містить тригери з динамічним 
керуванням типу JK, JKE (рис. 6.13, а), T, TE (рис. 6.13, б), D, DE 
(рис. 6.13, в), до назви яких долучається абревіатура FF (Flipflop). Прямий 
динамічний синхровхід позначається на символі трикутничком, а для інве-
рсного додається ще маленьке коло. Тригери виконано з асинхронними 
установлювальними входами CLRN (Clear – скидання, очищення) та PRN 
(Preset – передустановлення); до назви інверсних входів додається літера N 
(Not). Спеціалізовані для пакета макрофункції (рис. 6.13, г) відтворюють, 
по суті, тригери типу D і DE, а типові макрофункції серії 74 
(рис. 6.13, д), е) містять, в основному, тригери типу D і JK (по декілька 
тригерів у корпусі ІС). 
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б) 
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г) 
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е) 

Рисунок 6.13 
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6.1.5 Застосування тригерів у текстовому редакторі 
У графічному редакторі примітиви, макро- і мегафункції тригерів і 

інших елементів бібліотеки ЦПП застосовують так само, як і елементи біб-
ліотеки ЦКП. Проте в текстовому редакторі використовують спеціальні за-
соби програмного забезпечення. 

Примітиви тригерів запроваджують до проекту за допомогою під-
секції оголошення регістрів/тригерів Register Declaration секції змінних 
Variable Section і далі застосовують в булевих рівняннях Boolean Equation 
логічної секції Logic Section так само, як і зразки інших елементів. При 
цьому якщо зразок має лише один вхід або вихід, ім’я цього виводу в буле-
вих рівняннях можна не зазначати: у лівій частині рівнянь ім’я зразка 
означатиме вхід, а в правій частині – його вихід. Макрофункції  тригерів 
попередньо, зазвичай, вносять до складу проекту (Include Statement) із за-
значенням їх імен і параметрів в підсекції Instance Declaration 
(parametererized) секції змінних (Variable Section) і далі застосовують в бу-
левих рівняннях.  

 
6.2  Лабораторне завдання 

6.2.1  Дослідити основні типи тригерів 
6.2.1.1 Дослідити асинхронний RS-тригер з інверсними входами 

(RS/-тригер) на елементах І-НЕ: за принциповою електричною схемою та 
осцилограмами сигналів (файли 6asyn.gdf, .scf) скласти таблиці відповід-
ності (перемикальну) і переходів, мінімізовані рівняння вихідних функцій, 
виміряти затримку вихідних імпульсів; розглянути особливості побудови і 
перемикання макрофункції цього тригера та принципової схеми і макро-
функції асинхронного RS-тригера з прямими входами (RS-тригер). У звіті 
навести також умовне графічне позначення за ДСТУ таких тригерів зі сти-
слим поясненням принципу їх дії та осцилограм сигналів.  

6.2.1.2 Дослідити синхронний D-тригер зі статичним керуван-
ням (Latch – защіпка) на елементах І-НЕ за п. 6.2.1.1 (файли 
d:\max2work\tutorial\6lab\6stat.gdf, .scf) та розглянути особливості побудови 
і перемикання макрофункції і мегафункції цього тригера та схеми синх-
ронного RS-тригера (RSC-тригер). 

6.2.1.3 Дослідити синхронний JK-тригер з динамічним керуван-
ням структури MS (схема 1) за п. 6.2.1.1 (файли 
d:\max2work\tutorial\6lab\6dyn.gdf, .scf); розглянути особливості побудови і 
перемикання базових примітивів JKFF, TFF i DFF (схеми 2, 3, 4), Т-тригера 
на основі D-тригера (схема 5), макрофункції D-тригера expdff (схема 6), 
Т-тригера на основі типової макрофункції JK-тригера (схема 7), мегафунк-
ції D-тригера lpm_dff (схема 8) та універсальної мегафункції lpm_ff (схе-
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ма 9), налаштованої на виконання функції D-тригера з інверсним динаміч-
ним керуванням. 

6.2.1.4 Ознайомитися з різновидами тригерів бібліотеки бази да-
них (файл d:\max2work\tutorial\6lab\6lіbrе.gdf): примітивами, макрофункці-
ями (у тому числі вибраними ІС серії 74) та мегафункціями. Розглянути 
функціональні прототипи (FUNCTION), таблиці відповідності та інші до-
відкові дані (див. п. 1.1.2, в), пояснити призначення та особливості входів 
(основних) і виходів. 

6.2.2 Застосувати тригери в графічному редакторі для зберіган-
ня вхідних даних з подальшою реалізацією на їх основі логічної функ-
ції, що задана згідно з варіантом ХХ: за дóзвільного рівня Enable синх-
роімпульсом Clock записати до тригерів дані і сформувати на їх вихо-
дах потрібну логічну функцію 

6.2.2.1 Скласти пристрій на примітивах тригерів вибраного типу 
і логічних елементів у графічному файлі 6XXy.gdf проекту 6XХy за струк-
турною схемою 6str.gdf, виконати компіляцію і моделювання та перекона-
тися в правильності його функціонування за часовими діаграмами 
6XXy.sсf. 

< Приклад: →= 012 dddy  d:\max2work\tutorial\6lab\600y.gdf (схе-
ма 1), d:\max2work\tutorial\6lab\600y.sсf (вихід y). 

6.2.2.2 Виконати п. 2.1 на мегафункціях тригерів вибраного типу і 
логічних елементів (див. п. 4.2.2). 

< Приклад: d:\max2work\tutorial\6lab\600y.gdf (схема 2), 
d:\max2work\tutorial\6lab\600y.sсf (вихід y1). 

6.2.2.3 Виконати п. 6.2.2.1 на автоматично створених за допомо-
гою менеджера MegaWizard Plug-In Manager різновидах мегафункцій 
тригерів і логічних елементів (див. п. 4.2.5.1). 

F Примітки: 
1. Для створення тригера на сторінці 2а діалогового вікна менедже-

ра слід вибрати категорію storage i мегафункцію LPM_FF, на сторінці 3 – 
кількість тригерів, їх тип та встановити прапорець входу дозволу, а сторін-
ку 4 щодо необов’язкових (optional) установчих входів – пропустити. Під 
час створення логічної функції входи доцільно згорнути в шину: на сторі-
нці 3 діалогового вікна встановити прапорець Show input as bus. 

2. У графічному файлі d:\max2work\tutorial\6lab\600y.gdf (схема 1) 
для прикладу наведено перетворення RS- і JK-тригерів у D-тригер та ін-
вертування біта даних на виході тригера (схема 1), або безпосередньо на 
вході мегафункції (схема 2), або за допомогою вхідного інвертора (схе-
ма 3). При цьому назви ліній і шин мають відрізнятися (у прикладі data i 
dat), адже сигнали в них з урахуванням інверсії є різні.  
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< Приклад: d:\max2work\tutorial\6lab\600wiz_3d.sym, d:\max2work\ 
tutorial\6lab\600wiz_3and.sym, d:\max2work\tutorial\6lab\600y.gdf (схема 3), 
d:\max2work\tutorial\6lab\600y.sсf (вихід y2). 

 
6.2.3 Застосувати тригери в текстовому редакторі виконанням 

завдання за п. 6.2.2 
 
6.2.3.1 Створити пристрій на основі примітивів тригерів вибра-

ного типу у тестовому файлі 6XXreg_decl.tdf проекту 6XXreg_decl на 
кшталт схеми 1 файла 6XXy.gdf, для чого в секцію змінних (Variable 
Section) вставити шаблони підсекції оголошення регістрів/тригерів 
(Register Declaration), в яких ввести умовне ім’я зразка (на схемі 
d:\max2work\tutorial\6lab\600y.gdf зазначено в дужках) та через двокрапку 
назву вибраного типу тригера; відтак у логічну секцію (Logic Section) вста-
вити шаблон підсекції булевих рівнянь (Boolean Equation), за допомогою 
яких утворити з’єднання на зразок графічного файла. Перевірити правиль-
ність функціонування пристрою за часовими діаграмами 6XXreg_decl.sсf. 

< Приклад: d:\max2work\tutorial\6lab\600reg_decl.tdf, .sсf. 
SUBDESIGN 600reg_decl 
( 
 E, C, d[2..0]   : INPUT ; 
 y            : OUTPUT; 
) 
VARIABLE                                        
 de : DFFE;                                 
 sre       : SRFFE;                                
 jke       : JKFFE;                                
BEGIN                                           

de.D=d2; de.CLK=C; de.ENA=E; sre.S=d1; sre.R=!d1; 
sre.CLK=C;  sre.ENA=E; jke.J=d0; jke.K=!d0; jke.CLK=C; 
jke.ENA=E; y=de.Q & !sre.Q & jke.Q;                    

END; 
F Примітка. Якщо зразок має лише один вхід або вихід, ім’я цього 

виводу в булевих рівняннях можна не зазначати: у лівій частині рівнянь 
ім’я зразка означатиме вхід, а в правій частині – його вихід. 

< Приклад: d:\max2work\tutorial\6lab\600reg_decl1.tdf, .sсf. 
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VARIABLE           
 t1 : DFFE;     
 t2        : SRFFE;    
 t3        : JKFFE;    
BEGIN                                           
 t1.D=d2; t1.CLK=C; t1.ENA=E;   t2.S=d1; t2.R=!d1; 
 t2.CLK=C; t2.ENA=E; t3.J=d0; t3.K=!d0; t3.CLK=C; 
 t3.ENA=E;    y=t1 & !t2 & t3; 
END; 
 
6.2.3.2 Виконати п. 6.2.3.1 на мегафункціях тригерів вибраного 

типу і логічних елементів (див. п. 4.1.3)  у тестовому файлі 6XXmega_y.tdf 
проекту 6XXmega_y на кшталт схеми 2 файла 6XXy.gdf, для чого включи-
ти до складу проекту вибрані мегафункції тригера і логічного елемента 
(Include Statement) із зазначенням їх імен і параметрів в підсекції Instance 
Declaration (parametererized) секції змінних (Variable Section) та в логічну 
секцію (Logic Section) вставити шаблон підсекції булевих рівнянь (Boolean 
Equation), за допомогою яких утворити з’єднання на зразок графічного 
файла. Перевірити правильність функціонування пристрою за часовими ді-
аграмами 6XXmega_y.sсf. 

< Приклад: d:\max2work\tutorial\6lab\600mega_y.tdf, .sсf. 
 
6.2.3.3 Виконати п. 6.2.3.1 на автоматично створених за допо-

могою менеджера MegaWizard Plug-In Manager різновидах мегафункцій 
тригерів і логічних елементів (див. п. 4.2.4.1) у тестовому файлі 
6XXwiz_y.tdf проекту 6XXwiz_y на кшталт схеми 3 файла 6XXy.gdf, для 
чого включити до складу проекту створені в п. 2.3 різновиди мегафункцій 
тригера і логічного елемента (Include Statement) без зазначення їх парамет-
рів в підсекції Instance Declaration (non-parametererized) секції змінних 
(Variable Section) та в логічну секцію (Logic Section) вставити шаблон під-
секції булевих рівнянь (Boolean Equation), за допомогою яких утворити 
з’єднання на зразок графічного файла. Перевірити правильність функціо-
нування пристрою за часовими діаграмами 6XXwiz_y.sсf. 

< Приклад: d:\max2work\tutorial\6lab\600wiz_y.tdf, 600wiz_y.sсf. 
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Контрольні питання та завдання 
1. Складіть принципову електричну схему комірки пам’яті з двов-

ходових базових елементів типу a) ТТЛ, б) ЕСЛ, в) МОН ТЛ (елемент 
АБО-НЕ), г) КМОН ТЛ (елемент І-НЕ) і покажіть: 1) які величини напруг 
діють на входах і виходах тригера в обох його статичних станах та чому 
тригер може перебувати в них необмежено довго; 2) в якому стані опи-
ниться цей тригер, якщо один з його входів перебуває під рівнем а) логіч-
ного 0, б) логічної 1, а другий вхід підімкнено таким чином: а) закорочено 
на землю,  б) залишено вільним, в) підімкнено (через резистор) до джерела 
живлення, г) з’єднано з першим входом; 3) в якому стані опиниться цей 
тригер з надходженням забороненої для нього комбінації вхідних сигналів 
та при якій комбінації, що настає після забороненої, він перейде до неви-
значеного стану, а при якій – до визначеного; 4) у чому полягають умови, 
за яких можливе стрибкоподібне перемикання цього тригера, та як воно ві-
дбувається в даній схемі; 5) при якій мінімальній тривалості вхідних імпу-
льсів надійно спрацьовуватиме зображений тригер та з якою максималь-
ною частотою він зможе перемикатись (цифрові дані наведіть на прикладі 
конкретної серії ІС зазначеної елементної бази). 

2. Наведіть а) перемикальну таблицю, б) таблицю переходів, в) ха-
рактеристичні рівняння в МДНФ та МКНФ відносно прямого та інверсно-
го виходів, г) логічні функції збудження для тригерів типу: 1) R, 2) S, 3) Е, 
4) RSC, 5) RC, 6) SC, 7) ЕС, 8) DС, 9) DCЕ, 10) ТЕ, 11) TЕ, 12) JKC, 13) JK
C , 14) JKЕ, 15) асинхронний JK. 

3. Побудуйте граф перемикань та за допомогою позицій станів на 
схемі і часових діаграм охарактеризуйте швидкодію і вимоги щодо трива-
лості вхідних імпульсів і інтервалів часу, на яких заборонено змінювати 
вхідну інформацію для тригерів такого типу (через риску зазначено елеме-
нти або схема, за якими складено тригер): 

а) асинхронних: 1) RS –  І-НЕ, 2) RS –  АБО-НЕ; 
б) синхронних, керованих рівнем: 1) RSC – І-НЕ, 2) RSC – АБО-НЕ, 

3) CSR  – І-АБО-НЕ, 4) RSC – І-АБО-НЕ, 5) DC – АБО-НЕ, 5) DC  – 
І-АБО-НЕ та НЕ, 7) DC – І-АБО-НЕ, 8) DC – І-НЕ, 9) DC  – АБО НЕ, 10) D
C  – АБО-НЕ; 

в) за схемою МS: 1) RSC – з інвертором, 2) JKC – із забороненими 
зв’язками, 3) Т – з різнополярним керуванням на синхронних RS-тригерах, 
4) D – з різнополярним керуванням на однофазних D-тригерах;  

г) за схемою трьох тригерів: 1) DC, 2) JK, 3) Т, 4) ТЕ;  
д) з імпульсно-потенціальним керуванням: 1) JKC, 2) DC, 3) ТЕ. 
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7   РЕГІСТРИ 

Мета роботи: дослідження типових регістрів; побудова ЦПП на 
основі регістрів; засвоєння основ застосування регістрів у проектах, вико-
ристання шаблону оголошення регістрів (Register Declaration); визначення 
швидкодії за допомогою регістрового дисплея; засвоєння основ побудови 
послідовнісного пристрою як скінченного автомата.  

Домашнє завдання 
! Спроектувати на основі регістра зсуву ЦПП згідно з варіантом за-

вдання 7 (див. додаток А, варіанти завдання 7). 

7.1  Стислі теоретичні відомості 

Регістрами називаються ЦПП, що виконують операції запису 
(приймання, введення), збереження, перетворення (наприклад, шляхом 
зсуву) та зчитування (передавання, виведення) двійкових багатоцифрових 
чисел (слів). Особливістю регістрів є регулярність їх структури: кожний 
розряд складається з однакових тригера і додаткових елементів керування 
розрядом. Через це розрядність регістрів легко нарощується застосуванням 
програмованих ІС або з’єднанням кількох ІС жорсткої структури. 

Регістри належать до однієї з найпоширеніших груп ЦПП. Вони за-
стосовуються як оперативна пам’ять для тимчасового зберігання даних, 
для сполучення ЕОМ і радіоелектронних приладів із зовнішніми пристро-
ями, зокрема, з метою індикації і введення-виведення інформації, перетво-
рення її для передавання на далекі відстані, для виконання арифметичних 
операцій тощо. 

Залежно від способу записування і зчитування інформації регістри 
поділяються на два основні типи: паралельні і зсуву. Інші різновиди регіст-
рів (буферні, багаторежимні буферні, комбіновані, універсальні тощо) ба-
зуються на цих двох зазначених типах. 

7.1.1 Паралельні регістри 
7.1.1.1 Принцип побудови. Паралельними (регістрами пам’яті, схо-

ву) є регістри, в яких записування і зчитування всіх розрядів слова відбува-
ється одночасно і розряди слова займають фіксоване положення відносно 
розрядів регістра.  

Паралельний регістр – це набір тригерів з окремими інформаційни-
ми входами і виходами в кожному розряді та зі спільним для всіх розрядів 
синхровходом. Найпоширенішими є регістри з однофазним записом інфо-
рмації на D-тригерах (рис. 7.1, а). З надходженням синхроімпульсу (G = 1) 
відбувається записування до регістра в паралельному коді вхідного слова 
D, наприклад, чотирирозрядного Q3 ... Q0 = d3 … d0, а за його відсутності 
(G = 0) регістр перебуває в режимі зберігання записаної інформації, коли її 
можна зчитувати (також у паралельному коді) з виходів Q3 ... Q0.  
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а) 

 
б) 

 
в) 

Рисунок 7.1 

Регістри з трьома станами виходу (рис. 7.1, б) дозволяють здійс-
нювати гнучкіший зв’язок з вихідною шиною. У такому регістрі так само 
активним рівнем синхроімпульсу G = 1 вхідне слово записується до триге-
рів, які за пасивного рівня G = 0 перебувають у режимі зберігання. Елеме-
нти з трьома станами виходу за відсутності сигналу дозволу (ОЕ = 0) пере-
бувають у високоімпедансному стані уі = Z і від’єднують регістр від шини, 
а під час зчитування, коли тригери перебувають у режимі зберігання, сиг-
налом ОЕ = 1 інформація передається в шину: уі = Qі. Такі регістри з поту-
жними вихідними елементами називають буферними (рис. 7.1, в), бо забез-
печують підвищену навантажівну здатність і часову буферизацію даних. 

7.1.1.2  Різновиди паралельних регістрів,  їх макро-  і мегафункції. 
Основні різновиди стандартних ІС серії 74 (макрофункції з ідентифікацій-
ними номерами 1...3) і дві мегафункції (з номерами 4, 5) наведено на 
рис. 7.2. 

Паралельні регістри зі статичним керуванням (символи 1, 4), як і 
тригери, на яких вони виконуються, відрізняються позначенням синхров-
ходу (зазвичай G, gate, інколи С) і складником LATCH у назві символу. У 
таких регістрах заборонено змінювати вхідну інформацію під час дії акти-
вного рівня синхроімпульсу, бо її зміна, у тому числі й випадкова, тобто 
завада, як в асинхронному пристрої через ворота Gate потраплятиме до ви-
ходів. У паралельних регістрів з динамічним керуванням (символи 2, 3, 5) 
синхровходи позначаються літерами CLК або у вигляді трикутника стрілки 
і складником FF (Flip-Flop) у назві символу. Такі регістри мають підвище-
ну завадостійкість, бо в них заборонено змінювати вхідну інформацію ли-
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ше під час дії активного перепаду синхроімпульсу.  
Найпоширенішими є регістри з однофазним записом інформації на 

D-тригерах (символи 1, 2, 4, 5):  регістр 1 відповідає схемі на рис. 1,б, а ре-
гістр 2 – схемі на рис. 7.1, а), в якій використовуються D-тригери з динамі-
чним керуванням. В однофазних регістрах розряди вхідного слова (позна-
чаються Di, data[], а також  A, C, В, D…, причому зазвичай вага розряду 
зростає від початкових літер абетки до наступних, отже, правильною є від-
повідність груп data[3..0] = D, C, В, A) передаються однодротовою лінією, 
що зручно для обміну інформацією з шинами. Проте більші функціональні 
можливості мають регістри з парафазним записом інформації на JK-три-
герах (символ 3); їх можна використати як набір тригерів зі спільним синх-
ровходом для побудови, наприклад, лічильників або регістрів зсуву. 

 
1) 

 
2) 

 
3) 

 
4) 

 
5) 

Рисунок 7.2 

Регістри виконуються, здебільшого, з асинхронними установлюваль-
ними входами (символи 2, 3, 5). Спільним для всіх розрядів входом CLR 
(CLRN – інверсний вхід, aclr – асинхронний) регістр обнуляється, а по інди-
відуальному для кожного розряду входу передустановлення PR (РRN – інвер-
сний вхід) до регістра можна асинхронно записати довільне слово. Під час 
функціонування регістра на установлювальних входах рівні мають бути па-
сивними. За допомогою мегафункцій (символи 4, 5) можна побудувати пара-
лельні регістри в широкому діапазоні параметрів, основним і обов’язковим з 
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яких є LPM_WIDTH – розрядність вхідного і вихідного слова. 

 

7.1.2 Регістри зсуву 
7.1.2.1 Принцип побудови. Регістрами зсуву (послідовними) є регі-

стри, в яких записування і зчитування розрядів слова відбувається послідо-
вно в часі (у послідовному коді) через один вхід та один вихід, відповідно, 
отже, розряди слова з кожним тактом синхроімпульсів просуваються з од-
ного розряду регістра до іншого. Регістр зсуву є набором тригерів з послі-
довно з’єднаними входами і виходами та зі спільним для всіх розрядів си-
нхровходом. Напрямок з’єднань визначає і напрямок просування розрядів 
слова, залежно від якого розрізняють регістри прямого зсуву, зворотного 
зсуву та реверсивні (рис. 7.3, а), б), в).  

 
а) 

 
б) 

 
в) 
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г) 

Рисунок 7.3 

У регістрі прямого зсуву (зсуву праворуч), наприклад, чотирирозря-
дного (див. рис. 7.3, а), розряди вхідного слова D = d3d2d1d0, починаючи від 
старшого d3, надходять до входу послідовного введення DR, що є входом 
молодшого розряду регістра, а зчитуються з виходу послідовного виведен-
ня Q3, що є виходом старшого розряду регістра. 

Розглянемо для наочності запис до цього регістра чотирирозрядного 
слова D = d3d2d1d0 = 10012 (на рис. 7.3, г) верхні шість часових діаграм). 
Припустімо, що попередньо регістр заповнено нулями: Q3 = Q2 = Q1 = Q0 = 
0. Тоді, з надходженням в момент t0 позитивного перепаду першого синх-
роімпульсу С до тригерів одночасно (із затримкою на час перемикання од-
ного тригера) записується інформація, присутня на їх входах D, а саме: 
Q0 = DR =d3 = 1, Q1 = Q0 = 0, Q2 = Q1 = 0, Q3 = Q2 = 0. З надходженням пози-
тивного перепаду другого синхроімпульсу С до входу послідовного вве-
дення прикладено наступний розряд слова DR = d2 =0, а до входів інших 
тригерів – інформація з виходів попередніх, отже, відбувається запис: 
Q0 = DR = d2 = 0, Q1 = Q0 = d3 =1, Q2 = Q1 = 0,  Q3 = Q2 = 0. Таким чином, з 
кожним синхроімпульсом біти вхідного слова просуваються в бік старших 
розрядів і після закінчення серії з чотирьох синхроімпульсів (момент t1) 
все слово виявляється записаним до регістра: Q0 = d0 = 1, Q1 = d1 = 0, Q2 = d2 
= 0, Q3 = d3 = 1. Щоб протягом одного такту біти слова не могли просуну-
тися більше ніж на один розряд, у регістрах зсуву застосовують тригери 
тільки з динамічним керуванням. 

Для зчитування слова з виходу Q3 у послідовному коді необхідно по-
дати ще одну серію з чотирьох синхроімпульсів на інтервалі (t2, t3): перед 
позитивним перепадом кожного синхроімпульсу на виході Q3 з’являється 
черговий розряд. Якщо при цьому до входу послідовного введення прикла-
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дено DR = 0, регістр буде заповнено нулями, а якщо надходитимуть біти но-
вого слова, воно буде записано під час зчитування попереднього. 

Внаслідок того, що всі тригери регістра перемикаються одночасно, 
швидкодія регістра зсуву, як і паралельного, визначається часом переми-
кання одного тригера. 

У регістрі зворотного зсуву (зсуву ліворуч), наприклад, чотирироз-
рядного (див. рис. 7.3, б), розряди вхідного слова D = d3d2d1d0, починаючи 
від молодшого d0, надходять до входу послідовного введення DL, що є вхо-
дом старшого розряду регістра, а зчитуються з виходу послідовного виве-
дення  Q0, що є виходом молодшого розряду. Процеси записування і зчиту-
вання (на рис. 7.3, г) нижні шість часових діаграм) відбуваються так само, 
як і в регістрі прямого зсуву, але в протилежному напрямку. Проте напря-
мок зсуву є відносним: досить перенумерувати розряди для взаємного пере-
творення регістрів прямого і зворотного зсуву. Про це свідчать і часові діаг-
рами (див. рис. 7.3, г): при зміні напрямку нумерації розрядів одного з регіс-
трів (від старшого розряду до молодшого чи навпаки) діаграми обох регіст-
рів збігаються. Тому й випускають регістри зсуву без поділу на два види. 

Принципового значення напрямок зсуву набуває в реверсивних регі-
страх (див. рис. 7.3, в), в яких шляхом перемикання міжрозрядних зв’язків 
слово просувають у прямому або зворотному напрямку. Дійсно, при керу-
вальному сигналі S = 1 пристрій перетворюється на регістр прямого зсуву 
(див. рис. 7.3, а), а при S = 0 – на регістр зворотного зсуву (див. рис. 7.3, б). 

7.1.2.2  Різновиди регістрів зсуву,  їх макрофункції  і мегафункція. 
Основні різновиди стандартних ІС серії 74 (макрофункції з ідентифікацій-
ними номерами 1...5), спеціалізована макрофункція програмного комплек-
ту (символ 6) та мегафункція (символ 7) наведено на рис. 7.4. 

 
1) 

 
3) 

 
4) 

 
2) 
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5) 

 

 
6) 

 
7) 

Рисунок 7.4 
У регістрах зсуву обов’язковими є входи послідовного (serial) вве-

дення SER і синхровхід CLК, часто застосовують також входи передуста-
новлення: CLR – скидання та LD (STLD, LDST, load) – попереднього заван-
таження даних у паралельному коді. Запровадженням різних входів та ви-
ходів з поєднанням властивостей паралельних і послідовних регістрів 
утворюють комбіновані і багатофункціональні регістри. 

Класичний (з послідовним введенням і послідовним виведенням) 
регістр зсуву (символ 1 зі входом SER=А&B) стає послідовно-паралельним 
(символ 2), якщо використовуються виходи всіх розрядних тригерів (Q0...Q3 
на рис. 7.3, а). Після послідовного введення серією з n синхроімпульсів (n – 
кількість розрядів слова і регістра) слово можна зчитувати в паралельному 
коді (на інтервалі t1… t2 рис. 7.3, г), тобто перетворити послідовний код у 
паралельний. Таке перетворення застосовується для передавання інформа-
ції на значну відстань у послідовному коді однодротовою лінією зв’язку 
(яка є не тільки ощадливою, але й більш завадостійкою) з подальшою об-
робкою в паралельному коді. 

Для передачі інформації в однодротову лінію виконують зворотне 
перетворення (паралельного коду в послідовний) за допомогою паралель-
но-послідовного регістра (символ 3). Однорозрядним керувальним сигна-
лом STLD перемикаються міжрозрядні зв’язки в регістрі: при STLD = 1 
схема є звичайним регістром зсуву зі входом послідовного введення SER 
(див. рис. 7.3, а), а при STLD = 1 набуває вигляду паралельного регістра з 
розрядними входами A …H (див. рис. 7.1, а). Рівнем сигналу CLCІН = 0 до-
зволяється проходження синхроімпульсів CLC на входи тригерів. 

Комбінований регістр (символ 4) дворозрядним керувальним кодом 
S1S0 можна перетворити у паралельний з розрядними входами A …D та в 
реверсивний зі входом прямого SRSI або зворотного SLSI зсуву.  

Універсальний регістр (символ 5) з дворозрядним керувальним ко-
дом S1S0 виконує подібні операції, але з розширеними функціональними 
можливостями. По розрядних входах  A …D і входу SRCLRN здійснюється 
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відповідно паралельне завантаження або скидання, а прямий і зворотний 
зсув – по входах SERR та SERL. З основного регістра зсуву із синхровхо-
дом SRCLC дані можна перезаписати до вихідного паралельного регістра 
синхроімпульсами RCLC. Сигналом R/SN виходи регістра зсуву безпосере-
дньо або виходи паралельного регістра підмикаються до вихідних буферів 
з трьома станами виходу, які сигналом GN можна переводити до третього 
стану або з’єднувати з шиною. На додатковому виході СASС відображаєть-
ся біт A або D (залежно від напрямку зсуву). 

Під час просування через регістр зсуву інформація потрапляє до ви-
ходу послідовного виведення і втрачається. Якщо цей вихід з’єднати зі 
входом послідовного введення (наприклад, SERR = QD або SERL = QА на 
символі 5), утворюється кільцевий (циклічний) регістр, в якому попередньо 
записане слово циркулюватиме по колу: з надходженням кожного чергово-
го синхроімпульсу біти зсуваються на один розряд і на виходах з’являється 
певна їх комбінація. У спеціалізованій макрофункції (символ 6) такі з’єдна-
ння можна здійснити трирозрядним керувальним кодом S = S2S1S0, який 
дозволяє налаштувати регістр на виконання різноманітних операцій. На-
приклад, при S = 7 утворюється кільцевий регістр прямого зсуву, при 
S = 1 – зворотного зсуву, а при S = 0 – паралельний регістр. 

За допомогою мегафункції (символ 7) можна побудувати всі різно-
види регістрів у широкому діапазоні параметрів, основним і обов’язковим 
з яких є LPM_WIDTH – розрядність вхідного і вихідного слова. 

 

7.1.3  Генератори цифрових кодів і розподільники 
Крім виконання операцій, зазначених на початку теоретичних відо-

мостей, регістри зсуву застосовуються в цифрових системах радіотехніки 
та зв’язку, обчислювальної техніки, автоматики тощо для діагностування і 
корекції похибок цифрових пристроїв, у колах їх керування і синхронізації, 
мікропрограмного керування вузлами шляхом розподілення перемикаль-
них сигналів у певну кількість каналів і т. ін.  

Для розв’язання подібних задач використовуються генератори ко-
дової послідовності (ГКП) та розподільники імпульсів і рівнів (РІР). Серед 
різного типу ГКП набули поширення генератори псевдовипадкових чисел і 
генератори зі сталими кодами, в яких сполучення нулів та одиниць у роз-
рядах регістра залишається незмінним. На основі останнього типу ГКП бу-
дуються і РІР, які за видом сигналів поділяють на розподільники рівнів 
(РР), в яких активна величина потенціалу (логічна 1 або 0) діє протягом та-
кту синхроімпульсів, та розподільники імпульсів (РІ), в яких активний си-
гнал триває протягом синхроімпульсу. Проте з точки зору схемотехніки 
розподільники є комбінованими, бо РІ утворюють з РР.  

Згадані пристрої циклічної дії, що ґрунтуються на кодах зі сталим 
сполученням нулів і одиниць, можна побудувати, зокрема, на регістрах зсу-
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ву. Достатньо попередньо записане певне слово зсувати в кільцевому регіс-
трі для отримання на його виходах періодично повторюваної послідовності 
чисел, яка і правитиме за вихідні сигнали ГКП та РІР. Просування через ро-
зряди регістра періодично повторюваної послідовності символів, наприклад, 
000111000111... для стислості зручно позначити періодом у дужках: 
(000111). При цьому значення кодів N на виходах кільцевого регістра зале-
жать від кількості його розрядів n. Так, просуванням вправо наведеної пос-
лідовності символів через дворозрядний регістр (n = 2) на його виходах 
утворюватимуться коди N = Q1Q0 = 00, 00, 01, 11, 11, 10, які далі повторю-
ються. Стисло це можна позначити в десятковій системі кодів як 
N = (000111) = 0, 0, 1, 3, 3, 2. Детерміновані коди послідовності мають бути 
різними, тому дворозрядний регістр є неприйнятний для її формування, 
адже серед кодів є однакові. Розрядність регістра збільшують, поки не впев-
нюються, що серед вихідних кодів немає однакових, таку величину n і бе-
руть за мінімальну. Так, просуванням цієї ж послідовності через трирозряд-
ний регістр утворюються коди N = (000111) = Q2Q1Q0 = 0, 1, 3, 7, 6, 4, які є 
різними, отже, мінімальна кількість розрядів становить n = 3. Кількість різ-
них кодів, що періодично повторюються на виходах ЦПП, називається його 
модулем. Зі збільшенням розрядності змінюються значення кодів, але їх кі-
лькість залишається незмінною, модуль визначається лише кількістю сим-
волів послідовності. 

 
7.2  Лабораторне завдання 

7.2.1  Дослідити основні типи регістрів 
7.2.1.1 Дослідити паралельний регістр з трьома станами виходів 

на основі D-тригерів зі статичним керуванням: за принциповою електрич-
ною схемою та осцилограмами сигналів (файли d:\max2work\tutorial\7lab\ 
7par.gdf, .scf) визначити умови режимів записування, зберігання та зчиту-
вання інформації, виміряти затримку перемикання. У звіті навести також 
умовне графічне позначення за ДСТУ такого регістра зі стислим пояснен-
ням принципу його дії та осцилограм сигналів. 

7.2.1.2 Дослідити регістр прямого зсуву (зсуву праворуч) на D-
тригерах з динамічним керуванням (схема 1) у режимах послідовного запи-
су, паралельного та послідовного зчитування (файли 
d:\max2work\tutorial\7lab\7zsuw.gdf, .scf) та розглянути особливості побудо-
ви і перемикання регістра зсуву вліво (зворотного зсуву) і реверсивного ре-
гістра (схеми 2, 3).  

7.2.1.3 Ознайомитися з різновидами регістрів бібліотеки бази да-
них (файл d:\max2work\tutorial\7lab\7lіbrе.gdf): макрофункціями (вибрани-
ми ІС серії 74) паралельних регістрів і регістрів зсуву та мегафункціями. 
Розглянути функціональні прототипи (FUNCTION), таблиці відповідності 
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мок > зберегти файл 7XXgkp(ri)1.mtf > відтак зчитати текстовий файл 
7XXgkp(ri)1.mtf. 

< Приклад: d:\max2work\tutorial\7lab\700gkp1.tao, .mtf. 
7.2.2.4 Скласти та дослідити самовідновлювальний пристрій на 

мегафункції регістра зсуву (можна в тому самому графічному файлі).  
< Приклад: d:\max2work\tutorial\7lab\700gkp1.gdf, sсf (схема 3).  
7.2.2.5 Скласти та дослідити самовідновлювальний пристрій на 

автоматично створеному за допомогою менеджера MegaWizard Plug-In 
Manager різновиді мегафункції регістра зсуву 7XXwiz_reg.sym (можна в 
тому самому графічному файлі).  

< Приклад: d:\max2work\tutorial\7lab\700wiz_reg.sym, 700gkp1.gdf, 
sсf (схема 3).  

7.2.3 Застосувати регістр зсуву в текстовому редакторі вико-
нанням завдання за п. 7.2.2. 

7.2.3.1 Створити та дослідити пристрій на основі макрофункції 
регістра вибраного типу в тестовому файлі (.tdf) проекту 7XXreg_decl на 
кшталт самовідновлювальної схеми на макрофункції з графічного файла, 
для чого:  

а) після заголовку TITLE вставити шаблон Function Prototype 
Statement (non-parameterized), в який ввести параметри прототипу регістра 
безпосередньо з довідки Help (можна скопіювати і вставити копію): 

FUNCTION 74295 (oe, ld/shn, clk, ser, d[3..0])  
  RETURNS (q[3..0]);                            
б) після оголошення портів у секції підпроекту вставити в секцію 

змінних (Variable Section) шаблон оголошення регістрів (Register 
Declaration), де надати ім’я зразку регістра: 

VARIABLE                                %  Variable Section           % 
 rg : 74295;                     %  Register Declaration  % 
 в) у підсекції булевих рівнянь логічної секції виконати потрібні 

з’єднання (докладніше див. п. 6.2.3.1).  
< Приклад: d:\max2work\tutorial\7lab\700reg_decl.tdf, .sсf (на 

кшталт схеми 2 з файла 700gkp1.gdf). 
7.2.3.2 Виконати п. 7.2.3.1 на мегафункції регістра (див. п. 6.2.3.2)  

у тестовому файлі (.tdf) проекту 7XXmega_gkp(ri) на кшталт схеми на ме-
гафункції з графічного файла.  

< Приклад: d:\max2work\tutorial\7lab\700mega_gkp.tdf, .sсf (на 
кшталт схеми 3 файла 700gkp1.gdf). 
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7.2.3.3 Виконати п. 7.2.3.1 на автоматично створеному за допо-
могою менеджера MegaWizard Plug-In Manager різновиді мегафункції ре-
гістра (див. п. 6.2.3.3)  у тестовому файлі (.tdf)  проекту 7XXwiz_gkp(ri) на 
кшталт аналогічної схеми з графічного файла.  

< Приклад: d:\max2work\tutorial\7lab\700wiz_reg.tdf, 700wiz_gkp.tdf, 
.sсf (на кшталт схеми 4 файла 700gkp1.gdf). 

7.2.4 Засвоїти основи побудови послідовнісного пристрою як 
скінченного автомата (State Machine) виконанням завдання за п. 7.2.2. 

7.2.4.1 За перемикальним графом 7XXgkp(ri)1.gdf  створити при-
стрій з використанням оператора вибору Case Statement у тестовому 
файлі (.tdf) проекту 7XXsmcase_gkp(ri), для чого після оголошення портів: 

а) до секції змінних Variable Section вставити шаблон підсекції ого-
лошення скінченного автомата State Machine Declaration, в який ввести си-
мвольну назву скінченного автомата, наприклад, gkp або ri, після якої за-
лишити двокрапку і ключове слово Machine; відтак після ключових слів 
OF BITS у круглих дужках ввести через кому або у вигляді масиву симво-
льну назву розрядів автомата, наприклад, (q2, q1, q0) або (q[2..0]); нарешті, 
після ключових слів WITH STATES у круглих дужках ввести через кому 
символьні назви станів автомата і через знак рівності їх значення в одній із 
систем числення, наприклад, (s0 = 0, s1 = H”1”, s2 = B”011”, …); у кінці за-
лишити крапку з комою: 

 
VARIABLE                   

 gkp :  MACHINE                       %  State Machine Declaration  %    

 OF BITS (q[2..0]) 

 WITH STATES (s0 = 0, s1 = 1, s2 = 3, s3 = 7, s4 = 6,  

    s5 = 4, il1 = 2, il2 = 5); 

F  Примітки: 

1. У підсекції State Machine Declaration речення OF BITS залежно 
від розв’язуваного завдання є необов’язковим, тобто компілятор сам може 
призначити кількість розрядів n пристрою за критерієм мінімальної схеми 
(інколи схема є простішою за більшої величини n через спрощення міжро-
зрядних зв’язків). 

2. У реченні WITH STATES можна подати список символічних назв 
станів без зазначення їх кодів, якщо важливою є лише кількість станів, на-
приклад, (s0, s1, s2, ...). 
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3. З усіх 2n можливих станів дозволеними є ті, що подані в списку 
символічними назвами. Для усунення недозволених станів їх потрібно та-
кож перелічити в списку, наприклад, il1, il2 (від illegal). 

BEGIN 

   gkp.clk = C;        

   Q[] = gkp.q[];     

END;                            

б) до логічної секції Logic Section вставити шаблон булевих рівнянь 
Boolean equations, до якого ввести булеві рівняння керування, що пов’язують 
порти (входи та виходи) автомата із зовнішніми портами пристрою. 

F Примітка. Скінченний автомат State Machine має лише три вхідні 
порти: CLK (синхровхід з динамічним керуванням), RESET (скидання) і 
ENA (дозвіл на проходження синхроімпульсів, тобто на перемикання) та 
вихідні порти, оголошені перед ключовим словом OUTPUT секції 
SUBDESIGN. Булеві рівняння керування Boolean equations логічної секції 
складаються згідно із синтаксисом: <symbolic name>.clk, <symbolic 
name>.reset, <symbolic name>.ena, <symbolic name>.qi, де <symbolic name> - 
назва, оголошена в підсекції State Machine Declaration. У прикладі рівняння 
gkp.clk = C приєднує зовнішній порт „С” до синхровходу автомата, а рів-
няння Q[] = gkp.q[] приєднує його виходи до зовнішніх портів „Q1”, „Q2”, 
„Q3”. Отже, інші зовнішні сигнали не можна вважати портами автомата, їх 
треба пов’язувати з переходами автомата іншими логічними рівняннями 
або гілками умовних операторів чи таблиці, як, наприклад, у проекті 
d:\max2work\tutorial\7lab\700smtabl_gkp. 

в) після рівнянь у логічну секцію вставити шаблон умовного опера-
тора Case Statement (див. п. 3.2.4.3), до якого ввести переходи між станами 
автомата, так само, як у перемикальному графі: 

BEGIN                               

 gkp.clk = C;  

 Q[] = gkp.q[]; 

 CASE gkp IS                                        %  Case Statement         % 

  WHEN s0 => gkp = s1;              %  0 => 1                         % 

  WHEN s1 => gkp = s2;              %  1 => 3                          % 

  WHEN s2 => gkp = s3;              %  3 => 7                         % 



 

зультати проектування за часовими діаграмами 7

микальний граф 5, 700

товувати умовний оператор 

стрій з використанням 
проекту
до логічної секції вставити шаблон таблиці відповідності 
Statement
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END;

г) після
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VARIABLE                             

  WHEN s3 => gkp = s4;              %  7 => 6               

  WHEN s4 => gkp = s5;              %  6 =>

  WHEN OTHERS => gkp = s0;  %  4=>0,  2=>0,  5=>0   %

 END CASE;

END; 
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 gkp : MACHINE                        % State Machine Declaration   % 

 OF BITS (q[2..0]) 

 WITH STATES ( 

  s0 = 0, s1 = 1, s2 = 3, s3 = 7, s4 = 6, s5 = 4, 

  il1 = 2, il2 = 5); 

BEGIN                                                   %  Logic Section                       %  

 gkp.clk = C; gkp.reset = R;            %  Boolean equations               %  

 Q[] = gkp.q[]; 

   TABLE                                               %  Truth Table Statement         % 

 LD, gkp   => gkp;          

 ------------------------ 

 0,  s0    => s1;   1,  s0    => il1;   0,  s1    => s2;   1,  s1    => s1; 

 0,  s2    => s3;   1,  s2    => s2;   0,  s3    => s4;    1,  s3    => s3;          

 0,  s4    => s5;   1,  s4    => s4;   0,  s5    => s0;    1,  s5    => s5;          

 0,  il1   => il2;   1,  il1   => il1;   0,  il2   => s2;    1,  il2   => il2;         

   END TABLE; 

END; 

< Приклад: d:\max2work\tutorial\7lab\700smtabl_gkp.tdf, sсf; пере-
микальний граф 6, 700gkp1.gdf.  

 

Контрольні питання та завдання 
1. Тригери якого типу керування можна застосовувати в паралель-

них регістрах і регістрах зсуву? 

2. Побудуйте на тригерах: а) JK-, б) RS-, в) D-типу такий трирозря-
дний регістр: 1) паралельний, 2) зсуву (послідовно-послідовний), 3) пара-
лельно-послідовний, 4) послідовно-паралельний, 5) реверсивний, 6) кіль-
цевий, 7) універсальний, 8) буферний з трьома станами виходу.   

3. Користуючись умовними графічними позначеннями, складіть з 
ІС  4-розрядних регістрів схему 12-розрядного регістра: а) паралельного,        
б) зсуву.  

4 Перетворіть трирозрядний паралельний регістр у регістр зсуву. 
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8   ЛІЧИЛЬНИKИ 

Мета роботи: дослідження типових лічильників; застосування лі-
чильників у проектах; засвоєння основ створення проекту за сигнального 
його введення (часовими діаграмами).  

 
Домашнє завдання 

! Спроектувати згідно з варіантом (див. додаток А, варіанти завдан-
ня 8): а) недвійковий лічильник шляхом перетворення двійкового лічиль-
ника, б) недвійковий лічильник на тригерах зі зворотними зв’язками, в) 
безвентильний подільник частоти на JK-тригерах.  

8.1  Стислі теоретичні відомості 
8.1.1 Вступ 
Лічильником називається ЦПП, що перетворює послідовність вхід-

них імпульсів у цифровий код, значення якого залежить від кількості цих 
імпульсів. Сформований код може зберігатися в лічильнику, як і в будь-
якому послідовнісному пристрої, зокрема, у регістрі. Лічильники застосо-
вуються для кількісного визначення часових інтервалів, до яких поперед-
ньо перетворюють вимірювану величину в різного типу вимірювачах, для 
поділу частоти в синтезаторах частот і годинниках, для формування ко-
манд галуження програм під час цифрової обробки інформації тощо.  
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модулем лічби М. Цей параметр відображає, яку максимальну  кількість ім-
пульсів здатний однозначно підрахувати певний лічильник. Якщо, напри-
клад, вихідний код змінюється в межах N = 0, 1, … , 9, 0, 1, … , 9, ... ,  мо-
дуль лічби становить М = 10. 

Швидкодія лічильника характеризується часом усталення tл – най-
більшим часовим інтервалом, протягом якого після надходження кожного 
з вхідних імпульсів встигають встановитися всі розряди вихідного коду, а 
також максимальною частотою лічби fл – частотою вхідних імпульсів, за 
якої лічильник здатний перемкнутися від одного стійкого стану до іншого. 

За модулем лічби лічильники поділяють на двійкові, якщо модуль 
становить M = 2n (де n – ціле число), та з довільним модулем лічби (недвій-
кові), в яких модуль M ≠ 2n. За напрямком лічби розрізняють такі лічиль-
ники: підсумовувальні, код яких з надходженням чергового імпульсу збі-
льшується на одиницю (інкрементується), віднімальні, коли код зменшу-
ється на одиницю (декрементується), та реверсивні, в яких напрямок лічби 
є керованим. Крім того, залежно від порядку зміни коду можна виокреми-
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ти лічильники з природним порядком лічби, якщо код з надходженням чер-
гового імпульсу збільшується  або зменшується на одиницю, та зі штуч-
ним порядком лічби, коли код змінюється в довільному порядку. Щодо ор-
ганізації міжрозрядних зв’язків будують лічильники, в основному, за схе-
мами з послідовним,  паралельним і груповим перенесенням.  

8.1.2 Двійкові лічильники  
8.1.2.1 Лічильники з послідовним перенесенням. Модуль лічби 

двійкового лічильника M = 2n визначається кількістю його розрядів n, а ви-
хідний код змінюється в межах 0 ... М – 1. Наприклад, при n = 3 модуль 
становить M = 8 і вихідний код N = Q2Q1Q0 у випадку підсумовувального 
лічильника (табл. 1) з надходженням вхідних імпульсів зростає від 0 до 7 і 
далі цикл лічби повторюється. Позначаючи для наочності новий стан після 
перемикання кодом Q2

+Q1
+Q0

+  і напрямок перепадів вихідних сигналів dQi  
від логічного нуля до одиниці та навпаки знаками плюс і мінус відповідно, 
переконуємось, що молодший розряд перемикається до протилежного ста-
ну кожним лічильним імпульсом, а наступні розряди – негативним пере-
падом напруги з виходу попереднього розряду.  
Таблиця 8.1  

Отже, лічильник можна по-
будувати послідовним увімкнен-
ням ланцюжка Т-тригерів. З огля-
ду на те, що негативному перепаду 
напруги на прямому виході триге-
ра відповідає позитивний перепад 
на його інверсному виході, при 
використанні  Т-тригерів з прямим 
динамічним керуванням необхідно 
з’єднувати їх синхровходи з інвер-
сними виходами попередніх роз-

рядів 1−= ii QC (рис. 8.1, а). І, навпаки, синхровходи Т-тригерів з інверсним 
динамічним керуванням слід з’єднувати з прямими виходами попередніх 
розрядів Сі = Qі-1.  

У таких лічильниках з послідовним перенесенням (послідовних лі-
чильниках) кожний наступний тригер перемикається із запізненням відно-
сно фронту вихідного сигналу попереднього розряду, а тригер молодшого 
розряду – відносно лічильних імпульсів С на час перемикання тригера tT. 
Через це час усталення вихідного коду лічильника, який визначається за 
перемикання всіх розрядів, залежить від їх кількості і становить tл=ntT (на 
рис. 1,б кількість затримок tT позначено цифрами). З огляду на відсутність 
спільного для всіх розрядів синхровходу і внаслідок цього неодночасність 
їх перемикання послідовні лічильники є асинхронними.  

N Q2Q1Q0 Q2
+Q1

+Q0
+  dQ2 dQ1 dQ0

0
1
2
3
4
5
6
7

0  0  0
0  0  1
0  1  0
0  1  1
1  0  0
1  0  1
1  1  0
1  1  1

 0  0  1
 0  1  0
 0  1  1
 1  0  0
 1  0  1
 1  1  0
 1  1  1
 0  0  0

           +
       +   -
           +
   +   -   -
           +
       +   -
           +
    -   -  -



 

через регулярність структури і мінімум міжз’єднань, що сприяє також пі
вищенню завадостійкості, а недоліком 
від розрядності 
t
рехід вихідного коду від 3 до 4 супроводжується проміжними станами 2 і 0 
(див. рис. 
чених з вихо
ченн

ності результатів підраховують пачки імпульсів і зчитування коду викон
ють 
впливають вони також на поділ частоти: як видно з діаграм на рис. 
частота сигналу на виході кожного наступного розряду зменшується вдв
чі. Для подібних застосувань максимальна 
жується лише часом перемикання тригера молодшого розряду 
(бо кожний наступний розряд перемикається з удвічі меншою частотою, 
ніж попередній), тобто в цьому разі послідовні лічильники мають найвищу 
швидкодію і потре

микальної таблиці двійкового лічильника (див. табл. 
ний його розряд має перемикатися до протилежного стану з надходженням 
чергового лічильного
розрядів у стані 
нів 

 

Перевагою лічильників з послідовним 
через регулярність структури і мінімум міжз’єднань, що сприяє також пі
вищенню завадостійкості, а недоліком 
від розрядності 
tл. Крім того, під час перемикання виникають хибні стани, наприклад, п
рехід вихідного коду від 3 до 4 супроводжується проміжними станами 2 і 0 
(див. рис. 
чених з вихо
чення перехідного процесу його усталення, тобто через час 

Проте у вимірювальній техніці, коли з метою підвищення вірогі
ності результатів підраховують пачки імпульсів і зчитування коду викон
ють після
впливають вони також на поділ частоти: як видно з діаграм на рис. 
частота сигналу на виході кожного наступного розряду зменшується вдв
чі. Для подібних застосувань максимальна 
жується лише часом перемикання тригера молодшого розряду 
(бо кожний наступний розряд перемикається з удвічі меншою частотою, 
ніж попередній), тобто в цьому разі послідовні лічильники мають найвищу 
швидкодію і потре

8.1.
микальної таблиці двійкового лічильника (див. табл. 
ний його розряд має перемикатися до протилежного стану з надходженням 
чергового лічильного
розрядів у стані 
нів N = 1, 3, 5, 7, коли 

Перевагою лічильників з послідовним 
через регулярність структури і мінімум міжз’єднань, що сприяє також пі
вищенню завадостійкості, а недоліком 
від розрядності n: зі збільшенням модуля лічб
Крім того, під час перемикання виникають хибні стани, наприклад, п

рехід вихідного коду від 3 до 4 супроводжується проміжними станами 2 і 0 
(див. рис. 8.1, б), що може бути небезпечним для роботи пристроїв, спол
чених з виходами лічильника. Отже, вихідний код зчитують 

перехідного процесу його усталення, тобто через час 
Проте у вимірювальній техніці, коли з метою підвищення вірогі

ності результатів підраховують пачки імпульсів і зчитування коду викон
після закінченн

впливають вони також на поділ частоти: як видно з діаграм на рис. 
частота сигналу на виході кожного наступного розряду зменшується вдв
чі. Для подібних застосувань максимальна 
жується лише часом перемикання тригера молодшого розряду 
(бо кожний наступний розряд перемикається з удвічі меншою частотою, 
ніж попередній), тобто в цьому разі послідовні лічильники мають найвищу 
швидкодію і потребують мінімум ресурсу мікросхем.

8.1.2.2 Лічильники з паралельним 
микальної таблиці двійкового лічильника (див. табл. 
ний його розряд має перемикатися до протилежного стану з надходженням 
чергового лічильного
розрядів у стані логічної 1

1, 3, 5, 7, коли 

Перевагою лічильників з послідовним 
через регулярність структури і мінімум міжз’єднань, що сприяє також пі
вищенню завадостійкості, а недоліком 

зі збільшенням модуля лічб
Крім того, під час перемикання виникають хибні стани, наприклад, п

рехід вихідного коду від 3 до 4 супроводжується проміжними станами 2 і 0 
б), що може бути небезпечним для роботи пристроїв, спол
дами лічильника. Отже, вихідний код зчитують 

перехідного процесу його усталення, тобто через час 
Проте у вимірювальній техніці, коли з метою підвищення вірогі

ності результатів підраховують пачки імпульсів і зчитування коду викон
закінчення низки таких пачок, ці недоліки не є суттєвими. Не 

впливають вони також на поділ частоти: як видно з діаграм на рис. 
частота сигналу на виході кожного наступного розряду зменшується вдв
чі. Для подібних застосувань максимальна 
жується лише часом перемикання тригера молодшого розряду 
(бо кожний наступний розряд перемикається з удвічі меншою частотою, 
ніж попередній), тобто в цьому разі послідовні лічильники мають найвищу 

бують мінімум ресурсу мікросхем.
Лічильники з паралельним 

микальної таблиці двійкового лічильника (див. табл. 
ний його розряд має перемикатися до протилежного стану з надходженням 
чергового лічильного імпульсу лише за умови перебування всіх попередніх 

логічної 1. Так, розряд з виходом 
1, 3, 5, 7, коли Q0 = 1, а з виходом 

141

а)

б)
Рисунок

Перевагою лічильників з послідовним 
через регулярність структури і мінімум міжз’єднань, що сприяє також пі
вищенню завадостійкості, а недоліком 

зі збільшенням модуля лічб
Крім того, під час перемикання виникають хибні стани, наприклад, п

рехід вихідного коду від 3 до 4 супроводжується проміжними станами 2 і 0 
б), що може бути небезпечним для роботи пристроїв, спол
дами лічильника. Отже, вихідний код зчитують 

перехідного процесу його усталення, тобто через час 
Проте у вимірювальній техніці, коли з метою підвищення вірогі

ності результатів підраховують пачки імпульсів і зчитування коду викон
низки таких пачок, ці недоліки не є суттєвими. Не 

впливають вони також на поділ частоти: як видно з діаграм на рис. 
частота сигналу на виході кожного наступного розряду зменшується вдв
чі. Для подібних застосувань максимальна 
жується лише часом перемикання тригера молодшого розряду 
(бо кожний наступний розряд перемикається з удвічі меншою частотою, 
ніж попередній), тобто в цьому разі послідовні лічильники мають найвищу 

бують мінімум ресурсу мікросхем.
Лічильники з паралельним 

микальної таблиці двійкового лічильника (див. табл. 
ний його розряд має перемикатися до протилежного стану з надходженням 

імпульсу лише за умови перебування всіх попередніх 
. Так, розряд з виходом 

= 1, а з виходом 

141

а) 

б) 
Рисунок 8.1 

Перевагою лічильників з послідовним перенесенням
через регулярність структури і мінімум міжз’єднань, що сприяє також пі
вищенню завадостійкості, а недоліком – низька швидкодія та залежність її 

зі збільшенням модуля лічби 
Крім того, під час перемикання виникають хибні стани, наприклад, п

рехід вихідного коду від 3 до 4 супроводжується проміжними станами 2 і 0 
б), що може бути небезпечним для роботи пристроїв, спол
дами лічильника. Отже, вихідний код зчитують 

перехідного процесу його усталення, тобто через час 
Проте у вимірювальній техніці, коли з метою підвищення вірогі

ності результатів підраховують пачки імпульсів і зчитування коду викон
низки таких пачок, ці недоліки не є суттєвими. Не 

впливають вони також на поділ частоти: як видно з діаграм на рис. 
частота сигналу на виході кожного наступного розряду зменшується вдв
чі. Для подібних застосувань максимальна частота вхідного сигналу обм
жується лише часом перемикання тригера молодшого розряду 
(бо кожний наступний розряд перемикається з удвічі меншою частотою, 
ніж попередній), тобто в цьому разі послідовні лічильники мають найвищу 

бують мінімум ресурсу мікросхем.
Лічильники з паралельним перенесенням

микальної таблиці двійкового лічильника (див. табл. 
ний його розряд має перемикатися до протилежного стану з надходженням 

імпульсу лише за умови перебування всіх попередніх 
. Так, розряд з виходом 

= 1, а з виходом Q

перенесенням
через регулярність структури і мінімум міжз’єднань, що сприяє також пі

низька швидкодія та залежність її 
и M зростає і час усталення 

Крім того, під час перемикання виникають хибні стани, наприклад, п
рехід вихідного коду від 3 до 4 супроводжується проміжними станами 2 і 0 

б), що може бути небезпечним для роботи пристроїв, спол
дами лічильника. Отже, вихідний код зчитують 

перехідного процесу його усталення, тобто через час 
Проте у вимірювальній техніці, коли з метою підвищення вірогі

ності результатів підраховують пачки імпульсів і зчитування коду викон
низки таких пачок, ці недоліки не є суттєвими. Не 

впливають вони також на поділ частоти: як видно з діаграм на рис. 
частота сигналу на виході кожного наступного розряду зменшується вдв

частота вхідного сигналу обм
жується лише часом перемикання тригера молодшого розряду 
(бо кожний наступний розряд перемикається з удвічі меншою частотою, 
ніж попередній), тобто в цьому разі послідовні лічильники мають найвищу 

бують мінімум ресурсу мікросхем. 
перенесенням

микальної таблиці двійкового лічильника (див. табл. 8.1), кожний насту
ний його розряд має перемикатися до протилежного стану з надходженням 

імпульсу лише за умови перебування всіх попередніх 
. Так, розряд з виходом Q1 перемикається зі ст

Q2 – зі станів 

 

перенесенням є їхня
через регулярність структури і мінімум міжз’єднань, що сприяє також пі

низька швидкодія та залежність її 
зростає і час усталення 

Крім того, під час перемикання виникають хибні стани, наприклад, п
рехід вихідного коду від 3 до 4 супроводжується проміжними станами 2 і 0 

б), що може бути небезпечним для роботи пристроїв, спол
дами лічильника. Отже, вихідний код зчитують після

перехідного процесу його усталення, тобто через час tл.  
Проте у вимірювальній техніці, коли з метою підвищення вірогі

ності результатів підраховують пачки імпульсів і зчитування коду викон
низки таких пачок, ці недоліки не є суттєвими. Не 

впливають вони також на поділ частоти: як видно з діаграм на рис. 
частота сигналу на виході кожного наступного розряду зменшується вдв

частота вхідного сигналу обм
жується лише часом перемикання тригера молодшого розряду fмакс
(бо кожний наступний розряд перемикається з удвічі меншою частотою, 
ніж попередній), тобто в цьому разі послідовні лічильники мають найвищу 

перенесенням. Як видно з пер
1), кожний насту

ний його розряд має перемикатися до протилежного стану з надходженням 
імпульсу лише за умови перебування всіх попередніх 

перемикається зі ст
зі станів N = 3, 7, коли 

ня простота 
через регулярність структури і мінімум міжз’єднань, що сприяє також під-

низька швидкодія та залежність її 
зростає і час усталення 

Крім того, під час перемикання виникають хибні стани, наприклад, пе-
рехід вихідного коду від 3 до 4 супроводжується проміжними станами 2 і 0 

б), що може бути небезпечним для роботи пристроїв, сполу-
після закін-

Проте у вимірювальній техніці, коли з метою підвищення вірогід-
ності результатів підраховують пачки імпульсів і зчитування коду викону-

низки таких пачок, ці недоліки не є суттєвими. Не 
впливають вони також на поділ частоти: як видно з діаграм на рис. 8.1, б), 
частота сигналу на виході кожного наступного розряду зменшується вдві-

частота вхідного сигналу обме-
fмакс = 1/tT

(бо кожний наступний розряд перемикається з удвічі меншою частотою, 
ніж попередній), тобто в цьому разі послідовні лічильники мають найвищу 

Як видно з пере-
1), кожний наступ-

ний його розряд має перемикатися до протилежного стану з надходженням 
імпульсу лише за умови перебування всіх попередніх 

перемикається зі ста-
3, 7, коли 

 

простота 
д-

низька швидкодія та залежність її 
зростає і час усталення 

е-
рехід вихідного коду від 3 до 4 супроводжується проміжними станами 2 і 0 

у-
н-

д-
у-

низки таких пачок, ці недоліки не є суттєвими. Не 
, 
і-
е-

T 
(бо кожний наступний розряд перемикається з удвічі меншою частотою, 
ніж попередній), тобто в цьому разі послідовні лічильники мають найвищу 

е-
п-

ний його розряд має перемикатися до протилежного стану з надходженням 
імпульсу лише за умови перебування всіх попередніх 

а-
3, 7, коли 



 

Q
ралельно з лічильним входом, якщо дозвіл на перемикання 
здобути шляхом логічного множення сигналів з виходів усіх попередніх 
розрядів 
(рис.

чильниках) усі розряди, на входах дозволу яких діють рівні 
ремикаються одночасно 
визначається затримкою перемикання лише одного тригера
t
док цього вони перемикаються одночасно, паралельні лічильники є 
ронн

JK
ких паралельних входів 
вою є схема паралельного лічильника на економічних
на синтезувати з урахуванням функції збудження 
посередньо з перемикальної таблиці (див. табл. 
рмів значення 

 ; 10 QDQ =

 

Q0 = Q1  = 1. Отже, синхровходи тригерів всіх розряди можна з’єднати п
ралельно з лічильним входом, якщо дозвіл на перемикання 
здобути шляхом логічного множення сигналів з виходів усіх попередніх 
розрядів 
(рис. 8.2, а)

У таких лічильниках з паралельним 
чильниках) усі розряди, на входах дозволу яких діють рівні 
ремикаються одночасно 
визначається затримкою перемикання лише одного тригера
tл = tT. З огляду на те, що синхровхід для всіх розрядів є спільни
док цього вони перемикаються одночасно, паралельні лічильники є 
ронними.  

ТЕ
JK-тригерів шляхом об’єднання паралельних входів 
ких паралельних входів 
вою є схема паралельного лічильника на економічних
на синтезувати з урахуванням функції збудження 
посередньо з перемикальної таблиці (див. табл. 
рмів значення 

 1010 QQQQ +

= 1. Отже, синхровходи тригерів всіх розряди можна з’єднати п
ралельно з лічильним входом, якщо дозвіл на перемикання 
здобути шляхом логічного множення сигналів з виходів усіх попередніх 
розрядів Ei = Q0Q

а). 

У таких лічильниках з паралельним 
чильниках) усі розряди, на входах дозволу яких діють рівні 
ремикаються одночасно 
визначається затримкою перемикання лише одного тригера

. З огляду на те, що синхровхід для всіх розрядів є спільни
док цього вони перемикаються одночасно, паралельні лічильники є 

 
ТЕ-тригери з кількома входами дозволу 

тригерів шляхом об’єднання паралельних входів 
ких паралельних входів 
вою є схема паралельного лічильника на економічних
на синтезувати з урахуванням функції збудження 
посередньо з перемикальної таблиці (див. табл. 
рмів значення Qi

+ (рис. 

 01 QQQ ⊕=

= 1. Отже, синхровходи тригерів всіх розряди можна з’єднати п
ралельно з лічильним входом, якщо дозвіл на перемикання 
здобути шляхом логічного множення сигналів з виходів усіх попередніх 

Q1 … Q

У таких лічильниках з паралельним 
чильниках) усі розряди, на входах дозволу яких діють рівні 
ремикаються одночасно (рис. 
визначається затримкою перемикання лише одного тригера

. З огляду на те, що синхровхід для всіх розрядів є спільни
док цього вони перемикаються одночасно, паралельні лічильники є 

тригери з кількома входами дозволу 
тригерів шляхом об’єднання паралельних входів 

ких паралельних входів – за допомогою додаткових елементів І. Проте баз
вою є схема паралельного лічильника на економічних
на синтезувати з урахуванням функції збудження 
посередньо з перемикальної таблиці (див. табл. 

(рис. 8.3, а) і мінімізуємо функції збудження лічильника:

;00 QD =

 ; 021 QQDQ =

142

= 1. Отже, синхровходи тригерів всіх розряди можна з’єднати п
ралельно з лічильним входом, якщо дозвіл на перемикання 
здобути шляхом логічного множення сигналів з виходів усіх попередніх 

Qi-1 і побудувати лічильник на ТЕ

а)

б)
Рисунок

У таких лічильниках з паралельним 
чильниках) усі розряди, на входах дозволу яких діють рівні 

рис. 8.2, б), тому час усталення вихідного коду 
визначається затримкою перемикання лише одного тригера

. З огляду на те, що синхровхід для всіх розрядів є спільни
док цього вони перемикаються одночасно, паралельні лічильники є 

тригери з кількома входами дозволу 
тригерів шляхом об’єднання паралельних входів 

за допомогою додаткових елементів І. Проте баз
вою є схема паралельного лічильника на економічних
на синтезувати з урахуванням функції збудження 
посередньо з перемикальної таблиці (див. табл. 

а) і мінімізуємо функції збудження лічильника:

101 QQD =

021 QQQQ +

142

= 1. Отже, синхровходи тригерів всіх розряди можна з’єднати п
ралельно з лічильним входом, якщо дозвіл на перемикання 
здобути шляхом логічного множення сигналів з виходів усіх попередніх 

і побудувати лічильник на ТЕ

а) 

б) 
Рисунок 8.2 

У таких лічильниках з паралельним перенесенням
чильниках) усі розряди, на входах дозволу яких діють рівні 

б), тому час усталення вихідного коду 
визначається затримкою перемикання лише одного тригера

. З огляду на те, що синхровхід для всіх розрядів є спільни
док цього вони перемикаються одночасно, паралельні лічильники є 

тригери з кількома входами дозволу 
тригерів шляхом об’єднання паралельних входів 

за допомогою додаткових елементів І. Проте баз
вою є схема паралельного лічильника на економічних
на синтезувати з урахуванням функції збудження 
посередньо з перемикальної таблиці (див. табл. 

а) і мінімізуємо функції збудження лічильника:

10 QQQ =+

021 QQQQ =

= 1. Отже, синхровходи тригерів всіх розряди можна з’єднати п
ралельно з лічильним входом, якщо дозвіл на перемикання 
здобути шляхом логічного множення сигналів з виходів усіх попередніх 

і побудувати лічильник на ТЕ

перенесенням
чильниках) усі розряди, на входах дозволу яких діють рівні 

б), тому час усталення вихідного коду 
визначається затримкою перемикання лише одного тригера

. З огляду на те, що синхровхід для всіх розрядів є спільни
док цього вони перемикаються одночасно, паралельні лічильники є 

тригери з кількома входами дозволу Е утворюються на основі  
тригерів шляхом об’єднання паралельних входів J та 

за допомогою додаткових елементів І. Проте баз
вою є схема паралельного лічильника на економічних D-
на синтезувати з урахуванням функції збудження D-тригера 
посередньо з перемикальної таблиці (див. табл. 8.1) вносимо до діаграм т

а) і мінімізуємо функції збудження лічильника:

;10 DQQ ⊕  

.21 QQ ⊕  

= 1. Отже, синхровходи тригерів всіх розряди можна з’єднати п
ралельно з лічильним входом, якщо дозвіл на перемикання і-го розряду
здобути шляхом логічного множення сигналів з виходів усіх попередніх 

і побудувати лічильник на ТЕ-

 

перенесенням (паралельних л
чильниках) усі розряди, на входах дозволу яких діють рівні логічної 1

б), тому час усталення вихідного коду 
визначається затримкою перемикання лише одного тригера і становить 

. З огляду на те, що синхровхід для всіх розрядів є спільним
док цього вони перемикаються одночасно, паралельні лічильники є 

утворюються на основі  
та K, а за браком т

за допомогою додаткових елементів І. Проте баз
-тригерах, яку мо

тригера =iD
1) вносимо до діаграм т

а) і мінімізуємо функції збудження лічильника:

102 QQQD =

 

= 1. Отже, синхровходи тригерів всіх розряди можна з’єднати па-
го розряду

здобути шляхом логічного множення сигналів з виходів усіх попередніх 
-тригерах 

(паралельних лі-
логічної 1, пе-

б), тому час усталення вихідного коду 
і становить 
м і внаслі-

док цього вони перемикаються одночасно, паралельні лічильники є синх-

утворюються на основі  
а за браком та-

за допомогою додаткових елементів І. Проте базо-
тригерах, яку мож-

+= iQ . Без-
1) вносимо до діаграм те-

а) і мінімізуємо функції збудження лічильника: 

102 QQQQ +

 (8.1)

а-
го розряду 

здобути шляхом логічного множення сигналів з виходів усіх попередніх 
тригерах 

 

і-
е-

б), тому час усталення вихідного коду 
і становить 

і-
х-

утворюються на основі  
а-
о-
ж-
з-
е-

102 QQQ ⊕=

1) 



 

ряду:
 

на підставі якої можна побудувати схему багаторозрядного лічильника, з
крема, трирозрядного (рис. 
входи тригерів з прямим 
кання відбуватиметься за негативними перепадами цих імпульсів 
(рис.
ням.

їх
ктури і ускладнення міжз’єднань зі збільшенням розрядності 
кожного наступного розряду потрібно утворювати ко
виходів усіх попередніх розрядів.
лодші розряди та через одночасність перемикання в окремі моменти всіх 
тригерів виникають значні сплески струму в колах живлення. З огляду на 
те, що такі струмові імп

 

Узагальнюючи (
ряду: 
 

на підставі якої можна побудувати схему багаторозрядного лічильника, з
крема, трирозрядного (рис. 
входи тригерів з прямим 
кання відбуватиметься за негативними перепадами цих імпульсів 
(рис. 8.3, в), як за використання тригерів з інверсним динамічним керува
ням. 

Таким чином, перевагою лічильників з паралельним 
їхня максимально можлива швидкодія, а недоліком 
ктури і ускладнення міжз’єднань зі збільшенням розрядності 
кожного наступного розряду потрібно утворювати ко
виходів усіх попередніх розрядів.
лодші розряди та через одночасність перемикання в окремі моменти всіх 
тригерів виникають значні сплески струму в колах живлення. З огляду на 
те, що такі струмові імп

Узагальнюючи (

 

на підставі якої можна побудувати схему багаторозрядного лічильника, з
крема, трирозрядного (рис. 
входи тригерів з прямим 
кання відбуватиметься за негативними перепадами цих імпульсів 

в), як за використання тригерів з інверсним динамічним керува

Таким чином, перевагою лічильників з паралельним 
максимально можлива швидкодія, а недоліком 

ктури і ускладнення міжз’єднань зі збільшенням розрядності 
кожного наступного розряду потрібно утворювати ко
виходів усіх попередніх розрядів.
лодші розряди та через одночасність перемикання в окремі моменти всіх 
тригерів виникають значні сплески струму в колах живлення. З огляду на 
те, що такі струмові імп

Узагальнюючи (8.1), дістанемо функцію збудження довільного ро

 D

на підставі якої можна побудувати схему багаторозрядного лічильника, з
крема, трирозрядного (рис. 
входи тригерів з прямим динамічним керуванням через інвертор, перем
кання відбуватиметься за негативними перепадами цих імпульсів 

в), як за використання тригерів з інверсним динамічним керува

Таким чином, перевагою лічильників з паралельним 
максимально можлива швидкодія, а недоліком 

ктури і ускладнення міжз’єднань зі збільшенням розрядності 
кожного наступного розряду потрібно утворювати ко
виходів усіх попередніх розрядів.
лодші розряди та через одночасність перемикання в окремі моменти всіх 
тригерів виникають значні сплески струму в колах живлення. З огляду на 
те, що такі струмові імпульси можуть спричинити збої в роботі ЦП, 

143

1), дістанемо функцію збудження довільного ро

i QQD = 10 K

на підставі якої можна побудувати схему багаторозрядного лічильника, з
крема, трирозрядного (рис. 8.3, б). Якщо лічильні імпульси подавати на 

динамічним керуванням через інвертор, перем
кання відбуватиметься за негативними перепадами цих імпульсів 

в), як за використання тригерів з інверсним динамічним керува

а)

б)

в)
Рисунок

Таким чином, перевагою лічильників з паралельним 
максимально можлива швидкодія, а недоліком 

ктури і ускладнення міжз’єднань зі збільшенням розрядності 
кожного наступного розряду потрібно утворювати ко
виходів усіх попередніх розрядів. Крім того, зростає навантаження на м
лодші розряди та через одночасність перемикання в окремі моменти всіх 
тригерів виникають значні сплески струму в колах живлення. З огляду на 

ульси можуть спричинити збої в роботі ЦП, 

143

1), дістанемо функцію збудження довільного ро

ii QQ ⊕−1K

на підставі якої можна побудувати схему багаторозрядного лічильника, з
б). Якщо лічильні імпульси подавати на 

динамічним керуванням через інвертор, перем
кання відбуватиметься за негативними перепадами цих імпульсів 

в), як за використання тригерів з інверсним динамічним керува

а) 

б) 

в) 
Рисунок 8.3 

Таким чином, перевагою лічильників з паралельним 
максимально можлива швидкодія, а недоліком 

ктури і ускладнення міжз’єднань зі збільшенням розрядності 
кожного наступного розряду потрібно утворювати ко

Крім того, зростає навантаження на м
лодші розряди та через одночасність перемикання в окремі моменти всіх 
тригерів виникають значні сплески струму в колах живлення. З огляду на 

ульси можуть спричинити збої в роботі ЦП, 

1), дістанемо функцію збудження довільного ро

, 

на підставі якої можна побудувати схему багаторозрядного лічильника, з
б). Якщо лічильні імпульси подавати на 

динамічним керуванням через інвертор, перем
кання відбуватиметься за негативними перепадами цих імпульсів 

в), як за використання тригерів з інверсним динамічним керува

Таким чином, перевагою лічильників з паралельним 
максимально можлива швидкодія, а недоліком – нерегулярність стр

ктури і ускладнення міжз’єднань зі збільшенням розрядності 
кожного наступного розряду потрібно утворювати кон’юнкцію сигналів з 

Крім того, зростає навантаження на м
лодші розряди та через одночасність перемикання в окремі моменти всіх 
тригерів виникають значні сплески струму в колах живлення. З огляду на 

ульси можуть спричинити збої в роботі ЦП, 

1), дістанемо функцію збудження довільного ро

 

на підставі якої можна побудувати схему багаторозрядного лічильника, з
б). Якщо лічильні імпульси подавати на 

динамічним керуванням через інвертор, перем
кання відбуватиметься за негативними перепадами цих імпульсів 

в), як за використання тригерів з інверсним динамічним керува

Таким чином, перевагою лічильників з паралельним перенесенням
нерегулярність стр

ктури і ускладнення міжз’єднань зі збільшенням розрядності n, бо на вході 
н’юнкцію сигналів з 

Крім того, зростає навантаження на м
лодші розряди та через одночасність перемикання в окремі моменти всіх 
тригерів виникають значні сплески струму в колах живлення. З огляду на 

ульси можуть спричинити збої в роботі ЦП, 

1), дістанемо функцію збудження довільного роз-

 (8.2)

на підставі якої можна побудувати схему багаторозрядного лічильника, зо-
б). Якщо лічильні імпульси подавати на 

динамічним керуванням через інвертор, переми-
кання відбуватиметься за негативними перепадами цих імпульсів 

в), як за використання тригерів з інверсним динамічним керуван-

 

 

перенесенням є 
нерегулярність стру-

, бо на вході 
н’юнкцію сигналів з 

Крім того, зростає навантаження на мо-
лодші розряди та через одночасність перемикання в окремі моменти всіх 
тригерів виникають значні сплески струму в колах живлення. З огляду на 

ульси можуть спричинити збої в роботі ЦП, є об-

з-

2) 

о-
б). Якщо лічильні імпульси подавати на 

и-
кання відбуватиметься за негативними перепадами цих імпульсів 

н-

 

 

є 
у-

, бо на вході 
н’юнкцію сигналів з 

о-
лодші розряди та через одночасність перемикання в окремі моменти всіх 
тригерів виникають значні сплески струму в колах живлення. З огляду на 

б-



 

меження на максимальну розрядність паралельних лічильників у деяких 
ПЛІС, а в ІС жорсткої структури таке обмеження пов’язане також з кон
труктивними міркуваннями.

річчя між швидкодією і складністю, лічильники розбивають на групи з пе
ним видом переносу всередині них, а між групами окремо застосовують 
повий перенос
льно
довним перенесенням між ними (рис. 8.4), які в цілому є 

льного імпульсу переходять до одиничного стану, формується групов
перенос: елемент збігу дозволяє проходження наступному імпульсу до 
входу старшої групи розрядів. З урахуванням середнього часу
поширення
сенням
льний час усталення коду на виході лічильника з 
t
щуються міжрозрядні зв’язки та зменшується потрібний ресурс мікросхем.

денням у міжгрупових зв’язках на рис. 
ється
зв’язках схеми на рис. 
дових запровадити ланцюжок двовходових елементів І, отримаємо 
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вуваному вході має діяти пасивний рівень (у прикладі логічний 0). У режимі 
підсумовування імпульси подаються на вхід UP і вмикаються міжрозрядні 
зв’язки з прямих виходів тригерів, а рівнем DN = 0 вимикаються зв’язки з ін-
версних виходів. У режимі віднімання, навпаки, лічильні імпульси надходять 
на вхід DN, вмикаються зв’язки з інверсних виходів, а рівнем UP = 0 вими-
каються зв’язки з прямих виходів. Вихідні сигнали переносу COUT (Carry 
output) і позики BOUT (Borrow output) призначені для каскадування лічиль-
ників. 

8.1.2.5 Макрофункції. Лічильники належать до найпоширенішої 
групи ЦПП: засвоєно випуск чотирьох десятків їх типономіналів у складі 
серії 74, що є стандартними макрофункціями, крім того, для програмуван-
ня ВІСПС застосовуються кілька спеціалізованих макрофункцій та універ-
сальна мегафункція лічильника. Типові різновиди макрофункцій двійкових 
лічильників наведено на рис. 8.7.  

 
1) 

 
2) 

 
3) 

 
4) 

 

 
5) 

 
6) 

Рисунок 8.7 
У таких макрофункціях обов’язковими є лічильний вхід CLК (або два 

лічильні входи UP і DN) та вхід скидання CLR (символи 1 ... 6), часто є також 
вхід LD асинхронного передустановлення до потрібного стану зі входів A, B, 
C, … у паралельному коді (символи 3, 5, 6). Класичні лічильники є паралель-
ними за схемою на рис. 8.3, б); при цьому в корпусі ІС можуть міститися кі-
лька груп паралельних лічильників з окремими лічильними входами. Послі-
довним з’єднанням груп з одного і трьох розрядів (символи 1, 2, 3) можна 
утворити лічильники на 1...4 розряди, а додаванням ще чотирирозрядної гру-
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пи (символ 2) – лічильники на 1...8 розрядів. Проте за браком спільного синх-
ровходу утворені таким чином лічильники є асинхронними, з проміжними 
станами під час зміни вихідного коду. Цього недоліку позбавлена низка ІС 8-
розрядних паралельних лічильників, у тому числі з додатковими функціями. 
Прикладом є лічильник (символ 4) з вихідним регістром (його синхровхід 
RCLK, по виходах QA …QH формується вихідний перенос RCON), дозволом 
CCKEN на проходження лічильних імпульсів CCLK, асинхронним скиданням 
CCLRN та трьома станами виходів (керуються сигналом GN). 

Реверсивні двійкові лічильники виконано, як правило, за схемою на 
рис. 8.6, а) (символ 5), інколи за схемою на рис. 8.6, в (символ 6). 
 

8.1.3  Лічильники з довільним модулем лічби 
8.1.3.1 Перетворення двійкових лічильників у недвійкові 
Якщо в n-розрядному двійковому лічильнику з модулем 2n виклю-

чити Мн = 2n – М надлишкових станів, то він перетвориться в недвійковий з 
модулем М < 2n. Тому потрібна кількість розрядів n двійкового лічильника 
для утворення недвійкового з модулем М обчислюється в САПР як 
 n = Ceil (log2M), (8.4) 
де Ceil (ceiling – стеля) – найближче ціле число, що не менше виразу в ду-
жках, наприклад, Ceil (log25) = 3. Або простіше вручну розрядність можна 
визначити з умови 

 2n-1 <  М < 2n, (8.5) 

наприклад, недвійковий лічильник з модулем М = 5, виходячи з 22 < 5 < 23, 
можна утворити з трирозрядного двійкового лічильника, якщо усунути   
Мн = 2n – М = 23 – 5 = 3 надлишкові стани. 

Є декілька методів перетворення двійкових лічильників у недвійко-
ві залежно від способу усунення надлишкових станів. Лічильник з природ-
ним порядком лічби утворюється виключенням старших надлишкових 
станів N = M, … , 2n – 1 шляхом примусового скидання двійкового лічиль-
ника. Принцип такого перетворення розглянемо з самого початку. На ІС 
жорсткої структури приступними є лише її зовнішні виводи, зокрема, вхід 
скидання двійкового лічильника R і виходи, з яких знімається код N. З над-
ходженням лічильних імпульсів С вихідний код зростає в межах 
N = 0, 1, ..., М і перетворюється в дешифраторі в унітарний код. Коли на 
виході, номер якого збігається з модулем лічби М, з’являється активний рі-
вень RM, лічильник скидається до нуля і далі цикл лічби повторюється. 
Стан N = М, в якому лічильник перебуває короткочасно, не використову-
ється, тому кількість фіксованих станів N = 0, 1, ..., М – 1 становить потрі-
бний модуль лічби М. Програмований лічильник за методом примусового 
скидання двійкового лічильника можна побудувати заміною дешифратора 
на цифровий компаратор (рис. 8.9, а). Коли, під час лічби вихідний код N 



 

сягає потрібного модуля 
дженням наступних імпульсів на вхід

дних зв’язків 
вадженням 
передніх 
стани, отже, 
Якщо будувати в такий спосіб лічильники з послідовним або комбінов
ним 
збудження як інформаційних, так і синхровходів тригерів, а в паралельних 
лічильників 
функції збудження лише інформаційних входів. 

льного лічильника з модулем 
перемикатися за часовими діаграмами 

перемикальній таблиці (рис. 
наступного
хуванням того, що коди 

льника на 
цій 
розряду колонкам 
правої частини. Тому для переходів
J
розрядів згідно з таблицею переходів 
герах вносимо значення 
тригер не перемикається та 

а інші функції збудження мінімізуємо за діаграмами термів (на рис. 
порожнім клітинкам відповідають факультативні значення Х):

 

сягає потрібного модуля 
дженням наступних імпульсів на вхід

 
8.1.3.2
Двійкові лічильники утворюються за допомогою 

дних зв’язків 
вадженням 
передніх –
стани, отже, 
Якщо будувати в такий спосіб лічильники з послідовним або комбінов
ним перенесенням
збудження як інформаційних, так і синхровходів тригерів, а в паралельних 
лічильників 
функції збудження лише інформаційних входів. 

Методику проектування
льного лічильника з модулем 
перемикатися за часовими діаграмами 

1) За потрібною кількіст
перемикальній таблиці (рис. 
наступного
хуванням того, що коди 

 

2) Вибираємо тип тригерів (для прикладу розглянемо варіанти ліч
льника на 
цій збудження на їх
розряду колонкам 
правої частини. Тому для переходів
J2K2 = 0Х, 1Х, Х1, відтак аналогічно заповн
розрядів згідно з таблицею переходів 
герах вносимо значення 
тригер не перемикається та 

3) Безпосередньо з таблиці довизначенням Х = 1 маємо 
а інші функції збудження мінімізуємо за діаграмами термів (на рис. 
порожнім клітинкам відповідають факультативні значення Х):

сягає потрібного модуля 
дженням наступних імпульсів на вхід

8.1.3.2 Лічильники зі зворотними зв’язками
Двійкові лічильники утворюються за допомогою 

дних зв’язків – з виходів попередніх на входи наступних розрядів. Запр
вадженням зворотних

– блокуванням перенесень можна усунути будь
стани, отже, отримати
Якщо будувати в такий спосіб лічильники з послідовним або комбінов

перенесенням 
збудження як інформаційних, так і синхровходів тригерів, а в паралельних 
лічильників синхровхід всіх розрядів є спільни
функції збудження лише інформаційних входів. 

Методику проектування
льного лічильника з модулем 
перемикатися за часовими діаграмами 

1) За потрібною кількіст
перемикальній таблиці (рис. 
наступного по надходженн
хуванням того, що коди 

2) Вибираємо тип тригерів (для прикладу розглянемо варіанти ліч
льника на JK-, D- i 
збудження на їх

розряду колонкам Q
правої частини. Тому для переходів

= 0Х, 1Х, Х1, відтак аналогічно заповн
розрядів згідно з таблицею переходів 
герах вносимо значення 
тригер не перемикається та 

3) Безпосередньо з таблиці довизначенням Х = 1 маємо 
а інші функції збудження мінімізуємо за діаграмами термів (на рис. 
порожнім клітинкам відповідають факультативні значення Х):

сягає потрібного модуля M, сигналом
дженням наступних імпульсів на вхід

Лічильники зі зворотними зв’язками
Двійкові лічильники утворюються за допомогою 

з виходів попередніх на входи наступних розрядів. Запр
зворотних зв’язків 
блокуванням перенесень можна усунути будь
отримати лічильники з 

Якщо будувати в такий спосіб лічильники з послідовним або комбінов
 між окремими розрядами, потрібно визначати функції 

збудження як інформаційних, так і синхровходів тригерів, а в паралельних 
синхровхід всіх розрядів є спільни

функції збудження лише інформаційних входів. 
Методику проектування

льного лічильника з модулем 
перемикатися за часовими діаграмами 

1) За потрібною кількіст
перемикальній таблиці (рис. 

по надходженні лічильного імпульсу
хуванням того, що коди N = 5 ... 7 є надлишков

2) Вибираємо тип тригерів (для прикладу розглянемо варіанти ліч
 TE-тригерах) та заповнюємо стовпці таблиці для фун

збудження на їхніх інформаційних входах. Так, 
Q2Q2

+ лівої частини таблиці відповідають колонки 
правої частини. Тому для переходів

= 0Х, 1Х, Х1, відтак аналогічно заповн
розрядів згідно з таблицею переходів 
герах вносимо значення Dі = 
тригер не перемикається та Е

3) Безпосередньо з таблиці довизначенням Х = 1 маємо 
а інші функції збудження мінімізуємо за діаграмами термів (на рис. 
порожнім клітинкам відповідають факультативні значення Х):
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, сигналом 
дженням наступних імпульсів на вхід 

Лічильники зі зворотними зв’язками
Двійкові лічильники утворюються за допомогою 

з виходів попередніх на входи наступних розрядів. Запр
зв’язків – з виходів наступних розрядів на входи п

блокуванням перенесень можна усунути будь
лічильники з довільним модулем і порядком лічби. 

Якщо будувати в такий спосіб лічильники з послідовним або комбінов
між окремими розрядами, потрібно визначати функції 

збудження як інформаційних, так і синхровходів тригерів, а в паралельних 
синхровхід всіх розрядів є спільни

функції збудження лише інформаційних входів. 
Методику проектування розглянемо на прикладі побудови парал

льного лічильника з модулем М = 5 і природним порядком лічби, який має 
перемикатися за часовими діаграмами 

1) За потрібною кількістю розрядів 
перемикальній таблиці (рис. 8.9, а) заповнюємо колонки початкового 

і лічильного імпульсу
= 5 ... 7 є надлишков

Рисунок
2) Вибираємо тип тригерів (для прикладу розглянемо варіанти ліч

тригерах) та заповнюємо стовпці таблиці для фун
інформаційних входах. Так, 
лівої частини таблиці відповідають колонки 

правої частини. Тому для переходів Q
= 0Х, 1Х, Х1, відтак аналогічно заповн

розрядів згідно з таблицею переходів 
= Qі

+, а на ТЕ
Еі = 1, якщо перемикається.

3) Безпосередньо з таблиці довизначенням Х = 1 маємо 
а інші функції збудження мінімізуємо за діаграмами термів (на рис. 
порожнім клітинкам відповідають факультативні значення Х):

149

 RM лічильник обнуляється, а з надх
 C цикл лічби повторюється.

Лічильники зі зворотними зв’язками
Двійкові лічильники утворюються за допомогою 

з виходів попередніх на входи наступних розрядів. Запр
з виходів наступних розрядів на входи п

блокуванням перенесень можна усунути будь
довільним модулем і порядком лічби. 

Якщо будувати в такий спосіб лічильники з послідовним або комбінов
між окремими розрядами, потрібно визначати функції 

збудження як інформаційних, так і синхровходів тригерів, а в паралельних 
синхровхід всіх розрядів є спільни

функції збудження лише інформаційних входів. 
розглянемо на прикладі побудови парал
= 5 і природним порядком лічби, який має 

перемикатися за часовими діаграмами (рис. 8.8)
розрядів n = 
а) заповнюємо колонки початкового 

і лічильного імпульсу
= 5 ... 7 є надлишковими

Рисунок 8.8 
2) Вибираємо тип тригерів (для прикладу розглянемо варіанти ліч

тригерах) та заповнюємо стовпці таблиці для фун
інформаційних входах. Так, 
лівої частини таблиці відповідають колонки 

Q2Q2
+ = 00, 01, 10 вносимо значення 

= 0Х, 1Х, Х1, відтак аналогічно заповнюємо колонки для всіх інших 
розрядів згідно з таблицею переходів JK-тригера. Для розрядів на 

, а на ТЕ-тригерах 
= 1, якщо перемикається.

3) Безпосередньо з таблиці довизначенням Х = 1 маємо 
а інші функції збудження мінімізуємо за діаграмами термів (на рис. 
порожнім клітинкам відповідають факультативні значення Х):

лічильник обнуляється, а з надх
цикл лічби повторюється.

Лічильники зі зворотними зв’язками 
Двійкові лічильники утворюються за допомогою 

з виходів попередніх на входи наступних розрядів. Запр
з виходів наступних розрядів на входи п

блокуванням перенесень можна усунути будь
довільним модулем і порядком лічби. 

Якщо будувати в такий спосіб лічильники з послідовним або комбінов
між окремими розрядами, потрібно визначати функції 

збудження як інформаційних, так і синхровходів тригерів, а в паралельних 
синхровхід всіх розрядів є спільним, тому достатньо знайти 

функції збудження лише інформаційних входів.  
розглянемо на прикладі побудови парал
= 5 і природним порядком лічби, який має 

). 
= 3 аналогічно табл. 

а) заповнюємо колонки початкового 
і лічильного імпульсу Qі

+ станів тригерів з ур
ими. 

2) Вибираємо тип тригерів (для прикладу розглянемо варіанти ліч
тригерах) та заповнюємо стовпці таблиці для фун
інформаційних входах. Так, у JK
лівої частини таблиці відповідають колонки 

= 00, 01, 10 вносимо значення 
юємо колонки для всіх інших 

тригера. Для розрядів на 
тригерах записуємо

= 1, якщо перемикається. 
3) Безпосередньо з таблиці довизначенням Х = 1 маємо 

а інші функції збудження мінімізуємо за діаграмами термів (на рис. 
порожнім клітинкам відповідають факультативні значення Х):

лічильник обнуляється, а з надх
цикл лічби повторюється.

Двійкові лічильники утворюються за допомогою прямих міжрозр
з виходів попередніх на входи наступних розрядів. Запр

з виходів наступних розрядів на входи п
блокуванням перенесень можна усунути будь-які надлишкові 

довільним модулем і порядком лічби. 
Якщо будувати в такий спосіб лічильники з послідовним або комбінов

між окремими розрядами, потрібно визначати функції 
збудження як інформаційних, так і синхровходів тригерів, а в паралельних 

, тому достатньо знайти 

розглянемо на прикладі побудови парал
= 5 і природним порядком лічби, який має 

аналогічно табл. 
а) заповнюємо колонки початкового 

станів тригерів з ур

2) Вибираємо тип тригерів (для прикладу розглянемо варіанти ліч
тригерах) та заповнюємо стовпці таблиці для фун

JK-тригеру 
лівої частини таблиці відповідають колонки 

= 00, 01, 10 вносимо значення 
юємо колонки для всіх інших 

тригера. Для розрядів на 
записуємо Еі = 0, якщо 

3) Безпосередньо з таблиці довизначенням Х = 1 маємо К2
а інші функції збудження мінімізуємо за діаграмами термів (на рис. 
порожнім клітинкам відповідають факультативні значення Х): 

лічильник обнуляється, а з надхо-
цикл лічби повторюється. 

міжрозря-
з виходів попередніх на входи наступних розрядів. Запро-

з виходів наступних розрядів на входи по-
які надлишкові 

довільним модулем і порядком лічби. 
Якщо будувати в такий спосіб лічильники з послідовним або комбінова-

між окремими розрядами, потрібно визначати функції 
збудження як інформаційних, так і синхровходів тригерів, а в паралельних 

, тому достатньо знайти 

розглянемо на прикладі побудови парале-
= 5 і природним порядком лічби, який має 

аналогічно табл. 8.1, 8.2 у 
а) заповнюємо колонки початкового Qі та 

станів тригерів з ура-

 

2) Вибираємо тип тригерів (для прикладу розглянемо варіанти лічи-
тригерах) та заповнюємо стовпці таблиці для функ-

 старшого 
лівої частини таблиці відповідають колонки J2K2 її 

= 00, 01, 10 вносимо значення 
юємо колонки для всіх інших 

тригера. Для розрядів на D-три-
= 0, якщо 

2 = К0 = 1, 
а інші функції збудження мінімізуємо за діаграмами термів (на рис. 8.11, б)
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які надлишкові 
довільним модулем і порядком лічби. 

а-
між окремими розрядами, потрібно визначати функції 

збудження як інформаційних, так і синхровходів тригерів, а в паралельних 
, тому достатньо знайти 
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4) З’єднуючи синхровходи тригерів зі спільним лічильним входом 
С, а інші входи – згідно з функціями збудження, отримуємо варіанти реалі-
зації лічильника на JK-, D- i TE-тригерах (рис. 8.9, в), г), д) відповідно). 
Такі лічильники є синхронними, отже, перемикаються без проміжних ста-
нів вихідного коду (див. рис. 8.10). 

Найпростіший щодо реалізації варіант визначається елементною ба-
зою. Так, лічильники на JK-тригерах з дубльованими входами потребують 
мінімуму додаткових елементів у міжрозрядних зв’язках (при викори- 
станні інверсного виходу і подвійних входів у старшому розряді схема на 
рис. 8.9, в) не містить таких елементів) і можуть виявитися зручними для 
побудови на ІС жорсткої структури. 

На програмованих ІС економічнішими є схеми на D- і RSC-
тригерах з динамічним керуванням. Крім того, для низки застосувань доці-
льною є побудова лічильників з довільним модулем і порядком лічби за 
схемами з послідовним і комбінованим перенесенням.    

 
8.1.3.3 Макрофункції і універсальна мегафункція 
Серед ІС лічильників приблизно половина є декадними, з модулем 

лічби М = 10 (символи 1...7 на рис. 8.10), послідовним з’єднанням яких 
можна отримати лічильник з модулем М = 10n. Такі лічильники є парале-
льними за схемою зі зворотними зв’язками і задля гнучкості використання 
можуть містити в корпусі ІС окремі лічильники з модулем М = 2 і з моду-
лем М = 5 (див. рис. 8.9, г), послідовне з’єднання яких утворює асинхрон-
ний лічильник з модулем М = 10 (символи 1, 3, 4). Наявність в корпусі ІС 
ще й декадного лічильника (символ 1) дає змогу отримати також модулі 
М = 20, 50, 100. 

Користуючись входами скидання до нуля CLR (символи 1...4), пе-
редустановлення до дев’ятого стану SET 9 (символи 2, 3) та завантаження 
сигналом LDN зі входів A, B, C, D (символ 4), декадні лічильники, як і 
двійкові, можна перетворити у недвійкові з довільним модулем шляхом 
примусового скидання або нараховування. 

Реверсивні декадні лічильники будуються за таким самим принци-
пом, як і двійкові: з одним лічильним входом U/DN (символи 5, 7) або з 
двома – додавання UP та віднімання DN (символ 6). Засвоєно випуск низки 
лічильників з додатковими функціями, наприклад, з вихідним регістром і 
трьома станами виходу (символ 7) або з дешифратором семисегментного 
коду (символ 9). Є також спеціалізована щодо програмного пакету макро-
функція для лічби в коді Ґрея (символ 8). 

Універсальна мегафункція (символ 10) дозволяє реалізувати потрі-
бний тип двійковокодованого лічильника з довільним модулем лічби. 
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6) 

Counter Gray-Code 

 
8) 

7-Segment Driver 

 
9) 

 
10) 

Рисунок 8.10 

8.1.4  Подільники частоти  
8.1.4.1 Загальна схема безвентильного подільника частоти 
Будь-які лічильники можуть використовуватися як подільники часто-

ти, коефіцієнт поділу якої на виході лічильника дорівнює його модулю лічби. 



 153

Проте додаткові елементи (вентилі) у міжрозрядних зв’язках або потреба ду-
бльованих входів у тригерів ускладнюють лічильники з довільним модулем і 
природним порядком лічби. З огляду на те, що в подільниках частоти поря-
док лічби не має значення, без його дотримання схему гранично спрощують. 

Безвентильні лічильники на JK-тригерах без дубльованих входів бу-
дуються шляхом збільшення модуля лічби на одиницю. Для цього лічиль-
ник з довільним модулем М0 охоплюють зворотним зв’язком за допомогою 
двох тригерів (варіанти схеми на тригерах з інверсним і прямим динаміч-
ним керуванням подано на рис. 8.11, а, б). При цьому перший тригер збі-
льшує модуль вдвічі, а останній додає одиницю (через це для стислості йо-
го називають „одиничним”), тому в цілому модуль такого лічильника ста-
новить М = 2М0 + 1. Наприклад, охоплюючи таким зв’язком чотирирозря-
дний двійковий лічильник, дістанемо модуль М = 33 (рис. 8.11, в).  

Так само утворюються лічильники з будь-яким непарним модулем, 
а при М0 = 1 дістанемо модуль М = 3 безпосереднім з’єднанням першого і 
одиничного тригерів (виокремлена частина на рис. 8. 11, г). Для отримання 
парного модуля лічби досить послідовно ввімкнути лічильний тригер на 
вході або на виході. В останньому випадку (див. рис. 8.11, г) вихідні імпу-
льси Q матимуть форму меандра. 

 
а) 

 
б) 

 
в) 

 
г) 

Рисунок 8.11 

8.1.4.2 Макрофункції подільників частоти і цифрових таймерів 
Випускається обмежена кількість різновидів ІС подільників частоти 

з фіксованим коефіцієнтом поділу через зниження їх серійноздатності, то-
му доцільніше перетворювати лічильники на подільники з довільним мо-
дулем. Макрофункція подільника частоти програмного пакета freqdiv (си-
мвол 1 на рис. 8.10) є паралельним двійковим лічильником з наскрізним 
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перенесенням. На основі двійкових лічильників будуються подільники ча-
стоти з програмованим коефіцієнтом поділу або цифрові таймери (задавачі 
цифрових інтервалів). Модуль для макрофункцій серії 74 програмується в 
межах 23 ... 215 або 23 ... 231; крім того, за додатковими виходами встанов-
люються інші модулі, поєднанням яких зручно задавати часові  інтервали.  

 
8.2  Лабораторне завдання 

8.2.1 Дослідити основні типи двійкових лічильників 
8.2.1.1 Дослідити двійковий підсумовувальний лічильник з послі-

довним перенесенням (послідовний лічильник) на основі Т-тригерів: за 
принциповою електричною схемою і осцилограмами сигналів (схема 1, 
файли d:\max2work\tutorial\8lab\8dwij.gdf, .scf) з’ясувати принцип побудови 
і міжрозрядні зв’язки такого лічильника та визначити затримку його пере-
микання. (У звіті навести схему, умовне графічне позначення лічильника 
за ДСТУ, перемикальну таблицю, осцилограми сигналів, відомості щодо 
швидкодії). 

8.2.1.2 Дослідити двійковий підсумовувальний лічильник з пара-
лельним перенесенням (паралельний лічильник) на основі ТЕ-тригерів 
(схему і символ тригера див. у файлах d:\max2work\tutorial\8lab\8tе.gdf, 
.sym) за п. 8.2.1.1 (схема 2, файли d:\max2work\tutorial\8lab\8dwij.gdf, .scf) 
та розглянути особливості побудови і перемикання базової схеми на 
D-тригерах (схема 3, файли d:\max2work\tutorial\8lab\8dwij.gdf, .scf). (У зві-
ті навести принаймні одну зі схем, осцилограми сигналів, відомості щодо 
швидкодії). 

8.2.1.3 Розглянути особливості побудови і перемикання двійково-
го лічильника в режимі віднімання (схема 4, файли d:\max2work\tutorial\ 
8lab\8dwij.gdf, .scf) та дослідити двійкові реверсивні лічильники з пода-
ванням вхідних імпульсів до однієї точки (схема 5, файли 
d:\max2work\tutorial\8lab\8dwij.gdf, .scf) і двох точок схеми (схема 6, файли 
d:\max2work\ tutorial\8lab\8dwij.gdf, .scf). (У звіті навести схему реверсив-
ного лічильника на D-тригерах, осцилограми сигналів, стисле пояснення 
принципу його дії). 

8.2.1.4 Дослідити недвійковий лічильник, побудований шляхом 
перетворення двійкового (файли d:\max2work\tutorial\8lab\8m16.gdf, .sym) 
скиданням його надлишкових станів за допомогою дешифратора (файли 
d:\max2work\tutorial\8lab\8dc.gdf, .sym) на прикладі декадного лічильника 
(схема 1, файли d:\max2work\tutorial\8lab\8nedw.gdf, .scf); розглянути особ-
ливості побудови і перемикання лічильника, в якому за дешифратор пра-
вить елемент І (схема 2, файли d:\max2work\tutorial\8lab\8nedw.gdf, .scf), 
декадного лічильника на стандартній макрофункції – ІС серії 74 (схема 3, 
файли d:\max2work\tutorial\8lab\8nedw.gdf, .scf) та реверсивного декадного 
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лічильника на мегафункції (схема 4, файли d:\max2work\tutorial\8lab\ 
8nedw.gdf, .scf). (У звіті навести схему 2, осцилограми сигналів такого лі-
чильника, стисле пояснення принципу його дії). 

8.2.1.5 Ознайомитися з різновидами двійкових лічильників бібліо-
теки бази даних (файл d:\max2work\tutorial\8lab\8lіbr.gdf): 1) макрофункці-
ями (дібраними ІС серії 74) двійкових лічильників (Binary) та 2) двійкових 
реверсивних лічильників (Binary Up/Down), з різновидами недвійкових лі-
чильників: 3) макрофункціями (дібраними ІС серії 74) декадних лічильни-
ків (Decade), 4) декадних реверсивних лічильників (Decade Up/Down), з 
іншими різновидами лічильників і подільників частоти і 5) програмовани-
ми цифровими таймерами, а також 6) з універсальною мегафункцією лічи-
льника. (У звіті навести принаймні по одному символу з груп 1...6, поясни-
ти призначення та особливості входів і виходів, а також параметри мега-
функції). 

8.2.2 Спроектувати недвійковий лічильник із заданим модулем 
М (згідно з варіантом завдання див. додаток А, варіанти завдання 8, а) 
і природним порядком лічби шляхом перетворення двійкового лічи-
льника. 

8.2.2.1 Побудувати лічильник на основі макрофункції вибраного 
типу за графічного (.gdf) введення проекту 8XXper_gr, виконати компіля-
цію, моделювання (.sсf) та часовий аналіз у формі матриці затримок 
DELAY MATRIX зі збереженням результату (.tao) і дисплея швидкодії по-
слідовнісних схем REGISTERED PERFORMANCE зі збереженням резуль-
тату (.tao1). 

F Примітка. Тип часового аналізу перемикається з меню Analysis 
за ввімкненого часового аналізатора Timing Analyzer.   

< Приклад: програмований лічильник з природним порядком лічби 
і модулем М = 5, 7 на макрофункції 74293 у файлах d:\max2work\tutorial\ 
8lab\800per_gr.gdf, .sсf, .tao, .tao1. 

8.2.2.2 Виконати п. 8.2.2.1 за текстового (.tdf) введення проекту 
8XXper_tx. 

< Приклад: програмований лічильник з природним порядком лічби 
і модулем М = 5, 7 на макрофункції 74293 у файлах d:\max2work\tutorial\ 
8lab\800per_tx.tdf, .sсf. 

F Примітка. У текстовому файлі (підсекція Boolean 
Equation) імена виводів зразка макрофункції мають точно відповіда-

ти його функціональному прототипові, який можна скопіювати з довідки 
Help (клацнути по символу макрофункції в графічному файлі або по її іме-
ні в текстовому файлі), наприклад,  

AHDL Function Prototype 
FUNCTION 74293 (clka, clkb, clra, clrb) 



 156

                 RETURNS (qd, qc, qb, qa); 
і далі використовувати в рівняннях (з позначенням імені зразка з крапкою): 
ct.clra, ct.clrb, ct.clka, ct.clkb, ct.(qd, qc, qb, qa). 

8.2.3 Спроектувати паралельний лічильник зі зворотними 
зв’язками із заданими модулем М і порядком лічби (згідно з варіантом 
завдання, див. додаток А, варіанти завдання 8, б) та дослідити його, 
користуючись часовими діаграмами.  

8.2.3.1 Побудувати лічильник на тригерах заданого типу за гра-
фічного (.gdf) введення проекту 8XXzz_gr, виконати компіляцію та функ-
ціональне моделювання (.sсf) 

< Приклади: лічильник зі звичайним порядком лічби і модулем 5 
на тригерах типу JK (схема 1), D (схема 2), T (схема 3) та реверсивний лі-
чильник на JK-тригерах (схема 4) у файлах d:\max2work\tutorial\8lab\ 
800zz_gr.gdf, .sсf. 

8.2.3.2 Виконати п. 8.2.3.1 на мегафункції лічильника в тому са-
мому проекті. 

< Приклад: реверсивний лічильник зі звичайним порядком лічби і 
модулем 5 на мегафункції (схема 5) у файлах d:\max2work\tutorial\8lab\ 
800zz_gr.gdf, .sсf. 

8.2.3.3 Виконати п. 8.2.3 за текстового (.tdf) введення проекту 
8XXzz_tx на автоматично створеному за допомогою менеджера 
MegaWizard Plug-In Manager різновиді мегафункції лічильника 
8XXwiz_rew.sym. 

< Приклад: реверсивний лічильник зі звичайним порядком лічби і 
модулем 5 на зразку мегафункції d:\max2work\tutorial\8lab\800wiz_rew.sym 
у файлах d:\max2work\tutorial\8lab\800zz_ tx.tdf, .sсf. 

F Примітка. Зауваження щодо відповідності імен стосується і ме-
гафункції, наприклад, з автоматично створеного її зразка  

FUNCTION 800wiz_rew  (clock, updown) 
                     RETURNS (q[2..0]); 

використовуємо в рівняннях ct.clock, ct.updown, ct.q[]. Імена виводів можна 
взяти з її файлів включення 800wiz_rew.inc або символьного 
800wiz_rew.sym. 

8.2.4 Спроектувати подільник частоти із заданими коефіцієн-
том поділу – модулем М (згідно з варіантом завдання, див. додаток А, 
варіант завдання 8, в) 

8.2.4.1 Побудувати безвентильний подільник частоти з викорис-
танням JK-тригерів за графічного (.gdf) введення проекту 8XXpod_gr, ви-
конати компіляцію і моделювання (.sсf), визначити його швидкодію та 
скласти перемикальний граф.  
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подільник частоти з коефіцієнтом поділу 5 на основі 
лічильника 74293 (схема 1) і з коефіцієнтом поділу 11 на 

tutorial\8lab
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(схема 6) призначені для випробування лічильника
і побудови повного перемикального графа. Для 

цього інверсним кодом, наприклад, SN
часових діаграмах) можна асинхронно записати до 
ка одиниці і по моделюванні імітатором простежити шлях повернення до 

→ 15 → ...; відтак записати з метою наочності в 
цьому (або іншому) місці інший стан поза робочим циклом, знов змодел

і так само повторити цю процедуру для потрібної 

8.2.4.2 Створити подільник частоти за текстового
як скінченний автомат

ним вибором оператора логічної секції для позначення його
4) на кшталт файла 8XXpod

ючись часовими діаграмами (.sсf), визначити тип пристрою, утворений а
томатичним синтезатором як подільник частоти. 

подільник частоти із коефіцієнтом поділу 
lab\800pod

Засвоїти основи створення проекту
введення (часовими діаграмами) на прикладі автоматичного синтезу п
дільника частоти із заданими коефіцієнтом поділу 

, див. додаток А, варіанти завдання 

8.2.5.1 Створити новий файл часових діаграм
wdf з розширенням 

проектний файл часових діаграм) за допомогою 
піктограм (або командами з меню): визначити ім’я проекту, відкрити н
вий файл часових діаграм із зазначеним розширенням та надати йому ім’я 
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подільник частоти з коефіцієнтом поділу 5 на основі 
лічильника 74293 (схема 1) і з коефіцієнтом поділу 11 на 

lab\800pod_
Інверсні асинхронні входи передустановлення 

) призначені для випробування лічильника
і побудови повного перемикального графа. Для 

SN[4..0] = 00
часових діаграмах) можна асинхронно записати до 
ка одиниці і по моделюванні імітатором простежити шлях повернення до 

...; відтак записати з метою наочності в 
цьому (або іншому) місці інший стан поза робочим циклом, знов змодел

і так само повторити цю процедуру для потрібної 

8.2.4.2 Створити подільник частоти за текстового
скінченний автомат

ним вибором оператора логічної секції для позначення його
XXpod_gr.gdf та дослідити його. Корист
), визначити тип пристрою, утворений а

томатичним синтезатором як подільник частоти. 
подільник частоти із коефіцієнтом поділу 

pod_sm.tdf, s
Засвоїти основи створення проекту

на прикладі автоматичного синтезу п
дільника частоти із заданими коефіцієнтом поділу 

, див. додаток А, варіанти завдання 

8.2.5.1 Створити новий файл часових діаграм
ширенням wdf
за допомогою 

піктограм (або командами з меню): визначити ім’я проекту, відкрити н
ним розширенням та надати йому ім’я 

подільник частоти з коефіцієнтом поділу 5 на основі 
лічильника 74293 (схема 1) і з коефіцієнтом поділу 11 на 

_gr.gdf, sс
Інверсні асинхронні входи передустановлення 

) призначені для випробування лічильника
і побудови повного перемикального графа. Для 

[4..0] = 0016 (інтервал 460...480 нс на 
часових діаграмах) можна асинхронно записати до всіх розрядів лічильн
ка одиниці і по моделюванні імітатором простежити шлях повернення до 

...; відтак записати з метою наочності в 
цьому (або іншому) місці інший стан поза робочим циклом, знов змодел

і так само повторити цю процедуру для потрібної 

8.2.4.2 Створити подільник частоти за текстового
скінченний автомат (State Machine) за вла

ним вибором оператора логічної секції для позначення його
.gdf та дослідити його. Корист

), визначити тип пристрою, утворений а
томатичним синтезатором як подільник частоти.  

подільник частоти із коефіцієнтом поділу 
sсf. 

Засвоїти основи створення проекту за 
на прикладі автоматичного синтезу п

дільника частоти із заданими коефіцієнтом поділу – модулем 
, див. додаток А, варіанти завдання 8,

8.2.5.1 Створити новий файл часових діаграм
wdf (Waveform

за допомогою послідовн
піктограм (або командами з меню): визначити ім’я проекту, відкрити н

ним розширенням та надати йому ім’я 

подільник частоти з коефіцієнтом поділу 5 на основі 
лічильника 74293 (схема 1) і з коефіцієнтом поділу 11 на JK-тригерах (сх

сf. 
Інверсні асинхронні входи передустановлення 

) призначені для випробування лічильника
і побудови повного перемикального графа. Для 

(інтервал 460...480 нс на 
всіх розрядів лічильн

ка одиниці і по моделюванні імітатором простежити шлях повернення до 
...; відтак записати з метою наочності в 

цьому (або іншому) місці інший стан поза робочим циклом, знов змодел
і так само повторити цю процедуру для потрібної 

8.2.4.2 Створити подільник частоти за текстового (.
(State Machine) за вла

ним вибором оператора логічної секції для позначення його переходів 
.gdf та дослідити його. Корист

), визначити тип пристрою, утворений а

подільник частоти із коефіцієнтом поділу М

за сигнального
на прикладі автоматичного синтезу п

модулем М 
8, в). 

8.2.5.1 Створити новий файл часових діаграм
Waveform Design
послідовності наведених 

піктограм (або командами з меню): визначити ім’я проекту, відкрити н
ним розширенням та надати йому ім’я 

подільник частоти з коефіцієнтом поділу 5 на основі 
тригерах (схе-

Інверсні асинхронні входи передустановлення 
) призначені для випробування лічильника

і побудови повного перемикального графа. Для 
(інтервал 460...480 нс на 
всіх розрядів лічильни-

ка одиниці і по моделюванні імітатором простежити шлях повернення до 
...; відтак записати з метою наочності в 

цьому (або іншому) місці інший стан поза робочим циклом, знов змоделю-
і так само повторити цю процедуру для потрібної 

 
(.tdf) вве-

(State Machine) за влас-
переходів 

.gdf та дослідити його. Користу-
), визначити тип пристрою, утворений ав-

М = 11 –

сигнального його 
на прикладі автоматичного синтезу по-

М (згідно з 

8.2.5.1 Створити новий файл часових діаграм
Design File –
наведених 

піктограм (або командами з меню): визначити ім’я проекту, відкрити но-
ним розширенням та надати йому ім’я 

подільник частоти з коефіцієнтом поділу 5 на основі 
е-

Інверсні асинхронні входи передустановлення 
) призначені для випробування лічильника 

і побудови повного перемикального графа. Для 
(інтервал 460...480 нс на 

и-
ка одиниці і по моделюванні імітатором простежити шлях повернення до 

...; відтак записати з метою наочності в 
ю-

і так само повторити цю процедуру для потрібної 

е-
с-

переходів 
у-
в-

– 

його 
о-

(згідно з 

8.2.5.1 Створити новий файл часових діаграм 
– 

наведених 
о-

ним розширенням та надати йому ім’я 



 

ний/вихідний тип порту) 
реби, вводимо інші входи, наприклад, скидання та передустановлення тр
герів);

Machine
призначаємо третій стан 
(вторинні входи, тобто керувальні входи, що приєднуються до автомата з 
утворених вхідних кіл) 

 

8.2.5.2 Створити такі кола для подільника частоти:
а) вхідне коло лічи

ний/вихідний тип порту) 
реби, вводимо інші входи, наприклад, скидання та передустановлення тр
герів); 

Machine; Default
призначаємо третій стан 
(вторинні входи, тобто керувальні входи, що приєднуються до автомата з 
утворених вхідних кіл) 

8.2.5.2 Створити такі кола для подільника частоти:
а) вхідне коло лічи

ний/вихідний тип порту) 
реби, вводимо інші входи, наприклад, скидання та передустановлення тр

Default Value
призначаємо третій стан 
(вторинні входи, тобто керувальні входи, що приєднуються до автомата з 
утворених вхідних кіл) 

8.2.5.2 Створити такі кола для подільника частоти:
а) вхідне коло лічильних імпульсів: В** по

ний/вихідний тип порту) – прапорець 
реби, вводимо інші входи, наприклад, скидання та передустановлення тр

Value –  залишаємо не
призначаємо третій стан Z чи визначені стани 0 або 1); 
(вторинні входи, тобто керувальні входи, що приєднуються до автомата з 
утворених вхідних кіл) – прокруткою вводимо 
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8.2.5.2 Створити такі кола для подільника частоти:
льних імпульсів: В** по

прапорець 
реби, вводимо інші входи, наприклад, скидання та передустановлення тр

залишаємо не
чи визначені стани 0 або 1); 

(вторинні входи, тобто керувальні входи, що приєднуються до автомата з 
прокруткою вводимо 
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8.2.5.2 Створити такі кола для подільника частоти:
льних імпульсів: В** по

прапорець Input Pin
реби, вводимо інші входи, наприклад, скидання та передустановлення тр

залишаємо невизначений стан Х (або прокруткою 
чи визначені стани 0 або 1); 

(вторинні входи, тобто керувальні входи, що приєднуються до автомата з 
прокруткою вводимо 

8.2.5.2 Створити такі кола для подільника частоти:
льних імпульсів: В** по полю у верхній частині 

діаграм (під заголовками 
Name, Type
алоговому вікні 
Node (вставити коло) вв
сти в графах: 
ім’я вхідного порту, н
приклад, 
(рівень за замовчуванням) 
– пасивний рівень, напр
клад, 0 
кою); І/О 

Pin > OK (так само, у разі по
реби, вводимо інші входи, наприклад, скидання та передустановлення тр

б) внутрішнє коло 
для логічного зв’язку вх
дних і вихідних сигн
повторюємо п. 
алоговому вікні 
Node вводимо в графах: 
Node Name
вого автомата (
chine), наприклад, 
Type – 
Node (внутрішнє коло); 
Node Type

визначений стан Х (або прокруткою 
чи визначені стани 0 або 1); 

(вторинні входи, тобто керувальні входи, що приєднуються до автомата з 
прокруткою вводимо Clock (тактові імпульси): 

clk та, я
Reset (скидання) і 
(передустановлення) > 
OK; 

в) вихідне коло 
подільника частоти: п
вторюємо п. 
логовому вікні 
Node вводимо в гра
Node Name
хідного порту, напр

8.2.5.2 Створити такі кола для подільника частоти: 
полю у верхній частині 

діаграм (під заголовками 
Type, Value

алоговому вікні 
(вставити коло) вв

сти в графах: Node
ім’я вхідного порту, н
приклад, clk; Default
(рівень за замовчуванням) 
пасивний рівень, напр
клад, 0 (можна прокру
кою); І/О Type

(так само, у разі по
реби, вводимо інші входи, наприклад, скидання та передустановлення тр

б) внутрішнє коло 
для логічного зв’язку вх
дних і вихідних сигн
повторюємо п. а,
алоговому вікні 

вводимо в графах: 
Name – ім’я 
автомата (State

), наприклад, 
 прапорець 
(внутрішнє коло); 
Type – ввімкнути 

визначений стан Х (або прокруткою 
чи визначені стани 0 або 1); Secondary

(вторинні входи, тобто керувальні входи, що приєднуються до автомата з 
(тактові імпульси): 

та, якщо є, так само 
(скидання) і 

(передустановлення) > 

в) вихідне коло 
ника частоти: п

вторюємо п. а, але в ді
логовому вікні 

вводимо в гра
Name – 

хідного порту, напр

полю у верхній частині 
діаграм (під заголовками 

Value) > у ді-
алоговому вікні Insert

(вставити коло) вве-
Node Name –

ім’я вхідного порту, на-
Default Value

(рівень за замовчуванням) 
пасивний рівень, напри-

(можна прокрут-
Type (вхід-

(так само, у разі пот-
реби, вводимо інші входи, наприклад, скидання та передустановлення три-

б) внутрішнє коло 
для логічного зв’язку вхі-
дних і вихідних сигналів: 

а, але в ді-
алоговому вікні Insert

вводимо в графах: 
ім’я кінце-

State Ma-
), наприклад, stm; І/О 
прапорець Buried

(внутрішнє коло); 
ввімкнути 

визначений стан Х (або прокруткою 
Secondary Inputs

(вторинні входи, тобто керувальні входи, що приєднуються до автомата з 
(тактові імпульси): 
кщо є, так само 

(скидання) і Preset
(передустановлення) > 

в) вихідне коло 
ника частоти: по-

але в діа-
логовому вікні Insert

вводимо в графах: 
 ім’я ви-

хідного порту, напри-

полю у верхній частині 
діаграм (під заголовками 

і-
Insert 
е-
– 
а-

Value 
(рівень за замовчуванням) 

и-
т-
д-
т-
и-

б) внутрішнє коло 
і-

лів: 
і-

Insert 
вводимо в графах: 

е-
a-

; І/О 
Buried 

(внутрішнє коло); 
ввімкнути 

визначений стан Х (або прокруткою 
Inputs 

(вторинні входи, тобто керувальні входи, що приєднуються до автомата з 
(тактові імпульси): 
кщо є, так само 

Preset 
(передустановлення) > 

в) вихідне коло 
о-
а-

Insert 
фах: 

-
и-



 

клад, 
призначаємо потрібний стан); І/О 
–
OK
можна ви

цанням на ньому в полі заголовків викликати діалогове вікно 
таке саме, як і  

ми способами, наприклад, з контекстного меню: натиснути кнопкою В2 в п
л

за відповідну прямок
воруч.

лювання: меню 

литься чо
го кольору) вертикаль
С
значений початковий рі
ти 

 

клад, q; Default
призначаємо потрібний стан); І/О 
– вмикаємо 
OK (те саме, у разі по
можна вивести деякі розряди або їх групи).

F Примітки
1. Якщо потрібно виправити якесь коло, достатньо подвійним кл

цанням на ньому в полі заголовків викликати діалогове вікно 
таке саме, як і  

2. Діалогове вікно створення кіл
ми способами, наприклад, з контекстного меню: натиснути кнопкою В2 в п
лі Name або 

3. Для змін
за відповідну прямок
воруч. 

8.2.5.3 Відредагувати створені
а) попередньо, як і для 

лювання: меню 

в полі заголо
литься чор
го кольору) вертикаль
Сlock (зад
значений початковий рі
ти Multiplied

Default Value
призначаємо потрібний стан); І/О 
вмикаємо Registered

(те саме, у разі по
вести деякі розряди або їх групи).
Примітки

1. Якщо потрібно виправити якесь коло, достатньо подвійним кл
цанням на ньому в полі заголовків викликати діалогове вікно 
таке саме, як і  Insert

Діалогове вікно створення кіл
ми способами, наприклад, з контекстного меню: натиснути кнопкою В2 в п

або Type > Insert
Для змінення

за відповідну прямок

8.2.5.3 Відредагувати створені
а) попередньо, як і для 

лювання: меню File

б) ввести вхідні лічильні імпульси у формі меандр
в полі заголовків (

рним, відтак натисненням інструмента С
го кольору) вертикаль

(задати тактові імпульси), в якому або залишити 
значений початковий рі

plied By (коефіцієнт 

Value – залишаємо довільне зна
призначаємо потрібний стан); І/О 

Registered; Secondary
(те саме, у разі потреби, повторюємо для інших виходів, 

вести деякі розряди або їх групи).
Примітки: 

1. Якщо потрібно виправити якесь коло, достатньо подвійним кл
цанням на ньому в полі заголовків викликати діалогове вікно 

Insert Node, та внести необхідні зміни.
Діалогове вікно створення кіл

ми способами, наприклад, з контекстного меню: натиснути кнопкою В2 в п
Insert Node
ення ширини полів 

за відповідну прямокутну кнопку вгорі та перетягнути її ліворуч або пр

8.2.5.3 Відредагувати створені
а) попередньо, як і для 

File > End Time
лишити 1.0
ню Options
ввести потрібний крок сітки, наприклад, 20.0
OK; зауважимо, що одиниці вимірювання (
ns = 
для відображення лі
ж меню 

б) ввести вхідні лічильні імпульси у формі меандр
вків (Name

ним, відтак натисненням інструмента С
го кольору) вертикальної панелі 

ти тактові імпульси), в якому або залишити 
значений початковий рівень) 0, або прокруткою змінити його на 1 та вве

(коефіцієнт 
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залишаємо довільне зна
призначаємо потрібний стан); І/О Type

condary Inputs
треби, повторюємо для інших виходів, 

вести деякі розряди або їх групи).

1. Якщо потрібно виправити якесь коло, достатньо подвійним кл
цанням на ньому в полі заголовків викликати діалогове вікно 

, та внести необхідні зміни.
Діалогове вікно створення кіл

ми способами, наприклад, з контекстного меню: натиснути кнопкою В2 в п
Node. 
ширини полів 

утну кнопку вгорі та перетягнути її ліворуч або пр

8.2.5.3 Відредагувати створені
а) попередньо, як і для SCF-файла, визначити часовий інтервал мод

Time > ввести потрібну величину, наприклад,
лишити 1.0us 

Options викликати ді
ввести потрібний крок сітки, наприклад, 20.0

; зауважимо, що одиниці вимірювання (
 нс) вводяться тут без 

для відображення лі
ж меню встановити

б) ввести вхідні лічильні імпульси у формі меандр
Name, Type або 

ним, відтак натисненням інструмента С
ної панелі зліва

ти тактові імпульси), в якому або залишити 
вень) 0, або прокруткою змінити його на 1 та вве

(коефіцієнт k періоду тактових імпуль
чуванням при 
ки часової сітки 40.0
ненн
пульсів;

то
да
вер
сти ку
ми) при утри
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залишаємо довільне зна
Type – прапорець 
Inputs – прокруткою водимо 

треби, повторюємо для інших виходів, 
вести деякі розряди або їх групи). 

1. Якщо потрібно виправити якесь коло, достатньо подвійним кл
цанням на ньому в полі заголовків викликати діалогове вікно 

, та внести необхідні зміни.
Діалогове вікно створення кіл Insert Node

ми способами, наприклад, з контекстного меню: натиснути кнопкою В2 в п

ширини полів Name, Type
утну кнопку вгорі та перетягнути її ліворуч або пр

8.2.5.3 Відредагувати створені часові діаграми
файла, визначити часовий інтервал мод
ввести потрібну величину, наприклад,

 > OK та позначити часову сітку: з м
викликати ді

ввести потрібний крок сітки, наприклад, 20.0
; зауважимо, що одиниці вимірювання (

) вводяться тут без 
для відображення ліній сітки на екрані слід у цьому 

встановити прапорець 
б) ввести вхідні лічильні імпульси у формі меандр

або Value) порт 
ним, відтак натисненням інструмента С

зліва викликати діалогове вікно 
ти тактові імпульси), в якому або залишити 

вень) 0, або прокруткою змінити його на 1 та вве
періоду тактових імпуль

чуванням при 
ки часової сітки 40.0
нення ОК відтвориться весь рядок і
пульсів; 

в) ввести стани скінченного а
томата stm
дагування (вер
вертикальної панелі ліворуч), прове
сти курсором реда
ми) при утри

залишаємо довільне значення Х (або прокруткою 
прапорець Output
прокруткою водимо 

треби, повторюємо для інших виходів, 

1. Якщо потрібно виправити якесь коло, достатньо подвійним кл
цанням на ньому в полі заголовків викликати діалогове вікно 

, та внести необхідні зміни. 
Node можна викликати і інш

ми способами, наприклад, з контекстного меню: натиснути кнопкою В2 в п

Type, Value
утну кнопку вгорі та перетягнути її ліворуч або пр

часові діаграми: 
файла, визначити часовий інтервал мод
ввести потрібну величину, наприклад,

та позначити часову сітку: з м
викликати діалогове віконце 

ввести потрібний крок сітки, наприклад, 20.0
; зауважимо, що одиниці вимірювання (

) вводяться тут без пропуску
ній сітки на екрані слід у цьому 
прапорець Show

б) ввести вхідні лічильні імпульси у формі меандр
) порт clk, рядок якого вид

ним, відтак натисненням інструмента Сlock (го
викликати діалогове вікно 

ти тактові імпульси), в якому або залишити Star
вень) 0, або прокруткою змінити його на 1 та вве

періоду тактових імпульсів), який за замо
чуванням при k = 1 становить два кр
ки часової сітки 40.0

ОК відтвориться весь рядок і

в) ввести стани скінченного а
stm: натиснути інструмент р

вання (верхня кнопка зі стрілками 
ної панелі ліворуч), прове

рсором редагування (зі стрілк
ми) при утримуваній лівій кнопці м

чення Х (або прокруткою 
Output Pin; Node

прокруткою водимо Clock
треби, повторюємо для інших виходів, наприклад, 

1. Якщо потрібно виправити якесь коло, достатньо подвійним кл
цанням на ньому в полі заголовків викликати діалогове вікно Edit

можна викликати і інш
ми способами, наприклад, з контекстного меню: натиснути кнопкою В2 в п

Value достатньо взятися 
утну кнопку вгорі та перетягнути її ліворуч або пр

 
файла, визначити часовий інтервал мод
ввести потрібну величину, наприклад,

та позначити часову сітку: з м
логове віконце Grid

ввести потрібний крок сітки, наприклад, 20.0
; зауважимо, що одиниці вимірювання (

пропуску після цифри, а 
ній сітки на екрані слід у цьому 

Show Grid; 
б) ввести вхідні лічильні імпульси у формі меандра: клацнути 

, рядок якого вид
(годинник червон

викликати діалогове вікно 
Starting Value

вень) 0, або прокруткою змінити його на 1 та вве
сів), який за замо

= 1 становить два кр
ки часової сітки 40.0ns; після

ОК відтвориться весь рядок і

в) ввести стани скінченного а
: натиснути інструмент р
хня кнопка зі стрілками 

ної панелі ліворуч), прове
гування (зі стрілк

муваній лівій кнопці м

чення Х (або прокруткою 
Node Type

Clock: clk > 
наприклад, 

1. Якщо потрібно виправити якесь коло, достатньо подвійним кла-
Edit Node, 

можна викликати і інши-
ми способами, наприклад, з контекстного меню: натиснути кнопкою В2 в по-

достатньо взятися 
утну кнопку вгорі та перетягнути її ліворуч або пра-

файла, визначити часовий інтервал моде-
ввести потрібну величину, наприклад, за-

та позначити часову сітку: з ме-
Grid Size і 

ввести потрібний крок сітки, наприклад, 20.0ns > 
; зауважимо, що одиниці вимірювання (us = мкс, 

після цифри, а 
ній сітки на екрані слід у цьому 

 
: клацнути 

, рядок якого виді-
динник червоно-

викликати діалогове вікно Overwrite
Value (при-

вень) 0, або прокруткою змінити його на 1 та ввес-
сів), який за замов-

= 1 становить два кро-
після натис-

ОК відтвориться весь рядок ім-

в) ввести стани скінченного ав-
: натиснути інструмент ре-
хня кнопка зі стрілками 

ної панелі ліворуч), прове-
гування (зі стрілка-

муваній лівій кнопці ми-

чення Х (або прокруткою 
Type 

> 
наприклад, 

а-
, 

и-
о-

достатньо взятися 
а-

е-
а-
е-
і 

> 
, 

після цифри, а 
ній сітки на екрані слід у цьому 

: клацнути 
і-
о-

Overwrite 
и-
с-
в-
о-
с-
м-

в-
е-

хня кнопка зі стрілками 
-
а-
и-



 

ші над ді
пере
Overwrite
тично, вве
ся на виді
але збіль
відтак так само ви
вих імпуль
кількість яких у даному випадку дорівнює коефіцієнт
приклад, 11;

льника частоти: у нашому прикладі їх
шим, ніж період вхідних імпульсів 
валості 
періодів імпульсів 
співвідношення можна отримати шляхом порівняння складності під час 
моделювання). Редагуємо цю часову діаграму звичайним 
могою курсора виділення

тримок в елементах схеми, бо вони лише задають бажане співвідношення 
між сигналами, тому всі перепади проміжних і вихідних епюр мають точно 
відповідати моментам зміни вхідних сигналів. В меню 
Snap
сітки) є завжди ввімкненою, тому в часовій моделі не можна розузгодж
вати взаємне положення фронтів, яке може виникнути, наприклад, якщо до 
WDF
ньому є затримки фронтів

також інші варіанти 
ділянки 
риваються вкладки, які повторюють у 
тів вертикальної панелі.

так само, як і в 
шення, зменшення масштабу та розміщення всього зображення в межах 
екрану (кнопка з червоними стрілками).

 

ші над ділян
перепаду тактових імпульсів, відпустити кно
Overwrite 
тично, вве
ся на виді
але збільшен
відтак так само ви
вих імпуль
кількість яких у даному випадку дорівнює коефіцієнт
приклад, 11;

г) ввести діаграму імпульсів, яку бажано отримати на виході 
льника частоти: у нашому прикладі їх
шим, ніж період вхідних імпульсів 
валості (через непарний коефіцієнт поділу), наприклад, із сем
періодів імпульсів 
співвідношення можна отримати шляхом порівняння складності під час 
моделювання). Редагуємо цю часову діаграму звичайним 
могою курсора виділення

F Примітки
1. Часові діаграми 

тримок в елементах схеми, бо вони лише задають бажане співвідношення 
між сигналами, тому всі перепади проміжних і вихідних епюр мають точно 
відповідати моментам зміни вхідних сигналів. В меню 
Snap to Grid
сітки) є завжди ввімкненою, тому в часовій моделі не можна розузгодж
вати взаємне положення фронтів, яке може виникнути, наприклад, якщо до 
WDF-файла вставити скопійовану епюру з деякого 
ньому є затримки фронтів

2. Введення часових діаграм подано найпростішим способом, але 
також інші варіанти 
ділянки – 
риваються вкладки, які повторюють у 
тів вертикальної панелі.

3. Змінити розмір зображення по горизонталі у 
так само, як і в 
шення, зменшення масштабу та розміщення всього зображення в межах 
екрану (кнопка з червоними стрілками).

лянкою рядка 
паду тактових імпульсів, відпустити кно

 State Name
тично, ввести ім’я стану, наприклад, 
ся на виділеній ділянці (якщо ім’я не вміщується, відображається риска, 

шенням розміру лінзою зі знаком плюс ім’я можна відтворити); 
відтак так само виділити ділянку до наступного активного перепаду такт
вих імпульсів і ввести ім’я 
кількість яких у даному випадку дорівнює коефіцієнт
приклад, 11; 

г) ввести діаграму імпульсів, яку бажано отримати на виході 
льника частоти: у нашому прикладі їх
шим, ніж період вхідних імпульсів 

(через непарний коефіцієнт поділу), наприклад, із сем
періодів імпульсів 
співвідношення можна отримати шляхом порівняння складності під час 
моделювання). Редагуємо цю часову діаграму звичайним 
могою курсора виділення

Примітки
Часові діаграми 

тримок в елементах схеми, бо вони лише задають бажане співвідношення 
між сигналами, тому всі перепади проміжних і вихідних епюр мають точно 
відповідати моментам зміни вхідних сигналів. В меню 

Grid (сумістити фронти сигналів з вертик
сітки) є завжди ввімкненою, тому в часовій моделі не можна розузгодж
вати взаємне положення фронтів, яке може виникнути, наприклад, якщо до 

файла вставити скопійовану епюру з деякого 
ньому є затримки фронтів

Введення часових діаграм подано найпростішим способом, але 
також інші варіанти 

 з меню Edit
риваються вкладки, які повторюють у 
тів вертикальної панелі.

Змінити розмір зображення по горизонталі у 
так само, як і в SCF
шення, зменшення масштабу та розміщення всього зображення в межах 
екрану (кнопка з червоними стрілками).

кою рядка stm до першого актив
паду тактових імпульсів, відпустити кно

Name (задати ім’я стану), що при цьому з’явиться автом
сти ім’я стану, наприклад, 
леній ділянці (якщо ім’я не вміщується, відображається риска, 
ням розміру лінзою зі знаком плюс ім’я можна відтворити); 

ділити ділянку до наступного активного перепаду такт
сів і ввести ім’я s

кількість яких у даному випадку дорівнює коефіцієнт

г) ввести діаграму імпульсів, яку бажано отримати на виході 
льника частоти: у нашому прикладі їх
шим, ніж період вхідних імпульсів 

(через непарний коефіцієнт поділу), наприклад, із сем
періодів імпульсів clk як у проекті 800
співвідношення можна отримати шляхом порівняння складності під час 
моделювання). Редагуємо цю часову діаграму звичайним 
могою курсора виділенням або редагування

Примітки: 
Часові діаграми WDF

тримок в елементах схеми, бо вони лише задають бажане співвідношення 
між сигналами, тому всі перепади проміжних і вихідних епюр мають точно 
відповідати моментам зміни вхідних сигналів. В меню 

(сумістити фронти сигналів з вертик
сітки) є завжди ввімкненою, тому в часовій моделі не можна розузгодж
вати взаємне положення фронтів, яке може виникнути, наприклад, якщо до 

файла вставити скопійовану епюру з деякого 
ньому є затримки фронтів). 

Введення часових діаграм подано найпростішим способом, але 
також інші варіанти виходу 

Edit або з контекстного меню (
риваються вкладки, які повторюють у 
тів вертикальної панелі. 

Змінити розмір зображення по горизонталі у 
SCF-файлі, трьома кнопками вертикальної панелі: збіл

шення, зменшення масштабу та розміщення всього зображення в межах 
екрану (кнопка з червоними стрілками).

160

до першого актив
паду тактових імпульсів, відпустити кно

(задати ім’я стану), що при цьому з’явиться автом
сти ім’я стану, наприклад, s
леній ділянці (якщо ім’я не вміщується, відображається риска, 
ням розміру лінзою зі знаком плюс ім’я можна відтворити); 

ділити ділянку до наступного активного перепаду такт
s1; продовжуючи, аналогічно ввести всі стани, 

кількість яких у даному випадку дорівнює коефіцієнт

г) ввести діаграму імпульсів, яку бажано отримати на виході 
льника частоти: у нашому прикладі їх
шим, ніж період вхідних імпульсів clk

(через непарний коефіцієнт поділу), наприклад, із сем
як у проекті 800

співвідношення можна отримати шляхом порівняння складності під час 
моделювання). Редагуємо цю часову діаграму звичайним 

або редагування

WDF–файла є ідеалізован
тримок в елементах схеми, бо вони лише задають бажане співвідношення 
між сигналами, тому всі перепади проміжних і вихідних епюр мають точно 
відповідати моментам зміни вхідних сигналів. В меню 

(сумістити фронти сигналів з вертик
сітки) є завжди ввімкненою, тому в часовій моделі не можна розузгодж
вати взаємне положення фронтів, яке може виникнути, наприклад, якщо до 

файла вставити скопійовану епюру з деякого 

Введення часових діаграм подано найпростішим способом, але 
 на діалогові вікна 
з контекстного меню (

риваються вкладки, які повторюють у 

Змінити розмір зображення по горизонталі у 
файлі, трьома кнопками вертикальної панелі: збіл

шення, зменшення масштабу та розміщення всього зображення в межах 
екрану (кнопка з червоними стрілками).
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до першого активного (наприклад, позитивного) 
паду тактових імпульсів, відпустити кно

(задати ім’я стану), що при цьому з’явиться автом
s0, яке по натисненні ОК відобразит

леній ділянці (якщо ім’я не вміщується, відображається риска, 
ням розміру лінзою зі знаком плюс ім’я можна відтворити); 

ділити ділянку до наступного активного перепаду такт
1; продовжуючи, аналогічно ввести всі стани, 

кількість яких у даному випадку дорівнює коефіцієнт

г) ввести діаграму імпульсів, яку бажано отримати на виході 
льника частоти: у нашому прикладі їхній період має бути в 11 разів біл

clk і складатися з півхвиль  різної  тр
(через непарний коефіцієнт поділу), наприклад, із сем

як у проекті 800ctm (оптимальний варіант цього 
співвідношення можна отримати шляхом порівняння складності під час 
моделювання). Редагуємо цю часову діаграму звичайним 

або редагуванням та кнопок „0” і „1”). 

файла є ідеалізован
тримок в елементах схеми, бо вони лише задають бажане співвідношення 
між сигналами, тому всі перепади проміжних і вихідних епюр мають точно 
відповідати моментам зміни вхідних сигналів. В меню 

(сумістити фронти сигналів з вертик
сітки) є завжди ввімкненою, тому в часовій моделі не можна розузгодж
вати взаємне положення фронтів, яке може виникнути, наприклад, якщо до 

файла вставити скопійовану епюру з деякого 

Введення часових діаграм подано найпростішим способом, але 
на діалогові вікна 
з контекстного меню (

риваються вкладки, які повторюють у текстовій формі команди інструме

Змінити розмір зображення по горизонталі у 
файлі, трьома кнопками вертикальної панелі: збіл

шення, зменшення масштабу та розміщення всього зображення в межах 
екрану (кнопка з червоними стрілками). 

ного (наприклад, позитивного) 
паду тактових імпульсів, відпустити кнопку, у діалоговому вікні 

(задати ім’я стану), що при цьому з’явиться автом
0, яке по натисненні ОК відобразит

леній ділянці (якщо ім’я не вміщується, відображається риска, 
ням розміру лінзою зі знаком плюс ім’я можна відтворити); 

ділити ділянку до наступного активного перепаду такт
1; продовжуючи, аналогічно ввести всі стани, 

кількість яких у даному випадку дорівнює коефіцієнту поділу частоти, н

г) ввести діаграму імпульсів, яку бажано отримати на виході 
період має бути в 11 разів біл

і складатися з півхвиль  різної  тр
(через непарний коефіцієнт поділу), наприклад, із сем

(оптимальний варіант цього 
співвідношення можна отримати шляхом порівняння складності під час 
моделювання). Редагуємо цю часову діаграму звичайним 

та кнопок „0” і „1”). 

файла є ідеалізованими, без урахування з
тримок в елементах схеми, бо вони лише задають бажане співвідношення 
між сигналами, тому всі перепади проміжних і вихідних епюр мають точно 
відповідати моментам зміни вхідних сигналів. В меню 

(сумістити фронти сигналів з вертикальними лініями часової 
сітки) є завжди ввімкненою, тому в часовій моделі не можна розузгодж
вати взаємне положення фронтів, яке може виникнути, наприклад, якщо до 

файла вставити скопійовану епюру з деякого SCF-

Введення часових діаграм подано найпростішим способом, але 
на діалогові вікна Overwrite
з контекстного меню (при натисненні В2) роз

текстовій формі команди інструме

Змінити розмір зображення по горизонталі у WDF
файлі, трьома кнопками вертикальної панелі: збіл

шення, зменшення масштабу та розміщення всього зображення в межах 

ного (наприклад, позитивного) 
пку, у діалоговому вікні 

(задати ім’я стану), що при цьому з’явиться автом
0, яке по натисненні ОК відобразит

леній ділянці (якщо ім’я не вміщується, відображається риска, 
ням розміру лінзою зі знаком плюс ім’я можна відтворити); 

ділити ділянку до наступного активного перепаду такт
1; продовжуючи, аналогічно ввести всі стани, 

у поділу частоти, н

г) ввести діаграму імпульсів, яку бажано отримати на виході 
період має бути в 11 разів біл

і складатися з півхвиль  різної  тр
(через непарний коефіцієнт поділу), наприклад, із семи і чотирьох 

(оптимальний варіант цього 
співвідношення можна отримати шляхом порівняння складності під час 
моделювання). Редагуємо цю часову діаграму звичайним чином (за доп

та кнопок „0” і „1”). 

, без урахування з
тримок в елементах схеми, бо вони лише задають бажане співвідношення 
між сигналами, тому всі перепади проміжних і вихідних епюр мають точно 
відповідати моментам зміни вхідних сигналів. В меню Options

альними лініями часової 
сітки) є завжди ввімкненою, тому в часовій моделі не можна розузгодж
вати взаємне положення фронтів, яке може виникнути, наприклад, якщо до 

-файла (бо в оста

Введення часових діаграм подано найпростішим способом, але 
Overwrite... після виділення 

натисненні В2) роз
текстовій формі команди інструме

WDF-файлі можна 
файлі, трьома кнопками вертикальної панелі: збіл

шення, зменшення масштабу та розміщення всього зображення в межах 

ного (наприклад, позитивного) 
пку, у діалоговому вікні 

(задати ім’я стану), що при цьому з’явиться автома-
0, яке по натисненні ОК відобразить-

леній ділянці (якщо ім’я не вміщується, відображається риска, 
ням розміру лінзою зі знаком плюс ім’я можна відтворити); 

ділити ділянку до наступного активного перепаду такто-
1; продовжуючи, аналогічно ввести всі стани, 

у поділу частоти, на-

г) ввести діаграму імпульсів, яку бажано отримати на виході q поді-
період має бути в 11 разів біль-

і складатися з півхвиль  різної  три-
і чотирьох 

(оптимальний варіант цього 
співвідношення можна отримати шляхом порівняння складності під час 

чином (за допо-
та кнопок „0” і „1”).  

 

, без урахування за-
тримок в елементах схеми, бо вони лише задають бажане співвідношення 
між сигналами, тому всі перепади проміжних і вихідних епюр мають точно 

Options команда 
альними лініями часової 

сітки) є завжди ввімкненою, тому в часовій моделі не можна розузгоджу-
вати взаємне положення фронтів, яке може виникнути, наприклад, якщо до 

файла (бо в остан-

Введення часових діаграм подано найпростішим способом, але є
... після виділення 

натисненні В2) розк-
текстовій формі команди інструмен-

файлі можна 
файлі, трьома кнопками вертикальної панелі: збіль-

шення, зменшення масштабу та розміщення всього зображення в межах 

ного (наприклад, позитивного) 
пку, у діалоговому вікні 

а-
ь-

леній ділянці (якщо ім’я не вміщується, відображається риска, 
ням розміру лінзою зі знаком плюс ім’я можна відтворити); 

о-
1; продовжуючи, аналогічно ввести всі стани, 

а-

і-
ь-
и-

і чотирьох 
(оптимальний варіант цього 

співвідношення можна отримати шляхом порівняння складності під час 
о-

 

а-
тримок в елементах схеми, бо вони лише задають бажане співвідношення 
між сигналами, тому всі перепади проміжних і вихідних епюр мають точно 

команда 
альними лініями часової 

у-
вати взаємне положення фронтів, яке може виникнути, наприклад, якщо до 

н-

є 
... після виділення 

к-
н-

файлі можна 
ь-

шення, зменшення масштабу та розміщення всього зображення в межах 
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8.2.5.4 Виконати компіляцію і функціональне моделювання прое-

кту звичайним чином, так само, як за його графічного або текстового вве-
дення. Користуючись часовими діаграмами, визначити тип пристрою, 
утворений синтезатором як подільник частоти, порівняти з результатами 
проектування за п. 8.2.3, 8.2.4 та переглянути автоматично створений сим-
вол подільника.  

< Приклад: подільник частоти із коефіцієнтом поділу М = 11 – 
файли d:\max2work\tutorial\8lab\800wav.wdf, sсf, .sym. 

 
Контрольні питання та завдання 

1. Порівняйте лічильники з перенесенням різного типу за критерія-
ми швидкодії і складності. Для яких застосувань послідовні лічильники 
мають перевагу перед паралельними? 

2. Зобразіть раціональну схему з’єднань символів макрофункції 
7464 із вхідними і вихідними портами для отримання лічильника з моду-
лем: а) 22, б) 24, в) 25, г) 27, д) 28, е) 210, ж) 211, и) 215. 

3. Спроектуйте лічильник з модулем 2778 і звичайним порядком лі-
чби (для вимірювача фазових зсувів) на основі: а) макрофункцій двійкових 
лічильників, б) макрофункцій декадних лічильників, в) мегафункції лічи-
льника. Вказівка: за необхідності скористайтеся виразом (8.7). 

4. Спроектуйте подільник частоти на 60 на основі: а) макрофункцій 
двійкових лічильників, б) макрофункцій декадних лічильників, в) макро-
функцій подільників частоти, г) макрофункцій JK-тригерів (безвентиль-
ний), д) макрофункцій цифрових таймерів, е) мегафункції лічильника. 
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9   ФІЗИЧНЕ ПРОГРАМУВАННЯ ПЛІС 
 

Мета роботи: дослідження типового ЦП на ПЛІС; підготовка ма-
теріалів проекту для фізичного програмування ПЛІС; засвоєння основ про-
грамування і верифікації ПЛІС.  

 
Домашнє завдання 

! 1) Засвоїти теоретичні відомості щодо ПЛІС та інтерфейсу їх про-
грамування; 2) ознайомитися з описом лабораторного стенда на основі 
плати UP2 (у частині що стосується програмування ПЛІС родини МАХ 
7000S); 3) підготувати згідно зі своїм варіантом окремий проект за 
п. 3.2.2.4 для програмування ПЛІС ЕРМ7128S. 

 
9.1   Стислі теоретичні відомості 

9.1.1 Загальні відомості  
1.1 Сучасні  ПЛІС 
Інтегровані мікросхеми (ІС) за рівнем інтеграції (який для цифро-

вих ІС найчастіше оцінюється кількістю еквівалентних двовходових логіч-
них елементів в одному кристалі) поділяють на малі (МІС), середні (СІС), 
великі (ВІС) та надвеликі (НВІС). У вигляді МІС випускаються, в основ-
ному, функціонально повні набори логічних елементів, наприклад, І-НЕ, а 
також допоміжні щодо логіки елементи, наприклад, буфери. З огляду на це 
МІС універсальні – на них можна побудувати ЦП довільної складності, але 
для цього потрібно багато корпусів ІС, що збільшує габарити і витрати та 
знижує надійність. Саме тому було налагоджено випуск СІС, які вміщують 
готові ЦКП або ЦПП, наприклад, дешифратори, мультиплексори, регістри, 
лічильники невеликої розрядності. При цьому кількість друкованих плат, 
необхідних для побудови ЦП, зменшується, але внаслідок зниження уні-
версальності СІС є потреба у широкій номенклатурі (розвинуті серії міс-
тять до сотень типономіналів ІС), що знижує серійноспроможність мікрос-
хем і, як наслідок, збільшується вартість.  

Попри можливості мікроелектроніки, подальший шлях нарощуван-
ня ступеня інтеграції стандартних ІС жорсткої структури виявляється не-
виправданим – величезні витрати на розробку ВІС і НВІС такого типу не 
окупаються внаслідок зниження їх універсальності, отже, і серійноспро-
можності. Через це випускаються спеціалізовані ВІС / НВІС на замовлення 
для масового виробництва, завдяки чому витрати на їх розробку розклада-
ються на велику кількість виробів і вартість ІС у розрахунку на один виріб 
стає низькою.  

Забезпечення універсальності ІС полягає в їх програмованості, ко-
ли кожний споживач може налаштовувати стандартну ІС на виконання по-
трібних функцій. Для здійснення цього є два шляхи. Перший пов’язаний з 
розробкою мікропроцесорних ІС, структура яких залишається незмінною, 
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а функції визначаються записаною до пам’яті програмою у вигляді команд, 
що виконуються одна за одною послідовно в часі. Складність вирішуваних 
задач є при цьому практично необмеженою (за нарощуваного обсягу 
пам’яті), але швидкодія через послідовність дій може виявитися недостат-
ньою. Через це в радіотехнічних системах вдаються, наприклад, до засто-
сування апаратних засобів арифметичного множення, яке в мікропроцесорі 
займає багато часу, бо виконується за алгоритмом з багатьох кроків.       

Другий шлях полягає в програмуванні структури ІС на виконання 
потрібних функцій. Властивість програмованості набували вже деякі СІС 
або їх комбінації (такі як арифметико-логічний пристрій, універсальний 
логічний модуль на мультиплексорі з вхідним регістром, програмований 
лічильник на базі двійкового лічильника і компаратора тощо). Проте сут-
тєвий крок в бік програмованості структури було зроблено лише із впрова-
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ня інтеграції в ПЛІС стали розміщувати системні модулі, такі як блоки 
пам’яті, мікроконтролери, мікропроцесори, периферійні пристрої, зокрема, 
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пам’яті, арифметичні помножувачі, помножувачі частоти, системи ФАПЧ, 
приймачі-передавачі систем передачі даних тощо. Подібні ПЛІС здобули 
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2) Для типів ПЛІС, що виконуються за технологією програмованих 
ПЗП (ППЗП), у САПР використовується термін Programmable ROM 
(PROM). ПЛІС такого типу (наприклад, фірми Actel) є одноразово програ-
мованими користувачем, тому їх доцільно застосовувати, як правило, в се-
рійному виробництві, коли проект є ретельно відпрацьованим і виготовле-
ні вироби не підлягають модернізації. 

3) Якщо конфігурацію мікросхем можна змінювати шляхом стиран-
ня інформації, що в них міститься, і записом нової, за технологією вони ві-
дповідають репрограмованим ПЗП (РПЗП). Такі ПЛІС позначаються в 
САПР як EPLD – Erasable Programmable Logic Device (стиранна програмо-
вана логічна ІС), а типономінали родини ІС (далі посилання робляться на 
ІС фірми Altera) містять абревіатуру EP (Erasable Programmable), напри-
клад, ІС типу EPM7032S родини MAX 7000S. Процедура зміни конфігура-
ції мікросхем типу EPLD, яка полягає в стиранні старої і записуванні нової 
інформації, називається в САПР програмуванням.   

4) Різновид мікросхем EPLD, в яких стирання записаної інформації 
здійснюється ультрафіолетовим промінням, базується на технології РПЗП з 
ультрафіолетовим стиранням (РПЗП-УФ), що відповідає англійській назві 
Erasable Programmable Read-Only Memory (EPROM), тому вони познача-
ються як EPROM-based EPLD; прикладом є ІС родин Classic, MAX 5000. 
ПЛІС, що базуються на технології РПЗП-УФ, компактні, але виконуються 
в дорогому корпусі з прозорим для ультрафіолетового проміння віконцем. 
Крім того, для стирання старої інформації потрібно опромінювати кристал 
(тривалістю біля години) з вилученням ІС із пристрою та кількість циклів 
стирання обмежена (до 10 ... 100) через деградацію властивостей матеріа-
лів під дією УФ-променів. 

5) ПЛІС типу EPLD, в яких пам’ять конфігурації стирається елект-
ричними сигналами, за технологією подібні до РПЗП з електричним сти-
ранням (РПЗП-ЕС), що відповідає англомовному терміну Electrically Erasa-
ble Programmable Read-Only Memory (EEPROM або E2PROM). До таких 
ІС, що позначаються як EЕPROM-based EPLD, належать родини MAX 
7000A, 7000B, 7000E, 7000S, 7000AE (є ще MAX 7000, але ця родина ІС в 
нових розробках не рекомендована); MAX 3000A; MAX  9000, 9000A 
(MAX – Multiple Array MatriX – матриця багатьох масивів). Програмуван-
ня ПЛІС, що базуються на технології РПЗП-ЕС, виконується підімкненням 
до комп’ютера в звичайних лабораторних умовах або пристрою без вилу-
чення з нього ІС, або апаратного програматора, в який вставляється ІС. 
Стирання старої і запис нової пам’яті конфігурації здійснюється протягом 
мілісекунд, а кількість циклів перепрограмування сягає 104 ... 106. З удо-
сконаленням технології площа програмувальних елементів з електричним 
стиранням зменшується і такі ПЛІС витісняють схемотехніку з УФ-сти-
ранням. ПЛІС типу EPLD особливо зручно використовувати в нових роз-



 166

робках, що значно скорочує час і витрати. 
6) Різновидом РПЗП-ЕС є пам’ять типу Flash (спалах, мить), що ві-

дрізняється структурою, яка дозволяє виконувати електричне стирання всі-
єї інформації одночасно або великими блоками. Серед EPLD є родина ІС 
FLASHlogic, яка складається з мікросхем EPX8160 та EPX880.  

7) Для типів ПЛІС, пам’ять конфігурації яких виконується за техноло-
гією оперативних запам’ятовувальних пристроїв (ОЗП), у САПР використо-
вується термін Random-access memory (RAM) – „пам’ять із прямим досту-
пом” (ЗП з довільною вибіркою). Тригерні ЗП належать до статичних ОЗП 
(СОЗП) – Static RAM (SRAM), тому ПЛІС із тригерною пам’яттю конфігура-
ції позначаються як SRAM-based devices. До таких ПЛІС належать родини 
ACEX 1K; FLEX 6000, 6000A; FLEX 8000, 8000A; FLEX 10K, 10KA, 10KE; 
AРEX 20K, 20KC, 20KE; APEX II; ARM-Based Excalibur (мікросхема 
EPXA10); Mercury та ін. У ПЛІС, що базуються на технології СОЗП, стиран-
ня не потрібне, бо в тригерах інформація поновлюється під час її записуван-
ня, а кількість циклів перепрограмування не обмежена. Процедура зміни 
конфігурації мікросхем типу SRAM-based, яка полягає в записування нової 
інформації без стирання старої, називається в САПР конфігуруванням. Про-
те, на відміну від ПЗП, тригерна пам’ять в ОЗП є енергозалежною: після вим-
кнення джерела живлення інформація руйнується. Цей недолік подолано 
шляхом вбудовування в ІС енергонезалежної пам’яті, яка автоматично заван-
тажується до ОЗП конфігурації після вмикання джерела живлення.  

ПЛІС фірми Altera типів EPLD і SRAM-based до модифікацій 
FLEX 10K включно підтримуються САПР MAX+plus II, а подальші розро-
бки, починаючи з AРEX 20K (як і всі попередні) підтримуються САПР 
Quartus II. 

9.1.1.3 Програмовані елементи ПЛІС 
Програмованість ІС досягається за допомогою програмованих дво-

полюсників ab, еквівалентних ключам (рис. 9.2, а). Програмування полягає 
в зміні провідності двополюсника, тобто в переведенні ключа до замкнено-
го або розімкненого стану. Якщо ключ замкнено, відповідний сигнал sj на-
дходить до входу логічного елемента ЛЕ, а якщо розімкнено – не надхо-
дить, отже вихідний сигнал zi визначатиметься функцією ЛЕ і запрограмо-
ваною ключами сукупністю вхідних сигналів. На спрощеному зображенні 
замкнені ключі позначаються точками на перетині ліній, а розімкнені – ві-
дсутністю зв’язків, тому зазначені двополюсники називаються програмо-
ваними точками зв’язку (ПТЗ) або в англомовній документації Programma-
ble Interconnection Point (PIP). Кількість ПТЗ залежно від складності ІС 
може сягати мільйонів. Зупинимося стисло на основних типах ПТЗ, що за-
стосовуються в сучасних ПЛІС. 

Перетинки (рис. 9.2, б) використовуються як ПТЗ в одноразово 
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програмованих ІС (див. рис. 9.1). Під час програмування залишають лише 
необхідні елементи зв’язку ab, а непотрібні усувають перепалюванням то-
пких перетинок імпульсами струму достатньої величини і тривалості. У 
сучасних ПЛІС із перетинками новітньої технології у вигляді тришарового 
діелектрика оксид-нітрид-оксид, навпаки, програмувальним імпульсом на-
пруги перетинка пробивається, завдяки чому створюється провідний канал 
між точками a, b. Перевагою ІС із ПТЗ останнього типу є компактність і 
низька вартість, а недоліком – доцільність застосування лише в серійному 
виробництві, коли проект є ретельно відпрацьованим і виготовлені вироби 
не підлягають модернізації.  

 
а) 

 
б) 

 
в) 

 
г) 

 
д) 

 
е) 

Рисунок 9.2 
Елементом пам’яті конфігурації сучасних ПЛІС типу EPLD з УФ-

стиранням є транзистори типу ЛІЗМОН з плаваючим затвором (ЛІЗМОН – 
МОН-транзистори з лавинною інжекцією заряду). Плаваючий затвор може 
бути єдиний або додатковий до звичайного затвору як умовно зображено 
на рис. 9.2, в). Область між керувальним затвором і каналом, оточена з усіх 
боків діелектриком, називається плаваючим затвором. Під час програму-
вання напругою на керувальному затворі Uз до цієї області вводиться за-
ряд, що визначає стан транзистора: відкритий транзистор з’єднує точки a, 
b, а запертий – залишає їх роз’єднаними. Після зняття програмувальної на-
пруги цей заряд здатний зберігатися довгий час (протягом багатьох років), 
тобто запам’ятовувати конфігурацію ІС. Перед перепрограмуванням вико-
нують стирання інформації в елементі пам’яті УФ-промінням через прозо-
ре віконце в корпусі ІС. Це проміння спричиняє фотоструми і теплові 
струми, які руйнують заряд плаваючого затвору за кілька десятків хвилин. 

Аналогічним за принципом дії є елемент пам’яті конфігурації ПЛІС 
типу EPLD з електричним стиранням на транзисторі типу ЛІЗМОН з по-
двійним затвором (рис. 9.2, г). Між керувальним затвором і каналом вмі-
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щується оточена з усіх боків діелектриком провідна ділянка з полікремнію 
або металу, яка утворює другий затвор. Під час програмування до нього як 
у пастку потрапляє заряд, який залишається після зняття програмувальної 
напруги Uз. Запис здійснюється подачею на затвор високої напруги, при 
відімкненому затворі інформація зберігається, а подачею низької напруги 
(заземленням) відбувається швидке стирання пам’яті конфігурації. З метою 
зменшення затримки поширення через програмувальні ключі їх вилучають 
з кола передачі сигналу (рис. 9.2, д): якщо до ЛІЗМОН-транзистора запи-
сано логічну 1, сигнал передається через елемент І з малою затримкою, а 
якщо логічний 0 – ділянка між точками a, b розімкнена.  

У ПЛІС типу SRAM-based програмованою точкою зв’язку є ключо-
вий транзистор (pass-transistor) між точками a, b, а елементом пам’яті кон-
фігурації – тригер (рис. 9.2, е). Під час програмування сигналом G = 1 три-
гер активізується і через вхід D до нього записується інформація. У робо-
чому режимі сигналом G = 0 тригер перебуває в режимі зберігання конфі-
гурації: якщо Q = 1, точки a, b відчиненим транзистором з’єднуються, а 
якщо Q = 0 транзистор зачинено і точки a, b залишаються роз’єднаними. 
До тригера не ставиться вимога високої швидкодії, тому його проектують з 
міркувань максимально можливої компактності і стійкості статичних ста-
нів. У такій схемі перед конфігуруванням не потрібна процедура стирання 
інформації, а енергонезалежність забезпечується елементами пам’яті, які 
не розподілені по всьому кристалу як ПТЗ. Після ввімкнення джерела жив-
лення автоматично відбувається ініціалізація – процедура конфігурування 
шляхом перезаписування інформації з енергонезалежної пам’яті до триге-
рів. Тригерна пам’ять конфігурації широко застосовується в останніх роз-
робка ПЛІС.  

9.1.1.4 Принцип побудови програмованих логічних матриць 
Для реалізації логічних функцій в диз’юнктивній формі спочатку в 

елементах І утворюють терми – добутки змінних, а відтак потрібні терми 
підсумовують в елементах АБО. Регулярні структури з елементів І та АБО, 
в яких змінні до входів елементів І та терми до входів елементів АБО ви-
бираються за допомогою ПТЗ,  називають програмованими логічними мат-
рицями ПЛМ (Programmable Logic Array, PLA).  

Проілюструємо утворення таких матриць на прикладі побудови по-
вного суматора розрядів двох чисел ai, bi та вхідного переносу до цього ро-
зряду cin (рис. 9.3, а). Мінімізуємо функцію вихідного переносу cout, а фун-
кція суми si не піддається мінімізації (рис. 9.3, б), тому їх ДНФ має вигляд: 

 
де ti – відповідні терми. 
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Рисунок 9.3 
Реалізацію суматора згідно з цими виразами зображено на 

рис. 9.4, а. Вхідні однофазні сигнали ai, bi, cin у блоці вхідних буферів БВх 
перетворюються в парафазні і підсилюються за потужністю для забезпе-
чення необхідного коефіцієнта розгалуження. У програмованій матриці 
з’єднань ПМЗ (Programmable Interconnect Array, PIA) за допомогою ПТЗ 
(ввімкнені елементи з’єднань позначено точками) виконуються потрібні 
з’єднання прямих або інверсних сигналів зі входами матриці МІ елементів 
І для утворення термів tj. Вихід кожного елемента І живить одну з вертика-
льних ліній матриці розподілу термів МРТ (Product-Term Select Matrix, 
PSM), щоб можна було використовувати одні й ті самі терми для утворен-
ня різних функцій. Горизонтальними лініями так само за допомогою ПТЗ 
вибираються  потрібні терми, які надходять до входів матриці МАБО еле-
ментів АБО, де і реалізуються задані логічні функції. Блок вихідних буфе-
рів БВих призначений для забезпечення навантажувальної здатності вихо-
дів, формування сигналів потрібної полярності та, у разі потреби, і рівнів 
(для зменшення споживаної потужності внутрішні елементи логічної мат-
риці можуть живитися від джерела з меншою напругою, ніж зовнішні еле-
менти). Вихідні буфери здатні виконувати й інші функції, зокрема, зберіга-
ти інформацію у вихідному регістрі, а за застосування елементів з трьома 
станами виходу також приєднувати ІС до зовнішньої шини або 
від’єднувати від неї додатковим сигналом дозволу OE.  

Таким чином, структурна схема ПЛМ набуває вигляду рис. 9.4, б). З 
числа m змінних х1 ... хm у матриці І формуються терми t1 ... tl, отже, кіль-
кість l кон’юнкторів дорівнює числу термів. Відтак у матриці АБО утво-
рюються функції y1...yn, тому кількість диз’юнкторів n дорівнює числу фу-
нкцій. Розмірність матриці m : l : n є одним з основних її параметрів. Дру-
гим важливим параметром є швидкодія, яка для схеми на рис. 9.4, а) буде 
найбільшою для базових елементів певного типу через двоступеневу (без 
урахування буферів) реалізацію функцій.  
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Рисунок 9.4 
Проте задля ощадливості щодо ресурсу і гнучкості побудови вда-

ються до розширення функціональних можливостей ПЛМ. Так, складність 
схеми (див. рис. 4,а) q = 9 / 25 (кількість логічних елементів без буферів / 
загальна кількість їх входів) можна зменшити до q = 7 / 14 (рис. 3,в) за спі-
льної схемної мінімізації (див. п. 2.1.3). Перетворенням схеми (див. 
рис. 9.3, в) до структури І, АБО 
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дістанемо реалізацію суматора на ПЛМ (рис. 9.5). На цій схемі подано за-
гальноприйняте для ВІС і НВІС спрощене зображення елементів:  багатов-
ходові кон’юнктури і диз’юнктори замінюються одновходовими. Якщо на 
горизонтальній лінії, що відображає входи елемента, є точка перетину з 
вертикальною сигнальною лінією, то ця змінна з’єднується зі входом еле-
мента, а якщо точка відсутня, то не з’єднується. Отже, кількість точок на 
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горизонтальній лінії дорівнює числу задіяних входів елемента.  

 

Рисунок 9.5 
Спрощення ПЛМ відбувається завдяки так званому розділюваному 

(спільному) розширенню: спільні вертикальні лінії термів МРТ використо-
вуються неодноразово для утворення диз’юнкцій у МАБО та паралельному 
розширенню: диз’юнкції з виходу окремих елементів АБО (у прикладі 
диз’юнкція d) знов повертаються до ПМЗ для утворення інших логічних 
функцій. Проте через збільшення глибини реалізації збільшується також і 
затримка поширення сигналів, так само, як і на рис. 9.3, в). 

9.1.2 Архітектура ПЛІС 
9.1.2.1 План розміщення ПЛІС 
ПЛІС, що крім багатьох ПЛМ містить регістри, буфери, розгалуже-

ну систему програмованих з’єднань тощо, структурована на окремі части-
ни. У загальному вигляді ці частини зображаються в САПР на плані її роз-
міщення (Floorplan) як подано на рис. 9.6, а). Компілятор автоматично при-
значає елементи схеми, необхідні для реалізації проекту, виконує потрібні 
з’єднання і вносить всю цю інформацію до програмувального файла (після 
цього проектувальник має змогу скоригувати призначення вручну і знов 
перекомпілювати проект). Призначення (Assignments) для мікросхеми на 
плані розміщення містяться в лотку AoD (Anywhere on Device) і відобра-
жаються при натисканні на нього.  

Найбільшою функціональною частиною ПЛІС є логічний блок ЛБ 
(Logic Array Block, LAB), в якому згруповано набір логічних ресурсів та-
ким чином, що будь-який сигнал є доступний для кожного елемента набо-
ру. На плані ЛБ позначено літерами А, В біля лотків, в яких відображають-
ся призначення відповідного блоку. ПЛІС однієї родини однотипні і відрі-
зняються кількістю ЛБ; у прикладі подано ІС родини МАХ3000А най-
меншої складності з двох ЛБ, а ІС цієї родини найбільшої (на цей час) 
складності містить 32 такі блоки. 
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лька). Наступна група спеціалізованих виводів, призначена для фізичного 
програмування (TDI, TDO, TCK, TMS), є недоступною для користувача (по-
яснюється нижче). І, нарешті, остання група спеціалізованих виводів для так 
званих глобальних сигналів, до яких належать спільні для всіх ЛБ сигнали, 
зображається на плані окремо від них (у нас – ліворуч). Типовими є такі гло-
бальні сигнали: GCLK – Global Clock (спільний синхровхід, у нас показано як 
призначений для синхросигналу С), GCLRn – Global Clear (спільний сигнал 
скидання, зазвичай інверсний), Global OE – дозвіл виходу для компонентів з 
трьома станами, Ded. Input –глобальний вхід за призначенням користувача. 

Будь-який вивід ІС, розташований на плані біля комірки, може бути 
запрограмований як вхід або вихід пристрою (у разі потреби, як двоспря-
мований вхід/вихід). Якщо певний контакт стає виходом (на плані позна-
чається стрілкою, що виходить з ЛБ), він закріплюється за суміжною з ним 
коміркою, яка стає кінцевою і остаточно формує для нього сигнал (такі ко-
мірки забарвлено блакитним кольором). Якщо ж контакт стає входом (поз-
начається стрілкою, що входить до ЛБ), він не закріплюється за певною 
МК, а пов’язується з будь-якими комірками через програмовані матриці 
з’єднань. Так само МК, призначені як проміжні (забарвлені жовтим кольо-
ром), що беруть участь у формуванні проміжної логіки, обмінюються вхід-
ними і вихідними даними з виводами і з іншими комірками через програ-
мовані матриці з’єднань. Деякі МК, що не мають суміжних виводів (у на-
шій ПЛІС дві таких МК) не можуть бути запрограмовані як кінцеві.  

9.1.2.2 Структура ПЛІС із електричним стиранням 
Зв’язки між компонентами ПЛІС відображаються на її плані графі-

чно (кольоровими лініями) або логічними рівняннями (у спеціальному вік-
ні на частині екрана). Проте наочніше такі зв’язки можна показати на 
структурній схемі як дещо спрощено подано на рис. 9.7 для типової ПЛІС 
із електричним стиранням (типу EЕPROM-based EPLD) найменшої склад-
ності (ширина шин і кількість елементів, позначених цифрами, у ПЛІС різ-
ного типу можуть відрізнятися). Структура складнішої ПЛІС така сама: 
програмована матриця з’єднань ПМЗ є спільною і продовжується вниз, а з 
обох сторін ярусами розташовуються логічні блоки ЛБ, кожний зі своїм 
блоком керування введенням/виведенням БКВВ. Показані знизу інтерфей-
сні кола і сигнали, що діють у режимі програмування, розглядаються в на-
ступному розділі. 

Основні зв’язки між структурними складниками ПЛІС здійснюються 
через ПМЗ, до якої в робочому режимі надходять глобальні сигнали зі спе-
ціалізованих входів безпосередньо (показано вгорі; у деяких ПЛІС може бу-
ти два синхровходи для організації двотактових схем), інформаційні сигна-
ли з контактних площинок КП входів/виходів загального користування че-
рез БКВВ (показано з обох сторін нижніми шинами розрядністю 6...12 – за 
кількістю КП, що обслуговуються даним ЛБ) та сигнали з виходів макроко-
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мірок ЛБ (показано 16-розрядними шинами – за кількістю МК в кожному 
ЛБ). 

 

Рисунок 9.7 
Усі сигнали ПМЗ стають доступними для макрокомірок кожного 

ЛБ: потрібні з них програмуванням ПМЗ вводяться до блоків 
36-розрядними шинами. Крім того, з метою підвищення швидкодії ЛБ мо-
жуть одержувати сигнали колами швидкого введення безпосередньо з гло-
бальних входів і з контактних площинок через БКВВ (шини розрядністю 
6...12). У логічних блоках відбувається обробка інформації і її остаточні 
результати виводяться на КП через БКВВ (шини 6...12), а проміжні резуль-
тати надходять до ПМЗ (шини 16) для передачі до інших блоків, в яких за-
вершується обробка. 

Блоки керування введенням/виведенням БКВВ програмуються на 
введення інформації (КП стають входами) або на її виведення (КП стають 
виходами). Під дією шести глобальних сигналів дозволу виходу, що над-
ходять з ПМЗ (шина 6 ОЕ) досягається гнучкість керування блоком. 

9.1.2.3 Макрокомірка 
Макрокомірка МК (або логічна комірка ЛК) охоплює ресурс ПЛІС, 

потрібний для формування одного сигналу, який може бути або вихідним, 
або проміжним щодо перетворення інформації. Вона складається з двох 
частин: комбінаційної на основі ПЛМ і послідовнісної у вигляді програмо-
ваного тригера (рис. 9.8, а).  

До ПЛМ (рис. 9.8, б) із ПМЗ надходять змінні від зовнішніх виводів 
і з інших комірок. Із цих змінних у локальній матриці І формуються терми, 
які в МРТ програмуванням з’єднуються зі входами елемента АБО для фо-
рмування диз’юнкції уі. Таким чином, ця логічна частина МК не відрізня-
ється від звичайної ПЛМ відносно одного з її виходів (див. рис. 9.4, а). 

Для забезпечення гнучкості щодо формування функцій комірка має 
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два розширювача. Так званий розділюваний розширювач (РР) повертає 
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Рисунок 9.8
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з’єднанні  с з термом, зокрема, вхідною змінною, утворюється сума за мо-
дулем два. Додатково з ПЛМ знімаються 3 терми для керування тригером. 

Тригер, що є розрядом регістра, утворюваного комірками ЛБ, про-
грамується мультиплексорами 1 ... 4, зображеними на рис. 9.8, в) у вигляді 
ключів. Записом до ЛІЗМОН-транзистора (див. рис. 9.2, д), пов’язаного з 
адресним входом мультиплексора, логічний 0 або 1, останній переводиться 
до потрібного положення. Так, при верхньому по схемі положенні мульти-
плексора 1 сигнал LCi від ПЛМ надходить безпосередньо на вихід МК, зві-
дки передається до ПМЗ та, якщо комірка є кінцевою, до блоку керування 
введенням/виведенням БКВВ. Через мультиплексор 2 цей сигнал може бу-
ти переданий на вхід D для записування в регістр; в іншому положенні му-
льтиплексора 2 до регістра записується сигнал безпосередньо з контактної 
площинки ПЛІС, при цьому утворюється коло швидкого введення. Здвоє-
ним мультиплексором 3 тригер може перемикатися на тактування глобаль-
ним сигналом GCLK з мінімальною затримкою від спільного входу ПЛІС 
або термом з виходу ПЛМ. При цьому під керуванням зазначеного терма 
по входу дозволу ENA може утворюватися тригер типу DE або з’єднанням 
ENA = VCC – тригер типу D. Зінвертованими термами від ПЛМ тригер ке-
рується по індивідуальних входах передустановлення PRN і скидання 
CLRN, але мультиплексором 4 можна перемкнути скидання від спільного 
для всіх розрядів глобального сигналу GCLRN, що характерно для регіст-
рів. У деяких родинах ПЛІС можна керувати також типом тригерів – DE, 
TE, JKE або RSCE.  

9.1.2.4 Блок керування введенням/виведенням 
БКВВ складається з однакових керованих буферних каскадів БК1 ... 

БКN (рис. 9.9), кількість яких визначається числом N контактних площи-
нок, закріплених за даним ЛБ (зазвичай N = 4 ... 16). Напрямок передаван-
ня даних програмується мультиплексором.  

 

Рисунок 9.9 
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Якщо вхід дозволу ОЕ програмуванням з’єднується із землею GND, 
буфер переводиться до третього стану і від’єднується від контакту, який 
стає входом: сигнал від нього спрямовується до буферів ПМЗ і є тепер 
приступним для всіх ЛБ, а також потрапляє до кола швидкого введення 
макрокомірки (див. рис. 9.8, в). При з’єднанні входу ОЕ з напругою жив-
лення VCC буфер передає (з підвищеною навантажувальною здатністю) 
сигнал з виходу МК до контакту, який стає тепер виходом ПЛІС. І, нареш-
ті, за допомогою одного із шести глобальних сигналів від ПМЗ здійсню-
ється оперативне керування входом ОЕ в режимі входу/виходу, коли на-
прямок передавання даних може змінюватися (наприклад, спочатку від ко-
нтактних площинок приймається адреса, а відтак на них передаються ре-
зультати обробки інформації). 

Крім того, програмуванням буфер можна перетворити в схему з ві-
дкритим колектором з метою гнучкості використання його виходу. Є та-
кож можливість регулювати швидкість перемикання (Slew Rate) буфера 
шляхом зміни тривалості фронтів вихідного сигналу. З двох швидкостей 
перемикання висока забезпечує максимальну швидкодію, але круті фронти 
перемикання спричиняють при цьому високий рівень завад у вихідній лі-
нії. Тому, коли дозволяють міркування швидкодії, використовують режим 
положистих фронтів, який завжди запроваджується автоматично під час 
вмикання джерела живлення. 

9.1.2.5 Особливості архітектури ПЛІС із тригерною пам’яттю 
конфігурації 

З розвитком технології і зростанням ступеня інтеграції з’явилися ІС 
комбінованого типу, що поєднують в собі в себе властивості CPLD зі схе-
мотехнікою запам’ятовувальних пристроїв. Прикладом є популярна ПЛІС 
родини FLEX 10K фірми Altera (FLEX – Flexible Logic Element Matrix – 
гнучка матриця логічних елементів), план розміщення якої (Floorplan) по-
дано на рис. 9.10. Як і для ПЛІС типу CPLD (див. рис. 6,а), зв’язки між 
компонентами такої ПЛІС так само можна відображати на її плані графіч-
но або логічними рівняннями. 

Призначення (Assignments) для компонентів містяться в лотоках, 
пояснення яких винесено на плані вгорі. Крім логічних блоків ЛБ (Logic 
Array Block, LAB) до складу ІС входять також вбудовані блоки пам’яті 
ВБП (Embedded Array Block, EAB). Логічні блоки розташовано по рядках 
(Row) і колонках (Col), тому позначаються двокоординатною системою ві-
дліку, наприклад, відмічений внизу на плані блок має ім’я „В11”, а блок 
над ним – ім’я „А11”. ІС містить лише один стовпець блоків пам’яті (роз-
ташований всередині між стовпцями ЛБ), тому вони іменуються назвою 
рядка, наприклад, позначений внизу на плані блок має ім’я „ЕАВ_В”, а 
блок над ним – ім’я „ЕАВ_А”. 
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Рисунок 9.10 

Наступною за ієрархією структурних одиниць є логічна комірка ЛК 
(Logic Cell, LC), яка в технічній документації для ПЛІС із тригерною 
пам’яттю конфігурації (SRAM-based) називається логічним елементом ЛЕ 
(Logic Element, LЕ). Такий „елемент” подібно до макрокомірки має логічну 
частину і програмований тригер, що є розрядом регістра, але відрізняється 
тим, що логічна функція реалізується програмуванням її таблиці відповіднос-
ті в запам’ятовувальному пристрої (табличний спосіб реалізації). Крім того, 
ЛЕ містить коло переносу (для підвищення швидкодії схем типу лічильників 
і суматорів) та коло каскадування (для гнучкості формування функцій бага-
тьох змінних кількома комірками). Кожний ЛБ розглядуваного типу ПЛІС 
містить 8 логічних комірок, які позначаються своїм номером у блоці та його 
координатами, наприклад, відмічена внизу на плані ЛК має ім’я „LC7_В2”. 



 179

 
Рисунок 9.11 

Виводи (контакти, Pin) мікросхеми, які так само поділяються на 
спеціалізовані і виводи користувача (глобальні входи, у разі потреби, мо-
жуть використовуватися як звичайні), розташовано на плані по периметру 
з усіх боків. При цьому будь-який вивід користувача (але не глобальні 
входи) може бути запрограмований як вхід, вихід або двоспрямований 
вхід/вихід пристрою за допомогою комірок введення/виведення КВВ (I/O 
Cell) біля кожного з них. Аналогічно блоку керування введен-
ням/виведенням БВВ (див. рис. 9.9) у КВВ здійснюються функції підви-
щення навантажувальної здатності, перемикання напрямку передачі інфо-

рмації, регулювання 
режимів буфера 
(швидкість переми-
кання, емуляція 
схеми з відкритим 
колектором). Крім 
того, КВВ містить 
вхідний і вихідний 
регістри для тимча-
сового зберігання 
даних та складну 
систему перемикан-
ня сигналів між ши-
нами (більше десят-
ка програмованих 
мультиплексорів та 
інших елементів). 
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Двокоординатна система позначень блоків відповідає дворівневій 
системі зв’язків між ними за допомогою глобальної програмованої матриці  
з’єднань ГПМЗ, поділеній на рядки і стовпці (рис. 9.11), з якими 
з’єднуються комірки вводу-виводу КВВ по всьому периметру ПЛІС. Через 
рядки і стовпці ГПМЗ, між якими розташовані ЛБ і ВБП, здійснюється об-
мін даними, а обмін між комірками організовано через локальну програмо-
вану матрицю ЛПМЗ.  

ПЛІС однієї родини, як і EPLD, однотипні і відрізняються лише скла-
дністю, що й визначає назву ІС (основні довідкові відомості для двох типів 
ПЛІС наведено на рис. 9.12). Так, мікросхема EPF10K10 родини FLEX 10K 
найменшої складності має логічну ємність 10 тис. еквівалентних вентилів (72 
ЛБ, 576 ЛК, 3 ВБП обсягом 2048 бітів кожний), а ІС цієї родини EPF10K250 
найбільшої (на цей час) складності має логічну ємність 250 тис. еквівалент-
них вентилів (1520 ЛБ, 12160 ЛК, 20 ВБП). Такі ПЛІС придатні для побудови 
складних пристроїв обробки інформації. 

9.1.3  Програмування і конфігурування 
9.1.3.1 Режими програмування і конфігурування 
Як вже зазначалося (див. п. 9.1.1.2), структуру ПЛІС можна налаш-

товувати для реалізації проектів за програмувальними файлами  у двох ре-
жимах – у режимі програмування (Program) або конфігурування 
(Configure). Режим програмування застосовується для мікросхем типу 
EPLD, виготовлених за технологією РПЗП-ЕС (EEPROM), у тому числі та-
кому різновиду як  флеш-пам’ять, та РПЗП-УФ (EPROM). Режим конфігу-
рування може застосовуватися для мікросхем, виготовлених за технологі-
єю СОЗП (SRAM). Перед перепрограмуванням ПЛІС, що базуються на те-
хнології РПЗП-УФ, потрібне попереднє стирання даних ультрафіолетовим 
промінням з вийманням її з пристрою. 

Фізичне програмування або конфігурування виконується під дією 
згенерованих під час компіляції проекту програмувальних файлів, що над-
ходять з комп’ютера. Залежно від установлених опцій програматора 
MAX+PLUS II в автоматичному режимі реалізуються такі функції: 1) пе-
ревірка наявності контакту між мікросхемою і відповідним з’єднувальним 
пристроєм; 2) перевірка на порожність (Blank-Check), тобто на відсутність 
перед програмуванням записаної до ІС інформації; 3) програмування (Pro-
gram) або конфігурування (Configure), яке полягає в завантаженні до ІС 
даних з програмувального файла і налаштуванні її структури на виконання 
потрібних функцій; 4) верифікація (Verify), тобто перевірка ІС після про-
грамування на відповідність записаної до неї інформації даним програму-
вального файла; 5) функціональне тестування запрограмованої ІС (Test) 
шляхом подачі на її входи комбінацій сигналів згідно із сигнальним фай-
лом та порівняння вихідних сигналів на відповідність їх часовим діаграмам 
SCF-файла; 6) випробування (Examine), яке полягає в зчитуванні даних від 
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запрограмованої ІС (якщо вона не захищена спеціальним бітом захисту) з 
можливістю запису їх у власному файлі і подальшого використання, на-
приклад, з метою з’ясувати причини незадовільної роботи даної ІС або для 
програмування інших ІС. 

9.1.3.2 Інтерфейс JTAG 
Зручно мати можливість програмувати або конфігурувати мікрос-

хему безпосередньо на її робочому місці без вилучення з монтажної плати 
пристрою, без фізичного доступу до всіх її виводів та без застосування 
спеціального апаратного програматора. Якщо під час роботи пристрою ви-
являться недоліки або виникне потреба в модернізації, мікросхему можна 
перепрограмувати. Така можливість, яка позначається терміном in-system 
programmability (ISP) – програмованість у системі, є в мікросхем, що міс-
тять комірки периферійного сканування  BSC  (Boundary-Scan Cells). Май-
же всі сучасні ІС провідних фірм-виробників мають властивості ISP. 
Об’єднаною групою по тестах Joint Test Action Group (JTAG) схему тесту-
вання BST було покладено в основу стандарту IEEE Std 1149.1, який ви-
значає інтерфейс JTAG – сукупність засобів і порядок операцій для тесту-
вання ІС без фізичного доступу до кожного її зовнішнього виводу.  

Ідея периферійного сканування ілюструється спрощеною схемою на 
рис. 9.13. Периферійні комірки BSC можуть працювати у двох режимах. У 
робочому режимі логічні комірки кристалу з’єднано із зовнішніми вхідни-
ми xi та вихідними yi виводами і BSC не змінюють функціонування при-
строю.  

У режимі програмуван-
ня ПЛІС функціонує послідов-
ним виконанням команд за до-
помогою вбудованих контро-
лерів JTAG і ISP (див. 
рис. 9.7). Сигналом керування 
ТМS мультиплексорами (на 
рис. 9.13 показано перемика-
чами) зв’язки перемикаються: 
кристал від’єднується від зов-
нішніх входів, з комірок BSC 
утворюються вхідний і вихід-
ний регістри зсуву, за допомо-
гою яких здійснюється пери-

ферійне сканування. Вхідні тестові дані в послідовному коді надходять на 
вхід TDI послідовного введення вхідного регістра і за позитивними пере-
падами тактових імпульсів TCK відбувається послідовно-паралельне пере-
творення, після чого інформація з регістра подається в кристал у паралель-
ному коді. Через входи паралельного введення вихідного регістра дані з 

 
Рисунок 9.13 
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кристала записуються до вихідного регістра, після чого за негативними пе-
репадами тактових імпульсів TCK відбувається паралельно-послідовне пе-
ретворення – з виходу послідовного виведення ТDO знімаються вихідні те-
стові дані в послідовному коді. 

Така схема периферійного тестового сканування, що позначається 
абревіатурою BST (Boundary-Scan Test), використовується для перевірки 
наявності контактів на друкованій платі і на порожність ІС, її програму-
вання або конфігурування в системі, верифікацію, функціональне тесту-
вання та випробування ІС. Для автоматичного виконання таких операцій 
програматор (програмний модуль MAX+PLUS II) формує тестовий код, 
який вводиться до комірок мікросхеми зі входу TDI. Відтак з виходу ТDO 
зчитується результат і порівнюється залежно від операції, наприклад, з 
програмувальним або сигнальним файлом. 

9.1.3.3 Схеми програмування і конфігурування 
а) Програмування однієї мікросхеми в системі. Виводи ІС, призна-

чені для програмування, мають бути з’єднані на монтажній платі зі станда-
ртним 10-штирковим рознімачем 1DC10M інтерфейсу JTAG (рис. 9.14, а). 
За допомогою одного з інтерфейсних завантажувальних пристроїв цей ро-
знімач з’єднується з комп’ютером РС, завдяки чому під час програмування 
або конфігурування відбувається обмін даними між програматором 
MAX+PLUS II і мікросхемою. 

 
а) 

 
б) 

Рисунок 9.14 
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Поширеним є завантажувальний пристрій ByteBlasterMV, який є 
10-жильним стрічковим кабелем DB25 з двома рознімачами на кінцях. Один з 
них з’єднується з рознімачем JTAG, розташованим на платі з мікросхемою, а 
другий через шинний формувач (який живиться від джерела VCC на платі з 
ІС і змонтований в корпусі рознімача), з’єднується з 25-контактним розніма-
чем паралельного LPT-порту комп’ютера. Програмування з ByteBlasterMV 
(ByteBlaster MultiVolt) може застосовуватися за напруг живлення 
VCC = 2,5 В; 3,3 В та 5 В, а різновид ByteBlaster є придатним лише за напру-
ги 5 В. За значного (більше 1,2 м) віддалення плати з мікросхемою від 
комп’ютера використовують завантажувальні пристрої BitBlaster або 
MasterBlaster, що з’єднують стрічковим кабелем RS-232 рознімач JTAG на 
платі з послідовним портом комп’ютера RS-232 (порт COM). 

Процедуру фізичного програмування однієї мікросхеми в системі з 
інтерфейсними завантажувальними пристроями BitBlaster, ByteBlasterMV 
або MasterBlaster, а також типи ІС (із підтримуваних даною версією пакету 
MAX+PLUS II), які можна програмувати в такий спосіб,  наведено в розді-
лі довідки Programming a Single Device with the BitBlaster, ByteBlasterMV, 
or MasterBlaster; 

б) Програмування ланцюжка мікросхем. Стандарт IEEE Std 1149.1 
інтерфейсу JTAG дозволяє поширити схему периферійного сканування 
BST на низку мікросхем, якщо послідовно ввімкнути їх тестові входи TDI і 
виходи ТDO даних (рис. 9.14, б). Таке ввімкнення, що утворює ланцюжок 
JTAG (JTAG chain), застосовується для створення пристроїв та систем з кі-
лькох мікросхем. Схема з’єднань для програмування ланцюжка JTAG не 
відрізняється від схеми програмування однієї ІС (див. рис. 9.14, а). 

Процедуру фізичного програмування ланцюжка мікросхем з інтер-
фейсними завантажувальними пристроями BitBlaster, ByteBlasterMV або 
MasterBlaster, а також типи ІС (із підтримуваних даною версією пакету 
MAX+PLUS II), які можна програмувати в такий спосіб,  наведено в розді-
лі довідки Programming Multiple Devices in a JTAG Chain with the BitBlaster, 
ByteBlasterMV, or MasterBlaster; 

в) Конфігурування мікросхем. Схеми конфігурування однієї ІС в си-
стемі і кількох ІС ланцюжка JTAG аналогічні схемам програмування (див. 
рис. 9.13), відрізняються лише назви і кількість виводів ІС для конфігуру-
вання, з’єднаних на платі зі стандартним рознімачем. 

Процедуру конфігурування однієї ІС і ланцюжка мікросхем з інтер-
фейсними завантажувальними пристроями, а також типи ІС (із підтриму-
ваних даною версією пакету MAX+PLUS II), які можна конфігурувати в 
такий спосіб,  наведено в розділах довідки відповідно Configuring a Single 
Device with the BitBlaster, ByteBlasterMV, MasterBlaster, or FLEX Download 
Cable та Configuring Multiple Devices in a JTAG Chain with the BitBlaster, 
ByteBlasterMV, or MasterBlaster; 
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б) У діалоговому вікні Back-Annotate 
Project на вкладці Assignments to Back-
Annotate (призначення для зміни) вибрати 
тип, що містить Pin (вивід, штирок), напри-
клад, Chip, Logic Cell, Pin & Device та нати-
снути ОК; 

в) Інструментом вертикальної 
палітри (або з меню Layout > Current 

Assignments Floorplan) ввімкнути поточні 
(тобто нові) призначення заданих у пунк-
ті б) елементів розміщення. 

G Примітка. Якщо в проекті приз-
начено не всі елементи, то редактор розміщення виведе список непризна-
чених кіл і контактів у полі вікна Unassigned Nodes & Pins. Це поле можна 

використовувати також для тимчасового 
зберігання елементів під час їх перемі-
щення. 

г) Виставити в меню Options пра-
порець Show Moved Nodes in Gray (по-
казувати сірим переміщені вузли), після 
чого елемент Moved відобразиться в полі 
кольорових позначень вікна редактора; 

д) Взятися за контакт, наприклад, 
х6 і пересунути його для тимчасового 
зберігання до поля Unassigned Nodes & 
Pins (непризначені кола і контакти) або 
на вільний вивід (I/O), відтак на його мі-
сце перетягнути вхід х1, який відобра-
зиться сірим кольором. У такий самий 
спосіб впорядкувати розташування всіх 
входів (х1...х7) і виходів (N0…N2); 

е) Виконати перекомпіля-
цію проекту: піктограмою (або з 

меню MAX+plus II > Compiler) відкрити 
вікно компілятора, натиснути в ньому 
кнопку Start, кнопку ОК у віконці з пові-
домленням про успішну компіляцію піс-
ля її завершення та закрити вікно компі-
лятора. Внаслідок цього перепризначені 
контакти набудуть блакитного кольору. 

9.2.1.3 Виправити результати 



 187

неправильного призначення елементів у редакторі фізичного розміщення 
Floorplan Editor: 

а) Виконати п. 9.2.1.2, а)...д), але перемістити, наприклад, вхід х4 на 
контакт 7 (I/O, TDI) і запустити компілятор (п. 9.2.1.2, е); 

 
б) Після призупинення процесу компіляції у вікні процесора пові-

домлень з’явиться інформація про помилку, що не можна на вивід 7, приз-
начений для програмування/ конфігурування, помістити сигнал х4. У віко-
нці із запитом, чи не бажаєте Ви скасувати деякі налаштування і/або приз-
начення слід дати негативну відповідь, закрити віконце запиту і вікно ком-
пілятора, пересунути вхід х4 на попередню або іншу припустиму позицію 
(на вільний контакт I/O) та знов скомпілювати проект. 

G Примітка. Виправити неправильне призначення можна і в інший 
спосіб: виконати п. 9.2.1.3, а), б), але у віконці із запитом дати ствердну ві-
дповідь. 

в) З’явиться діалогове вікно Override User Assignments (відхилити 
призначення користувача), в якому повторюється інформація процесора 

повідомлень про зміст по-
милки. У цьому вікні слід 
натиснути кнопку Edit Pin 
Assignments & LCELLs (ре-
дагувати призначення кон-
тактів і логічних комірок). 

г) З’явиться нове ді-
алогове вікно Edit Pin As-
signments & LCELLs (реда-
гувати призначення контак-
тів і логічних комірок), в 
якому слід виділити рядок з 
неправильно призначеним 
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контактом для входу 
х4, ввімкнути опцію 
Ignore Pin Assignment 
(скасувати призначен-
ня контакту) і натис-
нути кнопку ОК.  

д) Натиснути 
кнопку ОК у поперед-
ньому діалоговому ві-
кні Override User As-
signments, після чого 
процес компіляції за-
вершиться. Відтак слід 

натиснути кнопку ОК у віконці з повідомленням про успішну компіляцію і 
закрити вікно компілятора.  

е) Натиснути на вертикальній палітрі інструмент відобра-
ження інформації про останню компіляцію (або в меню Layout ви-

ставити прапорець Last Compilation Floorplan) – вхід х4 повернеться на 
своє місце.  

9.2.1.4 Переглянути логічні зв’язки між контактами і логічними 
комірками або лотоками призначень: 

а) Виділити одну або декілька логічних комірок, натиснути інстру-
мент палітри Displays the fan-in to the selected item(s) – відображати вхідні 
зв’язки виділен(ого/их) елемент(а/ів) – (або в меню Options вибрати опцію 
Show Node Fan-In – показати вхідні зв’язки кіл) і спостерігати логічні 
зв’язки у вигляді рожево-бузкових ліній; 

б) Виділити один або декілька вхідних контактів, вимкнути інстру-
мент Fan-In і натиснути інструмент палітри Displays the fan-out to the se-
lected item(s) – відображати вихідні зв’язки виділен(ого/их) елемент(а/ів) – 
(або в меню Options вибрати опцію Show Node Fan-Out – показати вихідні 
зв’язки кіл) і спостерігати логічні зв’язки у вигляді зелених ліній. Так само 

виділити одну або декілька логічних ко-
мірок і спостерігати їх зв’язки з вихода-
ми; 

в) Виділити одну або декілька ло-
гічних комірок, ввімкнути обидва ін-
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статистика маршру
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або відсутність зв’язків між виділеними комірками; за її ввімкнення авт
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схеми з цим елементом пересу

ектн
натиснути п
in Design File
File). Після ць
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якщо компілятором було інакше синтезовано проект.
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схеми з цим елементом пересу
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натиснути піктограму панелі інструментів (або меню 
in Design File > натиснути ОК у діалоговому віконці

. Після цього з’явиться проектний файл із зазначеним елементом, н
приклад, схемою су
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інші, з’явиться повідомлення, що якийсь контакт не знайдено. Деякі ко
поненти проектного файла можуть бути відсутніми на плані мікросхеми, 
якщо компілятором було інакше синтезовано проект.

ж) Аби з’ясувати розміщення елемента проектного файла на 
плані мікросхеми, слід відкрити цей файл, наприклад, 500

виділити елемент і натиснути піктограму панелі інструментів (або меню 
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відображати шлях між виділеними елементами 
 Path – показати шлях

вигляді синіх ліній. 
Примітка. Команда 

або відсутність зв’язків між виділеними комірками; за її ввімкнення авт
матично вимикаються дві інші команди (

схеми з цим елементом пересу
) Аби з’ясувати зв’язок елемента на плані мікросхеми з пр

ми файлами слід виділити, наприклад, л
ктограму панелі інструментів (або меню 
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го з’явиться проектний файл із зазначеним елементом, н
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на контактів
сля цього шуканий контакт буде вид
лений та частина плану складної мікр

схеми з цим елементом пересунеться в поле зору вікна;
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поненти проектного файла можуть бути відсутніми на плані мікросхеми, 
якщо компілятором було інакше синтезовано проект.

) Аби з’ясувати розміщення елемента проектного файла на 
плані мікросхеми, слід відкрити цей файл, наприклад, 500

мент і натиснути піктограму панелі інструментів (або меню 
Utilities > Find Node in Floorplan > натиснути ОК у 

. Після цього з’явиться план мікросхеми
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показати шлях) і спостерігати логічні

Path дозволяє лише з’ясувати наявність 
або відсутність зв’язків між виділеними комірками; за її ввімкнення авт
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ктограму панелі інструментів (або меню 
натиснути ОК у діалоговому віконці
го з’явиться проектний файл із зазначеним елементом, н

Якщо в проектному файлі імена входів або виходів 
інші, з’явиться повідомлення, що якийсь контакт не знайдено. Деякі ко
поненти проектного файла можуть бути відсутніми на плані мікросхеми, 
якщо компілятором було інакше синтезовано проект.

) Аби з’ясувати розміщення елемента проектного файла на 
плані мікросхеми, слід відкрити цей файл, наприклад, 500

мент і натиснути піктограму панелі інструментів (або меню 
натиснути ОК у 

. Після цього з’явиться план мікросхеми
виділеними комірками або контактами, в яких розміщено заданий елемент. 
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оці призначень (або ви
tions вибрати опцію 

тизації) викликати вікно Routing
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Якщо в проектному файлі імена входів або виходів 
інші, з’явиться повідомлення, що якийсь контакт не знайдено. Деякі ко
поненти проектного файла можуть бути відсутніми на плані мікросхеми, 
якщо компілятором було інакше синтезовано проект.  
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Якщо в проектному файлі імена входів або виходів 
інші, з’явиться повідомлення, що якийсь контакт не знайдено. Деякі ко
поненти проектного файла можуть бути відсутніми на плані мікросхеми, 

) Аби з’ясувати розміщення елемента проектного файла на 
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ванням перегородки). Власне рівняння розташовано в центральній частині, 
у лівій 
хідні сигнали, для формування

 

чності встановити в цьому ж меню 
з’явиться вік

б) Клацнути 
в ній рівняння. Вікно 
складається з трьох частин (ширину кожної з них можна змінити 
ванням перегородки). Власне рівняння розташовано в центральній частині, 
у лівій – вхідні сигнали, з яких формуються терми рівнянь, а в правій 
хідні сигнали, для формування

чності встановити в цьому ж меню 
з’явиться вікно для рівнянь;

б) Клацнути 
в ній рівняння. Вікно 
складається з трьох частин (ширину кожної з них можна змінити 
ванням перегородки). Власне рівняння розташовано в центральній частині, 

вхідні сигнали, з яких формуються терми рівнянь, а в правій 
хідні сигнали, для формування

чності встановити в цьому ж меню 
но для рівнянь; 

б) Клацнути на логічн
в ній рівняння. Вікно Report
складається з трьох частин (ширину кожної з них можна змінити 
ванням перегородки). Власне рівняння розташовано в центральній частині, 

вхідні сигнали, з яких формуються терми рівнянь, а в правій 
хідні сигнали, для формування
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чності встановити в цьому ж меню Full

логічній комірці
Report File Equation 

складається з трьох частин (ширину кожної з них можна змінити 
ванням перегородки). Власне рівняння розташовано в центральній частині, 

вхідні сигнали, з яких формуються терми рівнянь, а в правій 
хідні сигнали, для формування яких використовуються рівняння;
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Full Screen (повний екр

ці – у вікні відобразяться сформовані 
File Equation Viewer

складається з трьох частин (ширину кожної з них можна змінити 
ванням перегородки). Власне рівняння розташовано в центральній частині, 

вхідні сигнали, з яких формуються терми рівнянь, а в правій 
яких використовуються рівняння;

область мікросхеми, в 
якій залиши
менше ресурсу) і зч
тати інф
на статистики.

лянути логічні рі
няння і їх зв’язок з 
елементами плану 
мікросхеми:

out (розташування) в
брати 
Equation 
перегляду рівнянь зві
ного файла) та для зр

повний екр

у вікні відобразяться сформовані 
Viewer (див. ілюстрацію 

складається з трьох частин (ширину кожної з них можна змінити 
ванням перегородки). Власне рівняння розташовано в центральній частині, 

вхідні сигнали, з яких формуються терми рівнянь, а в правій 
яких використовуються рівняння;

область мікросхеми, в 
якій залишилось на
менше ресурсу) і зч
тати інформацію з ві
на статистики.

9.2.1.6 Пере
лянути логічні рі
няння і їх зв’язок з 
елементами плану 

росхеми: 
а) У меню 

(розташування) в
брати Report
Equation Viewer
перегляду рівнянь зві
ного файла) та для зр

повний екран). Внизу екрана 

у вікні відобразяться сформовані 
(див. ілюстрацію 

складається з трьох частин (ширину кожної з них можна змінити 
ванням перегородки). Власне рівняння розташовано в центральній частині, 

вхідні сигнали, з яких формуються терми рівнянь, а в правій 
яких використовуються рівняння; 

область мікросхеми, в 
лось най-

менше ресурсу) і зчи-
рмацію з вік-

на статистики. 
9.2.1.6 Перег-

лянути логічні рів-
няння і їх зв’язок з 
елементами плану 

а) У меню Lay-
(розташування) ви-

Report File 
Viewer (вікно 

перегляду рівнянь звіт-
ного файла) та для зру-

ан). Внизу екрана 

у вікні відобразяться сформовані 
(див. ілюстрацію вище) 

складається з трьох частин (ширину кожної з них можна змінити перетягу-
ванням перегородки). Власне рівняння розташовано в центральній частині, 

вхідні сигнали, з яких формуються терми рівнянь, а в правій – ви-
 

область мікросхеми, в 
й-
и-
к-

г-
в-

няння і їх зв’язок з 
елементами плану 

y-
и-

File 
(вікно 
т-
у-

ан). Внизу екрана 

 
у вікні відобразяться сформовані 

) 
у-

ванням перегородки). Власне рівняння розташовано в центральній частині, 
и-



 

вхідні та вихідні зв’язки) наочно відобразити кольоровими лініями на пл
ні мікросхеми зв’язок логічних рі

полі рівнянь з’явиться його ім’я, у полі виходів 
ли, в яких використовується цей вхід, а на плані ці зв’язки буде відображ
н
комірки за п. 
клацнути і натиснути кнопку < 
слід натиснути кнопку 

–
полі входів 
на плані ці зв’язки буде відображено рожево
му дію можна виконати, якщо у вікні рівнянь комірки за п. 
клацнути ім’я виходу в полі 
To

би програмування

 

fan-
вибором опцій 

вхідні та вихідні зв’язки) наочно відобразити кольоровими лініями на пл
ні мікросхеми зв’язок логічних рі

г) Клацнути на плані мікросхеми вхідний контакт, наприклад, х1 
полі рівнянь з’явиться його ім’я, у полі виходів 
ли, в яких використовується цей вхід, а на плані ці зв’язки буде відображ
но зеленими лініями. Цю ж саму дію можна виконати, якщо у вікні рівнянь 
комірки за п. 
клацнути і натиснути кнопку < 
слід натиснути кнопку 

д) Клацнути на плані мікросхеми вихідний контакт, наприклад, 
– у полі Equations
полі входів 
на плані ці зв’язки буде відображено рожево
му дію можна виконати, якщо у вікні рівнянь комірки за п. 
клацнути ім’я виходу в полі 
To >). Для повернення до рівнянь комірки слід натиснути кнопку 

9.2.
9.2.2.1 Підімкнути до персонального комп’ютера апаратні зас

би програмування
9.2.2.2 Відкрити вікно програматора

надати проектові ім’я відповідно до імені поточ

в) Інструментами палітри 
-out (відображати вхідні та вихідні зв’язки) або з меню 

вибором опцій 
вхідні та вихідні зв’язки) наочно відобразити кольоровими лініями на пл
ні мікросхеми зв’язок логічних рі

г) Клацнути на плані мікросхеми вхідний контакт, наприклад, х1 
полі рівнянь з’явиться його ім’я, у полі виходів 
ли, в яких використовується цей вхід, а на плані ці зв’язки буде відображ
о зеленими лініями. Цю ж саму дію можна виконати, якщо у вікні рівнянь 
комірки за п. 9.2.1.6,
клацнути і натиснути кнопку < 
слід натиснути кнопку 

Клацнути на плані мікросхеми вихідний контакт, наприклад, 
Equations 

полі входів – комірки і вхідні сигнали, які використовуються в рівняннях, а 
на плані ці зв’язки буде відображено рожево
му дію можна виконати, якщо у вікні рівнянь комірки за п. 
клацнути ім’я виходу в полі 

>). Для повернення до рівнянь комірки слід натиснути кнопку 
9.2.2 Засвоїти
9.2.2.1 Підімкнути до персонального комп’ютера апаратні зас

би програмування, переконатися в правильності з’єднань.
9.2.2.2 Відкрити вікно програматора

а) Відкрити потрібний згідно із завданням проектний файл і 
надати проектові ім’я відповідно до імені поточ

в) Інструментами палітри 
(відображати вхідні та вихідні зв’язки) або з меню 

вибором опцій Show Node
вхідні та вихідні зв’язки) наочно відобразити кольоровими лініями на пл
ні мікросхеми зв’язок логічних рі

г) Клацнути на плані мікросхеми вхідний контакт, наприклад, х1 
полі рівнянь з’явиться його ім’я, у полі виходів 
ли, в яких використовується цей вхід, а на плані ці зв’язки буде відображ
о зеленими лініями. Цю ж саму дію можна виконати, якщо у вікні рівнянь 

1.6, б) двічі клацнути
клацнути і натиснути кнопку < 
слід натиснути кнопку Go To

Клацнути на плані мікросхеми вихідний контакт, наприклад, 
 з’являться рівняння, що формують вихідний сигнал, у 

комірки і вхідні сигнали, які використовуються в рівняннях, а 
на плані ці зв’язки буде відображено рожево
му дію можна виконати, якщо у вікні рівнянь комірки за п. 
клацнути ім’я виходу в полі 

>). Для повернення до рівнянь комірки слід натиснути кнопку 
2 Засвоїти основи фізичного програмування мікросхеми

9.2.2.1 Підімкнути до персонального комп’ютера апаратні зас
, переконатися в правильності з’єднань.

9.2.2.2 Відкрити вікно програматора
а) Відкрити потрібний згідно із завданням проектний файл і 

надати проектові ім’я відповідно до імені поточ
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в) Інструментами палітри 
(відображати вхідні та вихідні зв’язки) або з меню 

Node Fan
вхідні та вихідні зв’язки) наочно відобразити кольоровими лініями на пл
ні мікросхеми зв’язок логічних рівнянь з вхідними і вихідними сигна

г) Клацнути на плані мікросхеми вхідний контакт, наприклад, х1 
полі рівнянь з’явиться його ім’я, у полі виходів 
ли, в яких використовується цей вхід, а на плані ці зв’язки буде відображ
о зеленими лініями. Цю ж саму дію можна виконати, якщо у вікні рівнянь 

двічі клацнути
клацнути і натиснути кнопку < Go To). Для повернення до рівнянь комірки 

To >; 
Клацнути на плані мікросхеми вихідний контакт, наприклад, 

з’являться рівняння, що формують вихідний сигнал, у 
комірки і вхідні сигнали, які використовуються в рівняннях, а 

на плані ці зв’язки буде відображено рожево
му дію можна виконати, якщо у вікні рівнянь комірки за п. 
клацнути ім’я виходу в полі Fan-Out (або клацнути і натиснути кнопку 

>). Для повернення до рівнянь комірки слід натиснути кнопку 
основи фізичного програмування мікросхеми

9.2.2.1 Підімкнути до персонального комп’ютера апаратні зас
, переконатися в правильності з’єднань.

9.2.2.2 Відкрити вікно програматора
а) Відкрити потрібний згідно із завданням проектний файл і 

надати проектові ім’я відповідно до імені поточ
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в) Інструментами палітри Displays
(відображати вхідні та вихідні зв’язки) або з меню 

Fan-In та Show
вхідні та вихідні зв’язки) наочно відобразити кольоровими лініями на пл

внянь з вхідними і вихідними сигна
г) Клацнути на плані мікросхеми вхідний контакт, наприклад, х1 

полі рівнянь з’явиться його ім’я, у полі виходів 
ли, в яких використовується цей вхід, а на плані ці зв’язки буде відображ
о зеленими лініями. Цю ж саму дію можна виконати, якщо у вікні рівнянь 

двічі клацнути на імені
). Для повернення до рівнянь комірки 

Клацнути на плані мікросхеми вихідний контакт, наприклад, 
з’являться рівняння, що формують вихідний сигнал, у 

комірки і вхідні сигнали, які використовуються в рівняннях, а 
на плані ці зв’язки буде відображено рожево-бузк
му дію можна виконати, якщо у вікні рівнянь комірки за п. 

(або клацнути і натиснути кнопку 
>). Для повернення до рівнянь комірки слід натиснути кнопку 

основи фізичного програмування мікросхеми
9.2.2.1 Підімкнути до персонального комп’ютера апаратні зас

, переконатися в правильності з’єднань.
9.2.2.2 Відкрити вікно програматора: 

а) Відкрити потрібний згідно із завданням проектний файл і 
надати проектові ім’я відповідно до імені поточ

Displays the fan
(відображати вхідні та вихідні зв’язки) або з меню 

Show Node 
вхідні та вихідні зв’язки) наочно відобразити кольоровими лініями на пл

внянь з вхідними і вихідними сигна
г) Клацнути на плані мікросхеми вхідний контакт, наприклад, х1 

полі рівнянь з’явиться його ім’я, у полі виходів – комірки і вихідні сигн
ли, в яких використовується цей вхід, а на плані ці зв’язки буде відображ
о зеленими лініями. Цю ж саму дію можна виконати, якщо у вікні рівнянь 

ені входу в полі 
). Для повернення до рівнянь комірки 

Клацнути на плані мікросхеми вихідний контакт, наприклад, 
з’являться рівняння, що формують вихідний сигнал, у 

комірки і вхідні сигнали, які використовуються в рівняннях, а 
бузковими лініями. Цю ж с

му дію можна виконати, якщо у вікні рівнянь комірки за п. 
(або клацнути і натиснути кнопку 

>). Для повернення до рівнянь комірки слід натиснути кнопку 
основи фізичного програмування мікросхеми

9.2.2.1 Підімкнути до персонального комп’ютера апаратні зас
, переконатися в правильності з’єднань.

а) Відкрити потрібний згідно із завданням проектний файл і 
надати проектові ім’я відповідно до імені поточного файла;

an-in та Displays
(відображати вхідні та вихідні зв’язки) або з меню 

 Fan-Out (показати 
вхідні та вихідні зв’язки) наочно відобразити кольоровими лініями на пл

внянь з вхідними і вихідними сигна
г) Клацнути на плані мікросхеми вхідний контакт, наприклад, х1 

комірки і вихідні сигн
ли, в яких використовується цей вхід, а на плані ці зв’язки буде відображ
о зеленими лініями. Цю ж саму дію можна виконати, якщо у вікні рівнянь 

входу в полі Fan
). Для повернення до рівнянь комірки 

Клацнути на плані мікросхеми вихідний контакт, наприклад, 
з’являться рівняння, що формують вихідний сигнал, у 

комірки і вхідні сигнали, які використовуються в рівняннях, а 
овими лініями. Цю ж с

му дію можна виконати, якщо у вікні рівнянь комірки за п. 9.2.1.6,
(або клацнути і натиснути кнопку 

>). Для повернення до рівнянь комірки слід натиснути кнопку < 
основи фізичного програмування мікросхеми

9.2.2.1 Підімкнути до персонального комп’ютера апаратні зас
, переконатися в правильності з’єднань. 

а) Відкрити потрібний згідно із завданням проектний файл і 
ного файла;

Displays the
(відображати вхідні та вихідні зв’язки) або з меню Options

(показати 
вхідні та вихідні зв’язки) наочно відобразити кольоровими лініями на пла-

внянь з вхідними і вихідними сигналами; 
г) Клацнути на плані мікросхеми вхідний контакт, наприклад, х1 – у 

комірки і вихідні сигна-
ли, в яких використовується цей вхід, а на плані ці зв’язки буде відображе-
о зеленими лініями. Цю ж саму дію можна виконати, якщо у вікні рівнянь 

Fan-In (або 
). Для повернення до рівнянь комірки 

Клацнути на плані мікросхеми вихідний контакт, наприклад, N0 
з’являться рівняння, що формують вихідний сигнал, у 

комірки і вхідні сигнали, які використовуються в рівняннях, а 
овими лініями. Цю ж са-

1.6, б) двічі 
(або клацнути і натиснути кнопку Go

< Go To. 
основи фізичного програмування мікросхеми 

9.2.2.1 Підімкнути до персонального комп’ютера апаратні засо-

а) Відкрити потрібний згідно із завданням проектний файл і 
ного файла; 

 

the 
Options 

(показати 
а-
 
у 
а-
е-

о зеленими лініями. Цю ж саму дію можна виконати, якщо у вікні рівнянь 
(або 

). Для повернення до рівнянь комірки 

0 
з’являться рівняння, що формують вихідний сигнал, у 

комірки і вхідні сигнали, які використовуються в рівняннях, а 
а-

двічі 
Go 

о-

а) Відкрити потрібний згідно із завданням проектний файл і 

 



 

(Programmer)

вікна 

Programmer Log File (.plf):

файли (серед них і 
кті, завантажуються програматором автоматично для подальшого функц
онального тестування ІС. Якщо Р
він записується заново, а за вимкненої опції 
нуючого.

ню JTAG вимкнути Multi
мікросхем) та в меню FLEX вимкнути Multi
з декількох мікросхем FLEX).

грамування викликати з меню 
(опції програмування) і встановити в ньому прапорці: 

писаної до неї інформації перед програмуванням (за вимкненої цієї опції 

 

MAX+plus
(Programmer)

в) Ознайомитися з органами керування та інформаційними полями 
вікна програматора (Programmer), усвідомити їх призначення. 

9.2.2.3 Створити вихідний файл реєстрації програматора
Programmer Log File (.plf):

файли (серед них і 
кті, завантажуються програматором автоматично для подальшого функц
онального тестування ІС. Якщо Р
він записується заново, а за вимкненої опції 
нуючого. 

9.2.2.4 Виконати фізичне програмування ІС
а) У разі потреби встановити режим програмування одної ІС: в м

ню JTAG вимкнути Multi
мікросхем) та в меню FLEX вимкнути Multi
з декількох мікросхем FLEX).

б) Для автоматичного виконання низки дій під час фізичного пр
грамування викликати з меню 
(опції програмування) і встановити в ньому прапорці: 

– Blank
писаної до неї інформації перед програмуванням (за вимкненої цієї опції 

б) Піктограмою панелі інструментів (або з меню
MAX+plus II > Programmer) 

(Programmer); 

в) Ознайомитися з органами керування та інформаційними полями 
програматора (Programmer), усвідомити їх призначення. 

9.2.2.3 Створити вихідний файл реєстрації програматора
Programmer Log File (.plf):

файли (серед них і 
кті, завантажуються програматором автоматично для подальшого функц
онального тестування ІС. Якщо Р
він записується заново, а за вимкненої опції 
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мікросхем) та в меню FLEX вимкнути Multi
з декількох мікросхем FLEX).
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грамування викликати з меню 
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писаної до неї інформації перед програмуванням (за вимкненої цієї опції 

б) Піктограмою панелі інструментів (або з меню
II > Programmer) 

в) Ознайомитися з органами керування та інформаційними полями 
програматора (Programmer), усвідомити їх призначення. 

9.2.2.3 Створити вихідний файл реєстрації програматора
Programmer Log File (.plf): 

файли (серед них і SCF-файл часових діаграм), якщо вони існують у про
кті, завантажуються програматором автоматично для подальшого функц
онального тестування ІС. Якщо Р
він записується заново, а за вимкненої опції 

9.2.2.4 Виконати фізичне програмування ІС
а) У разі потреби встановити режим програмування одної ІС: в м

ню JTAG вимкнути Multi-Device JTAG 
мікросхем) та в меню FLEX вимкнути Multi
з декількох мікросхем FLEX).

б) Для автоматичного виконання низки дій під час фізичного пр
грамування викликати з меню 
(опції програмування) і встановити в ньому прапорці: 

Check Before 
писаної до неї інформації перед програмуванням (за вимкненої цієї опції 
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б) Піктограмою панелі інструментів (або з меню
II > Programmer) 

в) Ознайомитися з органами керування та інформаційними полями 
програматора (Programmer), усвідомити їх призначення. 

9.2.2.3 Створити вихідний файл реєстрації програматора

файл часових діаграм), якщо вони існують у про
кті, завантажуються програматором автоматично для подальшого функц
онального тестування ІС. Якщо РLF-фа
він записується заново, а за вимкненої опції 

9.2.2.4 Виконати фізичне програмування ІС
а) У разі потреби встановити режим програмування одної ІС: в м

Device JTAG 
мікросхем) та в меню FLEX вимкнути Multi
з декількох мікросхем FLEX). 

б) Для автоматичного виконання низки дій під час фізичного пр
грамування викликати з меню Options діалогове вікно 
(опції програмування) і встановити в ньому прапорці: 

Check Before Programming
писаної до неї інформації перед програмуванням (за вимкненої цієї опції 
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б) Піктограмою панелі інструментів (або з меню
II > Programmer) викликати вікно програматора 

в) Ознайомитися з органами керування та інформаційними полями 
програматора (Programmer), усвідомити їх призначення. 

9.2.2.3 Створити вихідний файл реєстрації програматора

а) З меню File > 
Inputs/Outputs (входи/виходи) в
кликати діалогове вік
Inputs/Outputs;

б) На вкладці Output File 
(вихідний файл) ввімкнути тип Log 
(.plf) – 
ім’я, яке вноситься до списку фа
лів Files

в) Натиснути кнопку ОК у 
цьому вікні.

G
файлі звітності (.plf) записуються 
дії програматора. Потрібні вхідні 

файл часових діаграм), якщо вони існують у про
кті, завантажуються програматором автоматично для подальшого функц

файл існує, то за ввімкненої опції 
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б) Для автоматичного виконання низки дій під час фізичного пр
Options діалогове вікно 
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в) Ознайомитися з органами керування та інформаційними полями 
програматора (Programmer), усвідомити їх призначення. 

9.2.2.3 Створити вихідний файл реєстрації програматора

а) З меню File > 
Inputs/Outputs (входи/виходи) в
кликати діалогове вік
Inputs/Outputs; 

б) На вкладці Output File 
ихідний файл) ввімкнути тип Log 

 файл реєстрації 
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Files; 
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цьому вікні. 
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таку перевірку можна виконати вручну кнопкою Blank-Check у діалогово-
му вікні Programmer); 

– Verify After Programming – верифікація (перевірка) ІС після про-
грамування на відповідність записаної до неї інформації даним програму-
вального файла (за вимкненої цієї опції таку перевірку можна виконати 
вручну кнопкою Verify в діалоговому вікні Programmer); якщо верифікацію 
не виконувати, надійність не гарантується; 

– Test After Programming – функціональне тестування ІС після про-
грамування, яке полягає в завантаженні SCF-файла і перевірці вхідних і 
вихідних сигналів ІС на відповідність часовим діаграмам SCF-файла (за 
вимкненої цієї опції таку перевірку можна виконати вручну кнопкою Test у 
діалоговому вікні Programmer); 

– Initiate Configuration After Programming – використовується під 
час конфігурування ІС; 

в) За необхідності вставити відповідний адаптер в модуль MPU (або 
APU) та мікросхему в рознімач програмування (у „панельку”). 

г) У вікні Programmer натиснути кнопку Program. Після цього про-
граматор за ввімкнених відповідних опцій автоматично перевіряє ІС на ві-
дсутність записаної до неї інформації, програмує проект до мікросхеми, 
зчитує з неї записані дані і порівнює їх з даними програмного файла (.pof) 
та виконує функціональне тестування. 

д) Переглянути текстовий файл звітності програматора (.plf). 

G Примітка. Для мікросхем з ультрафіолетовим стиранням даних 
(Classic, MAX 5000, MAX 7000) перед програмуванням (або якщо під час 
програмування була зупинка) вимагається стирання. Для інших мікросхем 
стирання не потрібно. Для мікросхеми ACEX 1K, FLEX 6000, FLEX 8000 
та FLEX 10K використовується режим конфігурування, але не програму-
вання.  

9.2.3 Дослідити пристрій на запрограмованій ІС 

9.2.3.1 Розробити методику експериментального дослідження 
пристрою на запрограмованій ІС. 

9.2.3.2 Виконати необхідні експериментальні дослідження. 

9.2.3.3 Порівняти результати експериментальних досліджень з 
даними проектних файлів, зробити висновки. 

 
Контрольні питання та завдання 



 194

1. Чим відрізняються сучасні програмовані ПЛІС від мікропроцесо-
рних ІС, робота яких базується на виконанні програми? Порівняйте мож-
ливості таких ІС щодо складності виконуваних функцій і швидкодії. 

2. Схарактеризуйте відмінності щодо реконфігурування структури 
ПЛІС типу EPLD з електричним стиранням (EЕPROM-based) і з пам’яттю 
конфігурації, основаній на СОЗУ (SRAM-based). Які елементи пам’яті 
конфігурації застосовуються для цих типів ПЛІС? Що розуміється в САПР 
під термінами „програмування” і „конфігурування”? 

3. Зобразіть схему ПЛМ для реалізації одного з варіантів функції 
завдання 2 (див. додаток А, варіанти завдання 2). 

4. Поясніть архітектуру ПЛІС типу EPLD: призначення сигналів і 
складників та їх взаємодію. 

5. Поясніть архітектуру ПЛІС типу FLEX: призначення сигналів і 
складників та їх взаємодію. 

6. Дайте поняття інтерфейсу JTAG і поясніть схеми програмування 
однієї ПЛІС та їх ланцюжка. 
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Додаток А 
Індивідуальні завдання до лабораторних робіт 

 
Варіанти завдання 1 

Наведіть для кожної схеми (а...п) заданого рисунку значення конс-
танти або умовне позначення еквівалентного логічного елемента, якщо 
елемент A виконує таку логічну функцію (далі наводиться варіант – рису-
нок – функція): 1) А1 – АБО,  2) А1 – І,   3) А1 – Виключне АБО,  4) А1 – 
Заборона,   5) А1 –  АБО-НЕ,  6) А1 – І-НЕ,  7) А1 – Виключне  АБО-НЕ, 
8) А1 – Імплікація, 9) А2 – АБО, 10) А2 – І,  11) А2 – Виключне АБО, 
12) А2 – Заборона, 13) А2 –  АБО-НЕ, 14) А2 – І-НЕ, 15) А2 – Виключне  
АБО-НЕ,  16) А2 – Імплікація.  

 
а) 

 
б) 

 
в) 

 
г) 

 
д) 

 
е) 

 
ж) 

 
и) 

 
к) 

 
л) 

 
м) 

 
н) 
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Рисунок А1 
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Рисунок А2 
 
 

Варіанти завдання 2 
Для заданої згідно з варіантом логічної функції y: а) побудувати 

таблицю відповідності і діаграму термів (Вайча-Карно); б)  навести доско-
налі (ДДНФ або ДКНФ) та мінімальні (МДНФ і МКНФ) форми; в) перет-
ворити мінімальні форми до базисів І-НЕ, АБО-НЕ, І-АБО-НЕ; г) мінімізу-
вати схему в базисі І-НЕ, АБО-НЕ чи мішаному, який забезпечує меншу 
складність; д) навести схеми за п. в), г); е) записати задану логічну функ-
цію (без перетворень) та вирази за п. в), г) мовою опису апаратури AHDL. 

1) ( ) ( )213\1 xxxy →⊕= ;   

2) ( )[ ]132\1 xxxy →⊕= ;  

3) ( ) ( )123123 \\ xxxxxxy +⊕→= ;  

4) ( ) ( )[ ]32321\1 xxxxxy ⊕→→= ;  

5) ( )[ ]31342\1 xxxxxy ⊕→+= ;  
6) ( ) ( )[ ]32341 \\1 xxxxxy ⊕→= ;  

7) ( ) ( )[ ]321423321 \\1 xxxxxxxxxy ⊕→++= ; 

8) ( ) ( ) ( )32421321 \ xxxxxxxxy ⊕+→+= ;  

9) ( ) ( )215454312 \ xxxxxxxxxy ⊕→++= ;  

10) ( )[ ]53434321\1 xxxxxxxxy +→⊕++= . 
 

Варіанти завдання 3 
а) Записати апаратною мовою AHDL логічну функцію (первісний 

вираз без перетворень) свого варіанта завдання 2.  
б) Спроектувати на основі двійкового дешифратора перетворювач 

(дешифратор) до семисегментного коду для індикації знаків: 
1) E, r, A; 2) d, o, b, A; 3) r, A, d, I, o; 4) A, b, C, d, E, F; 5) P, O, L, E, 

H, A, C; 6) b, L, o, c, A, h, r, E; 7) C, U, r, d, O, H, L, E, b; 8) 0…9; 9) 0...7; 
10) H, E, r, c. 

 в) Побудувати дешифратор-демультиплексор (двійковий):  
Варіант* 1 2 3 4 5 6 7 8 9 10 
Розрядність 4:9 3:5 4:10 3:6 4:11 3:7 4:12 3:8 4:13 4:14 

* Варіанти 11...20 – те саме, але з інверсними виходами.    
 

Варіанти завдання 4 
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Спроектувати ЦКП для реалізації логічної функції, заданої згідно з 
варіантом завдання 2, на мультиплексорах різної розрядності та вибрати 
оптимальний варіант. 
 

Варіанти завдання 5 
Побудувати пороговий елемент на суматорах і компараторах: 
1) 2 з 5, 2) 3 з 6, 3) 3 з 7, 4) 4 з 8, 5) 3 з 5, 6) 4 з 6, 7) 3 з 8, 8) 4 з 9, 

9) 4 з 5, 10) 5 з 8, 11) 6 з 9, 12) 7 з 10. 
 

Варіанти завдання 6 
За дóзвільного рівня Enable синхроімпульсом Clock записати до 

тригерів дані і сформувати на їхніх виходах логічну функцію, задану варі-
антом завдання 2, за власним вибором базису. 
 

Варіанти завдання 7 
Спроектувати на основі регістра зсуву ЦПП (далі наводиться тип 

пристрою – варіант – дані): 
ГКП реверсивний – 1) N = (0000101); 5) М = 5; 9) N = (00101); 
РІР  – 2) N = (01111); 6) М = 7; 10) М = 9; 
ГКП– 3) М = 7; 7) N = (01011);  11) N = (0001101);    
РІР реверсивний – 4) М = 5; 8) N = (00011); 12) М = 6. 

 
Варіанти завдання 8 

Спроектувати згідно з варіантом:  
а) недвійковий лічильник із заданим модулем М і звичайним поряд-

ком лічби шляхом перетворення двійкового лічильника (далі наводиться 
варіант – модуль): 1) М =3, 4, 5 – програмований; 2) М = 15; 3) М = 6, 7, 
8 - програмований; 4) М = 14; 5) М = 5, 10 – програмований; 6) М = 13; 
7) М = 9, 10 – програмований; 8) М = 12; 9) М = 10, 15 - програмований; 
10) М = 11;  

б) недвійковий лічильник із заданим модулем М і звичайним поряд-
ком лічби на тригерах зі зворотними зв’язками (далі наводиться варіант – 
модуль – тип тригерів): 1) М = 11 – D; 2) М = 7 – JK – реверсивний; 
3) М = 5 – RSC;  4) М = 7 – D – реверсивний; 5) М = 9 – TE;  6) М = 6 – RSC 
– реверсивний;  7) М =10 – JK; 8) М = 6 – TE – реверсивний;  9) М = 9 – JK; 
10) М = 5 – D – реверсивний; 

в) безвентильний подільник частоти на JK-тригерах (далі наводить-
ся варіант – модуль): 1) М = 6; 2) М = 7; 3) М = 9; 4) М = 10; 5) М = 14; 
6) М = 12; 7) М = 18; 8) М = 20; 9) М = 15; 10) М = 17. 
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Варіанти завдання 9 
Виконати фізичне програмування ПЛІС EPM7128S для реалізації 

функції згідно з варіантом завдання 3, б). 
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Додаток Б 
Таблиці до опису лабораторного стенда 

 
Таблиця Б1 – Дублювальні роз’єми мікросхеми EPM7128S 

Таблиця Б2 – Контакти рознімача  JTAG_IN 
Контакт Сигнал JTAG Призначення 

1 TCK Тактові імпульси 
2 GND Земля 
3 TDO Вихід даних 
4 VCC Напруга живлення (+) 

5 TMS Керування  
автоматом JTAG 

6 Не задіяний – 
7 Не задіяний – 
8 Не задіяний – 
9 TDI Вхід даних 
10 GND Земля 

 
Таблиця Б3 – Режими програмування 

Режим TDI TDO DEVICE BOARD 
Програмування мікросхеми C1&C2 C1&C2 C1&C2 C1&C2 
Конфігурування мікросхеми C2&C3 C2&C3 C1&C2 C1&C2 
Сумісне конфігурування 

двох мікросхем  C2&C3 C1&C2 C2&C3 C1&C2 

Об'єднання кількох плат UP2  C2&C3 Відкритий C2&C3 C2&C3 

P1 P2 P3 P4 
Зовні-
шній 

Внут-
рішній 

Зовні-
шній 

Внут-
рішній 

Зовні-
шній 

Внут-
рішній 

Зовні-
шній 

Внут-
рішній 

75 76 12 13 33 34 54 55 
77 78 14 15 35 36 56 57 
79 80 16 17 37 38 58 59 
81 82 18 19 39 40 60 61 
83 84 20 21 41 42 62 63 
1 2 22 23 43 44 64 65 
3 4 24 25 45 46 66 67 
5 6 26 27 47 48 68 69 
7 8 28 29 49 50 70 71 
9 10 30 31 51 52 72 73 
11 Х 32 Х 53 Х 74 Х 
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Таблиця Б4 – Семисегментні індикатори мікросхеми EPM7128S 

Сегмент 
Контакти мікросхеми, 
приєднані до першого 

знакомісця 

Контакти мікросхеми, 
приєднані до другого 

знакомісця 
а 58 69 
b 60 70 
c 61 73 
d 63 74 
e 64 76 
f 65 75 
g 67 77 

DP (знак десятково-
го дробу) 68 79 

 



 202

Навчальне видання 
 
 

Віктор Леонідович Кофанов 
Олександр Володимирович Осадчук 
Дмитро Володимирович Гаврілов 

 
 
 

ЛАБОРАТОРНИЙ ПРАКТИКУМ  
З ДОСЛІДЖЕННЯ ЦИФРОВИХ ПРИСТРОЇВ 

НА ОСНОВІ САПР MAX+PLUS II 
 

Навчальний посібник 
 
 
 
Оригінал-макет підготовлено Гавріловим Д.В. 
 
Редактор Т.О. Старічек 
  

Науково-методичний відділ ВНТУ 
Свідоцтво Держкомінформу України 
серія ДК № 746 від 25.12.2001 

21021, м. Вінниця, Хмельницьке шосе, 95, ВНТУ 
 
 
 
 
Підписано до друку Гарнітура Times New Roman 
Формат 29,7х42 4

1  Папір офсетний 
Друк різографічний Ум. друк. арк.  
Тираж           прим. 
Зам. №   
 
 
 

Віддруковано в комп’ютерному інформаційно-видавничому центрі 
Вінницького національного технічного університету 

Свідоцтво Держкомінформу України 
серія ДК № 746 від 25.12.2001 

21021, м. Вінниця, Хмельницьке шосе, 95, ВНТУ 



 203

 


